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1.  Introduction

1.1.  Copyright Notice
© Copyright 2023 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BV. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BV does not warrant, guarantee or make any representations regarding
the use, or the results of the use of the software or the information contained herein. Esko Software
BV shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use
or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in
any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means
without prior written permission from Esko Software BV.

This document supersedes all previous dated versions.

PANTONE
®

 Colors displayed in the software application or in the user documentation may not match
PANTONE-identified standards. Consult current PANTONE Color Publications for accurate color.
PANTONE

®
 and other Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to distribute
for use only in combination with Studio Visualizer. PANTONE Color Data and/or Software shall not be
copied onto another disk or into memory unless as part of the execution of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young
(eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.
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Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle
corporation in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered
trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Oce.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by GlobalVision. ArtProof and ScanProof are registered
trademarks of GlobalVision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BV

Raymonde de Larochelaan 13

B – 9051 Gent

info.eur@esko.com

1.1.1.  Third party license information

This product includes LibTIFF.

      Copyright (c) 1988-1997 Sam Leffler
      Copyright (c) 1991-1997 Silicon Graphics, Inc.

      Permission to use, copy, modify, distribute, and sell this software and
      its documentation for any purpose is hereby granted without fee, provided
      that (i) the above copyright notices and this permission notice appear in
      all copies of the software and related documentation, and (ii) the names of
      Sam Leffler and Silicon Graphics may not be used in any advertising or
      publicity relating to the software without the specific, prior written
      permission of Sam Leffler and Silicon Graphics.

      THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
      EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
      WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

      IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
      ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
      OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
      WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
      LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
      OF THIS SOFTWARE.
    
------------------------------------------------------------
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This product includes zlib.

 (C) 1995-2022 Jean-loup Gailly and Mark Adler

  This software is provided 'as-is', without any express or implied
  warranty.  In no event will the authors be held liable for any damages
  arising from the use of this software.

  Permission is granted to anyone to use this software for any purpose,
  including commercial applications, and to alter it and redistribute it
  freely, subject to the following restrictions:

  1. The origin of this software must not be misrepresented; you must not
     claim that you wrote the original software. If you use this software
     in a product, an acknowledgment in the product documentation would be
     appreciated but is not required.
  2. Altered source versions must be plainly marked as such, and must not be
     misrepresented as being the original software.
  3. This notice may not be removed or altered from any source distribution.

  Jean-loup Gailly        Mark Adler
  jloup@gzip.org          madler@alumni.caltech.edu
    
------------------------------------------------------------

This product includes JPEGLib.
This software is copyright (C) 1991-2016, Thomas G. Lane, Guido Vollbeding.
      All Rights Reserved.
      
      This software is based in part on the work of the Independent JPEG Group.
------------------------------------------------------------

This product includes IP*Works!.

      Copyright (c) 2017 /n software inc. - All rights reserved.

      DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY
 OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
 FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT,
 GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF
 THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY,
 CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE
 LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /
N SOFTWARE OR ITS EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF
 THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE.  FURTHER, THE
 LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED
 FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-
SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR
 COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS
 SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH,
 PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /
N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF
 FITNESS FOR HIGH RISK ACTIVITIES.
      LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO
 EVENT WILL /N SOFTWARE'S TOTAL AGGREGATE AND CUMULATIVE LIABILITY TO YOU FOR ANY AND
 ALL CLAIMS OF ANY KIND ARISING HEREUNDER EXCEED THE AMOUNT OF LICENSE FEES ACTUALLY
 PAID BY YOU FOR THE LICENSED SOFTWARE GIVING RISE TO THE CLAIM IN THE TWELVE MONTHS
 PRECEDING THE CLAIM. /N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY
 TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE
 LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT
 SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR
 ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR
 CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL
 DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT
 OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /
N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF
 THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL
 OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF
 LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.
    
------------------------------------------------------------

This product includes IP*Works! SSH.

      Copyright (c) 2017 /n software inc. - All rights reserved.
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      DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY
 OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
 FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE SPECIFICALLY DOES NOT WARRANT,
 GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF
 THE LICENSED SOFTWARE OR DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY,
 CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE
 LICENSED SOFTWARE IS ASSUMED BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /
N SOFTWARE OR ITS EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF
 THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE.  FURTHER, THE
 LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR INTENDED
 FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-
SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR
 COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE SUPPORT MACHINES, OR WEAPONS
 SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD LEAD DIRECTLY TO DEATH,
 PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE ("HIGH RISK ACTIVITIES"). /
N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ANY EXPRESS OR IMPLIED WARRANTY OF
 FITNESS FOR HIGH RISK ACTIVITIES.
      LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO
 EVENT WILL /N SOFTWARE'S TOTAL AGGREGATE AND CUMULATIVE LIABILITY TO YOU FOR ANY AND
 ALL CLAIMS OF ANY KIND ARISING HEREUNDER EXCEED THE AMOUNT OF LICENSE FEES ACTUALLY
 PAID BY YOU FOR THE LICENSED SOFTWARE GIVING RISE TO THE CLAIM IN THE TWELVE MONTHS
 PRECEDING THE CLAIM. /N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY
 TO YOU FOR ANY DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE
 LICENSED SOFTWARE, OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT
 SHALL /N SOFTWARE, ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR
 ANY LOST REVENUE, PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR
 CONSEQUENTIAL DAMAGES OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL
 DAMAGES OR LOSSES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT
 OF THE USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /
N SOFTWARE, ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF
 THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL
 OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF
 LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.
    
------------------------------------------------------------

This product includes QtCopyDialog.

      Copyright (c) 2009 Nokia Corporation and/or its subsidiary(-ies).
      All rights reserved.

      BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
      WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
      EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
      OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
      KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
      LIBRARY IS WITH YOU.  SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
      THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
    
------------------------------------------------------------

This product includes QtMigration.

        Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies).

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Digia Plc and its Subsidiary(-ies) nor the names
            of its contributors may be used to endorse or promote products derived
            from this software without specific prior written permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,

23



1 ArtPro

        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE."
    
------------------------------------------------------------

This product includes QtService.

        Copyright (C) 2010 Nokia Corporation and/or its subsidiary(-ies).

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Nokia Corporation and its Subsidiary(-ies) nor
            the names of its contributors may be used to endorse or promote
            products derived from this software without specific prior written
            permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes QtSingleApplication.

        Copyright (C) 2010 Nokia Corporation and/or its subsidiary(-ies). All rights
 reserved.

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Nokia Corporation and its Subsidiary(-ies) nor
            the names of its contributors may be used to endorse or promote
            products derived from this software without specific prior written
            permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

    
------------------------------------------------------------

This product includes QtSql.

      Copyright (c) 2009 Nokia Corporation and/or its subsidiary(-ies).
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      BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
      WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
      EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
      OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
      KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
      LIBRARY IS WITH YOU.  SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
      THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC Profiles were created by FFEI Ltd. (www.ffei.co.uk) using Fujifilm
    ColourKit Profiler Suite (www.colourprofiling.com)
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) by European Color Initiative, www.eci.org
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) of WAN-IFRA, www.wan-ifra.org
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) IDEAlliance(R). G7(R), GRACol(R) and
    SWOP(R) are all registered trademarks of IDEAlliance(C).
    
------------------------------------------------------------

This product includes QtScript.

      The Qt Toolkit is Copyright (C) 2016 The Qt Company Ltd.
    
------------------------------------------------------------

This product includes Little CMS.

    Little CMS
    Copyright (c) 1998-2020 Marti Maria Saguer

    Permission is hereby granted, free of charge, to any person obtaining
    a copy of this software and associated documentation files (the 
    "Software"), to deal in the Software without restriction, including
    without limitation the rights to use, copy, modify, merge, publish,
    distribute, sublicense, and/or sell copies of the Software, and to 
    permit persons to whom the Software is furnished to do so, subject
    to the following conditions:

    The above copyright notice and this permission notice shall be 
    included in all copies or substantial portions of the Software.

    THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
    EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
    MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
    IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
    CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
    TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE 
    SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
    
------------------------------------------------------------

This product includes libxml2.

    Copyright (C) 1998-2012 Daniel Veillard.  All Rights Reserved.

    Permission is hereby granted, free of charge, to any person obtaining a copy
    of this software and associated documentation files (the "Software"), to deal
    in the Software without restriction, including without limitation the rights
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    to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
    copies of the Software, and to permit persons to whom the Software is fur-
    nished to do so, subject to the following conditions:

    The above copyright notice and this permission notice shall be included in
    all copies or substantial portions of the Software.

    THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
    IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
    NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL THE
    AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
    LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
    OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
    THE SOFTWARE.
    
------------------------------------------------------------

This product includes XercesC.

    NOTICE file corresponding to section 4(d) of the Apache License, Version 2.0, in this
 case for the Apache Xerces distribution.

    This product includes software developed by
    The Apache Software Foundation (http://www.apache.org/).

    Portions of this software were originally based on the following:
     - software copyright (c) 1999, IBM Corporation., http://www.ibm.com.
    
------------------------------------------------------------

This product includes LibTIFF.

      Copyright (c) 1988-1997 Sam Leffler
      Copyright (c) 1991-1997 Silicon Graphics, Inc.

      Permission to use, copy, modify, distribute, and sell this software and
      its documentation for any purpose is hereby granted without fee, provided
      that (i) the above copyright notices and this permission notice appear in
      all copies of the software and related documentation, and (ii) the names of
      Sam Leffler and Silicon Graphics may not be used in any advertising or
      publicity relating to the software without the specific, prior written
      permission of Sam Leffler and Silicon Graphics.

      THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
      EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
      WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

      IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
      ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
      OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
      WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
      LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
      OF THIS SOFTWARE.
    
------------------------------------------------------------

This product includes OpenSSL.

      Copyright (c) 1998-2019 The OpenSSL Project.  All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions
      are met:

      1. Redistributions of source code must retain the above copyright
         notice, this list of conditions and the following disclaimer.

      2. Redistributions in binary form must reproduce the above copyright
         notice, this list of conditions and the following disclaimer in
         the documentation and/or other materials provided with the
         distribution.

      3. All advertising materials mentioning features or use of this
         software must display the following acknowledgment:
         "This product includes software developed by the OpenSSL Project
         for use in the OpenSSL Toolkit. (http://www.openssl.org/)"
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      4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
         endorse or promote products derived from this software without
         prior written permission. For written permission, please contact
         openssl-core@openssl.org.

      5. Products derived from this software may not be called "OpenSSL"
         nor may "OpenSSL" appear in their names without prior written
         permission of the OpenSSL Project.

      6. Redistributions of any form whatsoever must retain the following
         acknowledgment:
         "This product includes software developed by the OpenSSL Project
         for use in the OpenSSL Toolkit (http://www.openssl.org/)"

      THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
      EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT OR
      ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
      SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
      NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
      LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
      HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
      STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
      ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
      OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes OpenSSL.

      Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
      All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions
      are met:
      1. Redistributions of source code must retain the copyright
         notice, this list of conditions and the following disclaimer.
      2. Redistributions in binary form must reproduce the above copyright
         notice, this list of conditions and the following disclaimer in the
         documentation and/or other materials provided with the distribution.
      3. All advertising materials mentioning features or use of this software
         must display the following acknowledgement:
         "This product includes cryptographic software written by
         Eric Young (eay@cryptsoft.com)"
         The word 'cryptographic' can be left out if the rouines from the library
         being used are not cryptographic related :-).
      4. If you include any Windows specific code (or a derivative thereof) from
         the apps directory (application code) you must include an acknowledgement:
         "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

      THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
      ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
      ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
      FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
      DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
      OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
      HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
      LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
      OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
      SUCH DAMAGE.
    
------------------------------------------------------------

This product includes JBIG2Lib.

    Portions of this product copyrights (C) 2002 Glyph & Cog, LLC.
    
------------------------------------------------------------

This product includes FreeType.

    Portions of this software are copyright (C) 2014 The FreeType
    Project (www.freetype.org) licensed under the Freetype License.
    All rights reserved.
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------------------------------------------------------------

This product includes FCollada.

      Copyright 2006 Feeling Software. All rights reserved.

      Copyright 2005-2006 Feeling Software and
      Copyright 2005-2006 Autodesk Media Entertainment.

      Copyright (C) 1998-2003 Daniel Veillard. All Rights Reserved.

      Permission is hereby granted, free of charge, to any person obtaining a copy
      of this software and associated documentation files (the "Software"), to deal
      in the Software without restriction, including without limitation the rights
      to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
      copies of the Software, and to permit persons to whom the Software is fur-
      nished to do so, subject to the following conditions:

      The above copyright notice and this permission notice shall be included in
      all copies or substantial portions of the Software.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
      NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL THE
      AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
      LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
      OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
      THE SOFTWARE.
    
------------------------------------------------------------

This product includes Botan.

      Copyright (C) 1999-2022 The Botan Authors
      All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions are met:

      1. Redistributions of source code must retain the above copyright notice,
         this list of conditions, and the following disclaimer.

      2. Redistributions in binary form must reproduce the above copyright
         notice, this list of conditions, and the following disclaimer in the
         documentation and/or other materials provided with the distribution.

      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
      AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
      ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
      LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
      CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
      SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
      INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
      CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
      ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
      POSSIBILITY OF SUCH DAMAGE.  
    
------------------------------------------------------------

This product includes OpenJPEG.

      Copyright (c) 2002-2012, Communications and Remote Sensing Laboratory, Universite
 catholique de Louvain (UCL), Belgium
      Copyright (c) 2002-2012, Professor Benoit Macq
      Copyright (c) 2003-2012, Antonin Descampe
      Copyright (c) 2003-2009, Francois-Olivier Devaux
      Copyright (c) 2005, Herve Drolon, FreeImage Team
      Copyright (c) 2002-2003, Yannick Verschueren
      Copyright (c) 2001-2003, David Janssens
      Copyright (c) 2011-2012, Centre National d'Etudes Spatiales (CNES), France
      Copyright (c) 2012, CS Systemes d'Information, France
      All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions
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      are met:
      1. Redistributions of source code must retain the above copyright
         notice, this list of conditions and the following disclaimer.
      2. Redistributions in binary form must reproduce the above copyright
         notice, this list of conditions and the following disclaimer in the
         documentation and/or other materials provided with the distribution.

      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS `AS IS'
      AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
      ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
      LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
      CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
      SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
      INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
      CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
      ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
      POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes XMP Toolkit.
Copyright (c) 2020, Adobe
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this
   list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
   this list of conditions and the following disclaimer in the documentation
   and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its
   contributors may be used to endorse or promote products derived from
   this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
------------------------------------------------------------

This product includes curl.

   COPYRIGHT AND PERMISSION NOTICE

   Copyright (c) 1996 - 2023, Daniel Stenberg, <daniel@haxx.se>, and many
   contributors, see the THANKS file.

   All rights reserved.

   Permission to use, copy, modify, and distribute this software for any purpose
   with or without fee is hereby granted, provided that the above copyright
   notice and this permission notice appear in all copies.

   THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
   IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
   FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN
   NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
   DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
   OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
   OR OTHER DEALINGS IN THE SOFTWARE.

   Except as contained in this notice, the name of a copyright holder shall not
   be used in advertising or otherwise to promote the sale, use or other dealings
   in this Software without prior written authorization of the copyright holder.
    
------------------------------------------------------------
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This product includes Qt.

      The software uses Qt, licensed under LGPL v3. The Qt Toolkit is Copyright (C) 2019
 The Qt Company Ltd.

      Portions of this software are copyright (C) 2006-2015 The FreeType Project
 (www.freetype.org). All rights reserved.
      
      Copyright (C) 1991-2011, Thomas G. Lane, Guido Vollbeding.
      This software is based in part on the work of the Independent JPEG Group.
      
      Secure Hash Algorithm SHA-3 - brg_endian
      Copyright (c) 1998-2013, Brian Gladman, Worcester, UK. All rights reserved.

      LICENSE TERMS

      The redistribution and use of this software (with or without changes)
      is allowed without the payment of fees or royalties provided that:

       1. source code distributions include the above copyright notice, this
          list of conditions and the following disclaimer;

       2. binary distributions include the above copyright notice, this list
          of conditions and the following disclaimer in their documentation;

       3. the name of the copyright holder is not used to endorse products
          built using this software without specific written permission.

      DISCLAIMER

      This software is provided 'as is' with no explicit or implied warranties
      in respect of its properties, including, but not limited to, correctness
      and/or fitness for purpose.
    
------------------------------------------------------------

This product includes ICU.

      Copyright (c) 1991-2023 Unicode, Inc. All rights reserved.
      Distributed under the Terms of Use in https://www.unicode.org/copyright.html.
      
      Permission is hereby granted, free of charge, to any person obtaining
      a copy of the Unicode data files and any associated documentation
      (the "Data Files") or Unicode software and any associated documentation
      (the "Software") to deal in the Data Files or Software
      without restriction, including without limitation the rights to use,
      copy, modify, merge, publish, distribute, and/or sell copies of
      the Data Files or Software, and to permit persons to whom the Data Files
      or Software are furnished to do so, provided that either
      (a) this copyright and permission notice appear with all copies
      of the Data Files or Software, or
      (b) this copyright and permission notice appear in associated
      Documentation.
      
      THE DATA FILES AND SOFTWARE ARE PROVIDED "AS IS", WITHOUT WARRANTY OF
      ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE
      WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
      NONINFRINGEMENT OF THIRD PARTY RIGHTS.
      IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS
      NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL
      DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE,
      DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER
      TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
      PERFORMANCE OF THE DATA FILES OR SOFTWARE.

      ----------------------------------------------------------------------

      Chinese/Japanese Word Break Dictionary Data (cjdict.txt)
      
       #     The Google Chrome software developed by Google is licensed under
       # the BSD license. Other software included in this distribution is
       # provided under other licenses, as set forth below.
       #
       #  The BSD License
       #  http://opensource.org/licenses/bsd-license.php
       #  Copyright (C) 2006-2008, Google Inc.
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       #
       #  All rights reserved.
       #
       #  Redistribution and use in source and binary forms, with or without
       # modification, are permitted provided that the following conditions are met:
       #
       #  Redistributions of source code must retain the above copyright notice,
       # this list of conditions and the following disclaimer.
       #  Redistributions in binary form must reproduce the above
       # copyright notice, this list of conditions and the following
       # disclaimer in the documentation and/or other materials provided with
       # the distribution.
       #  Neither the name of  Google Inc. nor the names of its
       # contributors may be used to endorse or promote products derived from
       # this software without specific prior written permission.
       #
       #
       #  THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
       # CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
       # INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
       # MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
       # DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
       # LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
       # CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
       # SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
       # BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
       # LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
       # NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
       # SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
       #
       #
       #  The word list in cjdict.txt are generated by combining three word lists
       # listed below with further processing for compound word breaking. The
       # frequency is generated with an iterative training against Google web
       # corpora.
       #
       #  * Libtabe (Chinese)
       #    - https://sourceforge.net/project/?group_id=1519
       #    - Its license terms and conditions are shown below.
       #
       #  * IPADIC (Japanese)
       #    - http://chasen.aist-nara.ac.jp/chasen/distribution.html
       #    - Its license terms and conditions are shown below.
       #
       #  ---------COPYING.libtabe ---- BEGIN--------------------
       #
       #  /*
       #   * Copyright (c) 1999 TaBE Project.
       #   * Copyright (c) 1999 Pai-Hsiang Hsiao.
       #   * All rights reserved.
       #   *
       #   * Redistribution and use in source and binary forms, with or without
       #   * modification, are permitted provided that the following conditions
       #   * are met:
       #   *
       #   * . Redistributions of source code must retain the above copyright
       #   *   notice, this list of conditions and the following disclaimer.
       #   * . Redistributions in binary form must reproduce the above copyright
       #   *   notice, this list of conditions and the following disclaimer in
       #   *   the documentation and/or other materials provided with the
       #   *   distribution.
       #   * . Neither the name of the TaBE Project nor the names of its
       #   *   contributors may be used to endorse or promote products derived
       #   *   from this software without specific prior written permission.
       #   *
       #   * THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
       #   * "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
       #   * LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
       #   * FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
       #   * REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
       #   * INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
       #   * (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
       #   * SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
       #   * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
       #   * STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
       #   * ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
       #   * OF THE POSSIBILITY OF SUCH DAMAGE.
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       #   */
       #
       #  /*
       #   * Copyright (c) 1999 Computer Systems and Communication Lab,
       #   *                    Institute of Information Science, Academia
       #       *                    Sinica. All rights reserved.
       #   *
       #   * Redistribution and use in source and binary forms, with or without
       #   * modification, are permitted provided that the following conditions
       #   * are met:
       #   *
       #   * . Redistributions of source code must retain the above copyright
       #   *   notice, this list of conditions and the following disclaimer.
       #   * . Redistributions in binary form must reproduce the above copyright
       #   *   notice, this list of conditions and the following disclaimer in
       #   *   the documentation and/or other materials provided with the
       #   *   distribution.
       #   * . Neither the name of the Computer Systems and Communication Lab
       #   *   nor the names of its contributors may be used to endorse or
       #   *   promote products derived from this software without specific
       #   *   prior written permission.
       #   *
       #   * THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
       #   * "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
       #   * LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
       #   * FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
       #   * REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
       #   * INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
       #   * (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
       #   * SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
       #   * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
       #   * STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
       #   * ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
       #   * OF THE POSSIBILITY OF SUCH DAMAGE.
       #   */
       #
       #  Copyright 1996 Chih-Hao Tsai @ Beckman Institute,
       #      University of Illinois
       #  c-tsai4@uiuc.edu  http://casper.beckman.uiuc.edu/~c-tsai4
       #
       #  ---------------COPYING.libtabe-----END--------------------------------
       #
       #
       #  ---------------COPYING.ipadic-----BEGIN-------------------------------
       #
       #  Copyright 2000, 2001, 2002, 2003 Nara Institute of Science
       #  and Technology.  All Rights Reserved.
       #
       #  Use, reproduction, and distribution of this software is permitted.
       #  Any copy of this software, whether in its original form or modified,
       #  must include both the above copyright notice and the following
       #  paragraphs.
       #
       #  Nara Institute of Science and Technology (NAIST),
       #  the copyright holders, disclaims all warranties with regard to this
       #  software, including all implied warranties of merchantability and
       #  fitness, in no event shall NAIST be liable for
       #  any special, indirect or consequential damages or any damages
       #  whatsoever resulting from loss of use, data or profits, whether in an
       #  action of contract, negligence or other tortuous action, arising out
       #  of or in connection with the use or performance of this software.
       #
       #  A large portion of the dictionary entries
       #  originate from ICOT Free Software.  The following conditions for ICOT
       #  Free Software applies to the current dictionary as well.
       #
       #  Each User may also freely distribute the Program, whether in its
       #  original form or modified, to any third party or parties, PROVIDED
       #  that the provisions of Section 3 ("NO WARRANTY") will ALWAYS appear
       #  on, or be attached to, the Program, which is distributed substantially
       #  in the same form as set out herein and that such intended
       #  distribution, if actually made, will neither violate or otherwise
       #  contravene any of the laws and regulations of the countries having
       #  jurisdiction over the User or the intended distribution itself.
       #
       #  NO WARRANTY
       #
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       #  The program was produced on an experimental basis in the course of the
       #  research and development conducted during the project and is provided
       #  to users as so produced on an experimental basis.  Accordingly, the
       #  program is provided without any warranty whatsoever, whether express,
       #  implied, statutory or otherwise.  The term "warranty" used herein
       #  includes, but is not limited to, any warranty of the quality,
       #  performance, merchantability and fitness for a particular purpose of
       #  the program and the nonexistence of any infringement or violation of
       #  any right of any third party.
       #
       #  Each user of the program will agree and understand, and be deemed to
       #  have agreed and understood, that there is no warranty whatsoever for
       #  the program and, accordingly, the entire risk arising from or
       #  otherwise connected with the program is assumed by the user.
       #
       #  Therefore, neither ICOT, the copyright holder, or any other
       #  organization that participated in or was otherwise related to the
       #  development of the program and their respective officials, directors,
       #  officers and other employees shall be held liable for any and all
       #  damages, including, without limitation, general, special, incidental
       #  and consequential damages, arising out of or otherwise in connection
       #  with the use or inability to use the program or any product, material
       #  or result produced or otherwise obtained by using the program,
       #  regardless of whether they have been advised of, or otherwise had
       #  knowledge of, the possibility of such damages at any time during the
       #  project or thereafter.  Each user will be deemed to have agreed to the
       #  foregoing by his or her commencement of use of the program.  The term
       #  "use" as used herein includes, but is not limited to, the use,
       #  modification, copying and distribution of the program and the
       #  production of secondary products from the program.
       #
       #  In the case where the program, whether in its original form or
       #  modified, was distributed or delivered to or received by a user from
       #  any person, organization or entity other than ICOT, unless it makes or
       #  grants independently of ICOT any specific warranty to the user in
       #  writing, such person, organization or entity, will also be exempted
       #  from and not be held liable to the user for any such damages as noted
       #  above as far as the program is concerned.
       #
       #  ---------------COPYING.ipadic-----END----------------------------------
      
      ----------------------------------------------------------------------
      
      Lao Word Break Dictionary Data (laodict.txt)
      
       # Copyright (C) 2016 and later: Unicode, Inc. and others.
       # License & terms of use: http://www.unicode.org/copyright.html
       # Copyright (c) 2015 International Business Machines Corporation
       # and others. All Rights Reserved.
       #
       # Project: https://github.com/rober42539/lao-dictionary
       # Dictionary: https://github.com/rober42539/lao-dictionary/laodict.txt
       # License: https://github.com/rober42539/lao-dictionary/LICENSE.txt
       #          (copied below)
       #
       # This file is derived from the above dictionary version of Nov 22, 2020
       #  ----------------------------------------------------------------------
       #  Copyright (C) 2013 Brian Eugene Wilson, Robert Martin Campbell.
       #  All rights reserved.
       #
       #  Redistribution and use in source and binary forms, with or without
       #  modification, are permitted provided that the following conditions are met:
       #
       #  Redistributions of source code must retain the above copyright notice, this
       #  list of conditions and the following disclaimer. Redistributions in binary
       #  form must reproduce the above copyright notice, this list of conditions and
       #  the following disclaimer in the documentation and/or other materials
       #  provided with the distribution.
       #
       # THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
       # "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
       # LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
       # FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
       # COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
       # INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
       # (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
       # SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
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       # HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
       # STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
       # ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
       # OF THE POSSIBILITY OF SUCH DAMAGE.
       #  --------------------------------------------------------------------------
      
      ----------------------------------------------------------------------
      
      Burmese Word Break Dictionary Data (burmesedict.txt)
      
       #  Copyright (c) 2014 International Business Machines Corporation
       #  and others. All Rights Reserved.
       #
       #  This list is part of a project hosted at:
       #    github.com/kanyawtech/myanmar-karen-word-lists
       #
       #  --------------------------------------------------------------------------
       #  Copyright (c) 2013, LeRoy Benjamin Sharon
       #  All rights reserved.
       #
       #  Redistribution and use in source and binary forms, with or without
       #  modification, are permitted provided that the following conditions
       #  are met: Redistributions of source code must retain the above
       #  copyright notice, this list of conditions and the following
       #  disclaimer.  Redistributions in binary form must reproduce the
       #  above copyright notice, this list of conditions and the following
       #  disclaimer in the documentation and/or other materials provided
       #  with the distribution.
       #
       #    Neither the name Myanmar Karen Word Lists, nor the names of its
       #    contributors may be used to endorse or promote products derived
       #    from this software without specific prior written permission.
       #
       #  THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
       #  CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
       #  INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
       #  MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
       #  DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS
       #  BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
       #  EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
       #  TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
       #  DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
       #  ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
       #  TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
       #  THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
       #  SUCH DAMAGE.
       #  --------------------------------------------------------------------------
      
      ----------------------------------------------------------------------
      
      Time Zone Database
      
        ICU uses the public domain data and code derived from Time Zone
      Database for its time zone support. The ownership of the TZ database
      is explained in BCP 175: Procedure for Maintaining the Time Zone
      Database section 7.
      
       # 7.  Database Ownership
       #
       #    The TZ database itself is not an IETF Contribution or an IETF
       #    document.  Rather it is a pre-existing and regularly updated work
       #    that is in the public domain, and is intended to remain in the
       #    public domain.  Therefore, BCPs 78 [RFC5378] and 79 [RFC3979] do
       #    not apply to the TZ Database or contributions that individuals make
       #    to it.  Should any claims be made and substantiated against the TZ
       #    Database, the organization that is providing the IANA
       #    Considerations defined in this RFC, under the memorandum of
       #    understanding with the IETF, currently ICANN, may act in accordance
       #    with all competent court orders.  No ownership claims will be made
       #    by ICANN or the IETF Trust on the database or the code.  Any person
       #    making a contribution to the database or code waives all rights to
       #    future claims in that contribution or in the TZ Database.
      
      ----------------------------------------------------------------------
      
      Google double-conversion
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      Copyright 2006-2011, the V8 project authors. All rights reserved.
      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions are
      met:
      
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above
            copyright notice, this list of conditions and the following
            disclaimer in the documentation and/or other materials provided
            with the distribution.
          * Neither the name of Google Inc. nor the names of its
            contributors may be used to endorse or promote products derived
            from this software without specific prior written permission.
      
      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
      "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
      LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
      A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
      OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
      SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
      LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
      DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
      THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
      (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
      OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
      
      ----------------------------------------------------------------------
      
      File: aclocal.m4 (only for ICU4C)
      Section: pkg.m4 - Macros to locate and utilise pkg-config.
      
      
      Copyright (c) 2004 Scott James Remnant <scott@netsplit.com>.
      Copyright (c) 2012-2015 Dan Nicholson <dbn.lists@gmail.com>
      
      This program is free software; you can redistribute it and/or modify
      it under the terms of the GNU General Public License as published by
      the Free Software Foundation; either version 2 of the License, or
      (at your option) any later version.
      
      This program is distributed in the hope that it will be useful, but
      WITHOUT ANY WARRANTY; without even the implied warranty of
      MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU
      General Public License for more details.
      
      You should have received a copy of the GNU General Public License
      along with this program; if not, write to the Free Software
      Foundation, Inc., 59 Temple Place - Suite 330, Boston, MA
      02111-1307, USA.
      
      As a special exception to the GNU General Public License, if you
      distribute this file as part of a program that contains a
      configuration script generated by Autoconf, you may include it under
      the same distribution terms that you use for the rest of that
      program.
      
      
      (The condition for the exception is fulfilled because
      ICU4C includes a configuration script generated by Autoconf,
      namely the `configure` script.)
      
      ----------------------------------------------------------------------
      
      File: config.guess (only for ICU4C)
      
      
      This file is free software; you can redistribute it and/or modify it
      under the terms of the GNU General Public License as published by
      the Free Software Foundation; either version 3 of the License, or
      (at your option) any later version.
      
      This program is distributed in the hope that it will be useful, but
      WITHOUT ANY WARRANTY; without even the implied warranty of
      MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the GNU
      General Public License for more details.
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      You should have received a copy of the GNU General Public License
      along with this program; if not, see <https://www.gnu.org/licenses/>.
      
      As a special exception to the GNU General Public License, if you
      distribute this file as part of a program that contains a
      configuration script generated by Autoconf, you may include it under
      the same distribution terms that you use for the rest of that
      program.  This Exception is an additional permission under section 7
      of the GNU General Public License, version 3 ("GPLv3").
      
      
      (The condition for the exception is fulfilled because
      ICU4C includes a configuration script generated by Autoconf,
      namely the `configure` script.)
      
      ----------------------------------------------------------------------
      
      File: install-sh (only for ICU4C)
      
      
      Copyright 1991 by the Massachusetts Institute of Technology
      
      Permission to use, copy, modify, distribute, and sell this software and its
      documentation for any purpose is hereby granted without fee, provided that
      the above copyright notice appear in all copies and that both that
      copyright notice and this permission notice appear in supporting
      documentation, and that the name of M.I.T. not be used in advertising or
      publicity pertaining to distribution of the software without specific,
      written prior permission.  M.I.T. makes no representations about the
      suitability of this software for any purpose.  It is provided "as is"
      without express or implied warranty.
    
------------------------------------------------------------

This product includes Bonjour SDK.

   Copyright (c) 2003-2004, Apple Computer, Inc. All rights reserved.
  
   Redistribution and use in source and binary forms, with or without 
   modification, are permitted provided that the following conditions are met:
  
   1.  Redistributions of source code must retain the above copyright notice, 
       this list of conditions and the following disclaimer. 
   2.  Redistributions in binary form must reproduce the above copyright notice, 
       this list of conditions and the following disclaimer in the documentation 
       and/or other materials provided with the distribution. 
   3.  Neither the name of Apple Computer, Inc. ("Apple") nor the names of its 
       contributors may be used to endorse or promote products derived from this 
       software without specific prior written permission. 
  
   THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY 
   EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
   WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
   DISCLAIMED. IN NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY 
   DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
   (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
   LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
   ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
   (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
   SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------
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1.2.  General

1.2.1.  Files & Folders

When installing ArtPro, a bundle containing all files will be created.

When ArtPro is started, it will check for 3 folders, and create them if they are not present next to the
application bundle : Color Management (by default containing the 5 default profiles), Plug-ins (by
default containing the 4 default plug-ins), and Color Guides (the color and ink books). There will also
be an ArtPro folder, containing the preferences file, a jobsizes file etc. under Users / [username] /
Library / Preferences.

1.2.2.  Fonts

ArtPro works with the active Adobe Type One and TrueType fonts installed on your Macintosh.

There are several ways to activate fonts on Mac OS. It is advisable to use the folder System / Library /
fonts only for fonts needed by the system. The folder Users / username / library / fonts can be used, but
fonts placed in that folder will only be available for that one user. The best way to use fonts in Mac OS,
is either put them in the folder Library / Fonts, or use e.g. Extensis Suitcase, as ATM is not available
for Mac OS. Of course, newly added fonts will only be available after using the Reload Fonts function,
or restarting ArtPro. PS-fonts and TrueTypes can be used. For PS-fonts, both the screen fonts and the
printer fonts have to be present.

1.2.3.  ArtColor, internal CT and CT files

As of version 18, Contone editing in ArtPro (ArtColor, the "Contone" menu) has been discontinued. You
can however open and handle older files containing internal CT's.

You can still create internal CT's during PDF / PostScript import by enabling Make Images Internal

Saving ArtColor files

If you save a file with internal CT's, next to the ArtPro line art file a CT file is written on disk. This
internal CT file has the same name as the line art file with .CT appended to it. The CT file is always
right next to the ArtPro file (in the same folder). When changes are made to the line art, only the line
art file will be updated. When changes are made to the iCT, both the CT file and the line art file will be
modified. It is not possible to open the .CT file separately. It is strongly recommended not to move or
rename the .CT file. When opening a document, ArtPro will automatically look right next to the lineart
file for the .CT. If it is not there, ArtPro will pop up a file selector and ask for it. Press cancel to open the
file without its CTs.
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1.3.  Download & Installation

1.3.1.  Download

In order to obtain a Mac OS Personalized build, you need to log in on MySoftware.esko.com: https://
mysoftware.esko.com

Log in
 

 

When arriving on MySoftware.esko.com, you can sign in using your Esko ID. If you do not have an Esko
ID, you can create one using the Create a new Esko ID link

You can change the language in the dropdown in the upper left corner.

Select version
In the Product dropdown in Select Downloads, select "ArtPro"

 

 

Click the Download button for the version you want to download

 

38

https://mysoftware.esko.com
https://mysoftware.esko.com


1ArtPro

 

Create Personalized build
Click the Software you want to create (ArtPro or PowerLayout), and select the version you want. Click
Go

You will download a disk image (.dmg) that has been compressed with gzip (.gz) Normally your internet
browser will automatically unzip the archive leaving you with two files on the desktop : the .dmg.gz file,
and the .dmg file which you can mount by double clicking it (if your internet browser doesn't mount it
automatically).

1.3.2.  Installation

The installation of ArtPro is done through an installer on the mounted volume. The installer takes
several steps.

Note:

ArtPro is only supported on 64-bit operating systems:

• macOS 11 (on Intel and on Apple Silicon),
• macOS 12 (Monterey, Intel and Apple Silicon)
• macOS 13 (Ventura, Intel and Apple Silicon) and
• macOS 14 (Sonoma, Intel and Apple Silicon).

Introduction
When starting the installation process, the user is asked to enter Administrator User Name and
Password. Administrator Privileges are necessary. After that, an introduction is shown, stating what
software and version is about to be installed.

Read me
In the Read Me part, some installation info is given.

License
The user has to agree to the shown Software License Agreement before the installation is continued.

Destination
In this window, the Destination Disk and folder can be chosen.
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Installation / Finish up
Once all settings are made, the installation (or upgrading) can be started. All files will be copied to the
defined folder.

1.3.3.  Licensing

As from ArtPro 9.5, a new licensing system is used. You can open the Esko Local License Manager from
the Application folder, or from the Show Licenses dialog in the Preferences (see Show Licenses on
page 49). If you launch ArtPro without a license, the Show Licenses dialog will open on startup.

Note:  A valid ArtPro product key contains both an ArtPro license and an ArtPro Customer
Identification. ArtPro needs both to run.

As from ArtPro 9.6.4, a Network License Manager is also optionally available.

For more information on the Esko Local or Network License Manager, we refer to the specific
documentation on these topics, available on https://www.esko.com/en/support/product?id=Licensing
%20and%20Activation.

1.4.  Shortcuts

This overview shows all default shortcuts in ArtPro. In the left column you find the ArtPro Classic
shortcut. Next you find the function. In the right column you find the ArtPro (like Illustrator) shortcut.

You can change the key bindings in the preferences. See Shortcuts on page 59

1.4.1.  Menu Commands

Cmd-A Select All Cmd-A

Cmd-Shift-A Deselect All Cmd-Shift-A

Cmd-Alt-A Select Inverse Cmd-Alt-A

Cmd-B Box Dialog Cmd-B

Cmd-Alt-B Box Tool M

Cmd-Shift-B Bar codes Dialog Cmd-Shift-B

Cmd-C Copy text or objects to clipboard Cmd-C

Cmd-D Measure Tool and dialog None

40

https://www.esko.com/en/support/product?id=Licensing%20and%20Activation
https://www.esko.com/en/support/product?id=Licensing%20and%20Activation


1ArtPro

Cmd-E Ellipse dialog Cmd-E

Cmd-Alt-E Ellipse tool L

Cmd-Shift-E Edit Path Tool A

Cmd-F View - Fit in Window Cmd-0

Cmd-Shift-F View - Fit selection in window Cmd-Alt-0

Cmd-Alt-F View - Tile views Panes None

Cmd-G Make Compound Cmd-8

Cmd-Shift-G Make Group Cmd-G

Cmd-Alt-G Magnetism Dialog Cmd-Alt-G

Cmd-I Paint Style / Object Parameters Cmd-I

Cmd-Shift-I Separation Dialog Cmd-Shift-I

Cmd-Alt-I Select Same Paint None

Cmd-J Join Paths Cmd-J

Cmd-Shift-J Job Size Dialog Cmd-Shift-J

Cmd-K Preferences Dialog Cmd-K

Cmd-L Transform Dialog None

Cmd-Shift-L Layers Dialog None

Cmd-Alt-L Align Dialog None

Cmd-Alt-Shift-L Extended Align Dialog None

Cmd-M Previous View None

Cmd-Shift-M Move None

Cmd-N New Document Cmd-N

Cmd-O Open Cmd-O

Cmd-Alt-O Open without preferences Cmd-Alt-O

Cmd-P Export PDF / Print Dialog Cmd-P

Cmd-Shift-P More Print Settings Cmd-Shift-P
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Cmd-Alt-P Import PostScript Dialog Cmd-Alt-P

Cmd-Q Quit Cmd-Q

Cmd-R Show/Hide Ruler Cmd-R

Cmd-Shift-R Undo Ruler Cmd-Shift-R

Cmd-Alt-R Ruler Tool R

Cmd-S Save Cmd-S

Cmd-Shift-S Save as Cmd-Shift-S

Cmd-Alt-S Launch Workflow Cmd-L

Cmd-T Text Style Dialog Cmd-T

Cmd-Alt-T Selected paths to All Transparent / (forward slash)

Cmd-Shift-T Stroke Dialog Cmd-Shift-T

Cmd-U Release Compound Cmd-Alt-Shift-8

Cmd-Shift-U Release Group Cmd-Shift-G

Cmd-V Paste in job or input field Cmd-V

Cmd-Alt-V New view of active Job Cmd-Alt-N

Cmd-W Close Window Cmd-Shift-W

Cmd-Alt-W Close all windows Cmd-Alt-Shift-W

Cmd-Shift-W Close Job Window Cmd-W

Cmd-Alt-Shift-W Close all Job Windows Cmd-Alt-W

Cmd-X Cut text or objects to clipboard Cmd-X

Cmd-Y Preview on / off Cmd-Y

Cmd-Shift-Y Show Separations Cmd-Shift-Y

Cmd-Z Undo Cmd-Z

Cmd-Shift-Z Redo Cmd-Shift-Z

Cmd-/ Retrace Other Way or Trap Other Part Cmd-/

Cmd-= Zoom In Cmd-=

42



1ArtPro

Cmd Zoom Out Cmd

Cmd-, Repaint Cmd-,

Backspace / Delete Delete Selected Backspace

F8 (toggle) Hide /Show all floating windows (except
job windows and toolbar)

F8

Cmd-0 Interactive Trapping Dialog Cmd-Alt-U

Cmd-1 Spread Cmd-U

Cmd-2 Choke Cmd-Shift-U

Cmd-3 Hide Cmd-3

Cmd-4 Show All Cmd-Alt-3

Cmd-Alt- 4 Studio Cmd-Alt-4

Move forward Cmd-[

Move backward Cmd-]

Cmd-5 Bring to Front Cmd-Shift-[

Cmd-6 Send to Back Cmd-Shift-]

Cmd-7 Lock Cmd-2

Cmd-8 Unlock All Cmd-Alt-2

Cmd-9 PowerTrapper Dialog Cmd-9

1.4.2.  Select (always accessible)

Cmd Click/Drag Group Selection Cmd

Cmd-Alt Click/Drag Path Selection Cmd-Alt-Ctrl

Cmd-Ctrl Click/Drag Compound Selection Cmd-Ctrl

Cmd-Alt-Ctrl Click Area Selection Cmd-Alt

Cmd-Alt-Ctrl Drag Lasso Selection Cmd-Alt

Cmd-Alt-Ctrl Double-click Open placed file (ArtPro / PDF) Cmd-Alt
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Shift Click/Drag Adds to / removes from selection Shift

1.4.3.  View (always accessible)

Ctrl Click Zoom In Cmd-Space (*)

Ctrl-Alt Click Zoom Out Cmd-Shift-Space (*)

Ctrl Drag Zoom Rectangle Cmd-Space (*)

Alt Click Pan: Position to center Space

Alt Drag Pan: Move Space

(*) : for these shortcuts, the Space key should be pressed before the command key, as otherwise Mac
OS Spotlight will open.

1.4.4.  Move Ruler (only when ruler tool active)

Arrows Move Ruler over preset distance Arrows

Shift-Arrows Move Ruler magnetically Cmd-Arrows

Alt Drag Create Guide Alt

1.4.5.  Move (only when move tool active)

Arrows Move over preset distance Arrows

Cmd-Arrows Move over 10x the preset distance Shift-Arrows

Shift-Arrows Move magnetically to ruler Cmd-Arrows

Alt During Drag Make Copy while moving Alt

Shift During Drag Move magnetically, depending on Grid
Menu settings

Cmd
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Space Rotate 90 degrees clockwise

1.4.6.  Scale (only when scale tool active)

Alt During Drag Make Copy while scaling Alt

Shift During Drag Scale proportionally Cmd

1.4.7.  Rotate (only when rotate tool active)

Alt During Drag Make Copy while rotating Alt

Shift During Drag Rotate multiples of constrain angle Cmd

1.4.8.  Editing Splines

Shift During Drag Move points magnetic to ruler or
magnetic objects, or constrain rotation
to the constrain angle

Cmd

Space Switch between 4 drawing modes Space

1.4.9.  Text selection

1 click Position cursor in text box

2 clicks Select entire word

3 clicks Select entire line

4 clicks Select entire paragraph

5 clicks Select entire text box

click & drag Move selection to other position
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Alt click & drag Move selection to other position Alt

1.4.10.  Text: Editing Keys

Backspace Delete Backspace

Cmd-A Select entire text box Cmd-A

Cmd-X Cut Cmd-X

Cmd-C Copy Cmd-C

Cmd-V Paste Cmd-V

1.4.11.  Text: Cursor Keys

Cmd-Left Previous word Cmd-Left

Cmd-Right Next word Cmd-Right

Cmd-Up Beginning of Paragraph Cmd-Up

Cmd-Down End of Paragraph Cmd-Down

Cmd-Alt-Left Beginning of line Cmd-Alt-Left

Cmd-Alt-Right End of line Cmd-Alt-Right

Cmd-Alt-Up Beginning of text Cmd-Alt-Up

Cmd-Alt-Down End of text Cmd-Alt-Down

1.4.12.  Text: Typographic codes and functions

Ctrl * Discrete hyphen Ctrl *

Ctrl-W Elastic whitespace Ctrl-W

Ctrl-L Leadering Ctrl-L

Cmd-Shift-Space Plain type Cmd-Shift-Space

Ctrl-B ** Bold Ctrl-B **
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Ctrl-I ** Italic Ctrl-I **

Ctrl-U ** Underline Ctrl-U **

Ctrl-G Force text to upper case Ctrl-G

Ctrl-S Force text to lower case Ctrl-S

Cmd-Shift-L Left align Cmd-Shift-L

Cmd-Shift-R Right align Cmd-Shift-R

Cmd-Shift-J Justify Cmd-Shift-J

Cmd-Shift-F Forced Justify Cmd-Shift-F

Cmd-Shift-+ * Forced Justify Cmd-Shift-+ *

(*) Plus and minus from numeric keypad only.

(**) B,U, I, plus and minus toggle the function.

1.4.13.  Text: Fixed Spaces

Ctrl-Space Width of normal space (as specified with
Space Width

Ctrl-Space

Ctrl-1 Width of EM square (pointsize multiplied by
horizontal scale)

Ctrl-1

Ctrl-0 Width of a digit Ctrl-0

Ctrl-. (point) Width of a decimal point Ctrl-. (point)

Ctrl-, (comma) Width of a comma Ctrl-, (comma)

Ctrl-9 1/9 of an EM square width Ctrl-9

All of these spaces are non-breaking, i.e. no new line will be taken at these spaces. Their width is not
changed by justification.
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2.  ArtPro Menu

2.1.  Preferences...

2.1.1.  User Preferences vs Job Preferences

In ArtPro, there are 2 kinds of preferences that are saved. When launching ArtPro, all preferences are
loaded.

User Preferences
The User Preferences contains all settings of the Preference dialog, except for Color Management.
Open dialogs are also saved in these preferences. Also the Certified ArtPro parameters from Import
and Export PDF are saved in the Preferences.

The Preferences are saved as “ArtPro [xx] Preferences” in the User folder, in Library/Preferences/
ArtPro. This implicates that every user can have his own preferences saved.

However, the first time ArtPro is launched, ArtPro will look for older preferences, and will load these,
saving them as ArtPro [xx] Preferences. This is to avoid having to redo all settings and preferences.

Job Preferences
All other preferences are Job Preferences, and saved in the ArtPro file. If the Load Job Preference
option is enabled in the Preferences > General > Open, the Job Preferences will be used instead of the
default settings (User Preferences).

The result is that opening a file (from another station) will not change any of the User Preferences. For
example, if the User Preferences sets “units” to be inch, this will not change when opening a file that
was set in mm.

2.1.2.  General: General

Toolbar in Document Window
In the General tab of the Preferences, you can define if the toolbar should be always visible on top of
your screen (option disabled) as in earlier versions of ArtPro, or if the toolbar should be a part of the job
window, which implies that the toolbar is not visible if no job window is open..
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Load document window size and position from workspace
If this option is enabled, opening a file will set the position and size of the document window according
to the size and position saved in the Workspace.

Load viewmode from workspace
If this option is enabled, opening a file will set the view mode (e.g. outline) according to the view mode
saved in the Workspace.

Save Current Settings
The Save Current Settings saves all Preferences and settings (including the Job Preferences). The User
Preferences are the preferences to be loaded when launching ArtPro. The User Preferences contains
all settings of the Preference dialog, except for Color Management. Open dialogs are also saved in
these preferences. Also the Certified ArtPro parameters from Import and Export PDF, and the PDF
Export flavours are saved in the Preferences.

The Preferences are saved as “ArtPro [...] Preferences” in the User folder, in Library/Preferences/
ArtPro. This implicates that every user can have his own preferences saved.

Restore Default Settings
The Restore Default Settings option allows to return to ArtPro’s factory defaults. Keep in mind that
there is no undo possible for this function!

Show Licenses
The Show Licenses button opens a window, showing the active licenses. You can click the License
Manager button to open the Esko License Manager. For more information on the Esko License
Manager, we refer to the Esko License Manager documentation, which can be found on the Download
Center.

If you click the names of the base and module licenses that are listed, you will get to see the details on
what product license you need to unlock the functionality and what version of that license the software
is checking on.

“Cancel” will close the dialog, while “Quit” will quit ArtPro: after changing the license(s), it is necessary
to quit and restart ArtPro.

2.1.3.  General: Open

Load job preferences
Allows you to open a file with all its preferred settings. These settings are the Job Preferences, but also
open windows, and the position of the ruler. By default this option is enabled. When you switch it off,
a file will be opened with active preferences, and the ruler will be placed at the top right corner of the
trim box.
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Shortcut: Cmd-O, opens file with its preferences

Shortcut: Cmd-Alt-O, opens file without its preferences

Load PDF flavours
If the ‘Load Job Preferences’ option is enabled, you can also enable the “Load PDF flavours” option. If
this option is enabled, the PDF flavours as stored in the ArtPro file will be loaded. Note that only files
saved in ArtPro 10.1 or higher contain PDF Flavours information.

Open only one window
This option makes it possible to open a job fitted in one window only, even if the file was saved with
multiple open windows. By default the toggle is switched off, so opening a job will display the file with
all the windows that were open at the moment it was saved. (see also New Window on page 425)

Perform bar code consistency check
In ArtPro versions earlier than 8.2, it was possible to save a file containing a bar code, for which the Bar
code Information (the information that appears in the Bar code dialog if it is selected, and is used in the
XML info and in ArtLink) is not consistent with the actual bar code.

The Bar code Consistency Checker will check the bar code creator info when opening an ArtPro file.
Problems can be detected, but not corrected automatically. The problem bar codes will be selected,
and a warning will be shown.

You will have the option to remove the bar code creator information or keep it. Removing the bar code
creator information turns the bar code into a regular object, without bar code creator information.
Keeping it allows to modify the bar code.

Note:  The Bar code consistency check does not check 2D codes such as datamatrix bar
codes.

Perform text outline checking
There is an option to control if text outline checking should be done. You can define to perform the text
outline checking only for files from ArtPro 7.5 rev1 or older.

Next to the popup is an editable field with the tolerance level. The higher this value, the more forgiving
the outline checker will be. Converting live text to outlines frequently suffers from small rounding
errors (like most conversions), so the tolerance should not be set smaller than 25 internal units (0.05
mm). Otherwise a lot of text will be marked as incorrect while there is nothing wrong with it. For more
info on Text Outline Checking, see Check Outlines on page 236.

Merge layers with same name
This option will, when opening/inserting or saving an existing ArtPro file, merge those layers with the
same name into one layer (useful for e.g. die lines ....).

Keep in mind that this might change the order of the Layers, and thus the final result of the job.
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User Defined ArtLink Parameters
This preferences defines what value to use for identical ArtLink Parameters in the current job and in
the job you insert.

If e.g. you have an ArtLink Parameter "CustomerCode" with value "1269" in your current job, and you
insert another job, that has the same ArtLink Parameter "CustomerCode" but with value "8982". What
value will be used after inserting ?

If Use values from Current Job is selected, the value as in the current job will be kept, in this case
"1269".

If Use values from Inserted file is selected, the value from the inserted job will be used instead, in this
case "8982".

In case the open file and the inserted file contain the same ArtLink Parameters, a warning will be
shown, indicating what values will be used.

2.1.4.  General: Save

Append file extension based on file type
If this option is on, ArtPro will automatically use the appropriate file extension in the file name when
saving a file.

For ArtPro files, if the option is on, “.AP” or “.ART” will be appended to the filename (see below).

With the option off, PostScript files are named as in earlier versions : filename.composite or
filename.separated, ... With the option on, the filename will be “filename composite.ps” or “filename
separated.ps”.

If the option is off, you can not set “Hide Extension” option in the browse dialog.

Recalculate ink coverage
If the Recalculate Ink Coverage option is switched on, Ink Coverage will be recalculated every time
the file is saved. This ensures to have correct Ink Coverage data in the file, consistent with the latest
changes.

Use system tempfolder for temporary PDF files
If this option is on, temporary files when exporting to PDF will be written in the OS X system temp
folder. If the option is switched off, ArtPro will save the temporary files next to the ArtPro application.

Keep backup copy
By removing the check next to Keep backup copy, you deactivate the automatic backup system ArtPro
has. When you save a document, you can never be 100% certain that nothing went wrong during the
save. Therefore, ArtPro keeps the older version as a backup file.
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This backup copy has the characters “BU” appended to its filename and is stored in the same folder as
the original file. It contains the file as it was before you opened it. A backup copy is only created once
after opening a document, i.e. during the first save. Afterwards, when the document is saved, it is not
updated.

Use file swap when saving
The File Swap option can cause problems when saving ArtPro files directly from Mac OS 10.3.x onto
a Unix/Linux server running netatalk. In that case, switch the option off. In all other cases, leave it
enabled.

Save separated preview by default
If this option is on, the “Include Separated Preview” option in the Save As dialog will be on by default. It
can still be changed in that dialog. See Save as... on page 74

Save Certified PDF information by default
If this option is on, the “Include Certified PDF Information” option in the Save As dialog will be on by
default. It can still be changed in that dialog. Save as... on page 74.

Preferred extension for ArtPro files
The Preferred extension for ArtPro files allows to decide if ArtPro files, saved with the “Append file
extension based on file type” option on, should have a “.ap” or a “.art” extension.

Preview Resolution
Determines the resolution for the ArtPro preview files, saved with Preview in the File menu. In this
way it is possible to visualize a Step&Repeat job more accurately on the screen and to proof a higher
resolution with Bitmap Proofer. Note that a higher preview resolution makes the ArtPro file bigger and
slower to preview in e.g. a S&R job.

Enable anti-aliasing
It is possible to apply Anti-Aliasing on the preview of an ArtPro file. Anti-Aliasing will result in a
smoother preview.

2.1.5.  General: Import

Open new job
When the option is on (default), a new job is created for any Import function (PostScript/PDF, Illustrator
3.0, CAD and Vectorization) or S&R. When the toggle is switched off, the file is imported in the current
file. This option can also be controlled separately from the Vectorization, PostScript Import and S&R
dialogs with the toggle Make New Job.
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Keep page boxes from job
When the option is off (default), the page boxes from the imported file (when applicable) will be used,
replacing the page boxes in the open ArtPro file. If the option is enabled, the page boxes from the open
ArtPro file are kept. The option is only applicable if “Open new Job” (see above) is disabled.

Accept all file types
When importing a PS/PDF file, the file selector shows only PS and PDF files. By switching this toggle
on, all file types will be displayed. This option also works for Open ArtPro File, Place Picture, etc.

This will be useful, for files that are transmitted from another computer system. Sometimes they do
not have the correct file type. In recent Mac OSX, you also have this option to enable all types in the file
selector.

Keep HandShake LW strictly standard
Files transmitted from a Scitex system are not always the correct file type. ArtPro will ignore this on
Import if the Handshake LW strictly standard toggle is checked.

Show text import messages
The Warnings generated by the PS/PDF Import (e.g. “Some characters can be wrongly converted,
please check job carefully”), can be disabled by switching this option off. Switching this option off is
NOT recommended!

Limit memory to
This option allows to limit the amount of memory to be used for importing. The amount of memory is be
entered in kb, so you have to enter e.g. 11000 to get 10,7 Mb.

Custom Color List
The color list used in the Import PS/PDF section can be saved and opened there. This color list is a list
of color names and how they should be treated: converted to CMYK, renamed, kept as spot color,...

If this list file (which is an XML file) is loaded in the preferences, this color list will automatically be
entered in the Import PS/PDF dialog upon launching ArtPro. See also Import Postscript/PDF... on page
79 Color List on page 86

2.1.6.  General: Flatten

The Flatten Transparencies function replaces all blend modes and transparencies by “normal” objects,
maintaining the look of the final result, i.e. the blend will be calculated to whatever is underneath at
that moment, and will be adepted in a lineart object (if possible) or an image.

Flattening is done automatically when outputting PostScript, when saving in ArtPro 7.5 format, or
when exporting PDF with the “Enable Flattener” option on (creating PDF 1.3). Flattening can also be
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done interactively, with the function in the Prepress menu. In any way, flattening is calculated for the
complete job.

The settings used when flattening (either interactive, or through the Print, Save As or Export PDF
function), can be set in the General > Flatten tab of the Preferences.

Images
When using the interactive flattener, you will be asked to define the name and location for the images
that will be generated. All these images will be external images, and will be mapped. For Flattening
during PDF1.3, PS or ArtPro7.5 output, temporary files will be created on the hard disk in the system
temporary folder. The image resolution will be adapted automatically : it will use the highest resolution
of all images at the specific position. E.g. when a 200 dpi image is blended on top of a 300 dpi image,
the resulting flattened image will be 300 dpi.

Maximum Resolution for Images
In case flattening involves an image, ArtPro will use the highest resolution it encounters. This would
mean that if a large area contains a small image of 1200 dpi, or a 300 dpi image scaled to 25%, the full
area would be flattened at 1200dpi. The Maximum Resolution for Images will limit this resolution to e.g.
600 dpi.

Vectorize Opacity Channel
Vectorize Opacity Channel is an optimization tool for the flattener. It reduces the path containing an
ArtColor internal image, removing all areas being completely transparent (by vectorizing the opacity
channel) before flattening.

This way, objects underneath a part of an image where it is 100% transparent, no longer need to be
flattened.

Resolution for Gradients
The Resolution (in l/inch or l/cm) defines the resolution of the images to be created. This is used if
gradation or multistep gradations have to be flattened.

Noise for Gradients
This determines how much noise has to be applied on the objects that are flattened. The default value
is 0%. Noise is applied to make vignettes smoother and thus to avoid banding. For more information on
noise : see Print : More settings...  on page 142.

No Noise from / To
This allows to define a range in which no noise should be applied to gradations. This is useful e.g. for
autoblend screening.

2.1.7.  Pictures

54



2ArtPro

Put Eps in First Four Separations Only
ArtPro can separate EPS files that contain CMYK colors, grays and custom colors. As a consequence,
contones will mask out PANTONE® colors and Photoshop™ duotones will appear in the correct
separations.

In PostScript, by default, contones mask out underlying layers. ArtPro, however, provides a workaround
to generate transparency from CMYK contones to a spot color background.

In practice:

• When Put EPS in First Four Separations Only is active, the CMYK EPS will generate transparency in
all underlying elements, except for CMYK itself. Transparency within one ink cannot be generated.

• When Put EPS in First Four Separations Only is deactivated, the EPS will mask out all underlying
elements.

Remarks:

• The checkbox for Put EPS in First Fours Separations Only works on all placed EPS files in the job.
• If you have a monochrome EPS in a spot color (e.g. in a PANTONE® ink), or any EPS file containing

spot color separations (e.g. duotones), you cannot activate Put EPS in First Four Separations Only,
or the monochrome EPS will not be exposed.

• The Put EPS in First Four Separations Only option is only read at the moment you calculate the
PostScript file (= Print).

• DCS files are not influenced by this option. DCS files never mask out the background. Therefore
you need to put a mask layer underneath the DCS. This path should be zero to knock out the inks
underneath, or transparent for overprinting the inks underneath.

Use external clipping path for placed pictures
When placing a Photoshop Tiff, PSD or EPS file containing a clipping path, the clipping path is
converted to ArtPro line art, with the TIFF or EPS file inside it. During this process, all splines are kept
as splines.

Do keep in mind that, when placing an EPS with a clipping path, the clipping path will be editable, but
the picture inside that path is still the EPS with clipping path. Therefore it is not possible to extend the
clipping path further, as the EPS does not contain info outside its clipping path.

Recognize Tiff Channels
When Tiff pictures are to be placed (either by the Place Picture function or when Importing a PS or PDF
file, ArtPro will try to recognize any spot colors if the Recognize Tiff Channels is switched on. A Tiff file
can contain channels indicating masked areas (type1), channels indicating selected areas (type2) and
channels indicating spot colors (type3) Channels of type 1 and 2 are treated as alpha channels, thus
put into the opacity channel. If the Tiff contains more than one alpha channel, only the first is used,
and all others are ignored, though the separation are generated based on the channel names present
in the Tiff. These separations have CMYK value 0, 0, 0, 100, and only reflect the number of channels
in the Tiff. If spot color channels are found, a separation will be created with the same name as the
Tiff file channel. The color definition (CMYK representation) for this spot color will first be searched
in the ink book. If the spot color is not found in the ink book, or if no ink book is loaded, ArtPro will
extract the color information from the Tiff file. Since this color definition is normally given in RGB or
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HSB, conversion to cmyk will usually yield a deviation from what is expected. Therefor, a warning is
generated. If ArtPro encounters an unknown color space, a new separation will be created with the
channel name, and with cmyk representation 0, 0, 0, 100. If a tiff contains no extra channels, or if the
Tiff contains at least one spot color, the file will be placed as a mapped picture. If the Tiff contains an
alpha channel, the file will be imported as a Internal image.

Detect Image Resolutions in PostScript / PDF Import
If this option is enabled, ArtPro will attempt to take over the original resolutions of images when
importing a PostScript or a PDF file. Whenever the resolution is an integer (e.g. 360 dpi), this resolution
will be used, and the scaling of the image will be maintained. If the resolution is not an integer (e.g.
305,7) or if the option is off, images will be saved at the resolution defined in the Import PS/PDF dialog,
and their scaling is adjusted. See Resolution on page 96

Ignore blank separations when placing ArtPro files
The Ignore Blank Separations option, makes ArtPro to ignore blank lines in the separation dialog, when
placing or inserting an ArtPro file, e.g. when creating a Step and Repeat. Do not confuse this option
with “Remove unused separations”

Note:  Blank separations can only be seen in the Separation window, with the Show Indices
option enabled. See Separations... on page 470

Contone Cache
Contone Cache is the part of the ArtPro RAM memory which will be reserved specifically for tiled
ArtColor images. See ArtColor, internal CT and CT files on page 37

Show warning when exceeding Bleed Box
This option is used for all step and repeat options. When asking to apply bleed that exceeds the size
that was defined in the bleed box, there will be a warning. When you don't want this, e.g. when you
didn't define your bleed box, this option can be switched off.

Place/replace pictures using
This setting defines which job size needs to be used to place an ArtPro or PDF file as a picture. ArtPro
will generate a new object on the size of that box and place the complete picture inside it. This setting
could be useful for S&R.

Align placed/inserted pictures on
When a picture is placed in ArtPro, it is always positioned in the bottom right quadrant of the ruler.
When placing an ArtPro or PDF file, containing different job sizes, we can use this setting to define
which one of the sizes needs to be aligned to the bottom right of the ruler.
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Open images with
When opening an image from the Used Images dialog (see Links on page 438), they will be opened
using the default application as set in the Finder (Default Application) or in the application set using the
Browse option.

Open in Visualizer with
When submitting to Visualizer (see Open in Visualizer on page 166), the file will be opened using the
default Visualizer as set in the Finder (Default Application). You can define your specific version using
the Browse option.

2.1.8.  Edit

Default Font
The defined Default font will be used every time text has to be generated automatically, such as when
generating registration marks. The same default font will also be used when generating a Cruise report
or an Ink Coverage report. This feature can be interesting for japanese users. If a default japanese font
(e.g. Osaka) is defined, all these automatic generated texts will also contain japanese characters.

Units
The different units you can choose from are inch, mil, pica pt., PS point, Q, Bai, cm, mm and int. units
(internal units). Changing the units in this field, changes the units in the complete program, except
for the text parameters, where most units by default are in pica point, and where text units can be set
separately.

• 1 inch = 25.4 mm
• 1 mil = 1/1000 inch
• 1 pica point = 0.166 inch = 1/72.289... inch
• 1 PostScript point = 1/72 inch
• 1 Q = 0.25 mm (Japanese unit for character pointsize)
• 1 Bai = 2.24 mm (Japanese unit for character pointsize)
• 1 internal unit = 1/12000 inch

The internal unit of an ArtPro file is 12.000 dpi. All anchor points snap to this internal grid.

Undo steps
For path manipulations, ArtPro can have several Undo levels (up to 64,000). The default number is set
at 10. Keep in mind that a high number for Undo is memory consuming and will slow down the display
speed.
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Vertical nudge distance
The step used to move selected paths or selected anchor points vertically, when the move tool,
interactive transform tool or one of the edit path tools is active, by using the up or down arrow key.
When also pressing the modifier button (Cmd for ArtPro Classic key bindings, Shift for ArtPro like
Illustrator key bindings), the distance will be multiplied by 10.

Horizontal nudge distance
The step used to move selected paths or selected anchor points horizontally, when respectively the
move tool, interactive transform tool or one of the edit path tool is active, by using the right or left
arrow key.

When also pressing the modifier button (Cmd for ArtPro Classic key bindings, Shift for ArtPro like
Illustrator key bindings), the distance will be multiplied by 10.

Constrain Angle
Using the Shift key while rotating forces the rotation angle to multiples of the Constrain Angle. The
default Constrain Angle is 15°. Drawing paths with straight lines using the Shift key will force the drawn
paths to take the defined angle (or multiples). This magnetism to the Constrain Angle works in the Edit
Path, Retrace Path and Split Path function.

Create New Objects
This pop-up allows you to specify the position of newly created objects.

• Add on Top: by default all new objects are created on the top level in the active layer of the file.
• Insert in Front of Selected Objects: the path will be created in the level just above the level of the

selected objects. If paths in different layers are selected, the new path is put in the topmost layer.

Select Compound Paths Entirely
Selecting or deselecting an element of a compound, normally causes the entire compound to be
selected or deselected. If you want to select one or more paths of a compound separately, remove the
check next to Select Compound Paths Entirely. By default you always select or deselect a compound
completely.

Pressing Alt during a Select function inverts the Select Compound Paths Entirely flag, i.e. if Select
Compound Paths Entirely is on, and you press the option key, a part of a compound will be selected
and the rest of the compound will not. This selection is the same as the arrow minus selection, or path
selection explained earlier in this chapter.

Beware: pressing Alt before the Select activates the hand tool. You have to press option after you start
dragging, or press both command and option at the same time.
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Select Groups Entirely
Selecting or deselecting an element of a group, normally causes the entire group to be selected or
deselected. If you want to select one or more paths or compounds out of a group separately, remove
the check next to Select Groups Entirely.

Once this option is OFF, you get the compound selection (= arrow plus). See also Group, compound
(object) and path selection on page 244.

Preserve Text Attributes when pasting
If this option is switched on, text can be copy and pasted including all its attributes: font, size, etc. This
only concerns copying text within ArtPro.

Move Ruler Active
If the Move Ruler Active option is on, you can move the ruler when the Move tool is selected. See
Transform on page 199

Enable Contextual Menu
If Enable Contextual Menu is enabled, right-clicking on your job will show the contextual menu. The
items in the contextual menu depend on the current selection.

2.1.9.  Shortcuts

You can change the shortcuts for all functions and tools in ArtPro. There are 2 sets preinstalled in
ArtPro:

• ArtPro Classic: based on the original ArtPro shortcuts, and optimized / extended for 9.5. (Default).
• ArtPro (like Illustrator): shortcuts and modifiers based on the corresponding shortcuts in Adobe

Illustrator.

You can also define your own set of shortcuts, and define every shortcut individually. The default sets
can not be changed nor removed.

The shortcuts mentioned in this manual are the “ArtPro Classic” shortcuts, as this is the default setting.

2.1.10.  Display

Display Colors:
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for Selection, for Page Boxes, for Magnetic Objects, ...

Pressing one of these buttons will allow you to choose the display color on the Color Selection
extensions installed on the Mac, for:

• selections
• magnetic objects (see Magnetism... on page 441)

• job borders

• highlight color (Highlight in Viewer dialog, see Viewer on page 504)

• Trap Highlights

Background opacity
When showing highlights using the Viewer dialog (see Viewer on page 504), the rest of the job will be
dimmed, using the Background opacity value

Contone Screen Reduction
The Screen Reduction defines the display resolution of all internal CTs in the ArtPro document. It is the
ratio between the display resolution of an image and the actual high resolution. The Screen Reduction
is important for the calculation of the LR tiles per separation and the RGB LR preview tiles. The lowres
tiles use 1 pixel out of 2, 4, 8 or 16 pixels of the high res tiles, depending on how the Screen Reduction is
set.

The pixel used in the lowres images is the most top left pixel (first pixel) of 2x2, 4x4, 8x8 or 16x16 pixels
square. Obviously previewing becomes a lot faster this way. In 1/16 mode, ArtPro is only showing 1/256
pixels. See ArtColor, internal CT and CT files on page 37
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Anti-Aliasing
Anti-Aliasing can be applied on the preview and/or the outlines, to give a smoother preview. Using Anti-
Aliasing takes more time to calculate the preview. In ArtPro 9.5, this option is default enabled.

Picture Display Resolution
You can specify the preview resolution for picture display. The default value is set to 300 ppi. ArtPro
divides the original resolution of the TIFF image by two until the result becomes smaller than the value
in the TIFF Display Resolution field. E.g. If the Picture Display Resolution is +100 ppi and you have an
image of 300 ppi, then 300 ppi / 2 = 150, 150 ppi / 2 = 75 ppi < 100 ppi. The image will be displayed with a
resolution of 75 ppi.

Keep in mind that increasing the resolution also increases the internal memory needed to store
pictures in ArtPro.

Remarks:

A mapped picture which is already present in the file, only adapts its screen resolution the next time
a screen preview has to be calculated. Thus, change the display resolution, and force the system to
calculate a new preview. The easiest way to do this is by repainting the preview with the shortcut
Cmd-,.

Use RGB when Appropriate
This option is only taken in account when placing old ArtPro files that do not contain CMYK
separations.

In case the option is off, ArtPro will use the Separated preview of the ArtPro file. In most cases this will
be correct. However if the placed ArtPro file contains a placed EPS (which has only an RGB preview),
this EPS will NOT be shown in the separated preview.

If the option is off, ArtPro will use the (non separated) RGB preview of the ArtPro File. This will result
in a correct preview when EPS files were placed in the original file, but of course loses all benefits of
using a separated preview, such as viewing separations.
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If this option is enabled, it will not show the single separation preview with Placed ArtPro file or Step
and Repeat of ArtPro files which does not contain the CMYK separations.

Steps for Gradations
In this field you can define in how many steps a vignette should be represented on the screen. The
default value is 24. Keep in mind that a higher number of steps consumes more memory. For jobs
containing lots of gradations, it is advisable to reduce this parameter to get acceptable screen preview
speeds. The preview is adjusted by repainting the preview.

Paths for Selection Preview
In the Object Properties dialog, a preview of the selection is shown, as long as the number of paths
in the selection is not higher than the Paths for Selection Preview number. See Object Parameters on
page 445.

2.1.11.  Certified

The Certified Tab contains the basic settings for Certified mode. The complete usage of Certified
ArtPro is described below in Certified ArtPro on page 65

2.1.12.  Languages

ArtPro will by default start up using the system language, which you can set in the System Preferences.

In the Languages Tab you can disable one or more languages. After restart, ArtPro will start up in the
first available language, respecting the order of the languages as set in the Mac OS System Preference.

2.1.13.  Servers

Shuttle
You can add Automation Engine Servers you want to connect to using Shuttle, by clicking the New
button. A Shuttle Server can be removed using the Delete button. When adding a new Shuttle Server, or
when editing a server, the Shuttle Server Details dialog will open.

You can connect using Bonjour by selecting a Server in the dropdown. By entering the IP number and
Port, you can also connect to the Automation Engine Shuttle Server manually. For more on Shuttle :
see Shuttle on page 491

Automation Engine
This allows to connect to an Automation Engine server, by entering the server name or IP, and the user
name and password. Entering this data can be slowed down by the fact that the system is checking the
server while entering password and user name.

62



2ArtPro

If connection to an Automation Engine server is established, a green dot is shown next to the Server
details.

In that case, every Browse dialog (e.g. when opening a file, selecting a file to import, saving a file, ...)
will have a Job selector dropdown, a search button and a “Select in Pilot” option at the bottom.

 

 

In this dropdown, you can select the last selected jobs run through the Automation Engine Server.
Using the Search button you can get a full list of all jobs on the Automation Engine Server. The Find
field allows to search for a specific file. The OK button will select the job and return to the Browse
window.

You also have a Product dropdown and Search button. This allows to select or search based on
Automation Engine Products.

When an Automation Engine job is selected, the Browse dialog will go to the folder containing the
selected file. If necessary, the file server containing the file will be mounted. This means that you can
also use this function to save a file next to a Automation Engine job.

When importing a pdf file from the job folder of Automation Engine, ArtPro will ask to store the TIFF
images by default in the location of the Automation Engine server.

If the Select in Pilot option is on and the Automation Engine Pilot is open, the file you recently saved or
opened will be automatically selected in the Automation Engine Pilot. This allows to immediately take
further actions in Automation Engine on the file you just saved.

Note:  The connection between ArtPro and Automation Engine will only work if the server was
mounted on the computer running ArtPro the same way as the container share was added in
Automation Engine. If the container share was added in Automation Engine based on the IP
address, the server should be mounted based on its IP address (afp://xxx.xxx.xxx.xxx). If the
container share was added based on the computer name, the server should be mounted based
on the computer name (afp://computername).

Load Trap Tickets From

In the Load Trap Tickets From dropdown, you can define where PowerTrapper should load Trap Tickets:
either the Default Trap Ticket Folder (locally), from Automation Engine, or from a different location, by
browsing to the folder. See PowerTrapper on page 280
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Load Press Settings From

In the Load Press Settings From dropdown, you can define where Viewer should load Press Settings:
either the Default Press Settings Ticket Folder (locally), from Automation Engine, or from a different
location, by browsing to the folder. See Viewer on page 504

Shapes
This allows to define the Shapes server, by entering the Server address, the User Name and Password.
The Server address is suggested by default: shapes.esko.com. See also Import from Shapes...

2.1.14.  Color

Working Space Profile
In the General tab of the Preferences, you can define a CMYK and RGB working space. A CMYK and RGB
color profile can be selected to be used for the “Match Current Paint” feature in the Ink Book (see Ink
Books on page 478 Match Current CMYK Paint on page 479) and for Equinox. For more information on
Equinox, we refer to the Equinox documentation.

Use Pantone+ Ink Books
If this option is enabled, ArtPro will replace the standard Pantone Ink Books by the Pantone+ ink books.
After a clean install of ArtPro 12, the Pantone+ Ink books will be used by default. If preferences from
older versions were detected, the setting from these preferences will be used.

Note:  Changing this option only takes effect after restarting the application.

Load Color Engine Ink Books
These options allow to set up the use of Color Engine Ink Books. See Color Engine Ink Books on page
479.

2.2.  Quit ArtPro

Clicking on the Quit function quits the ArtPro program.

If any unsaved ArtPro files are open and modified, ArtPro will ask to save first. See Save as... on page
74.

Shortcut: Cmd-Q, Quit

Note:  If something goes wrong in ArtPro, ArtPro will try to recover unsaved files that are open
at the moment of crashing. After restarting ArtPro, you can save these recovery files.
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2.3.  Certified ArtPro

Note:  This module is optional. See Show Licenses on page 49 for more information.

“Certified ArtPro” allows to integrate the Certified PDF Workflow functionality into ArtPro. The aim is
to provide functionality to import Certified PDF, edit and then export as Certified PDF with information
about edits and changes to the document.

Note:  The Certified related menu items and options are only available if Certified is enabled in
the Preferences.

Certified ArtPro can be divided in 3 parts : Input, Output and Certified ArtPro sessions.

Preflight Profiles
If you have PitStop Pro and/or ArtPro+ installed on the same workstation, the Preflight Profiles
database will be shared. See the PitStop Pro and ArtPro+ documentation for more information.

To create or edit Preflight Profiles, you can use the Preflight Profile Editor from either PitStop Pro or
from ArtPro+.

2.3.1.  Certified ArtPro sessions

ArtPro can work in Certified ArtPro Mode, by switching it on in the Certified ArtPro dialog. This setting,
together with the User Info, can be found in the Preferences, in the “Certified” tab.

User information data
User name, Short user name, etc. - provides the information about the user who is editing the PDF
document. That information will be stored in Certified PDF each time when a new session is started
(see earlier).

If you enable Certified Mode, the filed “User name” is mandatory. So before switching on Certified
Mode, a User Name should be specified. Otherwise, switching to Certified Mode will not be allowed.

If you change the User information when working in Certified ArtPro Mode, a dialog will pop up, asking
if you want to start a new session or not. If you click yes, the active session will close, and a new
session will be started, using the changed User info. If you click No, the User info in the active session
will be overwritten by the new User info.

When opening or importing a document without any User information (without Certified ArtPro
switched on), a session will be recorded anyhow. At the moment the user information is entered in the
Certified ArtPro dialog, this User information will be used for the active session. In that case, the popup
to decide if a new session has to be started, will not appear.
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Session and User information is saved with the ArtPro file if “Include Certified PDF information” in
ArtPro’s Save As parameters is enabled. If the parameter for including Certified PDF info is enabled or
disabled in the Save As dialog, all subsequent Saves will use the same settings.

Sessions
Working Certified Mode in ArtPro, affects the way it works for all open/save operations. Whatever
the Certified options states are, ArtPro is now recording the history of changes made by the user and
saves them with the ArtPro files. From version 8.0, all ArtPro files have the possibility to be exported to
Certified PDF and all the history of changes will be recorded. Those changes are recorded as sessions.
An ArtPro session is a track of changes from beginning of the session to the end of the session.

A session starts when:

• A file is created or opened that doesn’t contain a session yet. This can be : opening an ArtPro file
from version lower than 8.0, importing a PDF (Certified or not) or importing any other file format.

• An ArtPro file is opened, changed and saved. The active session is closed, and a new session is
opened

• Certified PDF file is exported and Certified mode is on (explained later). In that case, the old
sessions are recorded to PDF file and a new session is opened.

The session is not begun when:

• An ArtPro file is saved without any changes, or modifications were not saved.
• Certified PDF file is exported and Certified mode is off. The active session will be continued.

2.3.2.  Input : Import PS/PDF

The Import PostScript/PDF dialog will show the type of selected PDF file in “Type” field. If it’s a Certified
PDF file, it will display “Composite Certified PDF”. If it is not certified PDF, it will display “Composite
PDF”. The Certified tab in the Import PS/PDF dialog, contains some settings on input, and the browse
button to select the input profile to be used. To clear the input profile, you can shift-click the browse
button.

Importing files other than PDF
When importing any other file type than PDF, the Sessions log will indicate that no input profile was
applied, and the session will begin AFTER the import.
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Importing non-Certified PDF
When importing a non-Certified PDF file, and Certified Import is enabled, ArtPro will Certify the PDF
file and import the Certified PDF instead of the original. Unless “Overwrite input file on re-preflight” is
on, a new, certified PDF will be saved, and this certified PDF will be imported. This will be saved as a
separate session.

If you click “Cancel” in the dialog to define name and location of the Certified PDF file, the uncertified
PDF is imported anyhow, and the session will start AFTER the import.

Re-Preflight if profile does not match : ON
If the profiles are not identical, the option “Re-preflight if profiles do not match” will be consulted. If the
option is on, the job will be re-preflighted if the input profile and the embedded profile don’t match. If
they match, the session log will indicate both profiles are identical.

When comparing 2 profiles, their content is checked, and not just the name.

Re-Preflight if profile does not match : OFF
If the option “Re-preflight....” is off, the Certified PDF will be imported without re-preflighting it. The
Session window will indicate the profile it was originally certified by.

Re-preflight
When Re-preflighting, ArtPro will create a new session, preflight the file and close the session. ArtPro
will prompt for the filename for the new Certified PDF file (if the Overwrite option is off). An additional
session will start in ArtPro.

Overwrite Input File
If the “Overwrite Input file on Re-preflight” option is on, there will be no new PDF file created by ArtPro.
Instead, ArtPro will replace the original PDF file with the certified PDF.

Get all bounding boxes for preflight report
This option forces ArtPro to obtain bounding boxes for the last preflight report. If activated, ArtPro will
get full information for every report item along with bounding box of the area where the error/warning
occurred. This will cause an additional preflight of the input document and consume additional time,
but will allow you to double-click on the preflight problems and warnings, and zoom in on the correct
areas

2.3.3.  Session Info

The Session information can be opened by clicking the Certified Session button. If the file is not
Certified or has preflight errors, this button will show a red cross.

 

67



2 ArtPro

 

If the file is Certified with no preflight errors, it will be represented as a green ok mark.

If Certified is not switched on in the Preferences, the Certified Session toolbar button will be disabled.

 

 

PDF Document Status
The PDF document status will indicate if the last Certified PDF file was preflighted, and by what profile.

This will be the original PDF coming from Importing, the Certified PDF when re-preflighting during
import, or the last exported PDF with Certified enabled.

ArtPro Document
The ArtPro Document status indicates whether or not the current ArtPro Document is fully certified.
This will only be the case after a Certified Import without errors, or after a Certified Export PDF.

As soon as the user starts editing the document, the status changes to Red.

Personal Info
User info on the specified session. For ArtPro sessions, this information comes from the Certified
Preferences.

Session times
start/end time of the session.
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Profile
information about Preflight profile used for that session. If the session was preflighted, it shows the
status of preflight (preflighted OK or with errors) and profile name.

Report
Report will be shown only for the last history session (which is one before the “Active session”), but only
if that session was preflighted. If the option “Always get bounding boxes for preflight info” is off, the
report will contain only error/warning messages and number of occurrences without bounding boxes
of the area where the error/warning occurred. If the option is on, each report entry, if available, will
contain an additional set of bounding boxes of the areas where the error/warning occurred. Double
Clicking on such an entry will zoom in on the area.

Report is marked by a red spot for errors and orange for warnings.

Edit Log
gives a list of edits that has been done for the session along with the short name of the product by
which the change was done. For ArtPro edits it will be “ARTP”. Additionally, if available, each edit log will
be accompanied by a set of clickable bounding box items where the edit had effect. Clicking a log item
will highlight it in the file, double-clicking it will zoom in on it.

Zooming in is always using the location of the object at the time of editing. If the object was moved
later on, the zoom will not show the object.

Session Comment
Session Comment is a text that can be entered whenever a session is ended (e.g. save the file)

The Comments entered for the session will be shown in the session info.

General
The “Sessions” dialog will show only non-empty information. There will be always one “Active session”
which is the current session. “Edit Log” for this session incorporates the current changes being made
to the document.

2.3.4.  Export

The “Export PDF” operation (with Certified enabled) will close the session, add “edit log” information and
optionally preflight the document. The standard “Export PDF” dialog window has now an additional tab
“Certified PDF”:

If the “Output profile” file is selected then PDF file is preflighted after being exported. The Output
profile can be cleared by shift-clicking the Browse button. If “Certified PDF Enabled” is unchecked, then
regular non-certified PDF file is saved and no new session is started.

The “Incremental save” option will work only if the last Certified PDF (i.e. the imported Certified PDF
or the last Exported PDF) is still available. The option means that the previous Certified PDF file’s
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contents will be merged with the exported PDF, so that “rollback” the PDF document to the previous
session will be possible. Using this option can result in a large PDF file.

To keep both the PDF as the ArtPro file in a certified (“green”) state, it is necessary to save the ArtPro
file after the Certified PDF Export.
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3.  File Menu

3.1.  New...

The New... function creates a new file. When selecting New..., a dialog box appears to set the name for
your new file. The default filename is “Untitled 1”. You also have the possibility to change the job size, if
necessary. After clicking the OK button, ArtPro will open an empty document with the 4 process colors
(CMYK) as predefined separations.

Right after starting up the application, the default job size will be 297mm x 210 mm if units are set to
mm or cm, or 8” x 11” if units are set to any other unit. If a job was opened before, the default job size will
be equal to the job size of the last active job.

Using the size pull-down menu, the dimensions for the job can be selected from a number of
predefined paper sizes. These sizes are either the defaults (see below), or the sizes found in a text file
called JobSizes, in the User folder, in Preferences, in the ArtPro folder.

 

 

This is an example of a jobsizes file, containing ArtPro Default sizes :

ArtPro Sizes File V1.0
A4 210 297 mm
A3 297 420 mm
US_Letter 11 8,5 inch
US_Legal 14 8,5 inch
Tabloid 17 11 inch
Tabloid_Extra 17 12 inch

The paper size name, vertical size, horizontal size and units are divided by a space or tab. This means
the name should not contain any spaces or tabs. An underscore in the name will be converted to a
space. When selecting a paper size, its units (either mm or inch) will be activated in the Preferences
dialog (Preferences... on page 48).

The Job sizes file will not work if the text file name is not exactly ‘jobsizes’, if the title in the text is not
exactly ‘ArtPro Sizes File V1.0’ or if the text file is not at the appropriate place. In ArtPro it is possible
to have a total of 9 job windows open at the same time, windows of different documents or multiple
windows of one document (see also New Window on page 425)
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Shortcut: Cmd-N : File New

3.2.  Open...

With Open... you can open an existing ArtPro file, using the Mac OS Navigation services.

When an ArtPro file is saved with the ...With Preview option on (Preview on page 75), this preview
will be available in the File open dialog. The navigation services also allow the use of Favorites and
Recently opened files, show mounted servers, sorting files by name, date,... ArtPro can open several
files at a time. Use shift to add files to the selection.

All Job Preferences are saved in the ArtPro file. If the Load job preference option is on in the
Preferences > General > Open is enabled, the Job Preferences will be opened upon loading the file. For
an indication of Job Preferences and User Preferences : see Preferences... on page 48.

When opening an ArtPro file, you can open it with or without its preferences (see Preferences :
Preferences... on page 48 Load job preferences on page 49).

When opening a locked file, ArtPro will perform an Open read only instead.

When opening an old ArtPro file containing JPEG or TIFF files that aren’t Mapped Pictures, ArtPro will
offer the possibility to map all pictures (see Mapped Picture on page 462)

When opening a file that uses external references, ArtPro will attempt to automatically connect to the
file server using SMB.

3.2.1.  Open Read-Only...

With this option you can open an existing ArtPro file for read only. A message will appear that you will
not be able to save any changes. Opening a file for read only is especially useful to copy and paste from
one job into another. Open read only is the only way to open a locked file, or a file from a CD/DVD or any
other locked volume.

Shortcut: Cmd-O : open file with preferences

Shortcut: Cmd-z -O : open file without preferences

3.3.  Open Recent

In the Open Recent menu, the 20 most recently opened ArtPro files can be chosen and opened.

The list of Recent Files is stored in a text file “ArtPro Recent Files” in the User Folder, in Library, in
Preferences, in the ArtPro folder.
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3.4.  Insert ...

It is possible to insert an ArtPro file in an already opened ArtPro file. By choosing the Insert... function
you will get a dialog box to select the ArtPro file you want to insert.

The inserted file will appear selected on the bottom right quadrant of your ruler. The media box of the
original job is aligned on the ruler. If anything was selected in the window before inserting the file, it will
now be deselected and only the inserted paths will be selected.

If separations from the inserted file are not in the open file, ArtPro adds these separations in the
separation table. One ArtPro job is limited to 64 separations. If the separation table exceeds the
maximum number of separations, the message “separation table full” will appear. Paths in overflow
separations will become white. All the layers in the inserted file will be generated in the opened ArtPro
job. In Preferences... on page 48 you can switch the toggle Merge layers with same name on page 50 on,
to keep ArtPro from creating double layers.

3.5.  Close / Close All

This function closes the active job window. The shortcut for closing a job window is Cmd-Shift-W.
Cmd-W closes the last activated dialog box. When all dialog boxes are closed, finally it closes the active
job window. With Cmd-Alt-W all menus and dialogs will be closed except for the job windows and the
toolbar. Cmd-Alt-Shift-W closes all active job windows at the same time.

When closing a document that contains changes compared to the previously saved version, ArtPro will
ask if you want to Save, Don’t save or Cancel.

• Don’t save: will close the active ArtPro document without saving any changes.

• Save: will save the ArtPro document under the active name. If your document has not been saved
yet, a dialog box will appear to define a name.

• Cancel: does not close the job window and returns to your active job.

Dialog Boxes containing a button, such as Create, Apply, modify, etc. can be closed by holding down the
Option key while clicking (and executing) the button.

E.g. if you fill in the box menu, and hold the option key while clicking Create, the box will be created and
the Box menu will close.

Shortcut: Cmd-W, close active dialog box

Shortcut: Cmd-Alt-W, close all dialog boxes

Shortcut: Cmd-Shift-W, close current job

Shortcut: Cmd-Alt-Shift-W, close all jobs
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3.6.  Save

With the Save command, you can save the changes on your ArtPro document and its preferences.
Save only works if you have made some modifications in the job. Otherwise Save will be grayed
out. However, when opening an ArtPro file without preview, with the Save Separated Preview by
Default option on, the Save function will be available to save the file with a separated preview. See
Preferences... on page 48 Save separated preview by default on page 52.

When you save a document that has not been saved before, the shortcut for save actually activates the
Save as... function (see below).

When you save a document that already has a name, ArtPro automatically updates the file with the
same name. Many ArtPro users will put an extension ‘.ap’ behind the file name. Although this is not
compulsory, it is advised, to be able to recognize the files easier.

When saving a file for the first time after opening it, a backup copy can be created of the original (see
Preferences... on page 48 Keep backup copy on page 51). Save regularly and save often. This way if
something goes wrong, you still can recall the last saved version.

If Certified ArtPro is on, a dialog allowing to enter Session Comments will open when saving a file. For
more info on Certified, see Certified ArtPro on page 65.

Shortcut:

Cmd-S, saves the active file

3.7.  Save and Select in Pilot

If a file from an Automation Engine Job Folder is open, the Save and Select in Pilot command can be
used to save the file and select it in the Job Folder in the Automation Engine Pilot. See Save on page
74 for more info on Save, and Automation Engine on page 62 for more info on Select in Pilot.

To ensure that the file can be selected in the Automation Engine Pilot, open Automation Engine Pilot
before performing the Save and Select in Pilot command.

3.8.  Save as...

The Save as... command allows you to store the active ArtPro job under a new name. Save as... can
be used to make a copy of the active file by storing it under another name. When selecting “Save As”,
or when saving a new file for the first time, the Save As parameters are opened. Whenever saving
an ArtPro document using the Save command, the same settings are used. The default for both
Include Separated Preview and Include Certified PDF Information can be set in the preferences. See
Preferences... on page 48 General: Import on page 52.
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Shortcut: Cmd-Shift-S, saves the active file under a new name

3.8.1.  Preview

As a preview in ArtPro will always be a separated preview, you have the possibility to choose between
no preview or separated preview.

3.8.2.  Include Certified PDF information

The checkbox allows to define if Certified PDF information should be included in the ArtPro file. If the
checkbox is on, the information will be included in the file.

More info on Certified PDF can be found in Certified ArtPro on page 65

3.9.  Save a Copy as...

The Save a copy as... command allows you to store the active ArtPro job under a new name. When
using the “Save a copy as” function, the active job will remain open, whereas when using the “Save As”,
the copy will become the open, active file.

3.9.1.  Include Preview

As a preview in ArtPro 8 - 18 will always be a separated preview, you have the possibility to choose
between no preview or separated preview.

When saving as 6.5 - 7.5 document, you still have the option to include only the “standard” RGB preview.
Choices then are none, Standard Preview or Separated Preview.

3.9.2.  Certified PDF information

The checkbox allows to define if Certified PDF information should be included in the ArtPro file. If
the checkbox is on, the information will be included in the file, even when saving as ArtPro 7.5 file. Of
course if you open that file in ArtPro 7.5, that info will be ignored.

More info on Certified PDF can be found in Certified ArtPro on page 65

3.10.  Revert

With Revert it is possible to return to the last saved version of your ArtPro file. Revert to Saved asks for
confirmation and then replaces the version on the screen by the last one you have saved.
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3.11.  Cruise Controls... (ArtCruise)

ArtCruise, the checking and reporting utility, allows you to set a number of criteria to which a
PostScript or PDF is checked during import. The criteria set in Cruise Controls will result in a Report
file. The cruising, or preflighting, happens during PS or PDF Import. To define controls, go to the File
menu, Cruise Controls and select them from the list. The Cruise Controls can also be accessed from
the PS/PDF Import dialog box (see Import Postscript/PDF... on page 79). The Cruise Controls are
set in advance and if errors are found, a report will be available after import. ArtCruise controls can be
set up and saved in the Preferences, so they don’t need to be redefined every time. Just close all jobs,
define the controls, go to the Preferences dialog and click Save Preferences. To know more about the
preferences, see Save Current Settings on page 49.

3.11.1.  Defined Controls

Cruise Controls are split up into different categories: Info, Lineart Color, Image, Object Kind, Text,
Transparency and Preflight Report. All these categories contain criteria to eliminate common errors in
an early stage of the production process.

To add controls to the list, double click on the control, or select it and click on the button with the arrow
to the right. To remove controls from the list, select it and click on the button with the arrow to the left.

Info Controls
 

 

With this settings, info about the imported file can be found :

Filename : The original name of the imported file

Format : What file format the imported file has (as found in the header of the file)

Title : Title of the document of which the imported file was created

76



3ArtPro

Creator : Application in which the imported file was created

Date : Date on which the imported file was created

Type : the type of file imported (Composite / Separated)

PDF 1.4 : Indicates if the imported file contains PDF 1.4 blend modes or transparencies. In that case,
the PS Import should Error (so always put on Red Alert)

Lineart Color Controls
* Overprint: Overprint defined in the imported file is detected. Overprints in a document could indicate
that the file may already contain some trapping.

*  Custom Colors: Using this control, you can be notified when and where a custom color is used in the
imported file.

* Ink Coverage: Ink coverage can be checked not to exceed a given percentage, e.g. 300%. This is used
to find a common error, like the use of registration color, where simple black was needed.

Image Controls
This category contains all controls to avoid most common errors in images.

* Resolution: if the resolution of all images used in the imported file is bigger or smaller than 72, 300,
1000 ppi or a freely entered value, a warning will be generated. This can point out low res images, or
images with an excessive resolution. Very important to know here is that ArtPro takes the scale factor
of an image into account. The real resolution is the scan resolution divided by the scale factor in % and
multiplied by 100.

The real resolution of a 300 ppi image scaled to 200% is 150ppi.

The real resolution of a 72 ppi image scaled to 20% is 360ppi.

* Color: Images in the specified color space (RGB, CMYK, LAB, Separated or Grayscales) can be found.
This could also be very useful, because ArtPro does not support any RGB images.

* Links : With the Link settings, OPI or EPS comments can be checked:

OPI Comments: indicates if OPI comments were encountered in the imported file

OPI Recognized: indicates if the found OPI comments were used

EPS Linked: indicates if linked EPS files were encountered in the imported file

EPS Imported: indicates if these found EPS files were imported (i.o. being placed)

Object Kind Controls
Object controls offer the possibility to point out objects smaller or bigger than a given value, e.g. to
avoid hair lines or small text printed in flexography.

*  Text: text smaller or bigger than 12pt, 6pt or any entered value can be looked up and reported.

* Strokes: strokes can be checked for size to be bigger or smaller than 2 mm, 1 mm, 0.5 mm or a user
defined value.
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Text Controls
Text controls contains 3 criteria for font control:

* Font Missing: A criteria can be set to search for missing fonts during import. ArtPro will report if no
font information was found at all, meaning the printer as well as screen fonts were missing.

* Font Name: If a font, used in the imported PS or PDF file matches the name entered here, there will be
a warning. This way, the system can notify the operator when for instance, a courier is used in a file, for
this is often a replacement font.

In the definition of the font name, a wild card can be used. If you enter Cour*, all font names starting
with cour will be found, including courier bold, courier italic, etc. The name is not case sensitive.

* TrueType: checks if TrueType fonts were used in the imported file.

Transparency Controls
Transparency controls contains 3 criteria:

* Blend Mode: A criteria can be set to search for any blend modes applied in the job.

* Opacity: a control can be set to look for an opacity above or below a defined value, or for an exact
match

* Opacity Masks: checks if opacity masks were used in the imported file.

Preflight Report
The Preflight Reports allow to get info from the PDF Preflight Reports. This of course only applies on
importing PDFs that were preflighted. The Cruise Controls that can be used, are the 3 levels of Preflight
report : fixes, warnings and errors.

Keep in mind that Bounding Boxes for preflight entries will only be available if the file was preflighted or
re-preflighted during import, with the “Get All BoundingBoxes” option on (see later).

3.11.2.  Report

The controls explained above, can be set green, yellow or red. A green control will generate a comment
line, a yellow or red control will generate a warning. Red errors are only used for Nexus, the Esko
workflow system. When a ‘red error’ is found, PS/PDF Import is stopped. Because it is possible to make
manual changes in the ArtPro file afterwards, ‘red errors’ don’t stop PS/PDF Import in ArtPro.

After import, the Cruise Report shows the errors and warnings that are encountered in the file. By
clicking the color buttons at the bottom of the dialog, you can filter the error list.

By double-clicking a line in the Report, ArtPro will zoom in and select the element where the error was
found. The report will be ordered by type of error. Click on the button on the left of the error to see a list
of all the errors of one kind.

The Report can be saved in a text file by clicking the Save Report button. Clear Report to erase the
cruise report.
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The report can, besides being saved as text file, also be exported to PDF. The resulting PDF file
contains Job name, date of cruising, a preview of the job, and all errors, warnings and notes
encountered in the imported file. This report file, as text file or as PDF, can be used to be send to
the customer. The report will be generated using the Default font as defined in the Preferences. See
Preferences... on page 48 Default Font on page 57.

3.12.  Import Postscript/PDF...

Import PostScript/PDF... allows you to import a PostScript/PDF file into ArtPro. This means you
can import QuarkXPress, Adobe Illustrator, Freehand, Adobe PageMaker, Corel Draw,... if saved in
PostScript or PDF format. ArtPro accepts PostScript and PDF files from both Mac and PC.

The PostScript or PDF files are completely converted into ArtPro internal format. We would like to draw
your attention to the fact that the file is converted into another format. Not all conversions are 100%
accurate (e.g. some complex shadings are converted to image), so it is recommended to check the
converted file thoroughly.

When a file is imported, we try to keep the highest possible editability, this means paths are converted
into internal ArtPro paths, text remains text. All text, logo’s and pictures can be modified, so it is no
longer necessary to switch applications.
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Shortcut: Cmd-Alt-P, Import PS/PDF

3.12.1.  Importing Normalized PDF

Normalized PDF files can be imported into ArtPro just like any other PDF. Keep in mind that in
Normalized PDF, image links are included as Esko Links. See  Links on page 89

3.12.2.  Steps for importing a PS or PDF file

• Choose Import PostScript/PDF... from the File menu, and the Import PostScript/PDF dialog will
appear.

• Click on the Select File... button, a dialog box appears to select the PostScript or PDF file. It is
also possible to drag and drop PostScript or PDF files from the finder onto the dialog box. When a
file is selected, ArtPro reads the PS / PDF header and all the relevant information is filled into the
different tabs of the PS/PDF Import dialog box. The file name, job title, creator, date, number of
pages and the preview, are always shown on top when available. If a Certified PDF is selected, this
will be shown next to the Type. If Certified is off, ArtPro will suggest to switch on Certified Mode.
See Certified ArtPro on page 65 If a Normalized PDF is selected, this will also be shown next to Type.

 

 

• Next to Pages the number of pages is shown, and, between brackets, all available page labels.
For composite PS, and for Separated PS without Import separated file as Multipage, these labels
correspond with the page labels in the PS file, which corresponds with the labels from within the
original application. These page labels can be numbers, but can contain other characters as well,
e.g. a page nr. prefix, roman figures, etc. When importing a separated file, with the Import Separat-
ed File as multipage option on, these labels simply represent the available separations as a range;
starting at one, ending at the total number of separations.

• If you select a PDF file to be imported, a number of options will be gray, as not all options are
relevant or implemented to import PDF files. See the options below for more detail.

• Activate the necessary options. These options have been split up into 9 sections : Page, Font, Color,
Blends, Shadings and Gradations, OPI, Links , Image, General and Certified settings.
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• Click on the Import button

3.12.3.  Page Settings

When opening the Import Postscript Dialog, the Page button is selected.

Import Page
This setting defines, if a multiple page PS or PDF document has to be imported, what pages should be
imported. If Import Page is inactive, all pages of the PS or PDF file will be imported. The positioning of
the individual pages depend on the setting of the Multiple Page offset checkbox (see below).

If Import Page is active, only one page out of the multipage document will be imported. The page that
has to be imported can be entered in the Import Page field. The Import Page field can take a string
input (a page label) as well as a numeric input (a page number). When the exact page labels are shown
(see above), the exact page label (e.g. “p.4”) can be entered.

When importing a Separated PostScript with the Import Separated File as Multipage option off, a
number has to be entered, defining what separation of which page has to be imported. As this requires
knowledge of the number and sequence of separations in the file, this is not very recommended. The
other dialogs, such as Color and Fonts Settings, will adjust to the selected page.

Ruler at top left
By default a PostScript or PDF file will be imported placing the PostScript origin (= 0,0) on the center
of the ruler. If you switch the option Ruler at top left on, the top left of the page will be placed in the
center of the ruler, placing the file in the lower right section. The origin in the PS file is in most cases
the bottom-left corner of the page, although this is not a general rule. E.g. in EPS files from Adobe
Illustrator, the PS origin is the same as the origin of the ruler in the Illustrator file.

Multiple Page Offset
When importing a PostScript or PDF file, ArtPro puts all pages with the 0,0 point in the center of the
ruler. This results in multipage documents being placed on top of each other. If you use the Multiple
Page Offset, all pages are put next to each other.

Import Separated File as Multipage
This option relates to importing a separated file, e.g. files using the %PLATECOLOR command to
identify the separation name or PSsetter files from Barco Graphics.

With the Import Separation File as Multipage on, all the elements of a separated file will come in as
grayscale, and the different separations will be treated as individual pages, so they will be placed on
top of each other, unless the Multiple Page Offset is on.

When importing a separated file with the Import Separated File as Multipage option off, the Separated
PostScript file converted to one (composite) ArtPro file with all the separations. Most separated PS/
PDF files do not contain any pantone color definition, so after import, not all PANTONE® separations
will display correctly on the screen. If an Ink Book is loaded, ArtPro will try to look up the name of the
used separation in the Ink Book, and if found, this Pantone color will be used. The separations that
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are not found in the Ink Book, will be displayed in black. Therefore, redefine the Pantone inks in the
Separations dialog by choosing them in the Ink Book, or type in color values for the print and display
colors.

The individual paths coming from the different separations, will be merged together into a path with
the combined color information, based on the Merge Equal Paths option (see later). Images will be
recombined into one mapped picture. In the case this recombination is not done properly, e.g. if there
are unmergable items in between the separations of the image, you can recombine the individual
grayscales manually to a mapped picture (see Mapped Picture on page 462).

 

 

Make New Job
When the option is activated (default), a new job is created for any Import PostScript/PDF. When the
toggle is switched off, the file is imported in the current job. This option goes along with the Import
Opens New Job toggle in the Preferences dialog (Preferences... on page 48 - General: Import on page
52).

3.12.4.  Font Settings

Click on the Fonts... button to open the font settings tab, in which can be defined how to handle Fonts
used in the file.

Clicking on the Display Fonts button will show a list of all fonts used in the file, and if the fonts are
available in the file or on the system. This makes it possible to see what fonts are needed, so they can
be activated before importing.

Use Replacement Font i.o. included Fonts
This allows you to define if ArtPro has to replace used fonts by the font installed on the system.
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If this option is off, ArtPro will look for fonts in the PostScript file first, and will use the system fonts if
the fonts are not in the PS file. This means that :

• if a font is embedded in the file, this outline information is used, so the text is converted to paths
• if a font is not embedded, the Replace by font will be used.

If this field is empty, the corresponding font is searched on the system, and if not available, the Default
font will be used.

If the option Use Replacement Font i.o. included fonts is on, ArtPro will try to replace the embedded
fonts by the fonts installed on the system. This means that :

• if a replacement font is entered, this font will be used.
• if the Replace by field is empty, and the font is available on the system, this system font will be used

• if the Replace by field is empty, and the font is not available on the system, the embedded outline
information is used. If this is not available, the default font is used.

Fail if missing font
When this option is activated, Import PS/PDF will error when text is imported with a missing font. A
“missing font” means “not available on the system” and not embedded in the PS/PDF file and not found
in any font folder. In the Import PS/PDF log you will see the message: Failed on font: (name of the
missing font).

Fail if Courier
Because the Courier font is used regularly as a replacement font in PostScript files, you can ask to
error when this font is used. In the Import PS/PDF log you will see the message: Failed on font: Courier.

Font folders...
It is possible to select multiple Font folders, in which ArtPro will look for fonts that are not installed on
the system nor embedded in the PS file.

This allows importing a file with the fonts in a separate folder, without activating the fonts. Keep in
mind that these fonts will be treated the same way as fonts embedded in the PS file, so all text will be
converted to outlines. The font folder can be used for Type 1 fonts and Truetype.

To add font folders, go to the Font folder..., click Add. A dialog appears to select a folder. Click on the
correct folder and hit Choose. The font folder is added immediately and ArtPro searches the folder and
all subfolders for printer fonts. A font folder is shown with its complete path. If fonts are found, they will
be displayed in the font folder list. To stop using a font folder, simply select it from the list and delete it.
The Reset button, will delete all the font folders from the list.

The PS default fonts toggle will make ArtPro use a set of default fonts, like Helvetica, Courier, Times,
Symbol,... They are stored in a folder called PS Fonts, that should be on your hard disk alongside
the ArtPro application file. This set can not be modified. ArtPro will try to use the system fonts first
and then the font folders, if Use replacement fonts i.o. included fonts is on. If not, it tries to use the
embedded fonts first and then the font folders.
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Display fonts
The Font list shows you which fonts are used in the file, whether these fonts are available in the
PostScript Files or on the system, and which replacement font will be used.

A font in the list was embedded in the PostScript file, if an “X” appears in the PS column. It is installed
on the system if an “X” appears under SYS. The detection for “Fonts available on System” will also work
for Adobe subsetted font names, such as “ABCDEF-Helvetica”.

If the font is not available a dash appears.

 

 

The pop-up next to the font name allows you to define the replacement font. In this pop-up all the fonts
installed on the system are available.

Using an embedded font means text will be vectorized. Using an installed font results in editable text.

A font is available on the system, if it is in the system font folder, or activated in your font manager.
After the installation of a new font, applying the Reload fonts function (see Reload Fonts on page 233)
makes the fonts available in the application. For PS/PDF Import, after reloading fonts, the file needs to
be reselected to see the correct font information.

Keep in mind that this information is not always accurate, as the information inside the PS/PDF is not
always available, and depends on the original application.

3.12.5.  Color Settings

In the Color Settings, you can define how to handle colors and separations defined in the PS or PDF
file.

Most PS files include separation information. When selecting a PS or PDF file, ArtPro is scanning the
file header and looks if special separations (other than CMYK) are used.

The list of the custom colors can be seen by clicking the Display Custom Colors... button.

Single Separation / remove separation
In ArtPro, all functionality is built in to support multiple version or multiple language handling, the so-
called Double Burn principle.

Example:

A brochure needs to be made in two languages, English and Spanish (cmyk). Both languages are made
up separately in, for example XPress. Usually the first document is made up and the text of the second
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language is copied and pasted into it. In doing so, it is not unknown for designers to move a picture or a
logo to make it all fit. But this means that on the press, the language plate can not simply be replaced,
because these logo’s and pictures won’t fit the cmy of the first language. ArtPro simulates what is done
on the press. You can check if everything fits and if it doesn’t, corrections can be made.

Single Separation allows the import of only the specified separation out of the selected PS file, and
place it over the open file. At the same time, the original separation is made transparent with Remove
separation.

So the English version is imported and saved. Then the black of the Spanish can be imported on top of
the English. Switch both Single separation (Black) and Remove separation on and switch make new
job (Page settings) of. With this new import, the newly imported objects will be placed transparent on
top of all existing objects, and if Merge equal paths (General settings) is on, objects with equal paths
will be merged, combining the paint style of both objects.

Obviously this double burn principle can be used with other separations as well.

Force Black Overprint
If Force Black Overprint is checked, 100% black in the PS or PDF file is converted to all transparent +
100% black in the ArtPro file.

If Force Black Overprint is not checked (default), all 100% Black in the PostScript or PDF file is treated
as any other color, meaning that the result depends on the Ignore all Overprints flag.

Ignore All Overprints
If Ignore All Overprints is not checked (default), overprint in the PostScript or PDF file is converted to
transparent in the ArtPro file. If Ignore All Overprints is checked, overprint in the PostScript or PDF file
is translated to 0% in the ArtPro file. This option can be used to take out the trapping. The trapping can
be remade in ArtPro. Note that this option is not removing the transparent strokes, but only taking off
overprints.

If both Force black overprints and Ignore all overprints are switched off, the file will be unchanged and
can then still be modified afterwards.

Keep screening
This option will keep the screening definitions, if they were available in the PostScript or PDF file.
ArtPro will create a custom screening set (see Screening on page 252) in the ArtPro file. This way the
screening (ruling, angles and custom dot code) doesn’t have to be defined manually again.

This option is disregarded when importing Normalized PDF: in that case, screening is always kept.

Convert C/CV/CVC/CVU/CVP to...
All the separations in the custom color list, that only have a different extension, will automatically be
converted to the one extension defined in this menu. So if there is a Pantone 300 CVU, Pantone 300
CVC and Pantone 300 CV, they can all be converted to e.g. Pantone 300 CVC, automatically.

85



3 ArtPro

Remove unused separations
This option does the same thing as Remove Unused Separations in the Separations dialog (see
Remove Unused Separations on page 475). After import, all the inks that are not used in the file, will
automatically be removed. This function will not work with placed images, unless they are mapped
pictures. So the option Map images in the Image settings, should also be switched on. This option is
mainly used in NexusImport.

Convert CMYK to Hexachrome CMYK
If the option “Convert CMYK to Hexachrome CMYK” is set, and the Hexachrome Color Book is set in the
Color Book option, CMYK will be replaced by Hexachrome CMYK. This will allow a smoother integration
with Hexachrome compatibility

Ink Book
The Ink Book will only be used when importing Separated PostScript. In separated imports, no
separation color information is given in the file, so we then use the ink book to find a CMYK value for
those separations. This functionality remains and does not change from previous versions.

For more information on Ink Books, see Ink Books on page 478

Color Book
We have the possibility to define a color book for import. The color book for import is the same (and
uses the same UI) as the ArtPro color book. We can define custom colors in import to be converted into
the color book inks. This means e.g. convert them into hexachrome values, if a hexachrome color book
was selected. The selected Color book will be shown next to the Color book button, and a checkbox is
provided to turn it on or off.

Color List
 

 

When displaying the custom colors, the color list is shown. This color list is a list of color names and
how they should be treated: converted to CMYK, renamed, kept as spot color,...

This List can be saved and loaded. When the Colorlist is set in the Preferences, it will be loaded when
launching ArtPro. See Preferences... on page 48 Custom Color List on page 53.
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If a color is found in the list, and “cmyk” is entered in the Rename list, it will always be converted to
cmyk. If a color is found in the list, and the Convert checkbox is on, the color will be searched in the
list. If there is a separation name in the “Rename to” list, this color will be searched, otherwise the
original name is searched. If the color is found in the Color book, these values and separations will be
used. If the color is not found, it will be converted to cmyk. If a color is found in the list and the convert
checkbox is off, a separation will be generated, by the name of the Rename value, or, if this is empty,
by the original separation name. If a color is not found in the list, the setting of the “Others” checkbox
is taken into account. When switched off, a separation will be generated. If the “others” checkbox is on,
the color will be converted using the color book. If the color is not found in the color book, or no color
book is loaded, it will be converted to cmyk.

Convert all custom colors to CMYK / Others
With this option on, automatically all inks are converted back to process colors, according to the cmyk
translation from the PostScript or PDf file.

The option Others is used for separations that are in the PostScript file, but are not defined in the PS
header. This does not occur in a well constructed PostScript or PDF file, like those from standard DTP
applications. With this option, we choose to keep them as pantones (off) or convert them to CMYK as
well (on).

Color Management
You can now define different profiles for importing CMYK, RGB or grayscale files through Import PS.
Clicking the Color Management button will open the Import PS tab in the Color Management dialog. For
more information, see Color management on page 183, Import PS tab on page 184

Remark on Custom Color Conversion
Keep in mind that Color conversion will not work properly on objects with overprints and
transparencies, and therefor can generate wrong results. You should check your job carefully after
converting custom colors to cmyk.

You can also use the Color Conversion Conflict option in the Viewer dialog. See Viewer on page 504.

An example on where the result can be different :

 

 

In the original file, the pentagon is Pantone239, and overprinting to cyan.
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After conversion, the color is set to 11%C and 79%M, so the overprint is lost.

3.12.6.  Blends, Shadings and Gradations

Go to this dialog to define how gradients, blends and shadings should be handled on PS or PDF import.

Recognize gradations (PS Only)
In a PostScript file, gradations can be described by a large number of paths, or by a tiff. In most cases,
ArtPro can recognize these paths and replace them by ArtPro gradations, if the option is checked
(default).

With this option, gradations from Freehand and Illustrator are automatically converted into ArtPro
gradations or multistep gradations. Freehand and Illustrator vignettes which are not linear, are
converted into multistep vignettes with midpoints (see Multistep Gradation on page 457). Gradations
from QuarkXPress are converted into ArtPro linear or multistep gradations.

If the option is not checked, depending on how the gradation was defined in the PostScript file, it will
be imported as a series of paths, or will be converted to a TIFF image.

This option will be grayed out when a PDF file is selected, as it only works for PostScript files.

Convert Shadings into Gradations
PostScript Level 3 and PDF 1.3 and above often use the shading command to define gradations. With
this option, ArtPro will try to convert most shadings into AP gradations or Multistep gradations. If this
option is switched off, ArtPro will generate an image.

Convert blends into CT at
When blends are used in a document, they normally come in as a series of paths, with changing paint
styles. These blends are very dicult to select, modify,... Especially trapping becomes very dicult.
Therefore, usually blends are flattened into images, with one single path and one single paint style

With this option on, blends will even be converted to internal ArtPro CT’s automatically. This means the
pictures will be embedded in the ArtPro document in a ‘.ct’ file. The resolution for these images can be
set and the unit can be changed from dots per inch to dots per cm.

Resolution for shadings
This option is for shadings that cannot be converted to ArtPro gradations (e.g. mesh gradations). All
these gradations are automatically converted and extracted as a tiff image on disk. The resolution
for those tiffs can be set here. Shading conversion to images is a very time consuming calculation.
Therefor, the default resolution is set to 50dpi, but a higher resolution is recommended in some cases,
depending on the shape of the object. Check the objects carefully.

Images generated during PS/PDF import will always generate a mapped image.
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Interpolate Shadings to 300dpi
When working certified, or use Cruise Controls, it is very likely that lowres images will generate a
warning or error. This would also happen for images generated when converting a shading.

To avoid this, the Resolution for Shadings can be set to a higher resolution (300dpi), but the sampling of
shadings at a high resolution is very slow and time consuming.

The option Interpolate Shadings to 300dpi Minimum will allow to sample at a low resolution, and create
a higher resolution image from it. The lowres images will be interpolated to a resolution higher than
300dpi. The resolution will always be a multiple of the sample resolution, e.g. if the sample resolution
is 70dpi, the image after interpolation will be 70 x 5 = 350 dpi. This results in a high resolution image,
generated at higher speed.

3.12.7.  Links

In this tab we define how ArtPro should handle images used in the PS or PDF files during import.

 

 

Placing or importing
The different pictures that could be used in the original document are tiff (with or without clipping
path), dcs, jpg, pdf, eps lineart, regular eps image (with or without clipping path), eps duotone,
tritones,... , LoRes or HiRes images from OPI systems,... Most of these images can be brought into
ArtPro in different ways: Most of them can either be placed or imported. Depending on the kind of
image and the desired result, we will do one or the other.

E.g. When eps images are imported, ArtPro converts the eps into a tiff on disk and the tiff is placed
in the ArtPro file. The big advantage is that the tiff image can be mapped, which gives us benefit for
trapping, previewing, ink swapping, ink coverage,... (see Mapped Picture on page 462). Therefore in
ArtPro it is recommended to work with mapped images (tiff or jpg) all the time:
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• TIFF: A tiff image can only be placed, not imported. A placed tiff file can be mapped and trapped
automatically. -> Place

• EPS: An eps image can be placed or imported. A placed eps can not be mapped. When it is
imported, the pixels are converted to tiff data. If the image has a clipping path, it can be converted
to an ArtPro path with the image inside. -> Import

• EPS lineart: If an eps lineart file, e.g. a logo, is placed in ArtPro it can be transformed (rotated,
scaled,...) but not edited. By importing it, it’s converted to ArtPro paths and text becomes editable.
The text can be modified, the colors can be changed and most important, the logo can be trapped
properly. Another common problem with placed eps logos, which doesn’t occur when they are
imported, is that Pantone colors can not be modified or deleted in the Separations dialog. -> Import

• EPS duotones (+ monotones, tritones and quadtones): Can be placed or imported. An imported
duotone will be correctly converted to a mapped picture. The condition here is that they were
created with Adobe Photoshop 5 or later and that PS level 3 is used. Duotones from older versions
of Photoshop are extracted as cmyk images when imported, so they should be placed instead. ->
Import

• DCS: A DCS is in fact a preseparated eps. So the same rules apply. Importing will make it a tiff,
which allows us to map, preview, trap,... but a DCS cannot be imported directly (selected directly
in PS import) in ArtPro. It has to be used in a PS or PDF file. In other words, if the DCS is placed in a
(Illustrator, XPress,...) document that is saved as a PS or PDF. Also the DCS has to be a multifile (->
image.dcs, image.c, image.m, image.y, image.k, image.p300). -> Import

• OPI images (Open Prepress Interface): When OPI images are used in a document that needs to
be imported in ArtPro, the images always have to be placed. If they are imported, ArtPro creates
complete new images that will not be recognized and replaced by the OPI server, resulting in a low
resolution output. -> Place

So depending on the type of image, the operator can decide to place or import. In many cases
importing is more useful, because we simply get more functionality. However, this does not mean that
ArtPro can’t handle placed images.

Omit/Embed
There are three ways to put an image in a PS or PDf file.

‘OPI’

The image is omitted (tiff, eps, dcs,...). This means the original picture is not included in the PS file,
only the link is available. The link is a path, indicating the place where the image can be found on the
hard disk, or anywhere else in the network (e.g. on the file server). These PS/PDF files are obviously
very small. They are quick to write and copy.

In the links dialog of PS/PDF Import, they will respond to the settings under OPI. In the picture list,
under display links, these images will have ‘OPI:’ in front of the name.

‘EPS’

The image is embedded. The complete original picture as well as the link is included in the PS file.
This means in ArtPro we can choose which we will use. These are usually eps’. They will respond to the
settings under Embed. These images can be recognized in the picture list, by the ‘EPS:’ in front of the
name. Obviously these PS/PDF files will be larger than in the first case.

The image can be completely embedded without the link. This is usually with tiff images.
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Because no link or name is available, ArtPro can not display these images in the picture list. No link
settings can be defined. These images are usually extracted to tiffs on disk during import.

EskoLink

These are linked images in a Normalized PDF. These act in the same way as OPI links, but use a
different syntax.

It is recommended to use the EskoLink to import your images, as in Normalized PDF, the embedded
images only contain a lowres preview.

How to handle links on Import
1. Use Link and place all

The original file referred to by the link will be searched, and this file will be placed. The embedded
information (if present) will be ignored. The file will be searched at its original location, unless the link
is re-routed in the Display links... part of the dialog, or if rerouting is defined in the OPI settings. If the
image is not found, the embedded info is used. If it is not available, the result is an empty path.

This setting is mostly used for tiffs and jpgs, omitted from the file, lores OPI images, single file dcs or
duotones from Photoshop < version 5.

2. Use link and import EPS

The file referred to by the link will be searched, and this file will be used. The embedded information (if
present) will be ignored. If the file referred to is an EPS/DCS, it will be imported, converting lineart to
ArtPro native lineart, and extracting images to disk according to the settings in the Images settings. If
the file referred to is not an EPS or DCS (e.g. tiff), it will be placed.

The file will be searched at its original location, unless the link is re-routed in the Display links... part of
the dialog, or if re-routing is defined in the OPI settings. If the image is not found, the embedded info is
used. If it is not available, the result is an empty path.

This setting has to be used for dcs and duotones (if you want them converted to mapped tiffs). It is
also used if there is an OPI swap. In general most opi images have the same format (e.g. eps). ArtPro
is rerouted to the hires. If that hires is an eps.duotone/dcs it is imported and converted to a tiff. In all
other cases it is placed. Last this option is used for eps, either if they are omitted from the PS file, or if
they were embedded and the original has been modified since.

3. Ignore all links

The link is ignored, and only the embedded information (if present) is used. This embedded information
will be imported, converting lineart to ArtPro native lineart, and extracting images to disk according
to the settings in the Images settings. This setting is used for embedded (hires) eps and tiffs. There is
no difference in result whether you apply use link and import or Ignore all links. However, if the links
are ignored, we don’t need to worry about ArtPro finding the original on disk (is the link correct?, does it
need re-routing?,...).

When importing a PS/PDf file, 1, 2 or 3 needs to be chosen for all ‘omitted’ images (the ones in the list
with OPI in front of the name) and also for all the embedded images (EPS).

When pressing the Display links button, a list of all the images linked to this file will be shown.

Both the name and the location is shown. In the Image list, the links settings return. All images with
‘Def’ (default) tagged, will respond to the settings above. The exceptions can be tagged separately:
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• Pl: Use link and place
• Ign: Ignore link
• Imp: Use link and import

Extensions
When image file name extensions are used in the PS/PDF import dialog, they overwrite all general link
settings (not the ones from the picture list). This is mostly used for Nexus, but it could just as well be
used with ArtPro. You need to make sure all images are saved correctly with the right extension.

Re-routing
The link to an image can be changed through OPI settings (see below) or by clicking on the button with
the three dots next to the link. In this second case, a dialog box appears to select an other image. After
this, the tag next to this image needs to be put on ‘Pl’ or ‘Imp’. ‘Def’ will ignore the new link. There is no
point in changing the link just to ignore it afterwards, so ‘Ign’ is not used in this case either.

Into Opacity : B/W, Gray, 5th channel, invert
With the Into Opacity checkboxes, you can define that linked tiffs in the Postscript file should be put
into the opacity channel, and thus be made transparent. For more information, see ArtColor, internal CT
and CT files on page 37

B/W

If the B/W checkbox is on, all black&white bitmaps referred to by link, will be put into opacity with a
solid black image channel, so all black pixels will remain black, and all white pixels will be transparent.

Gray

If the Gray checkbox is on, all grayscales, referred to by link, will be put into opacity, with a solid black
image channel. The resulting CT will be black for the percentage of the grayscale, and transparent for
the remaining percentage.

5th channel / invert

If this checkbox is on, a 5 channel tiff referred to by link, will result in a four channel internal CT, and
the 5th channel will be used as opacity channel. The areas of the Photoshop alpha channel that were
100% masked, result in 100% image in ArtPro. The areas that were 0% masked, become completely
transparent. Any value in between (e.g. soft edges on the mask) result in a partial transparency (see
pictures ).

If the checkbox Invert is on, the opacity channel will be inverted, using the Invert button in the Mapped
Picture paint style. (see Mapped Picture on page 462). This way, the alpha channel can be made up in
two ways, positive or negative.

With Into opacity it is also possible to work with extensions (see above): Example : B/W is off, Gray is
on, extension = .gr

This means all B/W will not be affected, and all grayscales with an extension .gr will be put into opacity.
All other grayscales are not affected
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The images above show :

Top, from left to right : The cmyk Image in photoshop, the alpha channel, and the complete photoshop
image

Bottom, from left to right :The image as placed in InDesign, the imported job in ArtPro, and a zoom on
the soft edge.

The Alpha channel is generated in Photoshop. When the picture is placed in e.g. InDesign, it is
displaying without its mask. When the file is imported in ArtPro, the mask can automatically be
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converted to transparencies. The soft edges, as shown clearly in the last image, results in a much
smoother combination between lineart and images.

3.12.8.  OPI

Click on the OPI button to define how links, defined in the Links settings, should be re-routed.

Re-routing is used to find missing images (e.g. because the eps was created on a different computer)
or to perform OPI swaps. This means all the lores images in the make-up are replaced by their hires
equivalent, or the other way around.

This re-routing can only be done when a link is used, i.e. in the case where Use Link and place all or
Use Link and import EPS is used.

Perform OPI Swap
The checkbox Perform OPI Swap enables the re-routing defined in the OPI dialog. If the checkbox is
off, all settings underneath will be grayed out, and the file will only be searched at its original location.

Sample extension
The Sample Extension and Hires Extension can be used to replace the extension of the linked file. This
can for example be used to place image.HR instead of image.LR described in the link.

Multiple extensions can be entered, separated by a space.

If the extension of the file referred to in the link, matches an extension entered in the Sample
Extension field, the extension will be cut off, and, when present, be replaced by the extension entered
in the Hires Ext. field at the same position. Extensions that have to be cut off, should be at the end of
the list.

Example :

Sample Extension : .LR .low .LAY ( divided by a space)

Hires Extension : .HR .HIG

The result will be :

.LR will be replaced by .HR

.low will be replaced by .HIG

.LAY will be cut off

Sample folder
The Sample and Hires Folder fields works exactly the same as the Extension fields, but not only the file
extension is checked, but the complete path, including the file name. This can be used to swap from
one folder to another.

It is possible that one path is changed twice. An example :

Sample folder : LR CUSTOMER

Hires folder : HR
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This means a file with as path

HD : : JOBNR : IMAGESCUSTOMER : LR : File

will result in using the file with as path

HD : : JOBNR: IMAGES : HR : file

Root Folder
If a linked file cannot be found at its original location, or after re-routing, the file will be searched for
in the folder or volume defined as Root Folder. ArtPro will search for the file in the Root folder and all
subfolders. Obviously, first ArtPro tries to find the file on its original location.

The path for the active root folder is displayed under the Root folder button. The root folder can be
cancelled by clicking on the button again with the SHIFT key held down.

Keep in mind that the more subfolders a Root folder contains, the more time it will take to search
through all these. Setting a Hard Disk as root folder is therefor possible but not advisable.

Exclude Folders From Search
When searching through the Root Folder, folders with a name as entered in Exclude folders from
search will not be searched.

This can be used if all images can be found on the same volume, with the possibility to exclude all
folders containing lores files.

3.12.9.  Image settings

Vectorize Bitmaps : Always/Most/Never
When importing a PostScript or PDF file containing 1-bit images, this setting will define how to handle
those.

When set to Never, the 1-bit images will be placed as images. When set to Always, 1-bit images will
always be vectorized.

When set to Most, the 1-bit images containing more than 5mio pixels will be placed, images smaller
than 5mio pixels will be vectorized. This option can be used to e.g. vectorize small logos, but leave large
scans, such as copydot files, unmodified.

When vectorizing a Bitmap, the precision can be set to Exact (no reduction factor and straighten
margin is applied), Fine, Normal and Coarse. For more info on these settings, see Vectorization
Parameters on page 101 .

If a bitmap is placed as an image, the bitmap will be converted into a Mapped Tiff with image
channels and an opacity channel. The image pixels will constitute the image and the white ones will be
transparent to the background.

Both a vectorized tiff and a bitmap mapped tiff will be colored exactly like in the original document.
When importing a PDF file, the result will always be a grayscale TIFF. In most cases a vectorized bitmap
will be smaller and quicker to handle than a mapped tiff.
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Make Images Internal
On import, all TIFF and JPG pictures (placed in the Postscript or PDF file, or extracted by ArtPro) are
placed as mapped images. They can be automatically converted into Internal Images in ArtPro, by
activating the option Make Images Internal. It is only used in exceptional cases. For more information
on internal images, see ArtColor, internal CT and CT files on page 37

Extract included images
If an image has to be extracted on disk during PS/PDF import (see also Links), a file will be saved to
disk. During Import, identical images will be detected and deleted. This means that, if ArtPro extract
images from the PS or PDF file and writes them to disk, these images will be compared and if the same
image is used several times, only one of them is kept. The comparison is done after writing the tiffs,
and before making them internal (if necessary). This comparing can take some time, but results in
faster editing and smaller file sizes.

Resolution
When images are extracted during the import of a PDF or PS file, and the Detect Image Resolutions in
PostScript / PDF Import option is on in the preferences, ArtPro will check the internal resolution of the
image.

If this resolution is an integer (e.g. 360 dpi), the image saved will use this resolution, and will be placed
in the ArtPro file at 100% scaling. If the resolution is not an integer (e.g. 243,6 dpi), or if the Detect
Image Resolutions in PostScript / PDF Import option is off, the resolution as defined in the Import PS/
PDF dialog will be used, and the scaling will be adjusted (in this case, the 300 dpi image will be placed at
a scaling of 123.56 %).

See also Preferences... on page 48 Detect Image Resolutions in PostScript / PDF Import on page 56

Compression & File Type
It is also possible to define the file type of the images that are extracted: Tiff (no compression), High
Quality JPEG, Medium Quality JPEG and High Compression JPEG.

Use original name
When an image is extracted from a file of which the original file name is known, switching this option
on will save the extracted file with the same name as the original name. If this option is off, or the
original name is not known, the name will be prompted, but default it will be the name of the postscript
file followed by underscore and a number.

Use Photoshop clipping path
If a PS file is imported, in which Photoshop Tiff files are placed, containing a clipping path, this clipping
path can be converted to ArtPro line art, with the Tiff file placed inside it’s path. Unlike the Use external
clipping path option in Preferences (see Use external clipping path for placed pictures on page 55), this
option only affects Tiff files. Clipping paths on eps images are always used. Another difference is that
during Import PS, all paths are imported as straight line vectors, while when using the Use external
clipping path option when placing a picture, the curves are kept as curves.
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Recognize Tiff Channels
When OPI linked pictures have to be placed, ArtPro will try to recognize any spot colors when placing a
Tiff file, and if the Recognize Tiff Channels is switched on.

A Tiff file can contain channels indicating masked areas (type1), channels indicating selected areas
(type2) and channels indicating spot colors (type3).

Channels of type 1 and 2 are treated as alpha channels, thus put into the opacity channel. If the Tiff
contains more than one alpha channel, only the first is used, and all others are ignored, though the
separation are generated based on the channel names present in the Tiff. These separations have
CMYK value 0, 0, 0, 100, and only reflect the number of channels in the Tiff.

If spot color channels are found, a separation will be created with the same name as the Tiff file
channel.

The color definition (CMYK representation) for this spot color will first be searched in the ink book.
If not found there, or if no ink book is loaded, ArtPro will extract the color information from the Tiff
file. Since this color definition is normally given in RGB or HSB, conversion to cmyk will usually yield a
deviation from what is expected. Therefor, a warning is issued to urge the user to correct this error.

If ArtPro encounters an unknown color space, a new separation will be created with the channel name,
and with cmyk representation 0, 0, 0, 100. If a tiff contains no extra channels, the file will be placed
unmapped. If the Tiff contains at least one spot color, the file will be placed as a mapped picture. If the
Tiff contains an alpha channel, the file will be imported as a Internal image.

3.12.10.  General Settings

Clip Text
Text that was clipped in another application will be clipped in ArtPro as well after Import PostScript/
PDF. In order to make this possible, though, clipped text is vectorized in ArtPro and thus no longer
available as real text. Normal text (not clipped) is not affected by this option, which is default on.

Merge Equal Paths
If Merge equal paths is not checked, all paths are converted to ArtPro in the normal way. With the
option on, two or more identical paths on top of each other are merged into one single path with the
combined color information. This option is switched on automatically for separated files (See Page
Settings on page 81).

Merge equal layers
If the option Merge Equal Layers is on, and ArtPro finds multiple layers with the same name, those
layers will be merged into one (e.g. An eps with a ‘Dielines’ layer is imported on an ArtPro template with
‘Dielines’ in it). It is possible in ArtPro to have several layers with the same name (See Layers... on page
434).
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Ignore Page commands
In a normal PostScript file, the document size is defined at two places: the bounding box, in the header
of the file, and page commands, later in the PostScript. In most cases, the Page Commands are more
exact than the bounding box. For files coming from certain versions of Esko systems, the Page Com-
mands are rounded off, while the bounding box is exact. In those cases, you can choose to Ignore Page
commands, and use the PS bounding box instead.

Keep Strokes
If the option Keep Strokes is checked, all strokes found in the PostScript or PDF file will be imported as
ArtPro Strokes. If the option is unchecked, the strokes will be converted to regular ArtPro paths. See
also Stroke... on page 491.

Autostroke CAD lines in ARD files
If you enable the Autostroke CAD lines in ARD files option while importing a normalized PDF
containing a link to an ARD file, every CAD line will automatically get a stroke.

See Autostroke CAD lines in ARD files on page 111 for more information on Autostroke.

Memory
This parameter indicates how much temporary memory is allocated to the PS/PDF Import function, in
order to store its variables, key words, dictionaries, etc. Generally, 15000 kB (default) is sucient to
perform the function. When the error message Out of PS memory or Virtual Memory Error appears,
however, the value should be increased.

3.12.11.  Certified

The Certified section can be used when working in Certified mode. See Certified ArtPro on page 65.

The Certified tab in the Import PS/PDF dialog, contains some settings on input, and the browse button
to select the input profile to be used. To clear the input profile, you can shift-click the browse button.

Importing files other than PDF
When importing any other file type than PDF, the Sessions log will indicate that no input profile was
applied, and the session will begin AFTER the import.

Importing non-Certified PDF
When importing a non-Certified PDF file, and Certified Import is enabled, ArtPro will Certify the PDF
file and import the Certified PDF instead of the original. Unless “Overwrite input file on re-preflight” is
on, a new, certified PDF will be saved, and this certified PDF will be imported. This will be saved as a
separate session.

If you click “Cancel” in the dialog to define name and location of the Certified PDF file, the uncertified
PDF is imported anyhow, and the session will start AFTER the import.
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Importing Certified PDF

Re-Preflight if profile does not match : ON

If the profiles are not identical, the option “Re-preflight if profiles do not match” will be consulted. If the
option is on, the job will be re-preflighted if the input profile and the embedded profile don’t match. If
they match, the session log will indicate both profiles are identical.

When comparing 2 profiles, their content is checked, and not just the name.

Re-Preflight if profile does not match : OFF

If the option “Re-preflight....” is off, the Certified PDF will be imported without re-preflighting it. The
Session window will indicate the profile it was originally certified by.

Re-preflight

When Re-preflighting, ArtPro will create a new session, preflight the file and close the session. ArtPro
will prompt for the filename for the new Certified PDF file. An additional session will start in ArtPro.

Overwrite Input File

If the “Overwrite Input file on Re-preflight” option is on, there will be no new PDF file created by ArtPro.
Instead, ArtPro will replace the original PDF file.

Get all bounding boxes for preflight report

This option forces ArtPro to obtain bounding boxes for the last preflight report. If activated, ArtPro will
get full information for every report item along with bounding box of the area where the error/warning
occurred. This will cause an additional preflight of the input document and consume additional time.
You will then be able to double click entries in the Certified Report or in the Cruise Report.

3.13.  Import > Vectorize ...

Vectorization is used to convert images into lineart. When a TIFF file is imported, it is directly
converted into the internal ArtPro format which is a vector format. The TIFF files can be any TIFF
format (B/W, Gray, CMYK, RGB,...) ArtPro supports files compressed by CCITT (on bitmap TIFFs), LZW
and PackBits.

During vectorization of the TIFF file, the cursor changes into a rotating ArtPro icon. All imported
objects will be colored white initially, so when the preview is on (Cmd-Y), the picture seems to
disappear. Use paint style to restore the original colors (see Deselect Even Areas on page 251).
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The quality of vectorization is dependent on the quality and resolution of the original scan. Therefore,
to get a good quality scan, make sure to scan at a high resolution (1200-2400dpi for bitmap linework).
You can abort the vectorization by typing command-period (Cmd-.)

3.13.1.  Import tiff...

By choosing Import TIFF... a dialog box appears to select the TIFF file you want to vectorize. The
picture is imported immediately after clicking OK, so first the settings have to be defined, then the
image is selected. A picture can also be vectorized by dragging a tiff file on the vectorization window
from the finder.

3.13.2.  Make new job

If there is no file open at the time, ArtPro will open a file with the same size as the TIFF and vectorize
it within that file. If an ArtPro file is open and the option Make New Job is not checked, ArtPro will
vectorize to the bottom right of the ruler. So you can position the ruler before importing the tiff file.
When the option is activated (default), a new job is created for any vectorization.

When the toggle is switched off, the file is vectorized in the current job. This option goes along with the
Import Opens New Job toggle in the Preferences dialog (Preferences... on page 48 - General: Import on
page 52).

3.13.3.  Grayscale Threshold

In order to vectorize non black-and-white TIFFs, the colors are first converted to grayscales. The
threshold determines which values of the grayscale will be converted to black or white. The default
value for the threshold is 50%.

Gray values darker than the threshold value will be considered as image and values lighter than the
threshold value will not be considered as image. So if the threshold is higher, more gray areas will be-
come white. You will notice that in this case, the higher the threshold, the more white the image will be.

Original image:

 

 

Threshold 55%:

 

 

Threshold 25%: Threshold 75%:
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3.13.4.  Import HandShake LW...

By importing a Scitex HandShake LineWork file, the Handshake format is converted to internal ArtPro
vectors. By choosing Import HandShake LW..., a dialog box appears to select the Handshake LW file.
One color is imported at a time. ArtPro only supports the old LW format, not the new.

3.13.5.  HandShake LW Color:

By default ArtPro vectorizes color number 2 of the Scitex LW file. In a black and white job, black is color
number 2. To import other colors, this value will have to be changed each time.

3.13.6.  Vectorization Parameters

The Vectorization is controlled by three parameters:

Precision: fine / normal / coarse
For the three parameters, there are three standard sets of values: fine, normal and coarse. You can
choose a standard in the Precision field. Fine is the smallest filter: the resulting vectors will be very
close to the original paths. Fine can be used to import scanned originals with a lot of details or with
parts of fine text on them. Normal and coarse have each time higher values which result in larger
filters. The choice between these three sets of filters depends totally on the quality of the scanned
original (TIFF-file) and the desired result. You need to look for the best compromise between all values
and parameters.

Reduction Factor:
The Reduction Factor makes the paths smoother. Higher values filter out more sharp edges and noise
resulting in smoother curves. Very large values may result in too few points to form a smooth output. To
prevent this, smoothen several times with a smaller value. Reduction Factor 0 turns filtering off, only
straightening is done.
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Straighten Margin:
 

 

Straighten Margin reduces the noise on the paths by replacing them with straighter parts. It specifies
the maximum deviation allowed between the output path and the filtered points. A larger value results
in fewer points and therefore speeds up all subsequent operations.

Straighten Margin 0 turns all straightening off, only filtering is done. This produces the smoothest
paths. When both straighten margin and reduction factor are 0, every single pixel of the original picture
is vectorized. For B/W images, this means there is no loss of quality at all, but the paths will contain a
lot of anchorpoints.

The example above shows the result with 1. Precision :Fine, 2. with a High reduction and straighten
margin set to 0, and 3. with reduction factor set to 0 and a high straighten margin.
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Dirt Margin:
Default value = 2 scan pixels

This function is used to eliminate scanned dirt. A Dirt Margin of 2 scan pixels means that all black
or white areas on the original smaller than 2 by 2 scan pixels will be filtered away by vectorization.
Obviously the dirt can also be removed after vectorization, using the Select dirt function (see further).
This way of working is safer, as the operator has more visual control on the result.

3.13.7.  Smoothen Paths

When you import a TIFF or a Handshake LW file, the values in the vectorization parameters are
calculated for the complete file.

After vectorization, it is still possible to modify parts of the file by selecting those parts and choosing
the Smoothen Paths function. Smoothen Paths applies the Reduction Factor and the Straighten
Margin value on the selected paths.Smoothen Paths is controlled by the same parameters as
vectorization: Scan Resolution, Reduction Factor and Straighten Margin.

Each time you apply Smoothen Paths, the values are calculated on the selected path, which makes it
possible to smoothen several times with the same value. Clicking on Smoothen Paths too many times
will result in loss of detail.

3.13.8.  Scan Resolution

Scan Resolution reflects the original scan resolution of the imported TIFF or Scitex Handshake LW file.
The straighten margin and dirt margin are resolution dependent and may be adapted slightly during
import.

This field only has an informative function. Changing this field has no effect on the vectorization result.

3.13.9.  Select Dirt

Select Dirt allows to clear out scanned dirt that was not eliminated by the Dirt Margin. When choosing
the Select Dirt function, the cursor changes to a small cross, by which you can define the largest area
to be filtered away, by dragging a rectangle in the window. All paths in the job smaller than this area
will be selected. Once selected, these areas can be deleted by using the Delete button or the Clear
function.

Practically, this means that the rectangle should always be made smaller than the smallest detail to be
kept on the original. (In many cases, the smallest detail is the dot on the i in text). All paths smaller than
the rectangle will then be selected. After checking these selections, the selected areas can be deleted.

Once the Select Dirt function is active, it stays active until another tool is activated. So every time a
rectangle is drawn, all elements smaller than the rectangle will be selected.
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3.14.  Import... Illustrator 3.0

Import Illustrator 3.0 File... converts an Illustrator 3.0 file into paths (vectors and splines) editable by
ArtPro.

By clicking Import Illustrator, a dialog will appear, so you can select the Illustrator file you want to
import. If there is no file open, or if the setting Import opens new job (See Preferences... on page 48
Open new job on page 52) is on, the file will be imported in a new Job. Otherwise, it will be imported in
the active Job window, with its origin in the center of the ruler. For most Illustrator files, this means
they will be placed in the upper right quadrant of the ruler. Today, Import Illustrator 3.0 is only useful to
import a separate clipping path from Photoshop (in Photoshop: File - Export - Paths to Illustrator).

3.15.  Import... Picture List

With Import Picture List... it is possible to import an ASCII text file containing information on name,
position and size of the bounding box of placed pictures.

These Picture List files can be created in ArtPro, using the Export Picture List function (see Export
Picture List  on page 124) or from any other application, if the ASCII text file has a construction as
shown in the example below.

ArtPro Picture File V1.0
units mm
size 1005.72 826.63
Bambolina1 -1.99 -1.99 142.4 126.99 0 60 30 trim box
Bambolina1 -1.99 125 142.4 125 0 60 30 trim box
Bambolina1 -1.99 250 142.4 125 0 60 30 trim box
Bambolina1 -1.99 375 142.4 125 0 60 30 trim box
Bambolina1 -1.99 500 142.4 125 0 48 20 trim box
Bambolina1 -1.99 625 142.4 126.99 0 60 30 trim box
Bambolina1 140.41 -1.99 140.41 126.99 0 60 30 trim box
Bambolina1 140.41 125 140.41 125 0 60 30 trim box
Bambolina1 140.41 250 140.41 125 0 60 30 trim box
Bambolina1 140.41 375 140.41 125 0 48 20 trim box
Bambolina1 140.41 500 140.41 125 0 60 30 trim box
Bambolina1 140.41 625 140.41 126.99 0 60 30 trim box
Bambolina1 280.83 -1.99 142.4 126.99 0 60 30 trim box
Bambolina1 280.83 125 142.4 125 0 48 20 trim box
Flatten 421.23 0 292.24 413.32 0 60 30 trim box
Flatten 421.23 413.32 292.24 413.32 0 60 30 trim box
Flatten 713.47 0 292.24 413.32 0 60 30 trim box

3.15.1.  Construction of a Picture List File

• ArtPro Picture File V1.0
• Units; this can be mm or inch
• Size; the job size, in the unit set above.
• Filename; when importing a picture list, ArtPro will place the pictures described in the Picture List

file, if the files are in the same folder as the picture list. If not, ArtPro will prompt for the specific
file. If the file is found in the folder or a file has been selected by the user, the picture will be applied
on the path, placing its center on the center of the bounding box.
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• Position of the bounding box; the position of the top left corner of the bounding box is defined.
The first value is the vertical distance from the top left corner of the job size, the second is the
horizontal distance.

• Size of the bounding box; the next two values define the vertical and horizontal size of the bounding
box.

• Rotation; the rotation can be 0, 90, 180 or -90 degrees.
• picture center offset, defining where to center the image, based on the topleft corner of the

bounding box. If no picture center offset is entered, the picture is centered on the bounding box
• Page box to be used. If no page box is defined, the trim box is used.

3.16.  Import HPGL...

With Import HPGL... it is possible to import HPGL plotter files (Hewlett Packard Graphics Language).

3.16.1.  How to import a HPGL file:

• After choosing Import HPGL... in the File menu, a dialog box will appear to select the HPGL file you
want to import. If there is no file open, or if the setting Import opens new job (See Preferences... on
page 48 Open new job on page 52) is on, the file will be imported in a new Job, in a layer named HPGL.
Otherwise, it will be imported in the active Job, in the current layer, with its origin in the center of the
ruler. For most HPGL files, this means they will be placed in the lower right quadrant of the ruler.

• ArtPro imports the paths from the HPGL file.

All HPGL path information is translated into ArtPro paths, which can be vectors or splines.

• HPGL data consists out of open paths.

• Arcs will be converted to splines.

• The HPGL paths can have different line types (different pens). ArtPro applies a different paint to these
paths so that a Select by Paint is possible, for instance to delete all measurement lines. The paint
applied to these paths is a screen (%) of the first used separation in the ArtPro file.

Once imported:
Imported HPGL can be treated in the same way as imported CAD files (see Structural Design on page
108)

3.17.  Import marks...

Import marks allows you to create personalized marks. The idea is to create one ArtPro file of the
marks you need. When importing this job with Import marks, the marks will automatically position and
the inks are adapted to any ArtPro file.

• Create and save an ArtPro file (e.g. 1 m x 1 m) with all the necessary marks at the correct distances
from the job borders.
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• With Import marks... this job can be inserted and will be stretched to fit on the current ArtPro job,
keeping the marks at the same distance from the borders.

3.17.1.  How to build a regmark file:

• A regmark file is a normal ArtPro job.

• The job is divided into 3 parts in the vertical and horizontal direction. It is cut on 1/4 and 3/4 of the job
size. (figure below)

• The position of any path or object in the mark file is determined by its distance to the jobsize corners
and the center.

 

 

• When importing this file as a mark, the job is stretched to fit the jobsize of the active ArtPro file.
Actually ArtPro cuts the job on 1/4 and 3/4 of the size, the 4 corner parts are positioned on the new
corners, the 5 center parts are positioned on the new centers.
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Figure 2:

 

 

The new job size is bigger than the marks files jobsize.

The gaps in between the corner parts and the center parts are filled with space, or by straight joins of
the cut path.

Figure 3:

 

 

Demonstrates of what could happen when the new jobsize is smaller than the regmark file, graphics
could overlap.

Sometimes it is important how big the jobsize of the regmark file is, just to make sure that a particular
item is never stretched.
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The maximum size of an ArtPro file is 16 x 16 m.

Remark:

If you want marks that change in one direction but not in the other, make the jobsize in the fixed
direction bigger than 4 times the wanted dimension.

Colors and Separations
If the marks file contains no separations, all paths will have registration color (all 100% of all
separations in the active job) after Import marks.

Separations used in the marks file will NEVER be added to the active job. In fact, it doesn’t matter at
all what separations are used in the marks file, as the colors will be adapted to the separations of the
active job. E.g. a path with 100% of the first separation of the marks file, will have 100% of the first
separation of the active job.

If the marks file contains more separations than the active job, the extra separation will be ignored.
This means paths that are 100% of the extra separation, will be empty (0%).

If the marks file contains fewer separations than the active job, only the paths with registration color
will use the extra separations of the active job.

3.18.  Import PS marks

This function works in the same way as Import marks, only it uses PS files instead of ArtPro files.

3.19.  Structural Design

3.19.1.  Import file...

With Structural Design > Import file. it is possible to import structural design files in the Common File
Format 2 (CFF2), in DDES2 format, in VLM format, in ArtiosCAD format (ARD and MFG) or BAG files, and
in Collada (.zae and .dae) format. For ArtiosCAD files (both for ARD as for MFG), you can choose to keep
the CAD layers (and editability) instead of analyzing the CAD information, and you have the option to
only import the real CAD data info, without the Bleed, Dimentions, ... by selecting “Only CAD Data”.

Analyze CAD files

How to import a CAD file:

• After choosing Structural Design > Import File... in the File menu, a dialog box will appear to select
the CAD file you want to import. If there is no file open, or if the setting Import opens new job (See
also Preferences... on page 48) is on, the file will be imported in a new Job. Otherwise, it will be
imported in the active Job, with its origin in the center of the ruler. For most CAD files, this means
they will be placed in the lower right quadrant of the ruler.
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• The Cad file will be imported in a layer named “Repetition”.

• ArtPro imports the paths as well as the text in the CAD file.
• All paths will be grouped.
• All CAD path information is translated into ArtPro paths, which can be vectors or splines:
• CAD data consists of open paths.
• Arcs will be converted to splines.
• The CAD paths can have different line types (e.g. cut, crease, etc.). ArtPro applies a different paint

to these paths so that a Select By Paint is possible, for instance to delete all measurement lines.
The paint applied to these paths is a screen (%) of the first used separation in the ArtPro file.
Included text is converted to ArtPro text.

• In CAD format, the text is monospaced. This means that all characters have the same width. The
text is converted to the Helvetica font. As Helvetica is not monospaced, the width for the converted
text will not be the same as the original text. (Text which was positioned in the center might not
appear in the center anymore).

• The vertical size of the font in CAD files is defined by its capital height. In PostScript the character
height is defined with the white space above and underneath the capital. As all fonts have differ-
ent capital heights according to their Pointsizes, ArtPro estimates the pointsize of the imported
characters, so it might not completely match.
 

 

Once imported:

The CAD paths react to the ArtPro functions like normal ArtPro paths. You might want to put them in a
separate layer, or you could make them magnetic.

You can join the open paths with the Join command (Cmd-J. see Join Paths on page 213). Complex
CAD files might exceed the number of points which can be joined. You can also Stroke the open paths
to give your die a line width. Still all open paths will be stroked separately.

More handy is making a compound of the CAD file first before making a Stroke. By making the paths to
a compound, the Stroke will automatically join the overlapping areas.

Stroke with a Round or Square cap which makes the corners completely close up. (see picture above)

For more info, see Stroke... on page 491, and Compound on page 219.

Reconstruct Common Cutting Lines
When creating a Structural Design file, you have the option to remove "Common Cutting Lines".
Common cutting lines can occur in e.g. a step and repeat, where the cutting lines of two one-ups fall on
top of each other.

In the example underneath, the common cutting lines are shown in the image on the left in red.
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If you would analyse a Structural Design file with these common lines removed, you could end up with
open paths (shown in blue in the image on the right).

By enabling the option Reconstruct Common Cutting Lines, ArtPro will fix this, and generate correctly
closed paths.

Keep CAD Layers
You can import the CAD information without analyzing and converting it, by using the Keep CAD Layers
option.

By using this option, all information from the CAD file is kept, and direct export to Visualiser is also
possible. ArtiosCAD information can be checked and edited as well. For more info, see Structural
Design... on page 495.

The CAD file is imported as a single layer, with the same name as the CAD file. All (not empty) layers in
the original ARD / MFG file are imported as groups in that layer.

Important:  It is advised not to create regular objects inside the CAD Layers, or to move
Structural Design objects out of the CAD layer. If you do a refresh (Window > Structural Design
> Refresh Link) or when you export Normalized PDF, these objects will be removed.

Only CAD Data
For ArtiosCAD files and for BAG files from Studio Toolkit For Flexibles, you can choose to import only
the actual CAD data, by selecting “Only CAD Data”.

By using this option, all other information such as Bleed, Dimensions are not imported, i.e. only Cut and
Crease lines are imported. For more info, see Structural Design... on page 495.

Only Stations
You can choose to import only the Stations of a manufacturing file, by selecting “Only Stations”.

By using this option, all other layers will not be imported.
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Autostroke CAD lines in ARD files
If you enable the Autostroke CAD lines in ARD files option while importing an ARD file, every CAD line
will automatically get a stroke.

The stroke will be 0.5mm wide, and will be colored in 100% of a technical ink with the same name as the
CAD line type (e.g. "Artios Cut") and overprinting to all other separations.

 

 

The strokes are in the Structural Design layer, but are regular objects: they can be edited in any way.
However, when the Structural Design file is reloaded, all strokes will be re-calculated, so all changes
will be undone.

You can reload the Structural Design file, or add autostrokes to an already imported ARD file by using
Refresh Link in the Structural Design window. See  Refresh Link on page 496

3.19.2.  Export...

Using the Export function, you can export the Structural Design layers to an ArtiosCAD ARD file. This
information can be imported from an ARD file (see Import file... on page 108), and changed in ArtPro,
or created by applying CAD line definitions to objects, using the CAD dialog (see Structural Design... on
page 495).

3.20.  Export PDF

The Export PDF dialog is built based on a number of settings or Flavours: “For Press”, “Normalized
PDF”, “Normalized PDF (Embedded)”, “Separated PDF”, “For Viewing”, “JDF” and “Custom”. The settings
for each of these flavours can be changed and saved to the user preferences (see Save / Load tab on
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page 122). Next to the flavour, an indication to the compliancy is given: this shows that, based on the
settings, the file will be pdf 1.3, 1.4, 1.5 or JDF compliant.

3.20.1.  Normalized PDF

With the Normalized PDF flavour you can output PDF files that can be opened and edited in PackEdge,
Automation Engine, etc.

Normalized PDF (Embedded) generates PDF files that can be sent to FlexRip. These files contain all
images embedded in the file.

As from ArtPro 9.5, a Normalized PDF will contain Station number info (see Job Info on page 169), and
Technical inks will be output (whereas other PDF flavours do not output Technical inks).

Please note that for example in PackEdge, objects with a Technical ink at a certain percentage (other
than 100%), are NOT supported and will result in a warning.

Station Number location can be used in Plato in combination with the smartmark - cell numbering
option.

Normalized PDF Options
When using Normalized PDF as flavour, some specific functions will be used, and some general options
will be changed.

Add All Page Boxes
By default, when exporting Normalized PDF, only the Trim box and Media box are included. By enabling
this option, also the Art Box, Crop Box and Bleed Box will be included.

Add Notes

The factory default for “Add Notes” has been changed to enabled. This means that if you start from a
clean install, or if you use Reset Currents to Defaults, Add Notes will be enabled by default. Note that
after “Reset Currents to Default”, you need to use “Save All to User Preferences” to store the settings.

Generate Normalized PDF

With this option in the General tab, the PDF file structure will be Normalized PDF, and XMP information
will be included in the PDF file.

Add Esko Preview

With this option in the General tab, the PDF file will contain a separated preview, that can be used in
e.g. PackEdge.

Screening Registration

The Screening Registration option allows to control the screen registration of the one ups to be used
in a Step and Repeat file in FlexRip.

When set to “Continuous”, the screening will be calculated over the full S&R. When set to “reset for
each external file”, the screening origin will be reset for every placed one up. This can be used if for
example you would like to have exactly the same screening rosettes in all placed one-ups.

Images

For Normalized PDF, Images will be included as Esko links, and also embedded at low resolution. This
means image downsampling is set at 96 dpi, the Link option is set to “Esko” and the “Embed Images”
option is on.
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For Normalized PDF (Embedded), no links are added, and all images are embedded at full resolution,
resulting in a “fat” Normalized PDF.

Normalized PDF Restrictions
• Screenings

If no screening is defined on all or some objects, a default screening will be applied to these
objects. The defaults are:

• ruling: 120
• dotshape: simpledot (round)
• angles C: 15, M:75, Y:0,B:45 any other : 45

• Pantone inks not in Esko color books:

These inks will be saved as unregistered inks.

Inks found in Esko ink books, will get the correct ink book reference.

Ink type is kept (opaque, varnish, normal, technical inks). Note that technical inks can have a
different behaviour in a PackEdge or an Automation Engine environment.

• Placed or repeated Files

Placed PDF files need to be Normalized PDFs in order to be able to export the ArtPro file to
Normalized PDF.

Placed or repeated files (ArtPro, normalized PDF) will be expanded in PackEdge.
• Bar code information

Some barcode info is added in the file, that Automation Engine can read. The barcode can however
not be edited in other Esko application.

• No font file information
• Text

All text is saved and the font is subsetted and embedded. This will result in real text in Esko
Software.

However, 2-byte fonts are always vectorized when exported to any PDF flavour in ArtPro.
• Images

Images will keep their links if possible (most TIFF, JPEG and PSD files). This is also the case for
mapped images.

Some image formats such as DCS images, PSD with multiple alpha channels, TIFFs with extra
channels (often generated by ArtPro PS/PDF import) are not supported or incompatible with the
Esko Software. These images will be embedded or will be generating a .ct fle on Esko software -
depending on the settings.

Note:  The "Copy links next to output" has to be enabled if you want to make sure that, when
you launch the file to a workflow as Normalized PDF, all links - not only to images, but also to
structural design files - are kept.

• RGB Images

The Normalized PDF Export will be aborted if the file contains placed RGB images. An error
message will be shown in the messages window. RGB images that are mapped will be embedded.

• Dot Gain Compensation

The Normalized PDF Export will NOT include Dot Gain Compensation curves. Neither when added to
the Export PDF dialog as XML file, neither when defined in the Screening.

If you want to send files with a DGC curves to e.g. a FlexRip anyhow, there are two possible
solutions:
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• Print to PostScript (including the DGC curve) and send it to FlexRip
• Export PDF “For Press” (including the DGC curve) and send this to FlexRip.

3.20.2.  Separated PDF

This allows to generate separated PDF.

There is one specific option for Separated PDF: Add Composite on Page 1. See General tab on page
114

The Optimize White Objects option is not only usable for Separated PDF, however it will be most useful
when applied on Separated PDF. See Optimize tab on page 116

Note:  Exporting a Separated PDF is not supported if the ArtPro file contains placed PDF or
PostScript files.

3.20.3.  General tab

Add All Page Boxes
By default, when exporting Normalized PDF, only the Trim box and Media box are included. By enabling
this option, also the Art Box, Crop Box and Bleed Box will be included.

Add Notes

With this option on, all ArtPro notes (see file menu) are included in the PDF file and will appear in
Acrobat or the Reader as normal, editable PDF notes.

Add Non Printing Layers

If switched on, layers set to non printing, are exported into the PDF file. With this option off, these
layers are not output, so the PDF file contains only layers with the Print option on.

Keep PDF 1.5 Layer Properties

PDF 1.5 allows the use of layers. If the option is switched on, the ArtPro layers will be put in the PDF
file as 1.5 layers. The compliancy will be set to PDF 1.5. This will allow you to switch layers on/off in
Acrobat. If the option is off, no layer structure is saved in the PDF file, but all objects will be included.

Output Fully Transparent Objects

If the option Output Fully Transparent Objects is off, objects that are completely transparent will not
be included in the PDF file. If it is switched on, these objects will also be in the PDF file. This can be
useful when using the Male / Female function. See Create Die: Male / Female on page 309.

By default, the setting is off.

Orientation

The Orientation can be set to portrait, turn right, turn left or upside down. It defines the direction in
which the file is put on film or on paper. Portrait will output the file in the upright position, turn right
will rotate the file 90° and turn left will rotate it -90°.

Mirror

114



3ArtPro

By activating Mirror, the job will be mirrored before exporting, resulting in a wrong-reading output.

Distortion

Distortion is defined as a percentage of the jobs original dimensions. This distortion is specifically
important for flexo jobs. On mounting a flexo plate on the press, it is stretched out in one direction.
By making the output slightly smaller than needed, we compensate for this distortion. The original
dimensions of the ArtPro file remain unchanged.

Positive values make the job bigger and negative values make the job smaller. E.g. Vert. distortion =
-2.35% will make the output 97.65%. In this way you can also scale the output: e.g. entering -50% for
both Vertical and Horizontal Distortion will output the job at half of its original size.

Note:  For Normalized PDF, the distortion information is stored in the XMP data, and will only
be applied on the RIP. For other PDF flavors, distortion is applied in the PDF immediately.

Add Thumbnail

With this option on, a thumbnail will be created of the file, a small preview, that can be shown in
thumbnails in Acrobat. With this option off, the thumbnail in Acrobat will be gray. A thumbnail preview
is based on the Media Box of the file. For JDF Output, the setting is used for all PDF files created.

Add Standard Preview

Preview can be defined by resolution (default 72 dpi) or by max size (in kb). This can be useful when
creating a pdf of a large size S&R, of which the preview at 72 dpi would be several Mb.

A standard preview is (unlike thumbnail and separated preview) based on the Artbox of the file, in
order to be compatible with other applications. This implies that the Standard Preview will not show
any bleed. For JDF Output, the setting is used for all PDF files created.

Add Separated Preview

It is now possible to save a separated 72dpi preview in the PDF file. This non-standard preview can
only be used by other Esko software, such as ArtPro S&R, Mnemo, ...

A separated preview is based on the Media Box of the file. For JDF Output, the setting is used for all
PDF files created.

Include XML Tickets

This option allows to include an XML ticket into the PDF file, which then can be used when importing
the PDF file in Nexus. The XML file contains options and settings on how the file should be processed
in Nexus. For more info : see the Nexus 8.0 documentation.

The browse button allows to select the XML folder. The location of this folder is saved in the
Preferences, and is independent of the flavour. The drop down will show all XML files in the selected
folder, and allows to choose a specific XML file.

Separated PDF

Allows to output Separated PDF.

Add Composite on Page 1

If this option is used, the Composite PDF is added as first page of the separated PDF.

Marks
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This will open the Marks dialog, also available from the Prepress menu. See Marks on page 406.

3.20.4.  Optimize tab

Use Picture Caching

Picture Caching makes the output faster by keeping all images that are put in the PDF file in the RAM,
until the complete file is written. This keeps ArtPro from having to read an image multiple times from
the hard disk, if it is used multiple times in the file. The condition is that you have enough RAM on your
machine. This is very useful if images are stored on a remote file server

Output Gradients as Images

If this option is switched on, all gradients will be converted to images instead of including them in the
PDF file as PDF Shadings.

Compress Page Description

When this settings is switched on, the PDF file will be compressed. This option is switched on by
default.

Optimize White Objects

When this settings is switched on, all white objects that do not influence the final result, will be
removed. This option is mostly usefull when outputting Separated PDF, however it can also be used for
composite PDF files, especially if certain separations are disabled for output. See Color tab on page
117.

Include Screening

If the option Include Screening is on, PostScript screening and Nexus Extended Screening info will be
saved in the PDF file. If other screening is found (Nexus screening) a warning will be generated. This
screening info can be used by the PDF RIP functionality in Nexus (using “Full control in PDF”) or in Esko
back-end systems (Include Screening is always enabled for Normalized PDF).

Generate JDF Output

JDF Output is an optimization system for outputting S&R of PDF files. When outputting a Step &
Repeat to JDF, multiple files will be generated.

First of all, the one up file(s) will be exported to pdf file(s). If the One up already was pdf, the file will be
just be copied, unless the checkbox “Copy File” is off. Second, one or more PDF files will be generated
containing all elements that are on the Repetition : registration marks, test strips, extra info, etc.
Items that are grouped, will be in the same file. Third, a JDF file is created, containing the positioning
of all these PDF files.

Copy PDF

If the Copy PDF option is on, the original PDF files in the S&R will be copied to the output folder of the
JDF Output. If the option is off, these single PDF files will not be copied, and the JDF will contain a link
to their original location.

Collect

If the Collect function is on, all PDF files containing registration marks, test strips, etc., will be
collected in the JDF output folder.
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Target Size

If a Target Size is entered, and the resulting PDF is more than 20% larger than the target size, this
error message is shown in the Messages window: “The size of the exported PDF is [actual size] while
the target size was [target size]. Lowering the target size still might help reducing the PDF's size. “

If a target size is entered, ArtPro will estimate the size of the PDF, and if necessary, change the
settings (e.g. compression & downsampling) to get an estimated file size smaller than the target size.
However, as an estimate is not precise, it is possible that the resulting size is significantly bigger
than the target size. In that case, entering a smaller “target size” will inflict even further action (e.g.
compression, downsampling), so it will result in a smaller file size (and, in this case, closer to the
original “target” size).

Estimated Size

The Estimated Size gives a rough idea of the size of the PDF file. This can be pretty inaccurate, as it is
very dicult to predict what size images will have after compressing.

Split Long Paths

Just like PS output, paths with many anchor points can be split up an parts. The more parts that need
to be exported, the longer it will take. The default settings is 1500 points. See also More Settings:
Optimize on page 150.

3.20.5.  Text tab

Vectorize text

Before exporting, ArtPro will convert all text to paths to avoid font problems at a later stage. When this
option is switched off, the text will be in the PDF file as real text. If text is not set to be vectorized, it
will always be embedded.

Japanese 2-byte characters are always vectorized.

Subset Embedded fonts ...

Subset Fonts defines wether fonts should be embedded as subset if only a part of the characters are
used. How much of the font characters should be used before the font is embedded completely, can be
set in the When percentage of characters used is less than field. If this value is set to 100%, a subset
will be created for every font which is not used completely.

3.20.6.  Color tab

Force Opaque Inks to knockout

If this checkbox is switched on, Opaque inks (such as Gold, Silver, ...) will knockout the background
in the PDF File. Overprints will be flattened first, so a visually correct result is generated, but the
resulting PDF is NOT OK for printing! In order to warn that the result will be correct visually, but not
for print, a red exclamation mark is shown when switched on. This option is only recommended for
proofing and viewing..

Exclude and Remap Separations
See Exclude and Remap Separations on page 119
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Color Management

The Color Management button opens the Color Management options to be used on the PDF Export. For
more info, see Color management on page 183

DotGain

This allows to apply a dotgain file on the output. For a full explanation on Dotgain, we refer to PS : Dot
Gain Compensation... on page 258.

The applied dot gain curve will be applied to the PDF as a transfer function in the Graphic state.
The dot gain curve for placed files will work without problems with placed ArtPro files and PDF files
coming from ArtPro or Nexus Processor. Placed PDF files from other application will work fine, as long
as they don’t define their own dot gain curve inside the PDF, as the embedded curve has priority. If a
placed PDF file coming from ArtPro or Nexus Processor already contains a dot gain curve, a warning
will be generated on PDF Output.

Always Generate CMYK Separations

If this option is on, all CMYK separations are included in deviceN color spaces as soon as one of the
CMYK separations is used. This option is only useful for customers that use a GMG color manager on
their PDF files.

Processing output separations using CMYK flags

If this option is used, ArtPro will use the CMYK flags in the separations the same way as in PostScript
output.

This option is also typically used by customer that have a GMG color proofer so CMYK ICC profiles can
be used on spot colors. If a spot color is marked as Cyan, Yellow, Black or Cyan on the Separations
palette, and this option is enabled, the spot color will be sent to the plate of the specified process
color (so the proofer can apply color management according to the CMYK ICC profile).

This can only work if the specified process color is not in use in the document.

The option is only available for composite PDF flavors and is intended for use on one-ups and S&R files
containing placed ArtPro files, not for S&R files containing placed PDFs.

See CMYK type on page 473

Flattener

The Flattener is used to translate transparencies and blends. This is necessary when outputting
PDF 1.3 compliant. More on the Flattener, including the Flattener Options, can be found in Flatten
Transparencies on page 411.

Vectorize opacity masks and channels without flattening

If flattening is enabled, opacity masks and channels can be vectorized. With this option you can
vectorize opacity masks and channels, without any flattening.

Isolate one ups from background

If the Isolate one ups from background option is enabled, the PDF transparencies defined in the one
up will not interact with the background.

Please check output carefully as this will also impact the bottommost overprints in the one up.
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Exclude and Remap Separations
If the Exclude and Remap Separations option is switched off, all separations in use will be output. See
also Separations In Use on page 474.

If the option is on, the Options button can be used to open the Output Separations dialog.

All separations used in the file are shown in the list. By clicking the checkbox in front of a separation,
you can set output on or off for this separation. Clicking the All Separations icon on top of the list will
turn all separations on or off.

 

 

The Export only used separation setting at the bottom, will exclude separations that are not used.
It will only turn separations off, separations unchecked earlier will not be turned on, even if they are
in use. The Search Unused Separation option does not take registration color into account. See
Registration on page 453.

Note:  Exporting a PDF with excluded separations is not supported if the ArtPro file contains
placed PDF or PostScript files.

Remap Separations
The Remap Separation part of the dialog can be expanded by clicking the triangle. If the section is
collapsed while remapping is defined, a yellow exclamation mark will be shown.

Note:  This section is only available for composite PDF flavors.
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The list of separations only shows spot colors in use, since those are the only separations that can be
remapped.

You can enter the Remap to ink manually, or you can select it from a dropdown, containing CMYK, all
spot colors from the job, and a From Inkbook option. This last option allows to select an ink from an ink
book that's not yet defined in the file.

When the Remap settings were changed, a yellow exclamation mark will be shown underneath, asking
you to validate the remapping. Click the Check All button to check the file for remapping conflicts. If
all separations can be exported as defined, a green check will be shown. If a conflict is found, a red
exclamation mark is shown. Possible conflicts are:

• an object using both the source and target separation
• the target separation is used in the same one-up as the source separation
• the source separation is used in an opacity mask.

Note:  Whether or not you did the validation, if a conflict exists and you do an Export anyhow,
the error message will be displayed in the Message Center, and output will not be generated.

Click the Reset All to reset the dialog to its initial values, i.e. remapping all spot colors onto
themselves.

3.20.7.  Images / Links tab

Save image links using

You can save links as Esko links, as OPI links or without links (“no”).
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Embedded images

You can choose to embed images or not. If “Save image links using” is disabled or set to “no”, this
option will always be enabled.

Copy linked files next to output

If this option is enabled, all linked files will be copied next to the output file, even if they are
embedded. This can be used e.g. when sending files using Shuttle.

Use Image Downsampling At

All images with a resolution higher that this value, will be resampled. This allows you to create smaller
PDF files.

Image Downsampling

If this option is on, only images with a resolution higher than the entered resolution, will be
downsampled to the down-sample resolution. In the example above, when switching on the checkbox,
images with a resolution below 450 dpi will remain unmodified, while images with a resolution above
450 dpi will be downsampled to 300 dpi.

Use Averaging When Downsampling

This option is the same as in the more print settings. When it is activated, image quality will be better,
but the output will be slower. The difference with PostScript output is that CCITT images are averaged
too when outputting to PDF.

Image Compression

None, Lossless compression (Flate), Maximum Quality JPEG, High Quality JPEG, Medium Quality JPEG
or High Compression JPEG. None means that all compression is taken off. Compressed images are
decompressed in the PDF file. A lossless compression means that the file will still be complete after
decompression. There will no loss of quality. In the three other cases, the files are compressed with a
JPEG compression. A higher compression means smaller files, but worse quality and vice versa.

Include RGB preview of images

This will add a lowres 72dpi preview of the large images inside the PDF. These previews will be used by
some Acrobat plugins, to speed up previewing files .

Image Clipping

The Image Clipping option allows to force ArtPro to clip images to the smallest size inside the clipping
path. ArtPro will include the full picture if clipping doesn’t give any benefit, i.e. if the sum of the image
parts is close to or bigger than the size of the full image. A full image will only be included once in the
PDF file, even if it is placed multiple times.

Links

The Links option allows to include OPI comments into the PDF file. You can choose between None (no
links), OPI links or Esko links. The option Embed Images allows to define if images with OPI comments
should be embedded as well.

OPI comments can not be used in e.g. Illustrator, unless the InPDF plug-in is used. For more
information, see the InPDF documentation.
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These OPI links in the PDF are recognised by ArtPro’s PDF Import and can be imported just like any
other OPI link. See  Links on page 89

3.20.8.  Certified PDF tab

The Certified PDF tab contains the settings to be used when working in Certified Mode. For an
overview of Certified Mode and the settings on Export PDF, we refer to Certified ArtPro on page 65.

3.20.9.  Save / Load tab

Save Current to XML

This writes an XML file containing all settings for the active flavour. Settings for other flavours will not
be included.

Load Current from XML

Load Current to XML opens an XML file and uses these settings to overwrite the settings of the active
flavour. Settings for other flavours will not be changed.

Save All to User Preferences

Save the settings for every Flavour into the user preferences. These settings will be used every time
this user starts ArtPro. This Save will only overwrite the PDF Export Preferences in the Preferences
File. All other preferences remain unchanged.

Reset Current to Defaults

Resets the settings for the active Flavour to the factory defaults.

3.20.10.  Placed Files (S&R)

When outputting PDF of a file containing placed EPS, this EPS will be placed in the PDF file as a PDF
XObject. This will work on certain RIPs. The Rip must accept PDF XObjects containing PostScript.
Nexus Rip for example, can handle these objects.

Placed DCS will only work with Separated PS Output, and not when outputting PDF

3.20.11.  Shortcut

There is a shortcut for Export PDF : Cmd - P.

This is the same shortcut as for the Print dialog. This results in a toggle between the Export PDF and
Print dialog. The first time the shortcut is applied, the Export to PDF dialog is opened. The second
time, or if the Export to PDF dialog is open, the Print dialog is opened.
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3.21.  Export Thumbnail / Printcheck

The option Export Thumbnail / Printcheck allows to create an image of the complete job.

Besides the resolution, the noise for gradation can be set. The compression allows to choose between
tiff and jpeg, with 3 possibilities on compression : High compression, Medium compression or High
Quality. The file can be exported as a Tiff/JPEG or an EPS. The Box drop box allows to define what
border has to define the boundaries of the image to be created.

3.22.  Export Illustrator

Export Illustrator creates an Illustrator file of the active ArtPro job. ArtPro can create Illustrator 3, 5 or
7 format.

Keep in mind that the Export Illustrator function does not support transparencies. All transparent
objects will be ignored when applying Export Illustrator.

It is advised to flatten the job before using Export Illustrator. For more info on the Flattener, see Flatten
Transparencies on page 411.

However, if the “Output fully transparent objects” option is on, objects that are completely transparent
will be included in the Illustrator file. This can be useful when using the Male / Female function. See
Create Die: Male / Female on page 309.

3.22.1.  Converting an ArtPro job into an Illustrator file:

Open the ArtPro job you want to export to the Illustrator format.

 

 

Choose Export Illustrator out of the File menu. The Export Illustrator dialog will open.

Set Include Traps as wanted.

Choose the compatibility you want : Illustrator 3, 5 or 7

Choose the Downsampling rate you want : none (leaving all pictures at original resolution), 2, 4 or 8
times downsampling.

Click Export. A dialog box will appear to set the name and the position of the Illustrator file.

Once the Illustrator file has been saved, you can open it in Adobe Illustrator 3, 5 or 7.
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Restrictions Illustrator 3.0
Illustrator 3.0... was developed for lineart only. This means:

• Text is not exported. To export text to Illustrator, convert all text to paths first.
• Images are not exported. A solution is to replace all images in ArtPro by a mask color (e.g. a bright

color). Once converted to Illustrator it is then easy to spot paths in mask colors and re-address the
images to them.

• Gradations are not converted. The exported color for the vignette is the first color in the gradation.
• Multistep gradations are not exported

Restrictions Illustrator 5.0
Illustrator 5.0... does not support TIFFs. This means:

• Placed TIFFs, mapped TIFFs and internal images are not exported
• Gradations converted to tiffs, namely non-linear multistep gradations, are not exported either.

Restrictions Illustrator 7.0
Illustrator 7.0... does not support internal Images.

• Mapped pictures are exported as a single CMYK tiff
• Internal CT’s are not exported

Illustrator restriction:
When a path or a compound is made of more than 16.000 points, a warning message will appear at the
end of the Illustrator export function. This means that all the paths were converted to Illustrator, but at
least one of the paths or compounds contains more than 16.000 points. This will result in an error when
trying to preview the file in Adobe Illustrator.

To reduce the number of points on a path or a compound, you have two alternatives:

• Re-smoothen the paths in ArtPro, using Straighten Margin, so paths with less points are created.
• Make smaller compounds. One compound is one path for Illustrator. Divide the compounds into

smaller compounds, so that paths with a smaller number of points are created.

3.23.  Export Picture List

With Export Picture List... it is possible to export an ASCII text file containing information on name,
position and size of the bounding box, the picture center and page box of placed pictures. These Pic-
ture List files can be used in ArtPro, using the Import Picture List function (see Import... Picture List on
page 104) or the Import Picture List activity in Nexus.

For more information on the Picture List file type, and the contents of a Picture List file, we refer to
Import... Picture List on page 104.
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3.24.  Export Differences

In the export Differences, you can select two open jobs which have to be compared. Using the
separation dialog, you can specify what separations should be compared. This function could be useful
e.g. to verify if the graphics of two different language versions fit, to find out what changes a customer
made to the new label compared to the one printed last year,...

 

 

3.24.1.  Align

For jobs with different job sizes, you can define how the jobs have to be aligned : vertical and
horizontal, top (left), middle or bottom (right). We do advise you, however to make the jobsize of the two
documents the same.

3.24.2.  Output

The result of the export depends on the setting at the bottom of the dialog: separated, CMYK, Binary,
log file or on screen

• Separated results in a grayscale tiff on disk for every separation. Where the image is 50% gray,
there is no difference at that position. If the original file is darker for the specified separation, the
difference file will be above 50%, and vice versa.

• CMYK will result in a CMYK TIFF file, showing only those pixels in the file where difference was
found.

• Binary results in one single 1-bit TIFF file, where differences are shown as black pixels.
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• Show on Screen is a preview functionality. The Modified Job will be dimmed, and all differences
found will be highlighted. The highlight color is defined in the appearance control panel of the
system, best is a bright color like magenta.

3.24.3.  Delete Matching Files

Will remove the TIFF files of separations in which no difference between the two jobs is found. As
Separated is the only setting that results in multiple files, it is the only one affected by the Delete
Matching Files setting.

3.24.4.  Make Report Job

Will generate a new ArtPro document, with the name of the compared files, date and time of
comparison, used resolution, and all difference files placed under each other, preceded by the separa-
tion name.

3.24.5.  Import Differences

Will vectorize the binary difference file on top of the original files.

3.24.6.  Resolution

When calculating the differences, ArtPro scans the job in pixels, it does not look at vector information.
Two pictures could be placed on exact the same position, but one was color corrected. Because
ArtPro scans in pixels, this difference will be found. The resolution of these files can be defined in the
Resolution field.

3.25.  Export CIP3

Note:  This module is optional. See Show Licenses on page 49 for more information.

Export CIP3 creates a CIP3 file of the active job. CIP3 is a file format used to transfer data about a
specific file through the production process. Besides a preview, this CIP3 file contains information
concerning separations, ink coverage, job dimensions, etc.

3.26.  Export Gravure JobTicket...

Note:  This module is optional. See Show Licenses on page 49 for more information.
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Jobticket is an output format for Hell gravure machines. For more information, please contact Hell
Gravure Systems.

3.27.  Export Gravure Tiff...

Note:  This module is optional. See Show Licenses on page 49 for more information.

Export Gravure Tiff is used to output ArtPro files directly as TIFF data for gravure printing. It creates
one TIFF file per separation.

 

 

3.27.1.  General concepts

Bitmap (gravure) vs. PostScript output (offset)
Calculations in PostScript are contour based. The output resolution on an imagesetter can go up to
2500 lpi and even more, which means that small dots are produced. As a consequence, the final result
will be very sharp and accurate.

Engraving, on the contrary, requires another file format since no dots are engraved, but small pits.
Therefore ArtPro prepares a TIFF- format, a continuous tone with gray values or as a bitmap, which
is more appropriate for engraving. Gravure output uses a diamond, so the dots are rather big. The
average output resolution is 360 lpi (=140 l/cm) hence large steps are taken and pixelized edges are
formed. When engraving, the jaggies are visible. There is however a possibility to make smaller steps in
between in order to make the edges less sharp and hence avoid the staircase effect, which will result in
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a nicer output. This is done by means of oversampling. Gravure output is not supported on placed EPS
files.

How is calculation time reduced ?
ArtPro recognizes a repeated file, so the program calculates the bitmap file of the repeated job
only once. When engraving, this bitmap file is read again and again. The pixels are repeated without
recalculation, in fact they are copied. ArtPro calculates one job beforehand and translates it to an
internal format which is saved as a temporary file on your Macintosh. This file will be automatically
deleted if the data are translated into gravure data.

Possible side-effects of time optimization
• 1. Registration marks and bearer bars are not oversampled. Oversampling is only done on

placed pictures (placed ArtPro or TIFF files) The complete repetition of ArtPro files is oversam-
pled, however without inserted elements such as marks. The step and repeat functionality
automatically uses placed ArtPro files. As they are placed as pictures, they will be oversampled.
The regmarks which are created on the step and repeat-file are plain contours, and are therefore
not oversampled. A result of this method can be jaggies on the parts of the job which aren’t ArtPro
files. Crop marks and regmarks though, should have sharp edges instead of blurred ones. In order to
avoid unwanted jaggies, the regmarks can be placed as images in the ArtPro job.

• 2. The edge of the job is clipped sharply. The mask is part of the repetition, but only the contents of
the mask is anti-aliased. To guarantee that the mask is completely filled, it is necessary to create
the job with bleed. The bleed is included in the calculation, but in the repetition the bleed will be
omitted, so the file is made to measure.

• 3. If the job is rotated, the temporary file becomes bigger.
• 4. TIFF output is not supported on EPS files.

How much disk space is needed for a repetition of an ArtPro job?
The temporary file which is created in between the ArtPro file and the TIFF data is made in the same
directory of the ArtPro application. So ArtPro must be installed on a large disk. To make sure the file
will not exceed the disk space, the size can be calculated beforehand.

The ArtPro job can contain another ArtPro job, there are 3 levels: the repetition, the job, and the logo
within the job

The calculation of the temporary files is slightly different for all 3 levels:

1. The Step and Repeat of one ArtPro job

The repetition (level 1) is calculated on output resolution, and written on output resolution. The
eventual gravure-output requires one 8-bit grayscale TIFF per separation, 1 grayvalue per pixel = 1 byte.
E.g. a repetition of 1m x 1m requires 100 x 140 x 100 x 140 bytes per separation (= 196.000.000 bytes Ý
187Mb)

A temporary file is created on output resolution to prepare for the TIFF output. If the same job is
repeated in one file, but under different angles, the job will be prepared for each angle, so the capacity
needed will then be x times the temporary file (x = the different rotations).

2. The ArtPro job
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For this calculation, the lowest level (= logo within the job) is prepared first and the sub-job is saved into
a temporary file. For the calculation of the ArtPro job (level 2), the oversampling is not written in the
temporary file. The job is calculated on high resolution, the average is taken (e.g. 4) and written on low
resolution (while the logo is calculated and written on high res).

The temporary file size = size of the ArtPro job x output resolution.

Suppose the job is 20 cm x 30 cm on an output resolution of 140 lines/cm : 20 cm x 140 l/cm x 30 cm
x 140 l/cm = 11.760.000 pixels. The temporary file will take up to 12 Mb, in this case, but each time the
TIFF file is calculated, the temporary file will automatically be deleted.

3. The logo within the job

The size of this temporary file is calculated :

H(eight) x W(idth) x res x res x oversampling H x oversampling W.

The oversampled data are written in the temporary file.

How much disk space is needed for a repetition of TIFFs?
If TIFFs are repeated, the calculation will be :

H x W x res x res, for each separation individually

A repetition of TIFFs (e.g coming from another system) is not oversampled because the anti-aliasing
is supposed to be calculated already. If the TIFF has the exact resolution (= output resolution),
oversampling is not needed and this is of course the best solution. If that is not the case, the resolution
is automatically adapted by omitting or doubling pixels. The TIFF is copied to the temporary file.

Problem

When the TIFF image is positioned in the job, the TIFF pixels (even if the TIFF has the same resolution
as the gravure resolution) might not be in the exact position of the gravure pixels. Normally only a part
of the image pixel would be copied into the output pixel. However this method looses sharpness.

Solution

Instead of copying a part of the TIFF pixel data into the output pixel, the TIFF is moved so that the
borders of the TIFF-image and the borders of the output converge. The image shifts with a max. of 1/2
output pixel (1/280 cm or 1/720 inch). When the image contains a rectangular mask (step and repeat),
the mask is also shifted so that it fits the output grid. The mask can grow or shrink. This means of
course that you will need to provide bleed for the TIFF. Otherwise a small white line could occur in
between the TIFF and its (grown) mask. In this way sharpness is gained. However, if 2 TIFF-images are
placed on top of one another and if they move in an opposite direction, the shift will be visible. If the
TIFF is positioned straight, the tmp-file will be W x H x res x res. As there is no oversampling, the file is
not so big.

Repetition of TIFFs as pictures in an ArtPro job
If TIFF is used as a picture in a job, the calculation will be different depending on the scale and rotation
of the picture:
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• if the resolution of the scaled TIFF is equal to the output and the picture is rotated over 0, 90, 180
or 270°, no oversampling is done, keeping the original sharpness (and moving the image a tiny bit as
described above).

• If the image is rotated over other angles, the temporary file will be: V x H x res x res x oversampling
x oversampling (with V and H measured after rotating the image). In this case more disk space is
needed.

3.27.2.  The parameters

Workflow
• Make sure ArtPro is installed on a Disk where there is enough room to create the temporary files

(see later in this chapter).
• Open : File - Gravure Out...
• Output: Choose TIFF in the Output popup menu.
• Separation: In the Separation popup, you can choose for which separation you will make the TIFF

output.

Oversampling:
Oversampling means that ArtPro makes the calculation of the TIFF on a resolution which is too high, i.e
higher than the one needed. Afterwards it is ‘averaged’, this means that it is converted to low resolution
by calculating the average of each group of lines. This gives a kind of “blurred” effect. Oversampling
requires a long calculation time and therefore needs optimization.

The oversampling filter can be chosen from none to 8 times.

• none: a lot of jaggies
• 4 times: default value, this is the oversampling value used the most in the packaging and label

market
• 6 times: very high, e.g. for stamps

Example
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If you have an oblique black line on 360 lpi (= 140 l/cm), the edges are very much pixelized.
Oversampling means that you will calculate with a higher resolution than the one you need.
Oversampling 4, means that the image is calculated at 4x the resolution (360 lpi) = 1440 lpi. Every line is
divided by 4. So there are 16 pixels read (4x4) for one output pixel. The output pixel gets the grayvalue
of the 16.

Resolution:
The resolution of the TIFF file can be defined in l/cm or l/inch. A normal engraving resolution is 140 l/
cm or ±360 l/inch.

Noise for gradation:
default : 3 %

1 byte = 256 gray values

Gradations can normally not have more than 250 bands (steps of 0.4 %). ArtPro creates 400 bands
instead of 250. The added noise makes the steps invisible. The desired amount of noise can be entered
in this field.

Exclude Separations
If the Exclude Separations option is switched off, all separations in use will be output. See also
Separations In Use on page 474.

If the option is on, the “Option” button can be used to exclude separations from the output. All
separations used in the file are shown in the list. By clicking the printer icon in front of a separation,
you can set output on or off for this separation. Clicking the printer icon on top of the list will turn all
separations on or off.
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The Search Unused Separation setting at the bottom, will exclude separations that are not used. It will
only turn separations off, separations unchecked earlier will not be turned on, even if they are in use.
The Search Unused Separation option does not take registration color into account. See Registration
on page 453.

Compression
For separations with a resolution above 600 dpi and without oversampling, you can select PackBits
Compression for HiRes. Otherwise, you can Compress the TIFF using LZW, or leave the separation
uncompressed (if you did not select Compress TIFF). PackBits compression results in lower
compression rate, but will be calculated much faster than LZW compression, so it is the best solution
for high resolution files.

IBM PC Byte order
By default this option is active, because most engraving machines are IBM-oriented. The system IBM
uses is ‘Little-endian’ while Macintosh uses ‘Bigendian’.

1 Bit
This option allows you to choose between 1 bit data (checked) and 8 bit 256 graylevel data (default,
unchecked). Most systems take 8 bit data

Save Fast Forward Data Minimum Fast Forward : + 280 lines
This option creates an extra text-file (.SVS) with a description of which parts of the TIFF-output
file are blank and hence can be skipped. Some engraving machines have the possibility to take this
information into account.

If the option is active, ArtPro will ask for the text-file. Give the automatically created file a name.
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3.28.  Export Mount-O-Matic

Note:  This module is optional. See Show Licenses on page 49 for more information.

With Export Mount-O-Matic ... it is possible to export an ASCII text file that contains all information
specifically for the Mount-O-Matic machine. Mount-O-Matic is a device allowing flexo printers to reduce
the use of photopolymer in the plate making process. This machine is useful when only small parts of
the file contain information.

 

 

In a traditional workflow, a complete photopolymer is made for every separation. If only a small
percentage is covered with information, still the complete polymer has to be exposed. As this is very
expensive material, Mount-O-Matic provides a solution to save the unnecessary polymer.

First of all, the file is output on film and the parts that contain information are cut out and positioned
together. Now, a polymer plate is made of these pieces. This polymer is of course much smaller then
a plate of the entire film, because there are no empty zones left. Finally, all separate groups of objects
are cut out of the polymer again and glued onto the printing cylinder.

To ensure a perfect registration, ArtPro adds registration marks to every group of objects. These
registration marks are output on film and therefor also on the polymer plate. The positions of these
register marks are also mentioned in the ASCII file and the Mount-O-Matic machine automatically turns
the cylinder towards the operator, who can use 2 camera’s to manually paste the piece of polymer onto
the cylinder. On the lens of each camera, a registration mark is visible. The Mount-O-Matic operator has
to put the left and the right mark of the polymer exactly under the marks of the left and right camera
respectively. As the 2 camera’s are positioned horizontally towards each other, also the marks from
ArtPro are always positioned horizontally.

3.28.1.  How to make a correct printing plate on the Mount-O- Matic using
ArtPro?

• Make groups of the objects that have to come on one separate piece of polymer.
• Select all the groups you want to export (generally the complete file).
• Choose Export Mount-O-Matic from the File Menu. Select a folder on the HD or directly on a floppy

disk to save the Mount-O-Matic file. This file has a file extension .mom.
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• Now, you will see that registration marks are made on the left and right side of each group you made
and selected. These registration marks contain 100% of ink for each used separation in the group.

• Print the file to film using the Print menu.
• Assemble the used pieces of film on a new, smaller film and expose a polymer plate using that film.
• Cut out all the pieces again from the polymer.
• Read the exported text file from ArtPro into the Mount-O-Matic (the file transfer method is generally

a floppy disc or local network).
• The camera’s will be automatically placed on the correct position for the first group, using the x,y-

coordinates described in the text file. In ArtPro, this group is marked by the number 1 underneath
one of the register marks. After sticking this piece of polymer on the cylinder, the camera’s will
be positioned for the second group of objects. Now you have to use the group marked by number
2 underneath the registration mark. Continue like this until all pieces of polymer are put on the
cylinder.

Remarks:
• When you save the Mount-O-Matic file, registration marks are made on every group of objects.

The position of those marks is depending on the horizontal size of the bounding box of that group.
Still, there is a minimum distance between the 2 marks of 108 mm because the camera’s cannot
approach closer then 108 mm to each other. If you notice that the registration marks of one group
overlap another group containing the same separations, you will have to make one group of it and
redo the export. One group results in one pair of registration marks and overlap is avoided.

• Shrink means the same as vertical distortion and serves as information for the Mount-O-Matic. As
the Mount-O-Matic file only contains coordinates and not the actual contents of the file, the same
vertical distortion has to be used when printing the job to film.

• Sometimes it is not possible to create groups in the ArtPro file. The order of the objects can change
when making groups and it is impossible to group objects in a step and repeat file, as the single
file is represented by a preview. In those cases, it is necessary to draw rectangles over the objects
you would normally group. These rectangles must have the combined color of all used separations
in the underlaying objects. When you export the ArtPro file to Mount-O-Matic, only select the
rectangles. Registration marks will now be made for each rectangle. If you delete the rectangles
afterwards, you will have the same result as if you would have used groups. The exact size of the
rectangles is not important. As long as the positions of the marks in the ArtPro file and in the
exported ASCII-file are the same, registration is guaranteed.

• It is recommended to put the rectangles on a separate layer. This will allow you to delete the
rectangles more easily afterwards, without the risk of deleting objects in your document.

3.29.  Export Macroflex

Note:  This module is optional. See Show Licenses on page 49 for more information.

The Cyrel Macroflex uses the same philosophy as the Mount-O-Matic, but is manufactured by DuPont
and has some differences. First of all, the minimum distance between the two registration marks is 127
mm. The registration marks also contain characters that refer to the used separations in the group. A
refers to the first separation, B to the second,... .

134



3ArtPro

The Macroflex is not using a cylinder to put the polymer on, but is a flat table model. First of all, an
adhesive sheet of laminate the size of the cylinder is put on the table. The camera’s can move horizon-
tally and vertically to show the exact position on the sheet for each piece of polymer. An operator glues
the polymer onto the sheet. Once completed, the sheets of all separations are put on the cylinders of
the flexo printing press.

3.30.  Launch Workflow...

The Launch Workflow ... function allows to send files directly to a workflow in Automation Engine using
Shuttle. For a full explanation on Shuttle and how to establish the connection, we refer to the Shuttle
documentation, available from the Esko Support pages and to Shuttle on page 491.

You can submit a file in 3 different formats:

• as a PDF file, using the settings from the corresponding PDF flavor in the Export PDF dialog

Note:  The "Copy links next to output" has to be enabled if you want to make sure that, when you
launch the file to a workflow as Normalized PDF, all links - not only to images, but also to CAD
files - are kept.

• as an ArtPro file, optionally including links
• as a PostScript file for Nexus, using the settings from the Print menu, device “Nexus”.

Shortcut: Cmd-Alt-S : Launch Workflow

3.31.  Print : General Settings

With the Print... module it is possible to generate PS output of any ArtPro file. The PostScript file
type depends on the Device Type chosen in the Print dialog. Changing the device type can change the
contents of the Print dialog and the more print settings. Print... can be activated in the File menu or by
its shortcut.

Shortcut: Cmd-P

3.31.1.  General Concepts:

Flattening
When creating a PS file, the ArtPro file is flattened, as PS does not support blend modes, opacity,
etc. The settings of the Flattening Options are used. For more info on Flattening, see Flatten
Transparencies on page 411.

Composite PostScript®

Composite PostScript means all information is calculated into a single page, unseparated PostScript
file.
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In a Composite file, placed EPS files are copied unmodified. This means that if you work with DCS
for instance, the placed low resolution will be sent to the printer. Both TIFF files and ArtPro files are
converted into PostScript at full resolution (or any resolution defined by other print settings).

There are mainly 4 ways of generating PostScript for Printers/Proofers.

Using DeviceN (Composite L3 Printer)

When outputting composite postscript using the Level 3 DeviceN comments, a composite PostScript
is generated, containing all transparencies and spot colors. If this composite output is handled by
a RIP, capable of handling these level 3 commands, a correct output can be achieved. This option is
preferred if the Proofer/Printer can handle it.

Please note that composite output, even when using the DeviceN command, does not include dotgain
or screening information.

DeviceN Off, Use Setcustomcolor OFF

The complete job, if necessary, will be flattened to remove all overprints and transparencies, and will
convert all pantone colors into CMYK.

The result will be a flattened CMYK composite PostScript file, which can be send to any color proofer.

DeviceN Off, Use Setcustomcolor ON

This will create a flattened file, flattening all CMYK overprints and blend modes.

The resulting PostScript file will contain CMYK objects in combination with separation color objects.
This PostScript file will still contain overprinted objects. Not every color Proofer can handle this.

Bitmap Proofer

This option will force ArtPro to Rip the complete job into a CMYK image at a given resolution, and
generate a PS file containing only the Ripped CMYK image.

Separated PostScript®

If you make a file with All Separations, a multipage PostScript file is created. Each page contains black
and white information describing the separation of one ink. So the file contains as many pages as there
are inks in the ArtPro file.

If you make a file per separation, a single page PostScript file is created containing the black and white
information of the film (ink) you asked for.

Placed art in separated output:

• EPS files containing CMYK, grays and custom colors are separated by ArtPro, using “separation
code”. Some EPS files however, are not suited for this separation code. Therefor an alternative
separation code is provided (by switching on the “simple separation code” option) for these
situations. If you work with DCS files (or DCS-2), ArtPro will replace the low resolution file by the
high resolution separations.

• TIFF CMYK files are separated and converted into PS.
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• ArtPro files are converted as normal, this means any picture in the file will be expanded with high
resolution.

• OPI: PostScript output of TIFF files always contains OPI comments (as specified in Aldus Open
Prepress Interface Specification 1.2 and 1.3). This makes it possible to work with low resolution
images on the Mac and in proofs (= unseparated output), and high resolution images on film (=
separated output). Even if the TIFF file type is not supported (not CMYK), OPI comments are
generated.

• Examples of TIFF files which are supported by OPI are RGB and palette TIFF files. These files can
be placed in ArtPro, you will see them on screen and you are able to make a color proofer output.
However, you will not be able to make a separation of these TIFFs, unless you use OPI replacement.

Output
“Normal” PostScript is created using Color Proofer and Generic ImageSetter output. So if the name of
your specific device does not appear in the list, choose Composite L3 Printer or Color Proofer to proof
and Generic ImageSetter to expose on your device.

Color Proofer outputs to a color proofer or a black-and-white proofer that accepts color commands.
By default it generates composite (= unseparated) files. Generic ImageSetter creates separated
PostScript.

Placed Files (S&R)
Placed PDF 1.3 files are converted to PS during output. Placed PDF 1.4 files cannot be converted to
PostScript Level 3, and will generate an error “Cannot convert PDF 1.4 into PostScript”. Note that
the distinction between PDF 1.3 and 1.4 is not done on the header, but on the presence of PDF 1.4
functionality.

3.31.2.  Procedure

In the Chooser, select the driver and the device you want to send the PostScript file to.

Open the Print... module and set the Device Type to the corresponding device.

Activate the necessary options.

Set the desired Page Setup. After choosing Page Setup... the system will give you the standard
LaserWriter Page Setup dialog box. This setup is specific for your printer driver and is described in
your printer manual. In the LaserWriter Page Setup, most of the settings are the same as in the Print...
module. These settings (paper size, reduce or enlarge, orientation) define the page handling, while the
same settings in the Print menu define the creation of the PostScript.

Click on Print... The Print dialog box which appears, depends on the printer driver you are using.
Clicking on Print activates the print procedure. Choosing Printer as Destination outputs directly to
the device set in the Chooser. Choosing PostScript® File as Destination creates a PostScript file.
Save will show a dialog box to specify where the PS file should be written. The PS file includes all the
file information (fonts, images,...) and al PPD dependent information (paper sizes etc.) OR Click on
Save PostScript...  If Save PostScript... is chosen, there will be no direct output through a Chooser
device, but the file will be written to the hard disk instead. The above described Page Setup settings
are of no importance with Save PostScript... , as all PPD dependent information is NOT included in the
PostScript file. A dialog box appears to define the name and place for the PostScript file. In a PS file
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saved with Save PostScript... no font information is included, unless the Embed Fonts option is on. If
Embed Fonts is not used, the fonts used should be vectorized first (with Text > Convert to paths or via
More Print settings > vectorize Text), installed on the imagesetter or added by an OPI server on the
moment the file is actually printed. Companies that work with remote exposing units, should include
fonts when sending the files to their service bureaus. A copyright on a Type 1 font program confers the
same protection against unauthorized copying that other copyrightable works, including computer
software, enjoy. (see Adobe Type 1 Font Format from Adobe Systems Incorporated).

During output to a device or to a PostScript® file, the cursor changes into a rotating ArtPro icon.

You can abort the Print operation by pressing Command-period (Cmd-.)

3.31.3.  Settings

Save / Load settings
All settings of the Print menu and the More settings can be saved using the Save Settings button.
Settings saved earlier can be reloaded with Load Settings.

When loading settings, the Device Type will be Custom ImageSetter or Custom Proofer, depending on
the device type that was saved and the Device Name will show what the original device was.

Paper Size
The Paper Size pop-up includes a number of sizes, From Page Setup, From job, From PageBox and
From media box

Choose a paper size from the pop-up menu. The dimensions of the different sizes are: A4 = 210 x 297
mm; A3 = 297 x 420 mm; US Letter = 8.5 x 11 inch; US Legal = 8.5 x 14 inch; Tabloid = 11 x 17 inch and
Tabloid Extra = 12 x 18 inch.

If you want to use the size defined in the Page Setup dialog, select from Page Setup.

From Media Box will always use the media box. From PageBox will use the active (i.e. the last selected)
page box. If any objects are outside the selected page box, a warning will be generated.

When choosing “From Job”, the active page box is used, enlarged if necessary to fit all objects.

This Paper Size is the size that will be used in the PostScript file. Unlike Page Setup, it does not affect
the paper tray to be used, nor the film or paper feed, unless Use SetPageDevice (for proofers) or Use
SetPageParams (for imagesetters) is on (see More Settings)

The Use SetPageDevice option is necessary when saving a postscript file to be distilled to PDF, as this
is the only way to get the job size into the PDF

Layout
For proofer output you can choose between center, fit always, fit large paper or tile output.

Center will position the job centered on the paper size, taking into account the indicated Distortion for
size. A distortion of 0% will result in a true size job output. If the job is bigger than the indicated paper
size, it will be clipped on the edges.
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Fit always will enlarge or reduce, so that the ArtPro file matches the paper size. Scaling is always
proportional.

Fit Large Paper will only reduce oversized artwork to a smaller paper size, this option will never enlarge
the artwork.

Tile is used when a job is larger than the paper size. It will thus divide the job over several pages, with
the indicated Tile Margin and Tile Overlap.

If you do not want to use the complete paper size, you can define a Tile Margin. The Tile Overlap
indicates how much of the tile edges will be printed on the next page as well, so as to create an overlap
area.

Orientation
The Orientation can be set to portrait, turn right, turn left or upside down. It defines the direction in
which the file is put on film or on paper. Choosing portrait will output the file in the upright position,
turn right will rotate the file 90° and turn left will rotate it -90°.

Mirror / Negative
If you put a check next to Mirror, the job will be mirrored before exposing, resulting in a wrong-reading
output.

Negative allows outputting separations as negatives.

In most cases it is the safest to define these settings on the RIP, to prevent operator errors.

Clip
If the ArtPro job is bigger than the paper or the film, you may choose to output in parts.

If Clip is not active, the complete job is printed or exposed and will thus be clipped on the output.

When you activate Clip, you can define the tile dimensions by clicking on the Rectangle... button. The
tile indicated in the Clip Rectangle dialog will output.

Clip Rectangle
 

 

Clip Rectangle allows you to define what part of the job should be printed.
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Pagebox Clipping
When Pagebox Clipping is selected, the job size chosen under Use Box will be used to clip the output.
The different boxes can be defined in the Job Size dialog (Cmd- Shift-J).

If you select "Current", the active pagebox (selected in the Job Size dialog, and visible in the preview)
will be used.

Manual Clipping
If Manual clipping is selected, the size and position of the part to be printed can be set manually.

In the Vertical and Horizontal field, the size of the rectangle to be printed can be entered. This
rectangle is shown as a light blue rectangle in the job.

By clicking the Move button, this rectangle can be moved to the desired position on the ArtPro Job. If
the Lock to Ruler option is on, the rectangle to be printed will move along when moving the ruler (see
Ruler tool on page 523). Changing the Media Box will resize and reposition the Clip Rectangle to the
complete job size.

Automatic Clipping
If Automatic clipping is selected, the size and position of the part to be printed will be defined by the
job size and the settings of the Divide and Print Part fields.

• Divide: in the Divide field, you can enter in how many parts the ArtPro job should be split up, both
vertical and horizontal. In the example on the left, the Clip Rectangle is set to clip the ArtPro job in
two parts vertical, and in three parts horizontal. Remember that when clipping a file this way, no tile
overlap is used.

• Print Part: in the Print Part field, you can define which part of the job should be printed.

Distortion
An ArtPro document can be output with a vertical and/or horizontal distortion. It is defined as a
percentage of the jobs original dimensions and is applied to the PostScript file. This distortion is
specifically important for flexo jobs. On mounting a flexo plate on the press, it is stretched out in one
direction. By making the output slightly smaller than needed, we compensate for this distortion. The
original dimensions of the ArtPro file remain unchanged.

Positive values make the job bigger and negative values make the job smaller. E.g. Vert. distortion =
-2.35% will make the output 97.65%.

In this way you can also scale the proofer output : e.g. entering -50% for both Vertical and Horizontal
Distortion will output the job at half of its original size.

Separations
In the separations dialog, you can define which plates need to be output. You can switch plates on
and off for printing and you can merge plates. In the left window all the separations used in the file are
shown. On the right are all the plates that can be printed.

Printing on/off

By switching off the printer icon next to an ink, it will not be output. With Search on, ArtPro will
examine the file and automatically switch off separations that are not in use. Search does not work
when unmapped pictures are placed in the file (except placed ArtPro documents, e.g. S&R files).
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Merging inks (separated output only)

The left column shows all the separations in the current job or repetition. Click on the triangular button
to see the separations they will be converted into (result). One separation can be converted into CMYK
or merged with one or multiple other plates.

First click on the original result and press Delete to remove. Then either type in the name of the plate
you want this ink to merge into (To plate) and press add, or choose a plate from the pop-up menu on the
right. When choosing a plate from the pop-up menu, the color is automatically added.

The star in the second column before the separation indicates this color is user-defined, so the default
was changed. An ArtPro logo in the first column before the separation indicates the color is used in the
file or not. In a Nexus Processor workflow plate merges can be defined without having a file open, so in
this case, the separation can be user defined, and not ArtPro defined.

 

 

Mapping of output separations is fully supported for all paint styles. Even placed ArtPro jobs can be
merged. e.g. for a layout, containing 2 ArtPro jobs, each with a different spot color, both separations
can be merged during output.

Separating placed EPS- and PDF-files takes into account overprints, PS3 and PDF1.3 vignettes
(Illustrator 8 and 9) and Photoshop duotones. Separations are remapped using the new separation
dialog of the Print-menu.

Screening for mapped separations

When you have a step & repeat file containing multiple jobs and you want to map separation X from job
A into separation Y from job B, separation X will still be output with its own screening settings as long
as this job (A) does not contain separation Y. When job a contains separation X as well as separation Y,
the screening which will be used to output the mapped separation X into Y will be separation Y.
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Dot Gain Compensation
The Dot Gain Compensation button defines if the dot gain curve(s), entered in the Screening menu or
defined in the Print menu (see below), has to be calculated on the Postscript output. With this option
off, all curves are ignored for output.

Dot Gain File ...
The Dot Gain File button allows you to select a Dot Gain File. The file name of the selected Dot Gain file
will be shown on the right side of the button.

If a Dot Gain File is selected in the Print menu, this Dot Gain File will override all Dot Gain settings in the
Screening dialog. The exception is an placed EPS that contains a dot gain compensation, in which case
both curves are used. A selected file can be removed by clicking the Dot Gain File button while holding
down the SHIFT key. Dotgain files are generated in and saved from the screening dialog.

Color Management
When clicking the Color Management button, The Output tab of the Color Management dialog will be
opened, allowing to make all settings and profiles to be used during Output. For more info, see Color
management on page 183.

Flattening Options
When creating a PS file, the ArtPro file is flattened, as PS does not support blend modes, opacity,
etc. The settings of the Flattening Options are used. For more info on Flattening, see Flatten
Transparencies on page 411.

Marks
This will open the Marks dialog, also available from the Prepress menu. See Marks on page 406.

3.32.  Print : More settings...

In this dialog a whole list of Print Settings are available. Depending on the active Device Type the
settings are defined automatically, whereby some will be checked by default. For some devices some
settings are not accessible (gray) and others can be (de)activated.

For Custom Proofer and Custom Imagesetter all options are available to allow specific customized
output. The options only relate to information that is written in the PS file by ArtPro, not to the part ef-
fected by the Laserwriter.

3.32.1.  More Settings: Page
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File Type is EPSF
In order to be able to place an ArtPro file in another application, e.g. QuarkXPress, the required file
type is EPSF. When this option is not checked, the file type will be TEXT, which can be opened in a text
editor.

Composite PostScript
Creates colored or composite PostScript as opposed to separated PostScript. Thus, the option is
automatically checked for Color Proofer output and also for Barco Transscript, Quark Separable EPS.

Separable Composite PostScript
In a plain PostScript file non-standard features, such as mapped TIFF, Pantone vignettes, etc.,
are not supported. With this option ArtPro can force them, thus tuning the EPS file specifically for
QuarkXPress separated output.

Make DCS Main File
Creates a job that contains only header and preview information. Thus, the resulting file is suitable e.g.
for the OPI server (see also Replace Placed ArtPro by OPI) and for archiving (visualization).

DCS Multi-file Format
This option defines the DCS file created by ArtPro, to be a multifile DCS instead of a single file format.
This option can be used if the OPI server does not handle DCS files, in combination with the “Specify
separated file in ArtPro OPI” when printing the S&R file.

Bitmap Output
This output makes it possible to proof the transparencies generated in ArtPro (see Bitmap Proofer).

The ArtPro file is calculated into image data which is sent to the proofer, preceded by a PostScript
header and followed by a PostScript footer. The image data consists of CMYK information.

Bitmap output can get quite substantial, depending completely on the output resolution and the file
size.

For placed TIFF and EPS the RGB preview is used with the following conversion RGB > CMY and Black
= 0. Better results will be obtained with Mapped TIFFs. For optimal results set the preview resolution
and steps for gradations higher.

File Extension
In the File Extension field, you can enter what extension ArtPro has to add to the file name to get
the Postscript Filename. If this field is empty, ArtPro will use its defaults (.DCS, .black, .Compos-
ite, .Separated,...).
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Add %%QRKPagebegin
This function adds a comment line in the PostScript file, needed to send to a RIP from SplashTech. In
other cases, the option should be left off.

Add %%BeginDocument: noname
Add %%BeginDocument: noname is a comment line that is always included when printing. Through the
chooser, it helps servers to understand the structure of the PS file. However, for rips from SplashTech,
this comment should be left out, by not checking the option. In all other cases, the option should be on.

Add%%BeginSetup, %%EndSetup and %%Trailer
These comment lines are included in all regular PostScript file, and thus should always be switched on.

Omit %%BeginDocument: xxx from PostScript
This option should be switched on to print to Agfa’s Process’It system. This system makes a link of a file
for imposition, but without the option on, instead of making a link per job, a link is made per separation.

Color List in Header
All separations used in the file are listed in the header. Some imposition systems require this option. It
should be activated for QuarkXPress output and when an OPI server is used.

Header Says EPSF
The first line of the PostScript file contains comment indicating that the file type is EPSF. In order to
recognize an ArtPro output file when placing it in another application, its file type needs to be EPSF.
Therefore this option has to be checked for e.g. QuarkXPress and OPI server output. It is generally not
required and sometimes not allowed for imposition programs.

Creator Says Quark
This option adds a line to the PostScript file, necessary for the Purup imposition software.

Header for Each Page in File
When printing a multipage document, each page needs to contain a header. Exceptions to this (and so
the cases where you can put the toggle off) are when sending a S&R to Creo, or when saving Postscript
from within ArtPro, without using a chooser device.

3.32.2.  More Settings: Separations
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Put Bounding Box on Job Size
Normally the bounding box dimensions of the whole file (i.e. including registration marks, bleeds, etc.)
are put in the file header.

When this option is switched on, only the trim box size is placed in the file header. This may be useful in
order to use the file in some imposition programs, like Preps.

Use SetPageDevice
SetPageDevice is very similar to SetPageParams, but for proofers. When this option is on, the
dimensions of the job or the paper can be specified in the PostScript information.

If a paper size is defined, this size will be put in the postscript file, to define what paper tray the printer
has to use.

If no Paper Size is defined, the job size is used, for example to optimize the paper feed and printing on
A0 size printers such as the HP design Jet 755.

Use SetPageParams
When Use SetPageParams is active, the page parameters are included in the PostScript output. The
SetPageParams PostScript command specifies the exact dimensions of the job, so that the output
device can optimize film usage.

In practice this means that if the device accepts these page parameters, it will only advance the film
it needs, to expose that page size on. If the device does not accept SetPageParams, it will always
advance standard page sizes, even if the job size is much smaller (e.g. a 100 x 100 mm job would then
expose on A4 size).

Although it is a typical imagesetter option, some proofers using large sizes, like the Hewlett Packard
630C and the HP 650C, need this command (or the Use Setpagedevice) as well. As it is not a standard
command in proofer output, many proofers will give an error on this command.

Alternate SetPageParams Orientation
This setting can only be used in combination with Use SetPageParams. It turns the job orientation by
90º. For some imposition programs it is required as they rotate the job automatically.

Set Linkfile Bounding Box
When printing to a Nexus (or an old PackFlow/PageFlow) RIP in order to create a Link File workflow,
this option should be activated in order to avoid rounding errors in the Link File’s bounding box. This
option is automatically checked when the device type is Nexus.

ShowPage at End
At the end of the file the ShowPage command is placed, which generates the page. This option is
activated by default for all output, except for the Linotype-Hell Delta RIP, where it is not supported.
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Separations On Multiple Pages
Creates one print job containing several pages as opposed to multiple print files.

Separations in Multiple Files
The Separations in Multiple Files button creates 1 file per separation, called name.sep. Hence, a file
with 6 separations will result in 6 output files. It could be useful for example to put the files separately
in a print queue. When it is used in combination with Make DCS Main, an additional file will be created,
called name.DCS.

All Separated Pages on Same Film
With this option on, ArtPro will put all the separations in one single page, instead of creating one page
per separation. This is used to make output of separated S&R jobs from PowerLayout. All separations,
screening commands,... are put together and output on one single film.

All on One Page
With this option, all elements are placed on the same page. Therefore, it is only used in combination
with composite postscript. The Delta Technology device however can be an exception, as you can put
the separated information on one page when sending to a Delta rip.

Page Comments
This option places information about each page in the PostScript file, in case there are several pages.
Thus, it can be useful for separated output and for tiled output.

PlateColor Comments
Each page will contain the color information of the respective page.

Omit brackets in PlateColor Comments
Some RIPS can not handle brackets around the separation name in the PlateColor comments. If this
situation occurs, this option allows you to remove the brackets.

Output 4 Separations As CMYK
As Scitex VIP users will know, VIP works with only 4 separations at a time (CMYK). If the file contains
more than 4 separations, you are forced to split up the PostScript file in groups of 4 separations.
Therefore this option has to be checked (default for Scitex VIP output) and, in addition, you have to
indicate in the Print menu which separation you want to start from with the Starting at button.

e.g. If the file contains 6 inks, you could start by printing the first 4 separations alone in one PostScript
file (= Output 4 Separations As CMYK, Starting at Cyan), and then send any additional ink as a separate
PostScript file (separation per separation).
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e.g. If the file contains 8 inks, you could send two groups of 4 inks, one starting at ink 1 and another
starting at ink 5.

When an Output 4 Separations As CMYK PostScript file is created, ArtPro writes an EPS file of the four
separations starting at the ink you defined. This PostScript file is a composite file, therefore ArtPro
suggests a .Composite extension for the PostScript file (e.g. name.composite).

Please note that a composite PostScript file cannot carry all the features you can define in ArtPro.
Some specific features which do not exist in a composite PostScript file are e.g. mapped pictures,
transparent vignettes towards images, etc. So if you do not need to use this option for APR, please use
Separated method to send to your Scitex imagesetter.

Use Separation Code of Photoshop EPS
When you placed a duotone or tritone EPS from Photoshop version 4 or older and you want to
separate it without remapping of separations, you have to check this option. If you want to remap
the separations, you will have to use files from Photoshop 5 or a more recent version, and you have to
deactivate this option. On most Postscript level 1 RIPs, this function is not supported and it is advisable
to use tiff-images that are put in the right separations in ArtPro.

3.32.3.  More Settings: Paints

Use SetOverPrint
The SetOverPrint option is only applicable to Composite output. When a color is transparent for at
least one separation, PostScript will make it transparent for all the other separations as well with the
SetOverPrint command.

For colors that must remain only partially transparent (e.g. transparent for Cyan, not for Magenta), the
SetOverPrint command is used in combination with the “Distinquish Zero and Trans” option.

Use SetCustomColor
The SetCustomColor command allows the passing of Pantone colors as Pantone colors from ArtPro
to another application. When Pantone colors are used in a vignette, however, they are converted into
CMYK. When this option is not active, all colors are converted into CMYK. Note that most proofers do
not recognize this command and will therefore give a bad result with this option.

Output separations as DeviceN
This is the option to define using the PS3 DeviceN colorspace to generate exact composite output. For
more info on this Composite L3 Proofer on page 157, and General Concepts: on page 135

Flatten Transparencies
This setting allows to flatten transparencies or not. For most devices, this option must be enabled. See
also General: Flatten on page 53
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Flatten Overprints / Opacity Channels
This setting allows to flatten overprints and opacity channels. See also General: Flatten on page 53

Custom Color Vignettes
This is to be used when sending to a Barco workstation. It allows gradations to be transferred to the
Barco. Use this toggle in combination with Gradations as Freehand.

Change PANTONE CVC into CV
The names of the Pantone inks are saved with CV appended to them instead of CVC. This can be useful
to recognize Pantone inks during conversion to other applications, e.g. QuarkXPress.

Define Illustrator Commands
At the beginning of the PostScript file the custom color and set overprint commands are defined. This
option has to be activated for some Barco TransScript output.

Only Print Traps
The Only Print Traps option, allows to print only the traps found in the file. This is an extension to the
Highlight overprint option, so that traps not only can be checked on screen, but also can be proofed.

Include Gradation Comments
This option includes a comment defining the start and end of the part of the PostScript code defining
a gradation. Gradations are replaced by images in the postscript file, and this comment makes the
difference between gradations and other images. This comment is used by Crosfield rips to handle
gradations as line art, while other images are handled as CT.

Binary Images & Gradations
Binary Data is ON by default. Images are stored in the PostScript file in Binary format. In the past
ArtPro used hexadecimal format. For images this produces twice as much PostScript information. The
option can be switched off since it is possible that certain printers and servers have problems with the
binary data.

Separate EPS images
This option activates the module that splits placed EPS images into separate grayscales, one for every
separation. In the case this process gives errors, it can be switched off, so the full EPS image is placed
in the PostScript file. At this time, no situations where errors occur are known to us.

Use Image Downsampling
When this option is switched on, all images used in the ArtPro document will output at the resolution
set in the Resolution input field. Image downsampling will be performed as exact as possible, instead
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of in powers of 2. This means that a 300 dpi image can be downsampled to exactly 115 ppi, instead
of 150 ppi or 75 ppi. Setting Image Downsampling is useful to make e.g. a quick print on a low quality
proofer.

Use Averaging when Downsampling
How images are downsampled is set by this checkbox. When this is set, all the pixels of the original
image are used to create the downsampled version, resulting in a high-quality image without visible
aliasing. Without this option, output will be faster, but the image quality will be lower. This option will
never be used for placed or mapped CCITT-images.

Gradations As FreeHand Commands
Users of Barco TransScript know that PostScript vignettes are translated into series of paths. A file
that contains this large amount of paths is very hard to edit, because every path is converted to a
separate layer. Barco solves this problem in TransScript version 4.0 by recognizing the PostScript
vignettes from Freehand 4.0 and translating them into Barco vignettes (blue lines). Normally ArtPro
converts its gradations to CTs when outputting to a PostScript device in order to avoid the typical
banding in the vignettes.

Gradations As Freehand Commands = OFF

ArtPro vignettes are converted to CTs to avoid banding. CTs can only be CMYK in PostScript : vignettes
with PANTONE® colors are converted to CMYK.

Gradations As Freehand Commands = ON

ArtPro linear and circular gradations are converted into special commands so that TransScript 4.0 can
convert them into real Barco vignettes. The special commands recognized by TransScript are those
used by Freehand 4.0 to create vignettes. Freehand only knows vignettes in CMYK or in one PANTONE
color, therefore ArtPro vignettes are replaced by more than one vignette if necessary.

Examples

• A linear or circular CMYK ArtPro vignette converts to one CMYK vignette (blue line) in the Barco file.
• A linear or circular PANTONE Color ArtPro vignette converts to one PANTONE Color vignette (blue

line) in the Barco file.
• A linear or circular CMYK + PANTONE Color ArtPro vignette converts to one CMYK and one PANTONE

Color vignette in the Barco file. Two blue lines are created in separate layers.

Remark:

• All transparent vignettes are converted to opaque on the Barco system. This means that the mask
color must be taken off manually in the Barco file.

• If two vignettes are built on top of each other, you will have to reset the upper contour for the mask
color. If the gradation was completely transparent in the ArtPro file, you will need to reset both
paths for the mask color.
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• When you create a PostScript file with this option, a few keywords are added in the PostScript
file which are not recognized by PostScript interpreters. This means that you cannot use these
PostScript files anymore in other applications.

Replace Images by pseudocolors
This option can be used when printing repetition files created by PowerOptimizer. When printing a
repetition, the original images, will be replaced by their representation color that can be chosen in the
PowerOptimizer dialog. In this way you can print very fast positioning proofs.

Image Compression
This option allows you to choose what compression will be used for images included in the PS file.
Default is As in Job, meaning that TIFFs remain TIFFs, and JPEG maintain their compression.

Other possibilities are No compression, Lossless compression (Flate), Maximum Quality JPEG, High
Quality JPEG, Medium Quality JPEG and High Compression JPEG.

3.32.4.  More Print Settings: Text

Text : Rip vectorized text as text
With this option on, text, even vectorized, will be filled as text on Nexus RIP.

Vectorize text
Before exporting, ArtPro will convert all text to paths to avoid font problems at a later stage. When
this option is switched off, the text will be in the PostScript file as real text. If text is not set to be
vectorized, it will always be embedded.

Japanese 2-byte characters are always vectorized.

Subset Embedded fonts ...
Subset Fonts defines wether fonts should be embedded as subset if only a part of the characters are
used. How much of the font characters should be used before the font is embedded completely, can be
set in the When percentage of characters used is less than field. If this value is set to 100%, a subset
will be created for every font which is not used completely.

3.32.5.  More Settings: Optimize

Split Long Paths
Level 1 PostScript can only handle paths with less than 1500 memory points. Level 2 printers are
supposed to have no limitation anymore. However, experience shows that there still is a limitation,
depending on the memory available on the printer. Testing your specific printer should show how much
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memory points per path it can actually take. A typical error message you can get sending paths with
too many points, is Limit Check Error.

By default, ArtPro splits longer paths on 10000 points to send them to the output device. Of course you
are free to set the number of points to split on, in the Long Path Limit field. If fewer splits have to be
made, the PostScript output will be somewhat faster.

Compress Paths
Reduces the path information significantly, thus creating a compact file that is three times smaller
than the normal one. As a result, ripping slows down but transferring becomes considerably faster. The
option only applies to paths. In order to reduce vignette and image data, you have to activate Binary
Images & Vignettes (see below).

Output gradations as Images
The option Output gradations as Images makes ArtPro to output all gradations using images.

Use PS forms
PSForms is a Postscript encoding, comparable to the use of subroutines. A repeated part of the file is
written as a subroutine or a PSForm, and in the full postscript file, this part can be left out and replaced
by a call for the specific PSForm. This way of output OPI has the big advantage that everything is
included within one Postscript file, and the fact that most RIPs support the use of PSForms. PSForms
is a level 2 code, and the way ArtPro uses, it requires a RIP with a hard drive, as the Form must be
written to disk. PSForms is not supported on Scitex Brisque.

Another advantage is that most advanced RIPs cache an executed PSForm, resulting in smaller ripping
times for S&R files. PSForms can always be switched on when printing S&R documents from ArtPro.

E.g. A 2.7Mb ArtPro file (Excl. placed pictures) is repeated 12 times in a document. The output
without PS Forms is 226 Mb and takes 170 seconds. The same output with PS Forms takes 15 seconds
and makes a 19 Mb file. According to the specifications on PSForms, all placed PS files inside the
PSForm must strictly follow the specs for Encapsulated Postscript Files. (See Adobe’s Postscript
Language Reference Manual p. 175 and Appendix I p. 737). PS Forms is not to be used for output to Delta
Technology or Scitex PCF, as these RIPs have a similar, but different workflow.

Use Picture Caching
When ArtPro encounters a Mapped Picture while creating a PostScript File, the mapped picture is read
from the hard disk into the random access memory (RAM) and written in the Postscript file on the fly.
After this, the picture is deleted from the RAM again. This means if you have the same picture several
times (e.g. created by automatic trapping), this picture has to be read from disk each time. With this
toggle on, each mapped picture will be kept in memory after reading, so if the same picture has to be
used again, it can be read from RAM. This will cause the creation of PostScript to be much faster e.g. if
automatic trapping is used on pictures. Of course, there must be enough RAM available to load all the
mapped pictures in memory.
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Absolute Coordinates
There are two ways to define the position of an memory point in a PS file: with coordinates out of
the 0 point of the file (ArtPro coordinates) or with coordinates out of the previous memory point
(PS coordinates). In the second case, round off errors can lead to errors in the file (> gaps between
objects). Most RIPs (like Adobe RIPs) will perform some sort of trapping, enlarging every object a little,
to make sure there are no gaps. For RIPs that don’t do this (like the Nexus RIP), absolute coordinates
can be used (from the job origin), where the round off errors are minimal.

Include White Background Paths
ArtPro writes its PostScript files from bottom to top. When creating a separated file, white contours on
the bottom are removed, assuming that the paper is white. However, in the case you are creating a DCS
to be used in other applications, these white contours can make a difference for underlying objects. In
that case, you can switch this toggle on to include all paths.

Include OPI Comments for Placed TIFF
ArtPro creates OPI comments in front of any image in the PostScript file. When you do not use OPI low
resolution images, the OPI comments are superfluous. When deactivating Include TIFF OPI Comments,
only the image itself will be included in the PostScript file, and not its OPI comment.

Cropped OPI Comments
When this toggle is on, ArtPro will place a comment in the PostScript file, so the OPI server only places
the part of the image that is actually used in the file. On some OPI servers, this causes images to shift.
Therefore, the option can be switched off.

Omit TIFF Data
When working with TIFF files, both the low resolution TIFF file and the OPI comments are included in
the PostScript output. When using OPI, the low resolution TIFF information in the PostScript file is
superfluous. When activating Omit TIFF Data, only the OPI comments are included in the PostScript
file. This makes PostScript files much smaller.

Replace Placed ArtPro by OPI
This option makes it possible to use OPI server functionality for Step & Repeat. Whereby, high
resolution image data is stored on an OPI server and a preview version is stored with the original file.
At output the OPI server automatically replaces the preview version with the high resolution data,
according to the OPI comments contained in the Step & Repeat file.

Printing from ArtPro will therefore be considerably faster, as network data transfer between the
workstation and the print spooler is reduced to a minimum.

Procedure:

Save the single job in the Print menu with the option DCS-2 and copy it onto the OPI server.

Create the Step & Repeat file of the single original ArtPro job and save it.
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Print the repetition file to Generic Imagesetter in the Print menu, with the option Replace Placed
ArtPro by OPI.

The option Creo Single Job and Creo Layout also uses this method.

Specify separated file in ArtPro OPI
With the option “Replace Placed ArtPro By OPI”, all placed ArtPro files are replaced by their DCS.
However, if you use an OPI server that does not handle DCS files, this toggle allows you to specify the
separations (.cyan, .magenta, ...) in the S&R file instead of the .DCS file.

Use Job Size in ArtPro OPI
S&R files are created using the bounding box to define the position of the placed ArtPro files. This
definition has to be adjusted to the way the DCS bounding box was created. If the DCS was created with
the “Put Bounding Box on Job Size” on, this toggle should be put on when printing the S&R file.

Use HiRes in ArtPro OPI
S&R files are created using the bounding box to define the position of the placed ArtPro files. This
definition has to be adjusted to the way the DCS bounding box was created. If the DCS was created with
the “Add %%HiResBoundingBox” on, and the OPI server recognizes that comment, this toggle should be
put on when printing the S&R file.

3.32.6.  More Settings: RIP

Nexus: NexusInclude, no PlateColor for Same Film
PlateColor is a PS command that is used when channels are mapped into another separation. This
command tells the RIP to swap channels of a mapped picture into the correct separation, though it
cannot be used for all RIPs. It is switched on by default for output to an Esko Nexus RIP.

Nexus: Write Jobticket
ArtPro can now embed jobticket information in jobs sent to the Nexus Rip. The information will be
stored as XML-tags. The typical information that is embedded in the jobticket contains separation
angles, linescreen, the dot shape that is used, screen sets used, jobsize, distortion and separations.
The jobticket information is added to the postscript output from and is copied into the linkfile by
Nexus.

Procedure to use XML jobtickets in Nexus:

• Print the ArtPro job to Nexus, with the Write Jobticket option on
• The jobticket information will be added to the postscript file in the form of XML-tags.
• When using the job in any linkfile workflow the jobticket will be copied to the linkfile eps.
• When using this linkfile in ArtPro, jobticket information can be viewed through the paintstyle dialog.

Example XML-tags:

%<aws.job.ticket>
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% <Size>

% <Vertical>243.8</Vertical>

% <Horizontal>357.2</Horizontal>

% </Size>

% <Distortion>

% <Vertical>0</Vertical>

% <Horizontal>0</Horizontal>

% </Distortion>

% <Separations>

% <Separation Name=”Cyan”/>

% <Separation Name=”Magenta”/>

% <Separation Name=”Yellow”/>

% <Separation Name=”Black”/>

% <Separation Name=”PANT146”/>

% </Separations>

% <Screenings>

% <JobScreenings Name=”Caipirinha 12x8_6.5”>

% <PSScreening Name=”Elliptical_150”>

% <DotShape> Elliptical </DotShape>

% <Frequency>150</Frequency>

% <Angles>

% <Angle Separation=”Cyan”>15</Angle>

% <Angle Separation=”Magenta”>75</Angle>

% <Angle Separation=”Yellow”>0</Angle>

% <Angle Separation=”Black”>45</Angle>

% <Angle Separation=”PANT146”>45</Angle>

% </Angles>

% </PSScreening>

% </JobScreenings>

% </Screenings>

%</aws.job.ticket>

%AWSEndXML

154



3ArtPro

Creo: Add DIG comments
DIG comments are used by Creo systems to access color and separation info for their virtual proofing
system. DIG stands for Digital Imposition Geometry and contains a number of PS comments to describe
the structure and organization of the PS output. These comments are also used to create S&R files. For
more information about the DIG options, please contact CreoScitex.

Creo: Add DIG Page Comments
These comments indicate the beginning of a new page and the number of the page in the job. For more
information about the DIG options, please contact CreoScitex.

Creo: DIG Surface Back
This comment is used to determine whether the surface of the sheet is the front or the back. Switch
the option on to define the output file as the back of the sheet, when printing to Creo systems.For more
information about the DIG options, please contact CreoScitex.

Creo: Plate select
Creo Platesetters can have different plate sizes in their feeder. In order to select the correct plate
size, the option Creo Plate Select can be switched on, adding a comment line in the PS file to select
the correct plate size. Next to the checkbox, a popup dialog is available, containing all plate sizes as
defined in the plateslist.txt file. This text file should be placed next to the ArtPro Preferences (for OS9
or earlier : in the ArtPro Extensions folder, which is in the ArtPro folder, for OSX : in Users / username /
library / preferences / ArtPro). The file should only contain the names of the plates, divided by returns.

Example of plateslist.txt file :

P750x860mm
P900x1250x0.5
K790x1030x0.3

If a file, created on e.g. another station, is opened, and the file contains a plate size, which is not
present in the plateslist file (or if there is no plateslist file present), the specific plate size will be added
to the dropdown menu in the more print settings. This plate size will be available from memory for
as long ArtPro is running. When closing ArtPro, the plate size will not be saved, and thus will not be
available when reopening ArtPro

Linotype-Hell: Add Delta S&R Comments
ArtPro adds special comments useful for Linotype-Hell Delta RIPs, so as to optimize the calculation of
objects repeated in the ArtPro file. If an object is placed several times under the same angle and with
the same scale factor, it will be calculated on the Delta RIP only once and the resulting Delta-List will be
positioned several times.
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Linotype-Hell: Use %LHCImageColor
Normally ArtPro defines mapped pictures using the PlateColor comment. However, on Linotype OPI
servers, this causes some problems. When using a Linotype OPI server, this function allows the use of
mapped pictures, without using platecolor comments.

Scitex: Distinguish Zero and Trans
You can activate this option in order to make a difference between 0% and Transparent color settings.
0% will thus be converted into 0.001% for transparent paint, so that 0% is not made transparent in the
PS file. If this option is not active, both 0% and Trans become transparent with Use SetOverPrint. The
option is only useful in combination with the Use SetOverPrint command.

Scitex: Scitex PCF generation
Switching on this option when printing enables output optimization in combination with Scitex Brisque
RIP (see p.97 for further details).

Scitex: 4 seps starting at
This option is only for Scitex VIP output. This device only takes 4 color work (composite PS). A job with
more inks, needs to be printed in groups of 4.

This option defines what separation will be used as Cyan (=first sep) of a 4 color composite file to be
send to Scitex. See Scitex VIP for more info.

Bitmap Proofer: Bitmap resolution:
This input field defines the resolution for the image data the ArtPro file will be calculated to when using
Bitmap Proofer . The ideal resolution is equal to the resolution of the proofer device you are using.
Keep in mind that doubling this resolution will quadruple the file size of the image data which is sent to
the proofer. By testing you can find out the minimum resolution which still gives a good result. As most
proofers have a resolution of 300 dpi, this is the default for this input field.

3.32.7.  More Settings: Preview

Add Preview
A preview is added to the EPS file, with the Preview Resolution defined in the Preferences dialog at
output time. The resolution can thus be adjusted, which may be interesting in particular cases. E.g.
use a higher resolution if you want to be able to position the placed EPS more accurately, use a low
resolution (36 ppi) to create a smaller output file.

Add PC Preview
With this option switched on, the preview is put in a different place in the file, so that it can also be
used on a PC.
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Mark All 100%
The Mark All 100% checkbox (found in the Preview tab) forces items with all 100% paint, to be at least
1 pixel on preview, regardless of how small they are. This makes register marks and cropmarks always
visible when generating a preview.

Do not generate mask for preview
When creating a PostScript file with a preview, this preview also contains a mask, defining where the
background should come through. Some systems, such as Mediabank, cannot handle these masks
properly. Therefore this mask should be left out, and thus this option should be activated.

3.33.  Print : Device Types

3.33.1.  Color Proofer

Color Proofer is the standard Composite PostScript output to send to PostScript proofing devices. For
a description of this type of PostScript we refer to the beginning of this chapter. The settings and the
procedure are also explained in the general part at the beginning of this chapter.

3.33.2.  Composite L3 Proofer

The Composite L3 Proofer device generates composite output, using Level 3 commands such as
deviceN and shadings. This results in correct composite output, containing all transparencies, etc.
If this composite output is handled by a RIP, capable of handling these level 3 commands, a correct
output can be achieved. Transparencies of flat colors and gradations, can be implemented using the
DeviceN command.

3.33.3.  Separated Proofer

Separated Proofer is a device to print separations on a color proofer or e.g. a LaserWriter. Although it
is sent to a Proofer, the output is separated.

3.33.4.  Bitmap Proofer

This output has been added to be able to proof the transparencies generated in ArtPro. Actually, this
device is not used so often anymore. Choose Color Proofer and switch Calculate Transparencies on
to output transparencies on any proofing device. In general, this will be faster than a bitmap proof.
Only jobs with a lot of vector data might still print faster as a bitmap picture. In this case the ArtPro
file is calculated into image data which is sent to the proofer, preceded by a PostScript header and
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followed by a PostScript footer. The image data consists of CMYK information. This output can get
quite substantial, depending completely on the output resolution and the file size.

The settings for the Bitmap is done by the Bitmap Quality, Bitmap Resolution and Bitmap Gamma
settings ( see More Settings: RIP on page 153)

Remarks on bitmap proofing:
• The size of the ArtPro file converted into the bitmap output is determined by the job size. This

implies that bleed is not included, unless you fit the job size first. This also implies that a small
object in a large job size will result in a huge output.

• The resolution of placed images is determined by their preview. Placed or mapped TIFFs are output
in the resolution with which they are previewed on screen. See Picture Display Resolution in the
Edit More Preferences dialog (p.134). EPS and DCS files are converted with their 72 dpi preview.
Placed ArtPro files are printed with the resolution their preview was saved (see Preview Resolution
on page 52). When you make a bitmap output of a Step & Repeat file, which consists of placed
ArtPro files, the output will be limited to the preview resolution defined on the moment the file was
saved (by default 72 dpi).

• With placed EPS, DCS, TIFF and ArtPro files, the four separations with the CMYK flags will be used
as CMYK. In the preview conversion of RGB to CMYK, ArtPro assumes that the first four separations
are CMYK. When the separation with the C flag is e.g. a PANTONE® color, the Cyan will be proofed in
the PANTONE color.

• The amount of RAM necessary to calculate this output is the same as the amount you need to
preview it, plus an extra ± 4 Mb. When the Bitmap Proofer output has started, the rotating ArtPro
cursor stops and starts again from time to time as ArtPro processes the file in parts of 4 Mb.

3.33.5.  Custom Proofer

Custom proofer is the output device for proofer with all settings available. If you load a setting that
was based on one of the above Proofer Devices, the device type will also be Custom Proofer, and thus,
all options will be available. The Device Name will still show the Device Type the loaded settings were
based on.

3.33.6.  Generic Imagesetter

This is the default device for the output of Separated Postscript. You can find more on Separated
Postscript and on the specific settings earlier in this chapter.

3.33.7.  Agfa

To generate output for an Agfa imagesetter, choose Agfa in the Device Type list. In the Chooser, select
the driver and the device you want to send the PostScript file to. The type of PostScript generated for
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Agfa is separated PostScript, therefore we refer to the description of the Separated Postscript in this
chapter for more information.

3.33.8.  Barco RipScript

This device type generates Separated Postscript, to be exposed through Barco Ripscript. As this is
Separated Postscript, we refer to this part earlier in this chapter.

3.33.9.  Barco TransScript

This output generates EPS files which can be sent to a Barco system, through Barco TransScript. Note
that these files are not standard EPS files, and are not to be used in applications other than Barco
TransScript.

Important for Barco users:
• The files created with this output are always saved to a hard disk. This can be the hard disk of the

Macintosh, or immediately the hard disk of the computer linked to the Barco system. When you save
immediately to the hard disk of the Barco system, a protocol running in background will make sure
that the Macintosh file can be read by the Barco system. When you save the EPS file first to the hard
disk of the Macintosh, the operator will need to copy the Macintosh EPS file to the hard disk of the
Barco system using a special program (e.g. Netcopy from Digital).

• As the PostScript file is saved to the hard disk, the easiest way to create the EPS file is by using the
Save Postscript function in the Print dialog. Save Postscript saves cleaner and shorter PostScript
as it bypasses the LaserWriter driver. Note that in a Save Postscript output, there is no font
information whatsoever, this means that the PostScript fonts must also be installed on the Barco
system. Another solution for this is converting all text in the ArtPro file to paths when you save the
EPS file.

• When the EPS file is created, please take into account the limitations of the filename on a Barco
system. A filename on a Barco system may not exceed 39 characters and does not support accents
or special characters. Two special characters which are supported are underscore ( _ ) and the
dollar-sign ($). Name the created EPS file with the sux “.EPS”, as Barco needs this extension for
conversion to its format (.GRC).

• By TransScript, the EPS file is converted into a GRC file from Barco. If necessary, CT files are built
for every contone used, and for every vignette. To be able to visualize the CT file on Barco you will
have to build a low res view file of it. Newer version of TransScript automatically build the CT files.

• Once the EPS is converted, you will need to do a “Borders Fit” on the Barco system. As the ArtPro file
is converted with standard page sizes (Page Setup). Newer TransScript versions recognize the non-
standard page size of the ArtPro file; also the borders are positioned correctly.

• When you are making your ArtPro file, take into account that it has to be sent to Barco afterwards.
Each path, or group of paths, of the ArtPro file will be transferred into a separate layer of the Barco
file. You should consider working with compounds, even if it is not necessary, to limit the number of
layers after conversion.

• The separations with CMYK flag are always converted to Cyan, Magenta, Yellow and Black (in that
order), even if they contain PANTONE® Color separations or custom colors. From the 5th separation
on, you can define PANTONE colors which will also convert as such. House inks or other custom
colors are not accepted by Barco.
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• The AW screen resolution, screen angles and dot shape are completely ignored by Barco.
• Transparencies: Barco supports only masking and non-masking layers. It does not support layers

that erase some separations and leave others unchanged. When TransScript encounters such
colors in a PostScript job, it does not convert this correctly but instead just generates non-masking
layers (= transparent). Since these colors are only rarely used, this is not often a problem.

In practice this means: try to avoid using paths which are both 0% in some colors and TRANS in other
colors.

If you have a job where these paths are used, correct them by using set operations (unite, intersect,
clip and subtract).

Working in the most common way, coloring and then spreading and choking gives no trouble in the
conversion.

One Specific option that is important for Barco output is Gradations as Freehand Commands, see
earlier in this chapter.

3.33.10.  Creo (Layout / Single Job)

These two Devices make it possible to use OPI server functionality for Step & Repeat on Creo Servers.
Whereby, high resolution image data is stored on the server and a preview version is stored with the
original file. At output the server automatically replaces the preview version with the high resolution
data, according to the OPI comments retained in the Step & Repeat file.

Printing from ArtPro will therefore be considerably faster, as network data transfer between the
workstation and the print spooler is reduced to a minimum.

Procedures:
Print the single job in the Print menu with the option Creo (Single Job) and send it through to the Creo
server.

Create the S&R file of the single original ArtPro job and save it.

Print the repetition file to Creo (Layout)
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Besides the OPI possibilities, the Creo output contains DIG comments, allowing ArtPro files to be used
in the VPS, the Creo Virtual Proofing System. Therefore, if the OPI Step & Repeat is not used, Creo
Layout should be used to enable the VPS.

3.33.11.  Crosfield

Crosfield output is based on Generic Imagesetter, but fine-tuned to make the Crosfield OPI work. The
setting Include Gradations comments allows Crosfield to put gradations (converted to CTs by ArtPro) in
the Lineart level (at high resolution), and CTs in the CT level.

3.33.12.  DCS-2 Single File / Multifile

The DCS-2 output creates a DCS file, a separated file format, including all separations, and a preview.
With Multifile, the result will be as many files as there are separations, and an additional preview file.
For Single File, everything is in a single file.

The DCS files can be used to be placed in other applications (e.g. Quark, Preps, INPosition,...), or to be
used with OPI when printing Step & Repeat files.

Hereby, high resolution image data is stored on an OPI server and a preview version is stored with the
original file. At output the OPI server automatically replaces the preview version with the high res-
olution data, according to the OPI comments contained in the Step & Repeat file.

Printing from ArtPro will therefore be considerably faster, as network data transfer between the
workstation and the print spooler is reduced to a minimum.

Procedure:
Save the single job in the Print menu with the option DCS-2 and send it through to the OPI server.

Create the Step & Repeat file of the single original ArtPro job and save it.

Print the repetition file to Generic Imagesetter in the Print menu, with the option Replace Placed
ArtPro by OPI.

3.33.13.  Delta Technology

This output device is only to be used for repetitions. For every group, a Deltalist is created. In the case
of S&R, a Deltalist will be created for a single label. The next time the same Deltalist is used, the RIP
only has to place it, resulting in a very high S&R optimization. To use this S&R optimization, the clipping
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box has to be a rectangle. For S&R Tabular, this is no problem, but nested CFF2 repetition can cause
troubles.

3.33.14.  Linotype-Hell

LinoType-Hell output is based on Generic Imagesetter. This output supports the Automatic Page
Positioning feature from Linotype-Hell.

3.33.15.  Optronics

The Optronics is the same as Generic Imagesetter output (see earlier in this chapter)

3.33.16.  Nexus

This device results in separated PostScript optimized for the Esko Nexus RIP. This device is used to
print single documents (to a lores link file) as well as S&R data with links. It is not compulsory to print
ArtPro files to Nexus, as Nexus can also use ArtPro native files.

3.33.17.  Purup

Purup is based on the Generic Imagesetter output, but fine-tuned for use with the Purup OPI system,
Imagelink, which is based on Low Resolution DCS files.

3.33.18.  Quark Separable EPS

To generate an EPS file that can be separated by Quark XPress you can choose Quark Separable EPS
as Device Type. As this is a composite output, this has some serious limitations concerning trans-
parencies. Therefore, DCS-2 is more advisable.

Why not EPS in general?
As the name shows, this output creates EPS files specifically tuned for QuarkXPress. These EPS files
might work when placed in other applications, but we cannot give any guarantees. ArtPro is able to
force lots of non-standard features in the EPS file. Think of mapped TIFF, Pantone vignettes, etc. In
a plain PostScript file these features are not supported. To be able to output this from Quark, ArtPro
tunes the EPS file specifically for the QuarkXPress application.

Important Options:
• Add Preview
• Calculate Vignettes
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Important for Quark XPress users:
• If you separate in XPress, all transparencies will be exactly as specified in ArtPro. If you do not

separate, paints will be opaque and translated into CMYK.
• The separations with the CMYK flag of the ArtPro job will always translate to Cyan, Magenta, Yellow

and Black (in that order) of the QuarkXPress file, also when they contain Pantone colors or custom
colors.

• For the additional separations: If you place an ArtPro EPS in Quark, the used separations will be
added to the color list. If you use a version before 3.3, you have to add the separations manually.
Make sure that you use exactly the same spelling as in the ArtPro file.

• Be careful to leave the Separation option off in the XPress color dialog. If not, the Pantone Colors
will be separated into their CMYK equivalent and AW transparencies cannot be guaranteed
anymore.

• For a detailed description of composite PostScript we refer to the generic proofer output.
Important is that the EPS files are copied unmodified, meaning, DCS low resolution files placed in
ArtPro are copied unmodified in the EPS file. Quark will not be able to switch the low res for the high
res separation of the DCS file. Therefore, work with TIFF pictures if you intend to send the AW file to
Quark afterwards. OPI pictures in the AP file will be replaced correctly by the RIP, even after putting
the file in Quark XPress.

• Gradations to EPS file for Quark: Linear Vertical, Linear Horizontal and Circular Gradations you
are free to convert them to CTs or not for the EPS file for Quark. (= Generate CTs for Gradations).
These gradations will only separate correctly in QuarkXPress if they contain the separations with
the CMYK flag. If these vignettes contain also Pantone Color or custom color separations, they will
not separate correctly. Multistep Gradations are always converted to CTs. They will always separate
correctly, also with Pantone color separations.

3.33.19.  Scitex Separated / VIP

The best way to send to Scitex is using separated output, as composite output has to many limitations.
The only reason to use composite (VIP) output, is for APS, Scitex OPI system, on the VIP rips, or if the
files are to be handled further on the Scitex systems.

To generate composite output for the Visionary™ Interpreter for PostScript from Scitex, choose Scitex
VIP in the Device Type list.

Scitex VIP is a computer application which converts PostScript files into the Scitex formats. The
Scitex VIP output always makes PostScript output to a file, as it is not a real device but a computer ap-
plication.

In some cases the VIP can be selected in the chooser, in other cases VIP has to be opened and the
PostScript file loaded into the VIP. This depends on the customers’ configuration. The type of Post-
Script generated for Scitex VIP is composite PostScript.

The composite output is then to be separated by the Scitex RIP. Please bare in mind that composite
PostScript is much more limited when it comes down to supporting transparencies, or not standard
ArtPro functionality like mapped pictures, etc.
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Four Separations starting at
As Scitex users will know, Scitex works with only 4 separations at a time (CMYK). If your file contains
more than 4 separations, you are obligated to split up the PostScript file in groups of 4 separations.
e.g. If your file contains 6 inks, you could start by sending the first four separations alone in one
PostScript file (= Four Separations starting at Cyan), and then sending any additional inks as a separate
PostScript file (Separation per Separation). E.g. If your file contains 8 inks, you could send two groups
of 4 inks. One group starting at ink 1 and another starting at ink 5.

When a Four Separations... PostScript file is created, ArtPro writes an EPS file of the four separations
starting at the ink you defined. This PostScript file is a composite file, therefore ArtPro suggests
a .Composite extension for the PostScript file (e.g. file.composite).

We would like to stress again that a composite PostScript file cannot carry all features you can define
in ArtPro. Some specific features which do not exist in a composite PostScript file are e.g. mapped
pictures, transparent vignettes towards images, etc. So if you do not need to use Four Separations
starting at... for the reason of APR (Automatic Picture Replacement), please use the Separated method
to send to your Scitex imagesetter.

Important remarks for Scitex users:
• Scitex is limited to handle 4 separations at the time. So never send more than 4 separations at a

time to Scitex VIP.
• If possible always send separated PostScript to the Scitex RIP. Avoid sending Composite if possible.

The only reason to use composite is to use the Scitex Automatic Picture Replacement (APR), which
can only work on composite output.

• Scitex does not treat custom colors and works only with CMYK. When you output a PostScript file
with First Four Separations starting at..., the 4 separations inside this PostScript file will always be
recognized as Cyan, Magenta, Yellow and Black, in that order. The screen angles and screen ruling
of the film depends on the VIP settings.

• Black Overprint: In the VIP settings, Black Overprint should always be off. In the VIP preference
settings, PostScript Overprint should be on. Please follow these settings, otherwise we can not
guarantee that the output will be correct.

• As mentioned before, if you ask for the VIP device, ArtPro will write composite output. This can
cause the following problems: a. If you have placed a DCS-file, the low resolution is converted
unmodified. Scitex users normally do not use DCS files but use APR from Scitex instead. APR does
not cause any problems and the low resolution file is switched for the high resolution in exposing. b.
In a composite file, transparencies are created by a set overprint command. These transparencies
are not available in contones. As vignettes are converted into contones, transparencies from
vignettes are not available. Making separated output can prevent these problems from occurring.
c. Mapped TIFF is not fully supported in a composite PostScript. If you define a TIFF channel
transparent towards a background, the TIFF will be opaque on the output.

3.33.20.  Scitex PCF (Optional)

The Scitex PCF (Packaging Control File) output is an output that enables S&R optimization on Scitex
Brisque v3.0.
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 The single file is made in ArtPro
It will be the user’s responsibility to assign the SBP_Cut and SBP_Folding separations to the right
elements in the single job if necessary. The final single job is printed using the ‘Scitex PCF’ output in
ArtPro: jobname.pcf

Single file on the Brisque
The brisque proofs the single job, generating a proof and generating a lowres file called jobname.eps.
The Brisque also creates the LW and CT and any other files it needs. This lowres EPS contains a
preview, all information concerning size and separations needed to repeat the file, and a comment
indicating it is a Scitex Lowres file. If you want to start from other EPS files, you should generate a
lowres file using the Brisque Lowres Generator, and then continue to step 3.

S&R in ArtPro
The lowres eps file is used for the repetition in ArtPro. This layout job is printed using the ‘Scitex PCF’
output in ArtPro. In this PCF file, the comments referring to the HR files on the Brisque are included.
The lowres EPS file is NOT included in this PCF file.

Output on Brisque
The Brisque interprets the layout.pcf file, and replaces the PCF comments by all other Scitex files of
the single job (LW, CT, ...).

3.33.21.  Screen

Screen output is basically the same as Generic Imagesetter. (see earlier in this chapter)

3.33.22.  Think Laboratories

This is a Generic Imagesetter output, fine-tuned for Think systems.

3.33.23.  Custom Imagesetter

Custom Imagesetter is the output device for Imagesetters with all settings available. If you load a
setting that was based on one of the above Imagesetter Devices, the device type will also be Custom
Imagesetter, and thus, all options will be available. The Device Name will still show the Device Type the
loaded settings were based on.
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3.34.  Open in Visualizer

If your ArtPro file contains ArtiosCAD info, either defined in the ArtPro file itself, or imported, you can
open the file directly in Esko Studio Visualizer. This can also be done after importing a BAG file from
Studio Toolkit For Flexibles, but the latter can not be edited in ArtPro. Open in Visualizer of course
implies that Studio Visualizer is installed on your computer. For more information on Studio Visualizer,
we refer to the Studio Visualizer documentation.

The Color Guides folder contains a specific ink book for Visualizer: Visualizer Standard Finishes. This
ink book contains a number of specific inks (metalic, fluorescent, foil, ...) that can be represented in
Visualizer with their specific characteristics.

Open in Visualizer uses separated, Normalized PDF. The “CMYK on One Page” option is used as a speed
optimization for Visualizer.

Note:  Since a temporary Normalized PDF is used for showing in Visualizer, the same
restrictions as for Exporting Normalized PDF apply. See Normalized PDF Restrictions

3.35.  Job Size...

The Job Size... dialog is used to check and modify the different dimensions of the file. 5 different job
sizes can be defined: media box, crop box, bleed box, trim box and art box. When a PDF file is exported
from ArtPro, it will also include the box information for other systems. This information can then be
used when placing the PDF or ArtPro file again, e.g. for step & repeat. The units are in mm by default.
You can change the units in the Preferences dialog box (Preferences... on page 48 Units on page 57).

 

 

Shortcut: Cmd-Shift- J, Job sizes

In the Job size menu, a list is shown, containing the 5 different borders that can be defined in
ArtPro. Next to every border type, its dimensions are shown, or the other border that is used (under
Default).The picture below helps to explain which is which:
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1. Media box: this is the page format
2. Crop box: includes the Bleed box and all cropmarks.
3. Bleed box: defines the trimmed page plus the bleed.
4. Trim box: this is the net document format.
5. Art box: the Artbox can be used to specify any section of the page.

The different sizes are saved in the ArtPro file, (e.g. for step & repeat), but also when exporting a PDF,
for use on other systems

Clicking on one of the borders, will highlight it, make it visible in the job, and its dimensions can be
changed (see below).

3.35.1.  Set to

With Set to, the selected border can be set to the same size and position as any of the other borders.
When changing the border, this size will be shown in the V. and H. fields. Each border has a different
color, set in Preferences... on page 48 Display Colors: on page 59.

3.35.2.  Change size for the selected border

A new job size can be entered in the vertical and horizontal job size fields. These fields can be filled
in manually or by choosing a predefined size from the Size drop menu (see New... on page 71). The
values are applied, when hitting the Apply button.

The square buttons will define in what direction the job size will be modified. E.g. the top left button
indicates that the top left corner of the job size will be unmodified, and all changes will be made to the
bottom and right side. By default the center button is selected, indicating that horizontal changes will
be equally divided over left and right side, and vertical changes over top and bottom. This is the same
situation as in earlier versions of ArtPro.
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Clicking on the dialog’s Resize button, adds 2 additional options to change the Job size: Dv and Dh.
These values allow the user to enter the change (vertical and horizontal) that has to be made to the job
size.

3.35.3.  Fit

By using the Fit button, it is possible to fit the job size around the shown paths in the ArtPro job. This
allows you to reduce the job size to the minimum needed to include all displayed job elements. If you
want to exclude elements for the adjustment of the job size (e.g. bleed, registration marks etc.) you can
hide those elements (see Hide on page 213). This change is executed immediately.

3.35.4.  Clipping

The Clip function in the job size window is comparable to the clip function in the arrange menu. This
function will clip the job on the active job border. It is not necessary to select any elements first. Live
text will be vectorized if it has to be clipped.

3.35.5.  Copy To All

When hitting the Copy To All button, the dimensions of the selected Job Border will be applied for all
job borders.

3.35.6.  Contextual menu

The Job Size dialog now contains a contextual menu : when control-clicking one of the borders in the
list, you can choose to “Fit on all” or “Fit on selections”

Fit on all will fit the selected border to all visible objects. This is the same as selecting the border and
clicking the “Fit” button.

Fit on Selections will fit the selected border to whatever is selected. If nothing is selected, the border
will not change.

3.35.7.  Undo Size

You can undo every change to the Page Box Sizes using the normal Undo and Redo function (Cmd-Z and
Cmd-Shift-Z), in a chronological order.

Using the Undo Size button, you can undo the last change made to the selected page box, even if other
changes were done after that. This goes only one step back. Clicking the button again will redo the
change, so you can in fact toggle back and forth between the current and previous dimensions of the
selected page box.
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3.36.  Job Info

3.36.1.  General

In the General tab of the Job Info, the version number is shown. This version is a number kept with the
ArtPro file, that increases by one every time the file is saved.

Besides the Job version number, the Job Information contains information on what ArtPro version was
used to save the file, and the size of the ArtPro file and of the ArtPro CT file.

3.36.2.  S & R

In the S & R tab, info concerning station number and trim and bleed can be attached to the single file.
When creating the nested Step & Repeat, the option Get from Single File can be used to retrieve the
info attached to the single file.

The Station Number buttons: using the Pick button you can click on any text object in the single file.
Its position, font and text size will be saved, in order to use it in the S&R file. After using Pick, the Show
button can be used to zoom in on the previously selected text item. How to use it in the S&R menu, is
explained in S&R Nested (Step & Repeat Nested...  on page 377). The values entered in Trim & Bleed
are also kept with the single file, in order to use them when making the S&R File.

 

 

Interactive Trim & Bleed
As is the case with station numbers and automatic trim & bleed, interactive trim & bleed information
may also be added to the single file. For more information on Interactive Trim see Interactive Trim on
page 381. When performing an interactive trim in either ArtPro or Nexus, this information will be used
to determine which flaps may be trimmed and which must be bled. Adding interactive trim information
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is done in the S&R tab of the Job Information dialog. The first step is to specify which areas of the job
are flaps. Pressing the ‘Specify…’ button will change the cursor in a flap drawing cursor (cross). Use this
cursor to draw boxes over the edges of all the flaps that may touch other flaps in the CAD layout. These
‘flaps’ must not be exactly aligned or have the proper dimensions, they are merely an indication of the
location of a flap. Since ‘flaps’ are ordinary ArtPro objects, they can be positioned or scaled with the
normal tools (rotation is forbidden however).

There are two kinds of flaps: flaps that must be bled and flaps that may be trimmed. The ‘Type’ radio
buttons can be used to change the type of all selected ‘flaps’. When the ‘Highlight Flaps’ checkbox is
on, all ‘flaps’ will be highlighted in the Mac OS selection color. The type of flap is indicated by an arrow:
outward pointing arrows are bleeding flaps, whereas inward pointing arrows indicate trimmable flaps.

 

 

Using interactive trim information in ArtPro
To use the flap information from the single file in an interactive trim, the ‘Get From Single File’
checkbox in the Nested S&R dialog must be set, together with the ‘Interactive’ radio button.
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Overlapping flap resolution will then use the flap information in the single file to automatically trim
the correct flap. If there is a conflict in the flap information, i.e. two overlapping flaps must both be
bled, then the user will be prompted and must interactively select the flap that should be on top (see
Resolving overlaps on page 381).

Both in Interactive as in Automatic trim, entering a value for Bleed (other than 0) will overrule the bleed
setting of the single file.

Printing and link files
Since ‘flap’ objects are transparent, they will not show up when printing the single file. When printing to
Nexus however, the flap information will be saved as XML in the resulting PostScript file (as was already
the case with station numbers and automatic trim & bleed). Link files created from this PostScript will
thus also contain the flap information, making them equally well suited for Nested S&R and interactive
trimming.

PDF files
Station number info, and trim & bleed settings set to the single file in ArtPro (using Job Info) are also
included when exporting a PDF file. This information can be used when repeating the PDF file.

Using automatic trim information
Older files that do not contain interactive trim information but instead have automatic trim information
can still be used in an interactive trim, both in ArtPro and NexusProcessor. Interactive trim flaps
will automatically be added to all four sides of the job. If the automatic trim value for a certain side
was positive, the corresponding flap will be trimmable. Otherwise, a bleeding flap will be added.
This means, the easiest way to set up workflows, is using Get from single file in combination with
Interactive. That way, single files containing interactive trim as well as those containing automatic
trim, will be processed correctly.

For less complex single files, it might be easier to define trims using automatic trim, and still get the
result as wanted.

3.36.3.  Converted Spot Colors

The “Converted Spot Colors” tab shows a list of all Equinox spot color conversions that have been
carried out for this job. This information will be stored in the ArtPro file. For more information on Equi-
nox, we refer to the Equinox documentation.

3.37.  Parameters... (ArtLink)

ArtLink is an ArtPro module for database driven page make-up, or label & packaging assembly. The
operator makes one ArtPro job (the template job) where graphic elements are linked to database
fields and uses ArtLink within ArtPro or in an ArtPro Action list on Automation Engine to make the
different versions of the series based on a database (parameters taken from the ArtPro job, an external
database file or Automation Engine Job or Product). Linking functionality is completely integrated
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throughout the program and ArtLink has only one dedicated dialog that can be found under File >
Parameters.

Note:  ArtLink only supports european languages and Japanese.

3.37.1.  Procedure to use ArtLink

1. Make a template ArtPro file as a base for all the versions or flavors you would like to create, and
define the links between the graphics and the database fields.

2. Create a database file (optionally).
3. Create the different versions by combining the template file with the database data in an

interactive way within ArtPro or by using an ArtPro Action List in Automation Engine.

Step 1: Make ArtPro template job containing links to database
Using ArtPro, you can find hotlink buttons next to the parameters that can be linked to a database file.
Select an object and click on the hotlink button next to the parameter you want to link. Create or select
a field name with a connected value in the parameters dialog which will appear, and apply or modify the
selected path to accept the modification. If you forget to apply or to modify, the path will not be linked
to the parameter.

 

 

e.g. To link the vertical size of an object to a field in the database: select the object, open the box
dialog, click on the link button next to the vertical size value. The select parameter dialog appears.
Type the name of a new parameter and press New or simply select an existing parameter. If necessary
change the assigned value to the parameter, apply or modify the change to the object in the box dialog.

One object can be linked to different parameters at a time. E.g. a bar code can be linked to a field that
defines the number of the bar code as well as a field that defines its color.

Linked parameters are supported for:

• Vertical and horizontal size for boxes, ellipses, polygons, stars and spirals.
• The color of an object in CMYK, or any form that can be looked up by a color book for flat paints,

vignettes.
• The content of a placed picture. Note that for images with a clipping path, you can only change

the content of the path, not the path itself. If a clipping path must change, you need to use EPS or
placed ArtPro pictures.

• The bar code number, bar code type, magnification and bar width reduction
• Text content can be linked within the Character Style dialog.
• The object parameters in relation to scale, rotation angle, shear and position, definable through

the Extended Align pallet. For these parameters the measure point (cfr. align pallet) is stored as
well. The position of this measure point and the ruler is important for creating the link as well as for
creating the different labels.

• Screening : All screens and screen angles can be used as ArtLink Parameter.
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• For Certified PDF : the Certified User Name
• The Ink Coverage value in its specified unit, and the Total Ink Coverage.

Step 2: prepare the Database file
After setting up the ArtPro template file, you will need to prepare the database file containing the
different parameters for the different versions. This text file can be made up in Simpletext, Word,
Excel,...

The easiest is probably to make it up in Excel. Save the document using ‘Text (Tab delimited)’. To match
the database fields with the linked parameters in the file, the database fields will need to use the same
names as defined in the parameters list of the linked ArtPro file.

ArtPro does not support real live hooks into a database yet, so you will have to write a flat text file of
the necessary records with their matching fields.

How the records and the fields are organized within the flat text file does not really matter as ArtLink
can read in many different file structures. If the parameter names are not mentioned in the file, they
should at least be put in the same order as in the file.

Step 3: create different versions by combining the linked ArtPro file with a database
file
Within ArtPro, in Draw > Parameters... you can open the 'Parameter Manager' dialog. This dialog gives
an overview of all defined links within the ArtPro file. Selecting any of the parameters allows you to
modify its name or value.

Select the database file using the 'File' button. Underneath this button, you will see the content of
the first lines in the text file containing the database records and fields. This will help you set up the
parameters in the bottom part of the dialog to match the records and the fields with the fields in the
active ArtPro template. Changing the record number, using the arrows or by keying in the number in the
field, will each time generate one of the versions. Save this newly generated version of the ArtPro file
and create another version by selecting another record. Continue as such until all files are generated.

3.37.2.  Parameter Manager dialog

Parameter List
The Parameter list on the left, contains all links that can be used in Artlink. The parameters that you
can define in the job yourself are grouped under the user header in the parameter list. Double-clicking
on one of the parameters will select the objects that are linked to it.

Under the User defined links, you can find some automatic parameters. These parameters contain
general information and are job related. The automatic parameters are:

• Job: name, version number, the used borders and their dimensions, transform (containing the last
used transform values), the ink coverage values

• Separation: the different separations from the job, and their printing method.
• Date and time: the date and time of the last modification
• Print: distortion and dotgain applied in the print window
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• PDF: distortion and dotgain applied in the Export PDF window
• Automation Engine: All relevant Automation Engine SmartNames, for documents in an Automation

Engine Job Folder or defined as Product.

The values of the automatic parameters can not be changed manually, they are always taken from the
job. They can e.g. be used to create marks-files. In the marks file you can link text lines to the job name
and the separation names, and when importing these marks into a job, the linked text will automatically
be replaced by the parameters from the new job.

When opening a dbase file on a job, there will be an indication of which user-defined parameters are
actually found in the database. This will be shown by the black link arrows next to the user parameters.

Name
contains parameter name selected in the list on the left. If the parameter name in the ArtPro template
and in the database is different, it can be modified here.

The Name can not be more than 30 characters.

Value
this field shows the value for the selected parameter and the selected record. Again, a value can easily
be changed at this point, by typing a new one and clicking on modify selected (or just pressing Tab if
Modify immediately is on)

Scale Text to Fit
When preparing an ArtLinked template or marks file, the length of the actual values is not known. This
means the text could therefore end up exceeding the text box dimensions. To prevent this, the Scale
Text to Fit option can be used.

If enabled, all text inside all of the document's text boxes containing ArtLink parameters will be resized
to fit the text box.

Resizing is done for all text in steps of 1 pt. All text within a text box will be reduced by the same
amount. If for example the text box uses 2 font sizes, 15 pt and 12 pt, and the parameter for the text in 15
pt is too wide to fit the text box and needs to be reduced to 11 pt (so by 4 pt), the text in 12 pt will also be
reduced by 4 pt, resulting in a text of 8 pt.

To ensure readability, a minimum font size of 4 pt is maintained. If the smallest font inside the text
box is already reduced to 4 pt, no further resizing is done, and a warning will be issued in the Message
Center.

The setting is stored inside the ArtPro file itself (and not in the job preferences), so it is independent of
job preferences being loaded or not.

Modify Immediately
modifies immediately the value of all paths of the ArtPro job which are linked to a parameter. When this
check box is inactive, one of the two buttons beneath can be used.
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Modify Selected
modifies the value of all selected paths within the ArtPro file which are linked to a parameter. This can
only be used when the modify immediately check box is off. When 1 specific parameter is selected,
the selected objects will only change for that parameter. When no parameter is selected, the selected
objects will be modified for all assigned parameters.

Modify All
if no parameters are selected it modifies the value of all paths of the graphics file which are linked to a
parameter. When one of the parameters is selected, it will modify the value of all the objects in the file,
linked to that parameter.

Open Dbase
allows you to select a dbase file saved in a text format.

Save user Parameters
The Save User Parameters function creates a comma separated text file of the parameters that are
created in the job, along with their current value. This text file can be used as a basis to create the
dbase file.

When holding down the Ctrl key when clicking the Save User Parameters button, the Keys and current
Values will be saved as an XML file. This NeXML file can then be used in Nexus using NeXML. See the
Nexus Manual for more info.

Delimiter
allows you to select by what character the individual cells in the dbase file are delimitered. Possible
options are semicolon, comma, tab or whitespace.

Column / Row names
With these settings, you can define if the first column or row from the database file contains the
parameter names, or already the value. If set, the first value in the column or row contains the pa-
rameter name, and thus will not be counted.

Find direction
defines if the dbase file is made up in rows or in columns.

Find key in / Find value in
allows you to define where to find the parameter names and values in the dbase. Mostly, the Key value
will be found in the first column or row, the values change for each version.
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Match Quotes, Match Brackets, Remove Quotes, Remove Whitespace
are additional controls on how the database has to be read.

New
Creates new parameter. Use the Name field to name the new parameter. It is not necessary to replace
the *** by the first value. When the database file is selected, these values will automatically change
depending on the selected record.

Delete
deletes the selected parameter.

Unlink all
Removes all existing ArtLink links.

3.37.3.  Modifying color with ArtLink

If you would like to modify the color of an object using ArtLink functionality, you have to make sure
that the color book in which the color name or number should be looked up is loaded (or saved as
a preference in the ArtPro template file) at the moment you start generating other versions. If not,
separation values of these colors are not available to the program and their screen representation will
be black.

Linking color to a separation
It is also possible to link a color for an object to a separation position. By doing so, you define the object
to have 100% for the separation at the linked position, and all others to be 0%

3.37.4.  Linking images

When linking pictures, the database should contain the path to the place of the new picture on the hard
disk. This can be done in two ways:

Absolute
For every image there is a complete description of where it can be found on disk, e.g. My Computer >
ArtLink > Images > image1.eps should be:

My computer:ArtLink:Image:Image1.eps
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Relative
The place can also be indicated in a relative way, starting from the position of the ArtPro template file,
e.g.

:Images:Image1.eps

This means that the ArtPro file is in the ArtLink folder. ArtPro starts to look for the first folder in the
path (Images) right next to the template. When defining file paths in the database, you can use ':' to
go 1 level lower in the directory tree and ':' to climb one level. The advantage of this second method is
that the complete job with images can be moved from one station/folder to another, without having to
remake the database file.

3.37.5.  Using Automation Engine parameters

You can use Automation Engine Parameters in ArtLink, if

• ArtPro is connected to the Automation Engine server. See Automation Engine on page 62

• the ArtPro file is saved in an Automation Engine job folder

• and/or the ArtPro file is defined as a Product on Automation Engine

Note:  You can not use Product Information for files that are not in an Automation Engine Job.

All relevant Automation Engine SmartNames available in Automation Engine are available in ArtPro
now.

Relevant, meaning all excluding the ones that depend on task/workflow information, like the
SmartNames in the Imposition, JDF, Step&Repeat, Stripping, Task Information, Upload Center and
Workflow Context categories.

If the ArtPro file is saved in an Automation Engine job folder, or it is defined as a Product which is linked
to an Automation Engine Job, the SmartNames from the following categories are available as ArtLink
Parameters:

• File Information
• all public Global SmartNames
• Job Information
• Job Barcodes (as mentioned in the ArtPro 12 manual)
• Job Parameters
• Miscellaneous (currently the Server name)
• Path Information

If the ArtPro file is defined as a Product (whether it is linked to an Automation Engine Job or not), the
SmartNames from these categories are available as ArtLink Parameters:

• Product Information
• Product Parameters
• Product Part Parameters

Known limitations:
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• When changing the Automation Engine parameters, the ArtLink values will only be updated when
reopening the file

• You do not see the current value in the Parameters list until you have actually ArtLinked text to the
parameter.

Note:  If you open an ArtLinked ArtPro document in older versions of ArtPro - in which some
of the automatic ArtLink parameters did not exist yet - they will be displayed as User defined
parameters there. Upon reopening the document in newer versions of ArtPro - that do know
the automatic parameters - the original parameters will be listed again

3.38.  Archive

The Archive function allows to collect all files relevant to the open ArtPro file, and copy them in a
selected Output folder.

 

 

3.38.1.  Collect From Job

Opens, or updates the list of archivable files

3.38.2.  Copy ...

When clicking the Copy... button, you will be asked to choose an output folder. All the files shown in
the Archive list are copied into the selected folder. The Copy button will only be available if the file is
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unchanged since the last time it was saved. When changes are made, the file should be saved first,
before it can be archived.

3.38.3.  Archive List

ArtPro files
the active ArtPro file and all placed ArtPro files

CT file
the CT file of the ArtPro file

Color Profiles

Miscellaneous
all EPS, PDF, CF2, ARD, BAG ... files that were imported in the file

Pictures
all placed or mapped pictures

Clicking the checkmark next to a category on or off, lets you decide if the files from that category
should be archived or not.

When selecting a specific file in the list, its path will be shown under the list.

3.38.4.  Exclude

Removes the selected file from the Archive function. Using the Exclude, you can exclude one specific
file rather than the whole category (see above)

3.38.5.  Error Log

Should an error occur during the output, ArtPro will generate a log file, containing an explanation on
the nature of the error, and a warning will appear, stating that errors were encountered, and an error
log file is created in the output folder.

Errors can be : being unable to copy, files in the output folder with same names as the ones to be
copied, etc.
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4.  Edit Menu

4.1.  Undo

 

 

Undo cancels the last function performed in the ArtPro file. The name of the function that can be
undone is shown next to Undo in the Edit menu. For path manipulations, ArtPro has several Undo levels
(up to 64,000). The default number, which can be changed in the Preferences menu (see Preferences...
on page 48), is set at 10. Keep in mind that a high number of Undo consumes memory and can slow
down the display speed. For contone manipulations with the (optional) contone module only one Undo
is possible. For Ruler and View operations there are separate undo functions.

Shortcut: Cmd-Z, undo

4.2.  Redo

 

 

Redo cancels the last Undo function performed in the ArtPro file. The name of the function that can
be redone is shown next to Redo in the Edit menu. For path manipulations, it is possible to Redo sev-
eral times, depending on the number of times Undo was used just before, with a limit as defined in the
Preferences menu (see above in Undo). For contone manipulations with the (optional) contone module
only one Redo is possible.

Any path or contone manipulation clears the redo buffer. This means that it is only possible to use Redo
immediately after using Undo.

Shortcut: Cmd-Shift-Z, redo

4.3.  Cut

Cut deletes the selected objects from the ArtPro file and places them on the clipboard. This function
is normally used in combination with Paste (see below). The position of the ruler is taken into account.
The clipboard is job related and contains not only the cut or copied objects but also the file’s color
information.
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Shortcut: Cmd-X, cut

4.4.  Copy

Copy puts a copy of the selected objects on the clipboard. The original objects are not removed from
the file. This function is normally used in conjunction with Paste (see below).

Shortcut: Cmd-C, copy

4.5.  Paste

Paste puts the clipboard objects in the active file, taking into account the position of the ruler. It is
possible to Paste the cut or copied objects into the same file or into another file. The position of the
objects is relative to the ruler. Thus, if the ruler has not been moved in the same file, the copied objects
will appear on top of the original ones.

Shortcut: Cmd-V, Paste

4.6.  Delete

Delete deletes the selected objects. When a dialog box is active or text is being edited, the backspace
key deletes the selected characters or the character before the current cursor position.

Shortcut: Backspace, delete

4.7.  Notes

The Notes... submenu provides functions to place notes on an ArtPro job. These notes can then be
saved in a separate file, this is a “note file”, or in the ArtPro file itself. Mostly these notes are created
in ArtView, an independent program that allows you to view, check and measure an ArtPro file for job
validation at a remote site. The file cannot be modified, but through the notes, the changes can be
communicated to the ArtPro operator.
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If a note file is saved in the same folder where the original ArtPro file is, the notes file will be opened
automatically when the ArtPro file is opened. Therefore, the name of the notes file should be the name
of the original ArtPro file, with “.not” attached to it.

4.7.1.  Note File

The note file is a small file that can be sent back to the production site to pass the remarks.

4.7.2.  Create Note

• activate Create Note by selecting Edit > Note > Create Note or by selecting the Note tool in the
toolbar.

• clicking in the job window will create a note

• clicking in a note will select the note and allow you to edit it.

4.7.3.  Clear

Clear deletes the active note.

4.7.4.  Clear All

Clear All deletes all the notes.

4.7.5.  Hide

Hide hides the active note.

4.7.6.  Show All

Show All shows all hidden notes.

4.7.7.  Open...

Open allows you to open a note file. The note file is positioned with its top left corner to the top left
corner of the job size. If you have changed the job size, the positioning of the notes may not be correct.
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So it is important to keep the job size of the ArtPro file unmodified, once you have created a note file on
it.

4.7.8.  Save...

Save allows you to save the note file. The dialog box that appears allows you to give a name to the note
file and decide where the computer should store it. When you use the normal Save function (Cmd - S),
the ArtPro file saves both the job and the notes.

4.8.  Color management

ColorSync is fully implemented in ArtPro. The color profiling has been implemented on 4 different
levels:

• profiling of the display (screen calibration)
• profiling of the imported pictures
• profiling of the output (proofer)
• profiling of the imported PostScript files

Currently there are three different colorspaces supported in ArtPro: CMYK, RGB, Grayscale (and
inverted grayscale).

All the color management settings have been ordered in one tabbed dialog, but they can also be
accessed by the related ArtPro dialogs.

4.8.1.  General tab

The general tab contains the settings that affect the overall behavior of the color management in
ArtPro.

Enable Color management:
Color management will only be used if this box is checked. When ArtPro can't find the necessary
system libraries for color management, this box will be disabled. So this means, if ColorSync is not
installed or when it has been disabled, you won't be able to use color management.

When this checkbox is disabled or unchecked, all the controls in the color management dialog will be
disabled, and the color conversion will be performed as in ArtPro 6.0.

Note:  Color Management calculation on images using blend modes does not make any sense.
Therefore, all Color Management calculations will make ArtPro to flatten the job first.

CMYK Working Space Profile:
The CMYK working space profile is the profile that is used for working in ArtPro. Everything that is
imported in ArtPro or exported from ArtPro passes through this colorspace. If no profile is selected,
the system default CMYK profile will be used. There are always three generic profiles shipped with
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ArtPro, in case the system default can't be retrieved. An easy way to see if an embedded profile is used
or a profile from disk, is the naming of the profile. If the embedded profile is used, only the name of the
profile will be visible in the field. If a profile from disk is used, the complete path is visible.

When you select a CMYK Working Space profile, either by browsing or by typing the path manually,
ArtPro checks if this profile really exists and if it maps to the correct colorspace.

Embed entire profiles in ArtPro file:
When saving an ArtPro job using color management, with this option active, all the profiles used
in the job will be saved completely in the job. This is useful when this job is meant to be opened on
another workstation. When the other workstation doesn't have the same color profile saved in the
Color Profiles folder, ArtPro will extract the embedded profile and use this for color conversion. The
only disadvantage is that these profiles take up quite some space in the file (this can be up to 1 MB in
size).

When you don't embed the profiles in the ArtPro file, only a reference to that file will be stored. So when
you open this job on a system on which the profile isn't stored, the profile will be discarded

New Job Uses Default Settings
If this checkbox is on, the Default settings as saved in the preferences will be used when creating a
new ArtPro file. If the setting is off, the settings as they are at the moment of creating the file, will be
used. The setting of the “New Job uses default settings” checkbox is a User Preference and not a Job
Preference. This means it will not be Opening an ArtPro file will open the Color Management settings as
saved in the file.

4.8.2.  Import PS tab

Input
On input, a color profile can be selected for RGB and for CMYK. This profile will be referred to as default
profile.

Processing
The Processing part is divided into 4 parts : CMYK Images, CMYK lineart, RGB images and RGB lineart.
For each of these parts, the user can define how ArtPro should process the colors.

For CMYK Images and lineart, there are 4 options :

No conversion means that the CMYK colors are left unchanged.

Use Default Profile makes ArtPro to use the profile defined above.

Use Embedded Profile means an embedded profile will be used. If no embedded profile is found, there
will be no conversion.

Use Embedded or Default Profile means the embedded profile will be used when present, otherwise
the default profile will be used.
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For RGB images and lineart, no conversion is not available. An option specific for RGB is Use Postscript
Conversion, meaning the conversion information stored in the PostScript File should be used. The Use
Default Profile and Use Embedded or Default Profile options as for CMYK are also available.

CMYK Lineart
In this section, some specific settings can be made on how to treat CMYK lineart.

The settings can be made for three kinds of CMYK lineart : Blacks (colors only containing black), Single
Separation (colors that consist of only one separation) or Mixed Colors (colors consisting of more than
one separation).

For each of these, you can choose to apply the profile, to preserve solids (leave the 100% values
unchanged), or to preserve all (leave everything unchanged).

4.8.3.  Place Picture tab

Images in Working Space Profile

Conversion

When a picture is placed in the ArtPro Job, and color management is enabled, ArtPro will use the
original image and its profile, to convert it once and saved to disk. This means that CM does not have
to be calculated for display, for output, etc. Another consequence, is that for every image that needs
Color Management, another, adjusted image is saved to disk. When a picture is being placed, either by
Place Picture, or when importing a PS or PDF file, the image will be converted to the working space. A
browse window will open, asking where the converted files need to be stored. By cancelling, the picture
can be placed “as is”, without any adjustment. When an ArtPro 6.5 or 7.0 file is opened, color-managed
images will be converted in the same way. If Color Management is disabled, it will be enabled and the
current working space is used. If no working space is available, the defaults will be used. Therefor, it is
advisable to select the correct working space profile in advance.

Links

The result will be that not the original image is placed, but the converted image. However, the link to
the original image and its profile, is also saved in the ArtPro file. These links can be seen and changed
in the Used Picture dialog. See Color Management on page 440

Profiles used for placing pictures:
When a picture containing no color profile is placed in ArtPro, one of the three defined color profiles
will be assigned, depending on the colorspace of the picture.

When the picture has an embedded profile:
If a color profile is embedded in the picture that is placed, it depends on the setting of the radio
buttons in the Place Picture tab.
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Use the embedded profile:

When this option is on, ArtPro will import the embedded profile and add it to the internal profile list.
This can be checked in the 'Used Pictures' dialog.

Override embedded profile:

With this option active, ArtPro will act as if no embedded profile was found.

When this is the case, or if there is really no embedded profile, two possible color profiles can be added
to the picture:

• If there is no color profile support, an empty profile is tied to the picture and color conversion
happens according the ArtPro standards.

• If the user turned color profiles off, or selected no profile, the standard system color profile for that
colorspace will be used. This is the generic CMYK profile that is installed by default in your system
folder

4.8.4.  Export / Flattener tab

When a job is exported, it is possible that you want to add a color profile in order to get the correct
colors on the final output. Especially when printing to a proofer, it can be interesting to use the press's
color profile in order to get an accurate proof. The same is true for soft proofing on screen.

Applying Color Management on images on which Blend Modes or Transparency is applied, doesn’t make
any sense, and would in fact give wrong results.

Therefor, Color Management is applied when flattening, on the flattened job. The settings are the same
as for the export.

Use Working space profile for press profile
If a job is meant to be printed on only one press, the profile for this press will typically be used as the
internal working space profile. Therefore you can check the button Use working space profile for
press profile. This will disable the profile for the press, and it will display the message: <Using Working
Space Profile>.

Proofer Color Profile
You can also specify the color profile for the proofer, as this is also taken into consideration for the
softproofing and used for converting the colors when printing the actual proof. When there is no
proofer profile selected, there will be no soft proofing nor output conversion performed on the colors.

Rendering Intent
The Rendering Intent defines the way the colors will be transformed through the colorspaces of the
output devices. For this you should take in account the purpose of output.

• default: use the default way defined in the color profile itselfperceptual: this option tries to
preserve the visual relationship between colors in a way that is perceived as natural to the human
eye, although the color values themselves may change. This rendering intent is most suitable
for photographic imagesrelative colorimetric: this rendering intent is identical to absolute
colorimetric except for the following difference: relative colorimetric compares the white point
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of the source colorspace to that of the destination colorspace and shifts all the colors ac-
cordingly. Although the perceptual rendering intent as traditionally been the most common
choice for photographic imagery, relative colorimetric can be a better choice for preserving color
relationships without sacrificing color accuracy.saturation: saturation aims to create vivid color at
the expense of accurate color. It scales the source gamut to the destination gamut, but preserves
relative saturation instead of hue. So when you scale to a smaller color gamut, the hues may shift.
This rendering intent is suitable for business graphics, where the exact relationship between colors
is not as important as having bright saturated colors.absolute colorimetric: leaves colors that fall
inside the destination gamut unchanged. This rendering intent aims to maintain color accuracy
at the expense of preserving relationships between colors. When translating to a smaller gamut,
two colors that are different in the source space may be translated into the same color in the
destination space. Absolute Colorimetric can be more accurate if the image's color profile contains
correct white point information.

Processing
The Processing section allows to set what needs to be processed.

For Images, you can set to apply all profiles, or to do no conversions.

For Line Art (Black, Single Separation and Mixed color Line art), the choice can be made to apply the
profile, to preserve solids or to preserve all.

4.8.5.  Display tab:

Soft Proof on Screen
The soft proof option will refresh the data and recalculate a new screen by mapping the colors through
the press and proofer profile before mapping to the display profile.

Note:  The RGB Preview Profile as defined on your Mac will be used.

4.8.6.  Save/Restore tab

This tab makes it possible to save and restore all the settings in the color management dialog to/from a
binary file.

Each setting has a name that is displayed in the Edit field. This name can only be modified when the
Edit button is pressed. Once this field is edited, it becomes disabled again.

In order to save the settings a name must be entered into the field. In this color settings file all the
settings are stored and all the used color profiles are completely embedded. This means that if you
want to restore the settings on another workstation, only the color settings file is needed. The only
requirement is that ColorSync is installed on the Macintosh.

The only profile that isn't included in this file, is the display profile. This is normal, as this profile differs
from user to user, and it shouldn't change once the correct calibrated profile has been set.

187



4 ArtPro

It is possible to see the used color management setting on the output. Therefor a new regmark is
created that will add the name of the current color setting between brackets to the print output.

If no color setting is loaded, nothing will be displayed on the output.

4.8.7.  Separation conversion

When we convert a color from one colorspace to another, we always start with a list of all the
separations and their presence (in %) in the current color. This list must be converted to a new list with
the same separations, or to another colorspace altogether.

As an example a conversion from CMYK (working space) to RGB for display purposes.

 

 

With color management the conversion will happen as follows:

 

 

In other words, the 4 separations marked as CMYK are converted in one chunk. In ArtPro the
separations must have the CMYK-flag in order to be considered as one of these four inks. When they
don't have the flag, they are treated as spot colors.

When converting to another colorspace, all the spot colors are converted using color management. In
the other cases the spot colors are exported as spot colors and their color value is untouched.

188



5ArtPro

5.  Object Menu

5.1.  Create Shape: general concepts

In ArtPro there are 7 tools to draw objects: box, box with special corners, ellipse, polygon, star, spiral,
arrow. Further it is also possible to draw new objects using the edit path tool (see later in this chapter).

5.1.1.  Four ways to draw

When using the draw tools, there are always 4 ways to create a new shape:

• Select the tool and click and drag in the document to draw freely.
• Define the coordinates and press create. You can enter the Top, Bottom, Left and Right coordinates

of the object. The ruler serves as a reference point for the coordinates. Positive values work
downwards and to the right of the ruler. Negative values work upwards and to the left.

• Define the vertical and horizontal size and press create. The object is created centered on the ruler.

• Make a selection first. The object information is filled into all the fields. Press create or modify the
values first and then click on create or modify. When changing the vertical and horizontal size, the
new object is created centered on the selection.

5.1.2.  Create

The Create button creates a shape with the active settings of the respective dialog.

5.1.3.  Reset

The Reset button resets changed values to the bounding box of the selected objects.

5.1.4.  Remarks

• Newly created objects can be positioned on three different levels in the file. Where the new objects
are put depends on the Insert New Objects Where? setting in the Edit Preferences dialog box. (see
Preferences... on page 48)

• When you select one or more objects, the bounding box dimensions will be displayed in the Box
dialog or in any corresponding dialog. So in order to see how big an object is, just select it and you
will be able to read its coordinates and size in the corresponding dialog.

• In any ArtPro input field you can calculate: use “+” to add, “-” to subtract, “/” to divide and “*” to
multiply. If you type in one calculation after the other, the computer will perform the calculations in
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the order they were keyed in. The accuracy of the calculation is 1/12000 inch. In case the input field
rounds off the value, the accuracy still remains 1/12000 inch (i.e. ± 0.002 mm).

• Creation info is stored for boxes, ellipses, polygons, arrows and bar codes. This means that
selecting an object will show the parameters it was created with, even if the object was moved or
rotated.

By using the Modify button, it is possible to change the values of the measured object. If the selected
object was not created in ArtPro (so no creation info is available) the bounding box will be measured
instead. The Modify button can then be used to replace the selected object by an object as defined in
the dialog. E.g. when a vectorized rectangle is selected, and the Modify button in the box dialog is used,
the vectorized rectangle will be replaced by a perfect rectangle.

5.2.  Create Shape: Box

 

 

The Box function allows the creation of rectangles or squares, manually or numerically. Box can be
activated by clicking on its toolbar icon, by clicking on the function in the Draw menu while pressing the
Alt key or by using its shortcut (Cmd-Alt-B).

When manually drawing a box, the use of the Alt key constrains this function to the creation of squares.
Using the Shift key applies magnetism, e.g. snapping to the ruler. The magnetism only works for the
end point, not the begin point.

Just click and drag in your job window in order to create a box. It will be shown during creation. If you
want to see the size of the rectangle you are drawing, open the Box dialog first (Cmd-B).

In the Box dialog you can enter the values to create a box. The Box menu can be opened by clicking on
the function in the Draw menu, by double-clicking its toolbar icon or by using its shortcut Cmd-B.

Shortcut, Cmd-B, box dialog

Shortcut, Cmd-Alt-B, Box tool

5.3.  Box with special corners

 

 

The Box with special corners function allows the creation of rectangles or squares with rounded
corners, manually or numerically. Box with special corners can be activated by opening the Box menu
and then switch to Box with special corners.

Using the Alt key constrains this function to creating squares. Using the Shift key applies magnetism
while creating a box. Pressing shift on the first click places the first point of the box on a nearby mag-
netic element. Pressing shift while dragging will try to find a magnetic element to snap to for this
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second point. Just click and drag in your job window in order to create a box. It will be shown during
creation. If you want to see the size of the rectangle you are drawing, open the Box dialog first (Cmd-B).

In the Box with special corners dialog you can enter the values to create a box. The Box with special
corners menu can be opened by opening the Box menu and then switching to Box with special corners.

5.3.1.  Defining the corner type and radius for the boxes

The type of the 4 corners and their respective vertical and horizontal radii depend on the active
settings in the Box dialog. Boxes are generated with splines. When you create boxes, a corner type and
a vertical and horizontal radius for each corner can be defined.

 

 

When a value is entered in the Vert. Radius field, the same value will be entered in the Hor. Radius field.
However, this value can be changed individually afterwards. The corner type can be set to Square,
Round, Cut or Antique (see figure in previous column). Clicking the Make Corners Equal button will
apply the shape and the radii of the first corner to all other corners

5.4.  Create Shape: Ellipse

 

 

The Ellipse function allows the creation of ellipses or circles manually or numerically. To draw an ellipse
manually, the tool can be activated by clicking on the function in the Draw menu while pressing the Alt
key, by clicking on its toolbar icon or by using its shortcut Cmd-Alt-E.

The use of the Alt key restricts this function to the creation of circles. Using the Shift key applies
magnetism while creating an ellipse. The ellipses or circles are created by clicking and dragging in the
active job window. During the process they are shown on the screen. If you want to see the size of the
ellipse you are drawing, open the Ellipse dialog first (Cmd-E). Ellipses are generated with splines.

In the Ellipse dialog you can enter the values to create an ellipse. The Ellipse menu can be activated by
clicking on the function in the Draw menu, by double-clicking its toolbar icon or by using its shortcut
Cmd-E.
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5.5.  Create Shape: Polygon / Star

 

 

The Polygon and Star function allows the creation of polygons and stars manually or numerically.
Polygon can be activated by clicking on the function in the Draw menu while pressing the OPTION key
or by its toolbar icon. By default a polygon will be created. In order to draw a star, the Star button has to
be activated in the Polygon menu.

The use of the Alt key restricts this function to the creation of regular shapes. Using the Shift key
applies magnetism while creating a shape. The shapes are created by clicking and dragging in the ac-
tive job window.

During the process they are shown on the screen. If you want to see their size while you are drawing,
open the Polygon dialog first. The shapes are generated with splines.

In the Polygon or Star dialog you can enter the values to create a polygon or a star. The Polygon menu
can be activated from the Draw menu by clicking on the Polygon function or by double-clicking its
toolbar icon.

Be aware of the fact that polygons and stars are created on the ellipse inside the defined
measurements. So the final result will have a smaller bounding box than the entered value.

5.5.1.  Number of points

Indicates how many points (and thus sides) the polygon will have or how many outward points the star
will have. The default is set on 5.

5.5.2.  Inner Radius (only for Star)

Defines the scale factor of the inner circle on which the inner star points are positioned, in relation
to the outer circle on which the star tips are described. The default is set on 38%, which results in
a “normal” star. This option is only available for the creation of Stars. A smaller number results in a
sharper star.
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5.5.3.  Phase Difference

Defines the position of the first point in percent between the first and second point of the polygon
when created with the first point top centered. This means the Phase Difference default of 0% places
the first polygon/star point top centered on its bounding box. For 100%, the first point is placed on the
second, giving the same result as a 0% Phase Difference. A Phase difference of 50% places the first
point of the polygon half way between first and second point (turning left) of the polygon created with
0% Phase difference
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5.6.  Create Shape: Spiral

 

 

The Spiral function allows the creation of spirals manually or numerically.

The resulting spiral is an open path.Spiral can be activated by clicking on the function in the Draw menu
while pressing the Alt key. The use of the Alt key restricts this function to the creation of proportion-
al spirals. Using the Shift key applies magnetism while creating a spiral. The spirals are created by
clicking and dragging in the job window. During the process they are shown on the screen. If you want
to see the size of the spiral you are drawing, open the Spiral dialog first.

In the Spiral dialog you can enter the values to create a spiral. The Spiral menu can be activated from
the Draw menu by clicking on the function.

5.6.1.  Starting Angle / Ending Angle
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Defines the position of respectively the innermost (first) and the outermost (last) point of the spiral.
The default 0% places the points top centered on the inner bounding box. Positive values will rotate
this starting position clockwise, negative values will rotate it counterclockwise.

5.6.2.  Ending Angle

Defines the position of the outermost (last) point of the spiral. The Ending Angle default of 0% places
the last point top centered on the outer bounding box. Positive values will rotate this end position
clockwise, negative values will rotate it counterclockwise.

5.6.3.  Number of revolutions

Indicates how many (full) windings the spiral makes.

The default is set on 10.

5.6.4.  Inner Radius

Defines the scale percentage of the inner circle on which the starting point is positioned, in relation to
the outer circle on which the end point is put. The default is set on 20%.

5.6.5.  Multiplication Factor

By default this option is switched off, resulting in a “linear” spiral where the distance between the
different windings is the same. Using a multiplication factor will multiply the distance between the
windings with the indicated value. This results in an “exponential” spiral. Thus, factor 2 will double the
distance for each new winding compared to the previous one. When this option is switched on, the
other parameters described above will automatically be adjusted to fit them in.

 

 

5.7.  Create Shape: Arrow
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The Arrow function allows the creation of arrows manually or numerically. Arrow can be activated by
clicking on the function in the Draw menu while pressing the Alt key.

The use of the Alt key restricts this function to the creation of vertical or horizontal arrows.

Using the Shift key applies magnetism while creating a spiral. The arrows are created according to the
settings of the options (see below) by clicking and dragging in the job window.

During the process they are shown on the screen. If you want to see the size of the arrow you are
drawing, open the Arrow dialog first.

In the Arrow dialog you can enter the values to create an arrow. The Arrow menu can be activated from
the Draw menu by clicking on the function.

5.7.1.  Arrows with distance as text

With this option on, the distance of the created arrow will be placed as text, as a part of the arrow.

5.7.2.  Text placement from user’s view

When creating an arrow with text, the text is placed according to the direction of the arrow. If this
option is on, text will always be placed upright, even if the arrow was drawn the other direction.

5.7.3.  Head / Tail
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Defines how the head / tail of the arrow should look like. Possibilities are narrow, normal and none.

5.7.4.  Text Placement

Defines if text has to be placed inside, above or below the arrow

5.7.5.  Text Alignment

Defines if text has to be aligned centered, left or right to the arrow.

5.7.6.  Text Size

The Text Size allows to define the size of the text in a percentage of the “standard” size. Entering 200%
will make the text twice as big.

5.7.7.  Size settings:

• Width : width of the arrow
• Ratio : ratio of the arrow head to the width

197



5 ArtPro

• Start v / Start h : coordinates of the first point.
• End v / End h : coordinates of the end point.
• Dist. V. / H. : distance in vertical / horizontal direction
• Distance : total distance
• Angle : Angle between start and end point.

5.8.  Arrange

5.8.1.  Bring to Front

 

 

Bring to Front places the selected objects on top of their layer. If more than one object is selected, the
relative order between the selected objects does not change. If objects are selected from different
layers, the object will each move on top of their own layer. Bring to Front can be activated by the menu
function, by its shortcut or by its toolbar button. This function can also be used to take objects out of a
group.

Shortcut: Cmd-5, Bring to Front

5.8.2.  Send to Back

 

 

Send to Back places the selected objects at the bottom of the layer. If more than one object is
selected, the relative order between them does not change. If objects are selected from different
layers, the objects will move to the bottom of their own layers. It can be activated by the menu function,
by its shortcut or by its toolbar button. This function can also be used to take objects out of a group.

Shortcut: Cmd-6, Send to Back

5.8.3.  Move Forward

Move Forward moves the selected objects one level upwards in the layer. If more than one object is
selected, the relative order between them does not change. You cannot use this function on selected
objects from different groups.

When you move a selected element forward, the element will first climb within its own group. Once it
has reached the topmost level of its group, it will automatically move into the groups parent, or outside
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its original group when there is no group higher than its own. The highest level that a selected element
can reach with Move Forward, is the top of its own layer.

Move Forward can be activated by the menu function or by clicking on the Bring to Front toolbar button
whilst holding down the option key.

5.8.4.  Move Backward

Move Backward moves the selected objects one level downwards in the layer. If more than one object
is selected, the relative order between them does not change.

When you move a selected element downwards, the element will first descend within its own group.
Once it has reached the bottommost level of its group, it will automatically move into the underlying
groups, or outside its original group when there is no group lower than its own. The lowest level that
this element can reach is the bottom of its own layer.

Move Backward can be activated by the menu function or by clicking on the Send to Back toolbar
button while holding down the option key.

5.8.5.  Sort by Size

The function Sort By Size puts the selected objects in the order they would have obtained during
vectorization, ranging from largest at the bottom to smallest one on top in a pyramid-like structure.
Using Sort by Size will not work on groups or compounds. In stead, double paths will be created!

Use this function to sort paths if you have accidentally changed their order. The Sort by size function
can also be helpful e.g. if you use the spread and choke functions not for normal trapping but for cre-
ation purposes.

5.9.  Transform

5.9.1.  Some General concepts:

The transform tools have three functions:
• selecting (if switched on in Preferences)
• moving objects
• moving the ruler (if on in Preferences)

As a selection tool, the move tool works exactly as the normal selection. To move the ruler, click on the
ruler and drag it to a new position.
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Shortcuts during transform
When using the Shift key (for magnetism) or the Alt key (for a copy) in transformations, always make
sure to click first and start dragging before pushing the shift or option key, otherwise, the cursor
changes respectively into the selection tool (-> to add objects to the current selection) or the Pan (-> to
scroll through the job).

Parameters
All the transformation tools will respond to the Path and Paint settings in the transform dialog (Cmd-
L). These parameters define on what the transformation has to have effect. The Scale Strokes setting
only effects scaling.

Ruler
Note that the result of transformations is different when the ruler is active or inactive. If the ruler is
active, it is the center point of the transformation. If the ruler is inactive, the center of the selection is
used as the center point for the transformation.

5.9.2.  Interactive Transform

 

 

The Interactive Transform tool can be found in the tool bar next to the Select tool. It is represented by
a select tool in a bounding box with handles. This object edit tool works with object handles, and can be
compared to the use of the select tool in e.g. Illustrator.

The Interactive Transform Tool can be used for 4 functions : selecting, moving, scaling and rotating.
During transformation, the Box dialog will continuously be updated, representing the bounding box of
the interactively transformed objects while dragging.

Keep in mind though that some transforms may result in losing the creator info (such as the number of
points of a star)

Selecting :
When used outside of the bounding box of a selection, the Interactive Transform tool will appear as
an arrow, and works as a regular selection tool. When selecting an object, the object handles (on every
corner, and on the centers of the bounding box sides) and the bounding box will become visible.

When holding down the shift key, the selection of the clicked object will be inversed : Clicking or
dragging around a selected object will deselect it, and vice versa. This is comparable to the regular
select tool. For more information, see Select  on page 243.
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If multiple objects are selected, the bounding box of the selection will be shown, including the handles.
In that case, all transforms will be applied to the selection, based on the bounding box of the selection.

Moving manually
• Select the objects you want to move.
• Choose Interactive Transform from the toolbar or the toolbox.
• When used inside the bounding box of a selection, but away from the handles, the Interactive

Transform tool will function as a Move tool.
• x : Using the Shift key while moving will make the paths you are moving magnetic. When moving

with shift, objects can snap to the ruler, magnetic objects and to an angle defined in Activate Angle
within the Magnetism dialog. The magnetism of the selection will be different depending on where a
group of objects is grabbed. If the group is grabbed on one of the objects, the 9 points of that object
will be magnetic. If the group is grabbed inside the bounding box of the selection, but not inside
one object in particular, the bounding box of the complete group will be magnetic. If an object is
grabbed on a path, that point on the path will be magnetic. This goes for all transformation tools.

• Alt : Pressing the Option key (= Alt) at the moment you release the mouse button, will keep the
original objects, i.e makes a COPY.

Moving using the arrow keys
• Select the objects you want to move.
• Choose Interactive Transform from the toolbar or the toolbox.
• The left or right arrow (of the keyboard) moves the selected objects horizontally over a distance

defined in the Preferences dialog in the Hor. Cursor Key Step field (see Preferences... on page
48) The up or down arrow moves the selected objects vertically over a distance defined in the
Preferences dialog in the Vert. Cursor Key Step field (See Preferences... on page 48).

• Cmd : Using the arrow keys with the Cmd button will move the selected objects over the distance
defined in the Preferences dialog, multiplied by 10 (See Preferences... on page 48)..

• Shift : Using the arrow keys simultaneously with the Shift button activates magnetism of the
selected objects to the ruler. The objects snap directly to the ruler. If the ruler is hidden (see Ruler
tool on page 523), nothing will happen. Shift-left, shift-right, shift-up and shift-down will position
the selected objects to the next magnetic point on the ruler. If there are no more magnetic points
in that direction, the paths will not move. Magnetism applies to the sides, center and corners of the
bounding box of the selection.

• Alt : Pressing the arrow keys simultaneously with the Alt button, copies the selection.
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Moving manually
When used inside the bounding box of a selection, but away from the handles, the Interactive
Transform tool will function as a Move tool. Holding down the shift key will cause magnetism towards
the ruler or other magnetic objects, holding down the option key (after starting the move) will result in
making a copy.

Scaling
When clicking and dragging exactly on top of one of the handles, the cursor changes to a double-sided
arrow, and the object can be scaled. When using one of the corner handles, the scaling is done from the
opposite corner of the bounding box (as if the ruler was placed in the opposite corner, so leaving that
opposite corner unchanged - see picture). When holding down the Shift key, the scaling will be done
proportional and relative to the center of the bounding box.

If a vertical (or horizontal) handle is used, the object will only be scaled vertically (or horizontally), based
on the other side of the bounding box, leaving the other side unchanged (see picture). When holding
down the Shift key, the scaling will be done proportional, so in that case, the scaling will not be only
vertical or horizontal. Holding down the shift key will result in proportional scaling, holding down the
option key will copy the object.

 

 

Rotating
 

 

By clicking and dragging on the outside of one of the corner handles, the cursor will change to a round -
arrow (see picture), and the object can be rotated. The center of the bounding box is always used as
center for the rotation.

Holding down the shift key will result in rotating over multiples of the constrain angle (set in
Preferences), holding down the option key will copy the object.

5.9.3.  Move tool
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The Move tool is used to move selected objects around in the document. Moving can be done by hand,
with the arrow keys, numerically or using the align dialog. Sometimes it can be useful to position the
Ruler first before executing the Move function, since the ruler can be used as a reference point or as a
magnetic object.

Shortcut: Cmd-Shift-M, Move Tool

Moving manually
• Select the objects you want to move.
• Choose Move from the Edit menu, the toolbar or the shortcut.
• Click within the bounding box of the selection and drag it to a new position.
• x : Using the Shift key while moving will make the paths you are moving magnetic. When moving

with shift, objects can snap to the ruler, magnetic objects and to an angle defined in Activate Angle
within the Magnetism dialog. The magnetism of the selection will be different depending on where a
group of objects is grabbed. If the group is grabbed on one of the objects, the 9 points of that object
will be magnetic. If the group is grabbed inside the bounding box of the selection, but not inside
one object in particular, the bounding box of the complete group will be magnetic. If an object is
grabbed on a path, that point on the path will be magnetic. This goes for all transformation tools.

• Alt : Pressing the Option key (= Alt) at the moment you release the mouse button, will keep the
original objects, i.e makes a COPY.

Moving using the arrow keys
• Select the objects you want to move.
• Choose Move from the Edit menu or activate the move tool.

• The left or right arrow (of the keyboard) moves the selected objects horizontally over a distance
defined in the Preferences dialog in the Hor. Cursor Key Step field (see Preferences... on page
48) The up or down arrow moves the selected objects vertically over a distance defined in the
Preferences dialog in the Vert. Cursor Key Step field (See Preferences... on page 48).

• Cmd : Using the arrow keys with the Cmd button will move the selected objects over the distance
defined in the Preferences dialog, multiplied by 10 (See Preferences... on page 48)..

• Shift : Using the arrow keys simultaneously with the Shift button activates magnetism of the
selected objects to the ruler. The objects snap directly to the ruler. If the ruler is hidden (see Ruler
tool on page 523), nothing will happen. Shift-left, shift-right, shift-up and shift-down will position
the selected objects to the next magnetic point on the ruler. If there are no more magnetic points
in that direction, the paths will not move. Magnetism applies to the sides, center and corners of the
bounding box of the selection.

• Alt : Pressing the arrow keys simultaneously with the Alt button, copies the selection.

Moving numerically:
See Transform... (Cmd-L) later in this chapter.
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Moving with the align functions
See Align and Extended Align later in this chapter.

(Cmd-Alt-L / Cmd-Alt-Shift-L)

5.9.4.  Move area tool

 

 

The Move Area tool is a transform tool that differs from the regular Move tool in 2 ways:

• When using the Move Area tool, it is not necessary to select the objects you want to move first, just
click inside the object and drag it to the desired position.Move Area is always magnetic to cursor
key distance.

As for the other Transform tools, holding down the option key while moving will create a copy of this
object. The magnetism with the shift key works exactly the same as for the regular move tool. This tool
is mostly used in combination with Set Grid (see Set Grid on page 424), to position jobs in a S&R.

With the Move area tool, you can also move objects using the arrow keys. This works the same way as
with the regular move tool: see Moving using the arrow keys on page 203

5.9.5.  Rotate

 

 

Rotate will rotate the selected objects to a new position in the document. Rotating can be done
manually, numerically or through the align function. This function uses the Ruler as a reference point,
when activated. The rotation works around the zero point of the Ruler, so it can be useful to position
the Ruler first before executing the Rotate function. When the Ruler is hidden, the rotation works
around the center of the bounding box of the selection.

Rotating manually
• Select the objects you want to rotate.
• Choose Rotate from the Edit menu or activate the rotation tool using the toolbar.

• Click inside the bounding box of the selected objects and drag them to their new position.Shift :
Using the Shift key while rotating forces the rotation angle to multiples of the Constrain Angle set in
the Preferences dialog (Default = 15°).Alt : Pressing the Option key (= Alt) at the moment you release
the mouse button, will keep the objects in their original position and thus make a COPY
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Rotating numerically
See Transform... later in this chapter.

Rotating with the Extended Align dialog
See Extended Align later in this chapter.

5.9.6.  Scale

 

 

Scale resizes the selected objects. Scaling can be done by hand, numerically or with the extended align
function.

Sometimes it can be useful to position the Ruler first before executing the Scale function, since the
active ruler can be used as a reference point or as a magnetic object.

When dragging closer to the zero point of the Ruler, the scale goes down. Further away from the zero
point, the scale goes up. Once past the zero point a mirror function is also performed. When the Ruler
is hidden, the Scale works from the center of the bounding box of the selected objects.

Scaling manually
• Select the objects you want to Scale.
• Choose Scale from the Edit menu or activate the scale tool in the toolbar.

• Click within the bounding box of the selected objects and drag to define their new size.
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• Shift : Using the Shift key while moving constrains the scaling to proportional sizes, i.e. Vertical and
horizontal scale factors are equal. When scaling in proportion, the objects are always mirrored both
horizontal and vertical when moving beyond the zero point.

• Alt : Pressing the Option key (= Alt) at the moment you release the mouse button, will keep the
objects at their original size and thus make a COPY.

 

 

Scaling numerically
See Transform... later in this chapter.

Scaling using the Extended Align function
See Extended Align later in this chapter.

5.9.7.  Rotate and Scale

 

 

Rotate and Scale makes it possible to manually rotate and scale the selected objects simultaneously.
The size is always changed proportionally. When the Ruler is activated, it is used as reference point.
When the ruler is hidden, the function is performed on the bounding box of the selected objects.

• Select the objects you want to Rotate and Scale.
• Activate the function in the Edit menu or through the toolbar.
• Click within the bounding box of the selected objects and drag them to their new position and size.
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• Shift: Using the Shift key forces the rotation angle to multiples of the Constrain Angle set in the Edit
Preferences dialog (Preferences... on page 48).

5.9.8.  Shear

Shear slants the selected objects along the vertical or horizontal axis. Shearing can be done by hand or
numerically.

Sometimes it can be useful to position the Ruler first before executing the Shear function, since the
active ruler can be used as a reference point. If the Ruler is hidden, the Shear works from the center of
the bounding box of the selected objects.

Shearing manually:
• Select the objects you want to Shear.
• Choose Shear from the Edit menu.

• Click within the bounding box of the selected objects and drag to define their new shape.

• The Shear function is automatically constrained to a vertical or a horizontal shear.Shift : Using the
Shift key while shearing constrains the function to the constrain angle in the Preferences dialog
(see Preferences... on page 48).Alt : Holding the Option key (= Alt) at the moment you release the
mouse button, will keep the objects at their original shape and thus make a COPY.

 

 

Shearing numerically:
See Transform... later in this chapter.
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Using the Extended Align dialog
See Extended Align later in this chapter.

5.9.9.  Mirror Vertically

Mirror Vertically mirrors the selected objects over the horizontal axis. When the Ruler is active, it is
used as a reference point and Mirror is performed over its horizontal axis. Therefore, it can be useful to
position the Ruler before executing the function.

 

 

When the Ruler is hidden (see Grids-Magnetism on p.225 or in Ruler earlier in this chapter), the Mirror
Vertically works over the horizontal center line of the bounding box of the selected objects.

Procedure:

• Select the objects you want to Mirror.
• Choose Mirror Vertically from the Edit menu.

• z : Pressing the Option key (= Alt) at the moment you release the mouse button or before you click on
the menu function, will keep the original objects and thus make a COPY.

5.9.10.  Mirror Horizontally

Mirror Horizontally mirrors the selected objects over the vertical axis.

When the Ruler is active, it is used as a reference point and Mirror is performed over its vertical axis.
Therefore, it can be useful to position the Ruler before executing the function.

When the Ruler is hidden (see Grids - Magnetism on p.225 or in Ruler earlier in this chapter), the Mirror
Horizontally works over the vertical center line of the bounding box of the selected objects.

Procedure:

• Select the objects you want to Mirror.
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• Choose Mirror Horizontally from the Edit menu.Alt : Pressing the Option key (= Alt) at the moment
you release the mouse button or before you click on the menu function, will keep the original
objects and thus make a COPY.

5.9.11.  2 Point Transform

This transform tool is a combination of move, scale and rotate, and is defined by 2 sets of 2 points.
After selecting the objects to be transformed, and selecting the 2-point transfer tool, 4 clicks are
needed. Based on the position of the points clicked, ArtPro will calculate what scaling, moving and
rotating is necessary to place point 1 onto point 2 and point 3 onto point 4. The scaling and rotation
used can be seen in the Transform dialog.

Logically, this tool will be useful to replace lineart, as in the example. It is also possible with 2 point
transform to replace pictures, e.g. when a lores scan is replaced by a hires scan, which differs in size,
resolution and rotation. This would not be possible using the Replace function in Used Pictures (see
Links on page 438). In that case one image can easily be replaced with the other, by using the 2 point
transform.

 

 

5.9.12.  Fit to borders

When applying the Fit to borders function, the selected object will be centered on the Job Size, and
scaled proportionally so that the object fits the job size either in horizontal or vertical direction, so that
the other dimension is smaller than the Job size. This means that if the objects fits the horizontal size
of the job size, the vertical size will be smaller than the job size, and vice versa. If more than one object
is selected, the same will be done based on the bounding box of the complete selection.
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5.9.13.  Scattered

The Scattered function allows to generate scatters. The function works on a single object with a flat
paint. The first two separations for which the flat paint has a non-zero and non-transparent value will
be used for generating the scatter.

In the Scattered dialog, you define the number of Vertical and horizontal steps, in both direction (up/
down and left/right). The Color Delta defines the change in color for the two separations between the
different steps. The spacing allows to define the space between the individual copies. Scattering a
square with 50% cyan and 50% magenta with the above settings, gives the result shown above.
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5.10.  Paint

5.10.1.  Modify Color

Modify Color allows you to change the screen percentages of objects with different paint styles for one
or more separations without modifying the others.

All values that are erased and left empty, will remain unchanged. A value between 0% and 100% or
trans will be applied in all selected objects for that separation. After defining Paint Style, do not press
apply or modify, but go to the Paint menu and click on Modify Color.

Modify Color can be useful for instance to add varnish or a white background ink to a finished ArtPro
job.

Modify Color does not work on live text, patterns or images.

Example: Adding Varnish to a colored ArtPro job:
Create a new separation Varnish (see Separations...  on page 470).

Select all paths where the Varnish should be applied.

Clear all fields in the Paint Style dialog.

Put 100 (%) for the Varnish Paint Style.

Press Modify Color from the Paint menu.

5.10.2.  Move Paint

Vignette and picture paints can be moved within a path. This can also be done by using the normal
transform tools, with the Path checkbox (Transform on page 199) off.

Procedure
Select one or more paths containing a gradation or a picture.

Choose Move Paint from the Paint menu.

Click and drag in the window to move the paint.

5.10.3.  Draw Gradation

With Draw Gradation you can define your own linear gradation with any length and under any angle.
Normally, linear gradations are only vertical, horizontal or circular, working on the bounding box of the
selected objects. Horizontal and vertical vignettes can be redrawn with this tool. With this tool it is also
possible to redraw circular multistep vignettes.
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Procedure
Select one or more paths which contain a normal vignette definition (vertical, horizontal or circular).

Choose Draw Gradation.

Click and drag a straight line in the window to define the new vignette. The length and the direction of
the line determine the length and the angle for the vignette.

5.11.  Lock

This function locks the selected paths. Locked paths are fixed in the job so that they cannot be
selected nor manipulated. They are still visible and can therefore be used as a reference or a guide.

Note that it will not be possible to select the full compound or group if part of it is locked. Instead,
all other objects inside the group are selected (but not the group itself). Lock can be activated in the
menu or by its shortcut.

Shortcut:Cmd-7, Lock
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5.12.  Unlock All

Unlock All releases all the locked paths. The magnetic objects that would have been locked in the
Magnetism menu (see Magnetism... on page 441) will be released as well. All the locked paths return to
their normal unlocked state. It can be activated in the menu or by its shortcut.

All unlocked elements will become selected right after unlocking.

Shortcut: Cmd-8, Unlock All

5.13.  Hide

This function hides the selected paths. Hidden paths are no longer visible and cannot be selected
nor modified. Still, they are saved with the file, so they will become visible again, when the file is next
opened, or when you make PostScript output. Hide can be activated in the menu or by its shortcut.

Note that it is not possible to select a full compound or a group if a part of it is hidden. Instead all other
objects inside the group or the compound are selected, but not the group or compound itself.

Shortcut: Cmd-3, Hide

5.14.  Show All

Show All makes all hidden paths visible again. It will deselect all paths in the current job first and then
show the hidden paths, which will come back selected. This allows you to check something and then
immediately Hide them again. It can be activated by the menu function or by its shortcut.

Shortcut: Cmd-4, Show All

5.15.  Path

5.15.1.  Join Paths

The Join Paths function joins the two nearest open points of the selected paths with a straight line.
This is repeated until no open points are left.

It can be activated in the Draw menu or by its shortcut Cmd-J.

Shortcut:

Cmd-J, Join Paths
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Joining Paths:
Select the open paths you want to join or close.

Choose Join Paths from the Draw menu or its shortcut.

5.15.2.  Unite

Unite creates the union of the selected paths. Select the necessary paths and click on Unite. You can
use elements from different layers or different groups. You cannot use individual paths inside com-
pounds. Only complete compounds are allowed.

 

 

The original paths are kept intact and the result appears as a selected path (or compound in the case of
several resulting paths) in the active (!) layer.

The position of the newly created object depends on the setting of the Create New Objects option in
Preferences - Edit. See Create New Objects on page 58

The color of the resulting object is that of the frontmost selected path.

Why?
Uniting objects is particularly useful to create varnish or white plates on packaging or labels. To make a
complete varnish, select all objects, unite and color the new path in 100% varnish and trans for all other
separations. As a separate object, the varnish is easy to spread or the other way around, a white would
be easy to choke.

Resulting paths
The result of this function will consist of splines. When live text was used, the original text will remain
unchanged, but the resulting text will be vectorized.

5.15.3.  Intersect

Intersect calculates the common part of all the selected paths. Select the necessary paths and
perform the Intersect function. You can use elements from different layers or different groups.
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You cannot use individual paths inside compounds. Only complete compounds are allowed.

The original paths are kept intact and the result appears as a selected path (or compound in the case of
several resulting paths) in the active (!) layer.

The position of the newly created object depends on the setting of the Create New Objects option in
Preferences - Edit. See Create New Objects on page 58

The color of the resulting object is that of the frontmost selected path.

Resulting paths
The result of this function will consist of splines. When live text was used, the original text will remain
unchanged. The result will be vectorized.

5.15.4.  Exclude

Exclude performs a unite minus an intersect. It calculates the areas belonging to just 1 path. Select the
necessary paths and execute the Exclude function.

 

 

You can use elements from different layers or different groups. You cannot use individual paths inside
compounds. Only complete compounds are allowed. The original paths are kept intact and the result
appears as a selected path (or compound in the case of several resulting paths) in the active (!) layer.

The position of the newly created object depends on the setting of the Create New Objects option in
Preferences - Edit. See Create New Objects on page 58

The color of the resulting object is the same as that of the frontmost selected path.
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Resulting paths
The result of this function will consist of splines. When live text was used, the original text will remain
unchanged. The result will be vectorized.

5.15.5.  Back minus Front

Back minus Front subtracts all higher selected paths from the backmost selected path. Select the
necessary paths and perform Back minus Front.

 

 

You can use elements from different layers or different groups. You cannot use individual paths inside
compounds. Only complete compounds are allowed. The original paths are kept intact and the result
appears as a selected path (or compound in the case of several resulting paths) in the active (!) layer.

The position of the newly created object depends on the setting of the Create New Objects option in
Preferences - Edit. See Create New Objects on page 58

The color of the resulting object is that of the backmost selected path.

Resulting paths
The result of this function will consist of splines. When live text was used, the original text will remain
unchanged. The result will be vectorized.

5.15.6.  Front minus Back

Front minus Back subtracts all lower selected paths from the frontmost selected path. Select the
necessary paths and execute the Front minus Back function.

 

 

You can use elements from different layers or different groups. You cannot use individual paths inside
compounds. Only complete compounds are allowed. The original paths are kept intact and the result
appears as a selected path (or compound in the case of several resulting paths) in the active (!) layer.
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The position of the newly created object depends on the setting of the Create New Objects option in
Preferences - Edit. See Create New Objects on page 58

The color of the resulting object is the same as that of the frontmost selected path.

Resulting paths
The result of this function will consist of splines. When live text was used, the original text will remain
unchanged. The result will be vectorized.

5.15.7.  Clip

Clip uses the frontmost selected path as a cutting form to adjust the shape of the underlying paths.
Any part of the underlying paths that falls outside the frontmost one will be cropped. Thus it masks out
the selected paths underneath.

 

 

The original paths are modified!

Select the necessary paths and perform the Clip function. You can use elements from different layers
or different groups. You can not use individual paths inside compounds. Only complete compounds are
allowed.

The result will be the topmost shape itself and the underlying paths adjusted to this shape. Each new
path is at the same level as the original and has the same color as the corresponding original path.

Clipping live text will result in vectorized text after clipping.

Why?
Clip is often used to clip objects that run of the bleed size of a job. Clipping can also be done through
the Job Size dialog (Job Size... on page 166), based on the correct size, without having to draw an extra
box first.

In DTP applications this is usually done by masking the background. The advantage of masking is that
the original objects can still be edited, e.g. moved around.
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With ArtPro’s clipping, you need to keep a backup copy of the original file to do this. On the other hand,
the print file from ArtPro will be more compact and cleaner, because all the redundant information, was
actually deleted from the file.

5.15.8.  Clip on Ruler

The Clip On Ruler function allows to clip all selected objects by the ruler. By selecting the appropriate
option, you can clip all selected objects to the top right, top left, bottom right or bottom left quadrant
of the ruler.

5.15.9.  Crop...

The Crop function is similar to the Trim function. It also works on placed images only and is mainly
used for S&R jobs. In this case, the entered value will make the picture boxes bigger (+) or smaller (-),
depending on the setting below. The activated square indicates in which direction the Crop has to
happen.

5.15.10.  Trim...

Trim is a function that can be used to adjust the size of placed pictures, especially in step and repeat
jobs. When you select all placed labels and enter for example, 4 mm at the top, 4 mm will be clipped of
the top of each placed picture in the selection.

This function actually works in the exact same way as automatic trimming from Step & Repeat Nested
(see Step & Repeat Nested...  on page 377).

5.15.11.  Optimize

Optimize deletes (parts of) the contours that are not needed to produce correct print output. The
function makes it possible to “clean” or flatten a file, removing all the superfluous and unnecessary
paths. For each path the program checks all the contours on top of it and decides which objects should
be cut, united or left untouched to maintain the same structure in the job.

Optimize is especially useful to eliminate unnecessary contours from an imported PostScript file, in
order to perform faster trapping, faster printing,... Keep in mind though, that the objects may be less
editable after optimization than before. (see bottom example).

Remarks
• Although only selected paths will be modified, the optimization takes into account the paths that

are not selected and the locked paths in order to calculate the new contours. Paths which are open,
hidden or deleted are not taken into account.

• Paths are united if they carry the same color information and if no other paths with a different color
are lying in between.
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• A path is cut with the contours on top of it on the condition that those contours are not completely
inside it and they do not carry any transparency significant to the underlying path.

• Paths that are completely hidden underneath other paths will be deleted.
• Text cannot be optimized, only contours can. Text is taken into account, though, during the process.

 

 

5.16.  Compound

5.16.1.  Make Compound

With Make Compound all the selected paths will become one single object. Where paths are
overlapping, a look-through window to the background is created.

As a compound is one object, it can have only one color (Paint Style), so when paths with different
colors are compounded, they will be filled with the paint style of the object at the bottom of the
selection. When making a compound of objects placed on different labels, the compound will be on the
bottom layer.

Make Compound can be activated by the menu function or by its shortcut.

Shortcut: Cmd-G, Make Compound
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Use
Every ArtPro path functions as a different object on a different level. In vectorization for instance, the
order of the paths runs from bottom/largest to top/smallest in a pyramid-like structure.

 

 

So this is particularly useful for the creation of holes in characters: both the outside and the inside of
the character should be selected and compounded to see the background through.

After making a Compound, paths are treated as one object for coloring. They are filled according to the
even-odd rule (See PostScript Language Manual, 2nd edition, page 162 for an explanation of the even-
odd rule).

Even areas actually work as holes : everything underneath is visible. A Compound is positioned in the
bottommost level of all the compounded paths. This means that the selected path can be moved out of
its compound, group or layer.

Selecting and deselecting compound paths
• (De)selecting a path belonging to a compound normally results in the (de)selection of the entire

compound.
• If you want to select one path of a compound only, remove the check next to Select Compound

Paths Entirely in the Edit Preferences dialog (see Preferences... on page 48), or use the shortcut
Cmd-Alt (see Select  on page 243).

Manipulating compounds
• Copy (or Move, Rotate, Scale or Shear with OPTION pressed) of an entire compound creates a new

independent compound in the level just above the original compound.
• Copying a part of a compound creates new paths inside the same compound.
• The Arrange commands, to change the order of objects (see Bring to Front on page 198 and

following) treat compound paths as one object.

Spreading & Choking compounds
Spread & Choke of compound paths take into account the even-odd rule: e.g. Spread, spreads outer
parts to the outside and inner parts to the inside. ArtPro will not allow spreading or choking of partially
selected elements of a compound. Intersecting paths should not be compounded. The trapping
functions (Spread & Choke) may have trouble handling them. If you insist on compounding intersecting
paths, perform a Unite afterwards. The Unite will make sure that any following trapping functions work
fine.
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Releasing paths from a compound
To remove certain paths from a compound it is not necessary to Release Compound first.

• Select the paths you want to release by removing the check next to Select Compound Paths
Entirely in the Edit Preferences dialog box. or by using the keyboard shortcut Cmd-Alt (see Group,
compound (object) and path selection on page 244).

• Make Compound, Cmd-G. A new compound is created with only the selected paths, which no longer
have any connection to the original compound

5.16.2.  Release Compound

Release Compound releases the paths of the selected compounds so that all paths return to individual
objects. When a compound is released, all the individual paths keep the color of that compound. There
is no need to release a compound in order to take paths out of an existing compound and put them
in another one. Select the necessary paths separately and just make a new compound instead (see
above). Release Compound can be activated by the menu function or by its shortcut.

Shortcut: Cmd-U, Release Compound

5.17.  Group

5.17.1.  Make Group

With Make Group all the selected paths will be grouped together. Grouping makes it easier to
manipulate paths that belong together, such as an entire logo. All the paths in a group keep their own
color and order. A group can consist of individual paths, compound paths and groups. The resulting
group is positioned on the topmost level and topmost layer of all selected objects. Make Group can
be activated by the menu function or its shortcut. If a selected object is already in a group, the group
function is not valid, and you will get a warning message. To make a group in group structure, you can
regroup (select) the highest level of groups.

Shortcut:Cmd-Shift-G, Make Group

Selecting and deselecting groups
• (De)selecting a path belonging to a group normally results in the (de)selection of the entire group.
• If you want to select one path of a group only, remove the check next to Select Groups Entirely in

the Edit Preferences dialog, or use the shortcut Cmd-Alt (See Group, compound (object) and path
selection on page 244).
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Manipulating groups
• Copy (or Move, Rotate, Scale or Shear with Alt pressed) of an entire group creates a new

independent group in the level just above the original group.
• Copy of part of a group creates new paths within the same group.
• Taking elements out of a group can be done by selecting them and using the Bring to Front or Send

to Back function.

5.17.2.  Release Group

Release Group cancels the group so that it no longer exists. When a group is released, its components
return to their normal state as path, compound or group. To release a group, it has to be selected
entirely. Release Group can be activated by the menu function or by its shortcut.

When releasing a group containing Group Transparency, a warning will be generated, saying that the
transparency will be lost when releasing the group.

Shortcut: Cmd-Shift-U, Release Group

5.18.  Opacity Mask

Opacity Mask allows to define or release an Opacity Mask. For a full explanation on Opacity Masks, see
Opacity Mask on page 489.

222



6ArtPro

6.  Text Menu

6.1.  Missing Fonts

In ArtPro it is possible to use live text or outlines. There are tools to create new text boxes or text lines
as well as tools to modify the existing text in a file.

When a document is imported it is possible to convert all text to paths or to use editable text. In the
second case it means that all fonts used in that file need to be installed on the system.

When ArtPro documents including live text are opened, by default the fonts installed on the system will
be used. If fonts are missing, it is still possible to make ArtPro use outline information, included in the
ArtPro job or directly from the hard disk.

Installing fonts is done through e.g. Adobe Type Manager (ATM), Suitcase,... Fonts could even simply
be copied in the fonts folder of the system. ArtPro supports all common font formats: Adobe Type 1,
TrueType, MultiMaster fonts.

6.1.1.  Missing fonts

Font names and font outlines are stored in the ArtPro file. This means that the names of missing fonts
are shown when opening a file. Thus a Missing Font dialog appears when you open a file if not all the
necessary fonts are present.

 

 

For every missing font, you can define the Replacement family and Replacement Type. You also have
the option to Use Contours When available. Files that are saved in version 6.0 format or later, will
always have outline information of fonts embedded in the file. When a font is missing, you can switch
this option on and press Replace. The outline information of every missing font is used from the file, all
other fonts remain editable.

When opening a file with missing fonts from older ArtPro versions, this option will automatically be
grayed out.

When clicking “Cancel”, the file will not be opened, so you can install the fonts first.
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6.2.  Text Box...

The Text Box... tab of the Text dialog defines the text box position, its size and the vertical alignment of
the text.

6.2.1.  Defining a Text Box

Text boxes can be created in a number of ways : see the Edit function further in this chapter.

In order to create a text box numerically, proceed as follows :

specify the Top and Left coordinates in relation to the zero point of the ruler

specify the size of the text box in Vertical Size (= height) and Horizontal Size (= width)

define Scaling in Vertical and Horizontal direction, angle and shearing.

choose the required Vertical Alignment (see below)

choose the required Writing direction (see below)

click Create

start typing text into the box immediately

6.2.2.  Vert. Alignment

The Vertical Alignment defines the vertical position of the text in its box. Therefore, it has no effect
when the text box was defined by just clicking a point or by dragging a horizontal line.

• Top: aligns the ascenders of the first text line to the top of the text box
• Center: aligns the text to the center of the text box.
• Bottom: aligns the baseline of the last text line to the bottom of the text box.
• Justify Lines: justifies the text in the text box, whereby the extra space is divided in between the

text lines.
• Justify Paragraph: justifies the text in the text box, whereby the extra space is divided in between

the paragraphs.
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The vertical alignment can also be specified in the Text Style dialog using the icons (see later).

6.2.3.  Writing Direction

The writing direction defines the flow of the text in its box.

This setting also has effect when the text box was defined by just clicking a point or by dragging a
horizontal line.

• Left to right: this is the default setting, where the next character appears on the right side of the
previous. The next line appears below the previous line.

• Right to left: the next character appears on the left side of the previous. The next line appears
below the previous line. This can be used e.g. for Arabic text, Hebrew,...

• Top to bottom: the next character appears below the previous. The next line appears on the left side
of the previous line. This can be used for special layout effects, or for Japanese text. When using
top to bottom, a number of other functions (underline, tabs, indent, ...) are no longer possible.

6.2.4.  Adjusting the text box position and size

select the text box you want to modify

open the Text Box... dialog : the Top, Left, Vertical Size and Horizontal Size, Vertical and Horizontal
Scale, Angle and Shear fields shows the values for the selected text box

change these parameters according to your wishes

click Apply
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6.3.  Paragraph...

The Paragraph Style tab of the Text dialog contains all the parameters related to a paragraph. Hence
all the following items are paragraph bound and can only be modified for a whole paragraph, i.e. text
blocks separated by a hard return.

6.3.1.  Leading

The Leading defines the amount of space between the lines and is by default defined in point (pt.).

6.3.2.  Auto (Leading)

With the Auto option, activated by default, the leading is set to the maximum capital height on the
line, plus the maximum descender height. When the vertical alignment is Top, the first line is on the
maximum capital height. When the vertical alignment is Bottom, the base of the last line is on the
bottom of the text box.

Note:  The capital height + the descender height is visible, when you select text partially, as the
highlighted rectangle or the size of the cursor.

6.3.3.  Par. Leading

Sets additional leading between paragraphs.

6.3.4.  Hor. Alignment

Horizontal Alignment defines the horizontal position of the text in its text box.

• Left: aligns the text to the left margin of the text box.
• Center: centers the text on the column width of the text box.
• Right: aligns the text to the right margin of the text box.
• Justify: justifies the text to the column width. The extra space is divided in between the words. The

last line of the paragraph is always aligned to the left.
• Force Justify: justifies the text to the column width. The extra space is divided in between the

words. The last line of the paragraph (or a paragraph existing of only one single line of text) is forced
to justification as well.

When setting a paragraph in Justify mode, it is possible to set hyphenation manually. If in Justify mode
a hyphen is followed by an enter (going to the next line), the line ending with a hyphen will be justified.
In case the line does not need to be justified, a space can be added after the hyphen, before hitting the
enter key.
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6.3.5.  Left / Right Margin

Sets the left /right text margin at the indicated distance from the text box.

6.3.6.  Indentation

Will indent the first line of every paragraph. The value can be positive as well as negative. See figure on
the right.

 

 

6.3.7.  Space Width

Sets the width of the space character as a percentage of the width specified for this character in the
font file.

6.3.8.  Min. Space - Max. Space

The minimum and maximum spaces, by default 66% and 200% respectively, are used for horizontal
justification. The smallest word space that can be used in justified text is the Min. Space, the largest
one is the Max. Space. They are indicated as a percentage of the normal word space. ArtPro text can
take a new line in between words or on a discrete hyphen position. (A discrete hyphen indicates the
positions on a word where hyphenation is allowed - see Typographic Codes further in this chapter).
Using the default values, this means that when justifying, the space will never be smaller than 66% of
the Space Width and will never exceed 200% of the Space Width.
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When ArtPro cannot find any breaking point on the position where these values are guaranteed, it will
take the breaking point closest to these values and use letter spacing to justify the line. In order to
avoid letter spacing, set the maximum word spacing very high.

6.3.9.  Tabs...

Four tab stops can be specified, which are automatically sorted when you enter them. Tabs only work
with left alignment, otherwise a tab functions as a normal space character. To activate a tab, press
the TAB key. The text will automatically jump to the first tabulation position to the right of the current
position. The Clear button resets all tab values to zero.

 

 

6.4.  Character...

The Character tab of the Text dialog contains all the parameters related to the actual characters.

This means that these parameters can change after any character.

6.4.1.  Font Family

In the Font Family menu a list appears of all Adobe Type One and Truetype fonts active on your
Macintosh. ArtPro needs Adobe Type Manager to use Adobe Type One fonts. The fonts are grouped by
ArtPro in font families, so third party filters,e.g. Type Reunion, are not needed. All Truetype fonts for
which an outline description exists, and PS fonts that can be rendered by ATM, are supported. Note
that this is not really correct as ATM sometimes transforms fonts to simulate italic or bold type. In this
case ArtPro, just like other programs, is not able to convert those letters to paths.

Remarks :
• Ascender and descender values, as stored in the font, are used for auto leading, for the position of

superiors and internally for indicating the selected text and the bounding box calculations. Some
fonts, however, contain obviously incorrect values. Monaco, Geneva, Chicago have values that
are too big. Apple Garamond on the other hand, has values that look more like the x height. ArtPro
cannot detect or correct these mistakes.

• If you get messages like “XYZ has no fond ?”, “Truetype font has no font resource ?” or “Font has no
width table ?” this can indicate a system memory low condition.
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• In some programs “synthetic” fonts can be used, such as Outline or Shadow. In those cases that text
will be vectorized when the PostScript file is imported.

6.4.2.  Face

The Face field gives access to the different styles or faces belonging to the same font family, that is
with the same font family name. All the faces of one particular font family are grouped together in one
pop-up. Faces can be changed in the menu or by shortcuts Ctrl-B, I (see further under Edit Text).

A font on a Macintosh can be bold, for example, in two ways :

• Font Tekton Bold with font number 200 style Roman
• Font Tekton with font number 20 style Bold.

Only in the second case, so if the style is known as Bold, the shortcut will work correctly. Nevertheless,
in the first case as well the Tekton font will be Bold.

6.4.3.  Level

• Superior: smaller text above the baseline, whereby the capital height aligns with the capital height
of the normal text

• Superscript: smaller text above baseline
• Base: normal text on the baseline
• Subscript: smaller text below the baseline

 

 

6.4.4.  Pointsize

The Pointsize field defines the type size of the characters. The default unit is pica point (pt.).The size
can be entered in another unit by typing the unit after the value. E.g. if the unit is set to pica pt, and you
enter “8 mm”, this will be recalculated to 22,77 pica pt.

6.4.5.  Hor. Scale

With the Horizontal Scale letters can be expanded or condensed. The value is expressed in % of em
(= a % of the width of the uppercase M in the active pointsize of the active font). A 100% value means
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the character will have its original width. Values bigger than 100% will expand the selected characters,
values smaller will narrow them.

6.4.6.  Tracking

The Tracking is the space between the characters, specified by default in % of em. To modify the
tracking between two characters, select only the first character.

6.4.7.  Slanting

The Slanting field defines an angle to slant the text, specified in degrees. Positive and negative angles
are allowed, which result respectively in slanting to the right and to the left. Slanting is mostly used
to generate an italic type style for a font of which you do not have the italic style. Note, however, that
slanting a type never gives the same result as the original italic style.

 

 

6.4.8.  Vert. Shift

Vert. Shift moves the baseline of the text up with a positive value or down with a negative value, by
default in pica point (pt.). It can be used to create sub- or superscript. It also works for text placed on
path.

6.4.9.  Scaled Point Size

The Scaled Point Size shows the actual point size of the text, taking all transformations into account.

If the vertical and horizontal scaling are not the same, the scaled point size will always display the
smallest size.

6.4.10.  Underline/Leadering...

In the Underline dialog you can define underlining and leadering on the selected text. Leaders are
characters, often dots or hyphens, used to lead the eye horizontally.

Underline
Activate Underline and specify the necessary parameters.
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• Position: defines the vertical position of the line. Positive values put the line above the text
baseline, negative values puts it below the text baseline.

• Width: defines the width of the line. It is placed above the position with positive values and
underneath the position with negative values.

• Dash: defines the length of the dashes for a dashed rule. If the Dash value is zero, a continuous line
is created instead.

• Gap: defines the width of the gaps between the dashes for a dashed rule. When the Gap value is
zero, a continuous line is created instead.

 

 

Leadering
• Character: defines the lead Character to be used.
• Step: defines the distance from one Character to the next.
• Select the spaces or tabulations you want to fill with leaders.
• Open the dialog and put the Leadering toggle to ON.

• Fill in the Character and the Step fields for the leader.

• Click Apply

6.5.  Text Style...

When activating Text Style, by using its shortcut Cmd-T or double clicking the text tool (T), a status bar
appears.

The status bar shows the most common text parameters and allows to change them immediately,
without having to press the Apply button.Often it is not even necessary to make a full selection.
Settings in relation to a paragraph (e.g. horizontal justification) can be changed without selecting the
whole paragraph. It is enough that a part of the paragraph is selected or that the cursor is positioned in
the paragraph.

The Status bar contains (from left to right) Font family and face, Pointsize and leading, horizontal scale
and tracking, and Horizontal and Vertical alignment.

Shortcut: Cmd-T, Text Style
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6.6.  Import Text...

With the Import Text... functionality text can be imported from any source program in Macintosh text
format, i.e. ASCI text in Mac format. DOS text can be converted into Mac text with a conversion program
(e.g. Apple File Exchange Program, MacLink).

To import text, activate the text tool, create a text area and choose Import Text... A dialog box will
appear to indicate the text file you want to import. The text will flow into the defined text area with the
parameters that were active on the moment of its creation.

6.7.  Find

Makes it possible to look for a certain character string and replace it by another. Search and replace
only works within one text box at a time. The text box needs to be edited with the Edit Text tool first.

6.7.1.  Search Next

Searches from the cursor position to the bottom of the text box for the next string matching the text in
the Search input field.

6.7.2.  Replace, then Search

Replaces the matching item and immediately searches for the next matching text string.

6.7.3.  Replace

Replaces the selected string with the text from the Replace input field.

6.7.4.  Replace All

Directly replaces all the matching text strings with the content of the Replace input field.

6.7.5.  Case Sensitive

By default ArtPro does not search case sensitive. This means that the use of uppercase or lowercase
characters is irrelevant. When the Case Sensitive box is activated, only those text items are selected
with upper- and lowercase characters written exactly like the search string.
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The following method is the safest way of searching, as you can decide for each matching text string to
replace it or not. You can also change the search or replace text in between the actions.

• Open the Search and Replace dialog.

• Type in the text you want to search for in the Search input field. You can also use Cut, Copy and
Paste from or to the text fields in the job.

• Type in the text you want to replace it with in the Replace input field.

• Put the cursor on the position where you want to start searching.Search Next looks for the first
string that matches the search field, starting from the cursor position to the bottom of the text box.
The program highlights what it has found and now you can decide to replace it or not.

• If you would like to replace the string found, click on Replace, then Search. If you do not want to
replace it, click on Search Next again, and so on.

• When no further strings are highlighted with Search Next, all the matching strings in that text box
are found.

6.8.  Reload Fonts

Makes it possible to update the font list without having to quit ArtPro. Thus, if not all the necessary
fonts are on the system, just install them and activate Reload Fonts.

Reload Fonts cannot be done while files are open. So as long as jobs are open, this function remains
grayed out.

6.9.  Font Folders...

Font Folders is a function that allows to use fonts in ArtPro, without having to activate them on the
system, through ATM or Suitcase. When a font is activated in Font Folders... but not active on the sys-
tem, a job will still open with live text. You can select several folders containing Truetype and Type 1
fonts, as well as PS Default fonts.

The Font Folders option in the text menu is similar to the font folders in the import postscript dialog.
Only at import, disk fonts are vectorized.

Before you can use these fonts in ArtPro you still have to close all jobs and Reload Fonts.

• Add: will add the font folders to the list
• Delete: will delete the selected font or font folder
• Reset: will empty the window
• PS default fonts: these are the fonts which are inside the 'PS font' folder in the ArtPro application

folder. In Import PS/PDF > Font Settings > Font Folders they are automatically included. In the
font folders you have to check them separately before you can use them. When checked, they are
automatically added to the list
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6.10.  Put Text on Path

Put Text on Path puts one selected text object on one selected open or closed path. Afterwards you
can still freely modify the text or the path (e.g. using Edit Text or Edit Path).

Select a Path. You can create a path for this function e.g. with Edit Path or you can use an existing path.

Select a line of text. If several lines of text are selected, they will be placed as a single line of text on the
path, removing all hard returns.

Choose Put Text on Path in the Text menu

6.10.1.  Remarks

• Circles or ellipses have a specific direction. The text will always come on the outside of the circle
and clockwise. Even when cut in half, the direction stays clockwise and to the outside. When you
want to put text on the inside of the circle, use the Flip Text on Path function below. (see the picture
below)
 

 

• You can define the starting point of a closed path by cutting it and joining it again with the functions
from the Object menu (see Cut Path on page 537 and following).

• You can define the alignment of the text on the path. You can align the text left, center or right on
the path. It is not possible to justify text on a path. The alignment can be set using the Paragraph
dialog, or the Text Style.

• Text and path are grouped. To select only the text or only the path, remove the check next to Select
Compound Paths Entirely in the Edit Preferences dialog or use the COMMAND-OPTION shortcut
(see Group, compound (object) and path selection on page 244). To separate the text from the path
again, use Release Path.

• When you delete the path, the text will return to its original position. To anticipate this you can
convert the text to paths before deleting the path.
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6.11.  Flip Text on Path

Allows at any time for text to be placed on the other side of a path if it was positioned there with Put
Text on Path.

6.12.  Put Text within Path

Makes it possible to put text inside a closed path. : Select the text box containing the text you want to
put in a path, create or select a closed path, and apply Put Text in Path.

 

 

6.12.1.  Remarks

• The text and the path are grouped, so normal selection will always select the path as well as
the text. To select only the path or the text, disable Select Compound Paths Entirely in the Edit
Preferences dialog or use the Cmd-CONTROL shortcut. To separate the text from the path again,
use Release Path.

• The text and its path can be modified with the functions from the Edit menu. Paths can be modified
separately with the functions from the Draw menu. Text can be modified with the text functionality.
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6.13.  Release Path

Separates text and path again after Put Text on Path or Put Text in Path.

6.14.  Reflow Text

Most applications (Quark, Illustrator, ...) apply tracking, kerning, etc. in their postscript files by splitting
the text in parts. Therefore, if you import a file, text is fragmented into small pieces or even single
characters, instead of in a single text box. Text Reflow is a function that recombines the selected text
in one text box. This recombination is complex, as it implies deriving settings like spacing, tracking,
alignment, etc.... from the distance between characters or words.

Therefore, it is possible that text shifts slightly when this function is used. But if text needs to be
modified, the only other option is to retype the whole text box and redefine the parameters.

It is advisable to use Reflow Text only on text that needs to be changed, and to select no more than
the text box that will be affected by the change. Also, it could be useful to center the ruler on the text
before reflowing. If the text shifts, it can be placed back on the center of the ruler.

6.15.  Convert to Paths

To convert text objects into paths, just select the text box with the normal selection or the text
selection and choose Convert to Paths.

By converting text into paths, colors remain unchanged and each character will be a compound to
support the “see-through” window in the holes of the characters. Within one text box, all characters
are grouped together and can be selected separately by using the compound selection (Cmd-CTRL).
Once text is converted, the paths consist of splines and can be treated as any other ArtPro path. By
converting text to paths, there will be no quality loss.

6.16.  Reset Transforms

Reset Transforms restores the selected text to its original size and orientation before transformation,
performed with the functions from the Edit menu such as Rotate, Scale, Shear,.... Only the Move
distances are kept.

6.17.  Check Outlines

Unlike most other application, ArtPro saves text in a document as ascii codes and font name, but also
the corresponding outline information.
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The Check Outlines functionality compares the outline information included in the ArtPro document
(based on the system on which the file was saved), with the result of the live text (on the actual system).

Live text consists of Ascii codes, and a font name. When this text has to be rendered (i.e. converting to
outline information), the application will use a system call to the OS (in Mac OS9 using ATM) to retrieve
the outline corresponding to the Ascii code for that specific font.

As the system calls used by OSX are different than those in OS9, this might cause a different result.

In short, problems can occur:

• when exchanging files between OS9 and OSX.
• when some older fonts are used that require ATM to work correctly
• when a font is used on 1 system, and a font with the same name is used on another system with

different character outlines for some codes (e.g. old Helvetica font without the euro sign)
• when the appearance of some characters is slightly different. This happens often with characters

as “\” and “#”.

6.17.1.  Text Checking on Open File

When an ArtPro file is opened and the Text Checking is activated in Preferences, all live text is
compared with its outlines stored in the file, when differences are detected, a warning is reported and
the Outline Checker dialog is opened with differences will be shown.

In ArtPro file of any version before 6.0, no outline info is stored. When opening such a file, no Outline
Check can be performed, and another warning is generated.

6.17.2.  Text Outline Check Dialog

The Outline Check will be opened when differences are found when opening a file (see above) , but it
can also be opened manually, in the Text menu.

The List in the top part of the dialog, contains all text elements where a difference between live text
and outlines was found. The difference margin can be set in the Preferences.

The errors are shown per text bloc, and by clicking the triangle next to it, the individual errors can be
shown.

An error or text frame can be selected by clicking on it.

Zoom
Double-clicking will zoom in on the selected error, same as clicking the Zoom button.
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The user can respond to any of these errors in two different ways:

Accept (All) Live Text
“Accept live text” means the editable text is kept, the outlines for this text are deleted and recalculated,
based on the characters and positions of the live text as shown. Accept Live Text works on the error
selected in the Text Outline Check window, on the complete text block. Accept All Live Text works on
the complete file.

In ArtPro 16.0.1 and later, you can also hold the Shift key while clicking the Accept All Live Text button.
If a file was saved in specific builds of ArtPro 16.0 (build 109-110) the text outlines may not have been
saved correctly for all characters, hence triggering a text outline check. If Accept Live Text does not
show the characters as expected, you can Undo, Recalculate and try Accept All Live Text while holding
the Shift key for an alternative calculation.

Accept (All) Outlines
“Accept outlines” means the outlines are kept and the live text is deleted. Since the outlines are just a
set of lines and curves and have neither character nor font information associated with them, the live
text cannot be recreated. So after accepting the outlines, the text is no longer editable.

Accept Live Text works on the error selected in the Text Outline Check window,, on the complete text
block. Accept All Live Text works on the complete file.

Show differences on screen
If this option is enabled, you will see the difference for the selection. The Outline Text is shown in its
normal preview color, the Live text is shown in selection color.
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Recalculate
The Recalculate button will re-evaluate all text in the ArtPro file and remove text objects that have
been altered manually (who no longer contain an error), and add entries that reappeared (e.g. after
undo-ing text corrections).

6.17.3.  S&R Files

When ArtPro files are placed in another ArtPro file (Step & Repeat), every placed file will be checked
once when the output (PS or PDF) is performed. If a text error is detected in a placed ArtPro file then a
warning will be reported, informing the user to correct the placed files. The user can choose to cancel
the current output to correct the problem or continue, ignoring the errors.
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7.  Picture Menu

7.1.  Place Picture...

With Place Picture... you can place a picture in an ArtPro job. A rectangular path is created
automatically on the 100% size of the bounding box of the placed picture. The position of the picture
depends on the ruler and the settings in the Preferences under Place Picture Using and Align Placed
Picture on. Tiffs and Jpegs are always placed as mapped image.

7.1.1.  Procedure

Clicking on Place Picture will open a dialog box to choose the picture you want to place. A rectangle will
be created, based on the size of the original image. The selected picture is applied as its Paint. For Tiff
and JPEG images, the image will be mapped. The picture will be placed in the second quadrant of the
ruler.

7.1.2.  Clipping Paths

Depending on the option Use External Clipping Path for TIFF/EPS in Preferences... on page 48,
the image will be placed in a rectangle or inside the clipping path. For TIFF images with path, the
complete original picture is put inside the object and the image can still be spread into the background
if necessary. An EPS image however, once saved with a clipping path, is always transparent in the
background and visible inside the clipping path, even when the clipping path is used. This means it
cannot be spread, only choked.

7.2.  Optimize CT

If your ArtPro document contains internal CT's (after applying PowerWarp), you can select Optimize CT
in the Picture menu.

Using Optimize CT you can remove redundant image data. It will automatically optimize the CT files
(e.g. reduce file size when a contone picture was removed), using the Contone screen reduction
preference setting. See Contone Screen Reduction on page 60

7.3.  Apply Picture

Using Apply Picture, you can apply or modify one picture to several paths individually. Apply Picture
opens a dialog to select an image. If no other image was used in that object before, this picture will be
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placed in all selected paths with default parameters (centered, 100% and not rotated or sheared). If
the paths already contained a picture, the picture you select with Apply picture will be modified, i.e.
the selected picture will be placed in the paths, using positioning and scaling of the previously placed
picture. In both cases, if the Applied picture is a Tiff or Jpeg, it will be applied as a Mapped Picture.

This function can be very useful e.g. to replace a picture by a newer (edited) version of the image. You
select all the paths containing the image, select Apply Picture, and choose the new version of the im-
age. The image will be placed in every path, keeping its original scaling and positioning, providing it
still has the same size and resolution. This function is actually very comparable to the Apply Graphics
button in Step & Repeat CFF2. (See Step & Repeat Nested...  on page 377)

7.4.  Map Pictures

It is necessary to map placed Tiff/Jpeg images for flattening. In recent ArtPro versions, most images
will already be mapped. Only old ArtPro files can still contain placed Tiff/Jpeg images.

In case the ArtPro job contains JPEG or TIFF files in a color space that can’t be mapped (RGB or LAB), a
warning will be generated, indicating how many pictures couldn’t be mapped.

7.5.  Replace Pictures

Replace Pictures is a function that originally was developed to create the Verso side of a S&R

7.5.1.  Verso

The Verso button will mirror the ruler and the selected paths horizontally. It can be used for the
creation of die-side up repetitions as opposed to normal print-side up repetitions.

If the objects does contain graphic files already, their paint will first be mirrored horizontally over its
own center and then it will be mirrored horizontally together with the die.

7.5.2.  Replace

If you click the Replace button, ArtPro will check the names of the placed pictures, searching for the
“Search” string. When found, ArtPro will replace the Search string by the “Replace” string, look for that
picture at the same location of the original picture, and when found, place it at the same position in its
path.

7.5.3.  Swap

The Swap function replaces the Search value by the Replace value, and vice versa.
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7.6.  Folder Mapping

Folder Mapping can be used if placed images are to be used from a mounted server, in order to adjust
the path. This can e.g. be very useful for ArtPro files saved by Nexus, in order to adjust the paths from
Server to the corresponding path for the client.

 

 

Folder mapping is set in a separate dialog, accessible through the “Folder Mapping” button. You can
enter multiple Folder Remap entries. An entry can be Added by setting On Server and On Client, and
click “Add”. By selecting an entry in the list and clicking the Remove button, you can delete an entry
from the list.

The mapping is defined by entering the part of the path as seen by the server (e.g.
E:Nexus_Mac:Images:) and as it should be used on the client (e.g. Nexus_Mac:Images:)
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8.  Select Menu

8.1.  Select

 

 

Select activates one object or a group of objects. The selected objects are shown in the selection color
(see Display Color for Selections in Display on page 59).

8.1.1.  Closest selection vs. Area selection

There are two main selection tools, called the Closest selection and the Area selection. The active
selection will be marked in the menu.

Closest
 

 

When ...Closest is active, the cursor changes into an arrow. When the ...Closest Select tool is active
(arrow), you can select in different ways:

• clicking on a vector of an object in the job will select one single object or the entire group this
object was grouped in, disregarding the position or layer it is on.

• dragging a selection rectangle will only select the objects which fall entirely within the selection
rectangle. If several objects are grouped together, the selection rectangle must enclose this whole
group

• When dragging a rectangle, pressing the option key allows to rotate the selection rectangle. While
the option key is pressed, you can rotate the rectangle, and you can scale it, but only proportional.
When releasing the option key, the rotation is kept, and you can again scale freely

Shortcut: Cmd, closest select

Area
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When ...Area is active, the cursor changes into an arrow with a “o” next to it. When the ...Area Select
tool is active (arrow with o), you can select in different ways:

• clicking inside a closed object will select that object. Only the object on top can be selected, not the
ones behind it. Groups are ignored by this selection.

• clicking and dragging gives you a lasso selection, meaning that every object that is fully enclosed in
this random selection shape will be selected. This tool is very useful, because not all elements can
be selected in an easy way with a selection rectangle. When the selection shape is not complete,
ArtPro will automatically connect the start with end point.

Shortcut: Cmd-Alt-Ctrl, Area select

8.1.2.  Group, compound (object) and path selection

Apart from the closest and area selection, there are three main selection tools: the group, compound
and path selection. The group selection is the default selection tool. This default can be changed in the
Preferences (see Preferences... on page 48).

Group selection
• This selection is the same as the default closest selection tool (black arrow).
• Selects the group you click on, or which falls completely in the selection rectangle. When a group

contains other groups, the top (largest) group is selected. When the paths do not belong to a group,
the group selection selects complete compounds. When the paths do not belong to a compound,
the group selection selects paths instead.

Shortcut: Cmd, group selection

Compound selection
• This selection is represented by a black arrow with a plus.
• This selection ignores groups. So it selects the compound or the path you click on, or which falls

completely in the rectangle. Compounds have priority over paths.
• this option allows the selection of elements inside a group.

Shortcut : Cmd-CTRL, compound selection

Path selection
• represented by a black arrow with a minus.
• This selection ignores both groups and compounds, so it selects the path you click on, or which falls

completely in the selection rectangle.
• this selection selects the paths within a compound or group.
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Shortcut : Cmd-Alt, path selection

8.1.3.  Climbing in the selection

The Compound or Path Selection methods will allow you to climb in the selection. This means that
clicking again on the path you just selected will select one level higher. The selection climbs from path
to compound, to group, next group level, until you reach the complete layer. Area selection does not
climb at all.

8.1.4.  Shift key

Using the Shift key while selecting inverts the selection of the objects. A deselected object is selected
and vice versa. E.g. to hide all objects except one object, there are different ways:

1. select that one object
2. press Shift and drag a selection rectangle around the entire job
3. hide

or

1. select all
2. press Shift and click on that one object to deselect it
3. hide

8.1.5.  Locked & Hidden Paths

When a group or compound contains hidden or locked elements, only the elements that are not hidden
or locked can be selected.

Be aware that when you click on a group with the closest group selection, the system tries to select all
elements out of the group (or compound), but all hidden and locked paths will not be selected. When
a group or a compound contains one or more locked or hidden elements, the climbing in the Closest
selection will not work.

Path Selection Compound Se-
lection

Group Selection
(default)

Area Selection

Lowest Level Middle level Highest level Area level

CLICK (click on
one path)

Selects 1 path Selects 1 com-
pound or 1 path (if
it does not belong
to a compound)

Selects the top-
most group or the
topmost com-
pound or a path

Selects the com-
pound or the path
of the area you
click in.

RECTANGLE (Drag
rectangle)

Selects all paths
completely in the
rectangle

Selects all paths
and compounds

Selects all single
paths and single
compounds of the
topmost group

Selects paths in-
side the lasso
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Path Selection Compound Se-
lection

Group Selection
(default)

Area Selection

completely in the
rectangle

completely in the
rectangle

Click on a select-
ed object to climb.
Climbing is inac-
tive when object
contains hidden or
locked paths

will climb one lev-
el and select com-
plete compound or
group or layer

will climb one lev-
el and select com-
plete group or
layer

Does not climb does not climb

Shortcut : Cmd-Alt Cmd-Ctrl Cmd Cmd-Alt-Ctrl

8.2.  Select All

Select All selects all objects in the document, except for the locked or hidden objects. When you are
editing a text box or a text line, all the text in that box or line will be selected.

Shortcut: Cmd-A, Select all

8.3.  Deselect All

Deselect All deselects all objects or the selected text at once.

Shortcut: Cmd-Shift-A, deselect all

8.4.  Select Inverse

Select Inverse deselects all selected objects and selects the unselected objects.

Shortcut: Cmd-Alt-A, Select Inverse

8.5.  Select Same Paint

Select Same Paint selects all the paths that are colored with the active Paint Style. Each time a path is
selected by clicking on it, its filling is shown in the Paint Style dialog. Select same Paint works on flat
colors and vignettes, not images and patterns.

Text will only be selected by Select same Paint, if the complete text box is in the specified color. If a
text box contains different colors, it cannot be selected by Select same Paint

Shortcut: Cmd-Alt-i Select by Paint
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8.6.  Select Same screen

This function is comparable to Select Same Paint. When choosing this option, every object in the
document that has the same screening as set in Paint Style at that moment, will be selected. In combi-
nation with Modify Screen, this option is useful to find and change screening on several different
objects.

8.7.  Select All Text

Makes it possible to select all the text at once in an ArtPro job.

8.8.  Select All Traps

When using PowerTrapper, Instant Trapper or Automatic Trapper, all trapping elements are tagged
internally. When choosing Select AllTraps, all these elements are selected automatically. This could
be useful to remove old trapping from a document and redo it with different settings. To remove only
some of the traps, hide the rest first.

8.9.  Select by Attributes...

The Select by Attributes function allows you to select or deselect objects, based on a number of
criteria. When using the Select button, the objects matching the criteria, will be added to the selection.
Nothing will be deselected before the select function is used.

When using the Deselect button, all objects matching the criteria will be deselected.

When using the Collect button, a Collection will be made of all the objects in the document that match
the criteria that are currently selected. See Collection on page 432

8.9.1.  Select Within Current Selection

If this option is on, clicking the “Select” button will search for the objects that match the defined
criteria inside the current selection. Objects that don’t match these criteria will be deselected. Clicking
the “Deselect” button will deselect the objects inside the selection that match the defined criteria.
Objects that don’t match these criteria will remain selected.

8.9.2.  Paint
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Paint Style
Selects all objects filled with the paint styles selected in the list. Note that one or more paint styles can
be selected.

Image Type
Selects all placed files of the file type defined in the list : Jpeg, ArtPro files, EPS, Tiff, Tiff/IT, Internal
CT, PDF, DCS or PSD.

Image Color
Selects all images in the file, based on the setting of the dropdown menu. Choices are : CMYK, RGB,
Grayscale, B/W (Black and white one bit images), iCT (ArtColor images) or All.

Current Color
The “Current Color” option allows to select or deselect objects with the same paint style as the current
paint. The margin allows to define how exact the paint should match. A 0% margin searches for an
exact match.

Registration color
Select Registration colors, i.e. all objects with the Registration flag switched on. For more info on
Registration Color, see Paint Style... on page 452, Registration on page 453.

Registration color Candidates
This option allows to select all objects for which the Registration flag might need to be switched on. It
will search for flat paint objects, with the Registration flag switched off, and having the same value for
every separation (except for all 0% or all Trans). For more info on Registration Color, see Paint Style...
on page 452, Registration on page 453..

8.9.3.  Transparency

Blend Mode
Selects all objects containing the defined blendmode. When selecting “All”, all objects with a
blendmode other than “Normal” (i.e. no blendmode) will be selected. When choosing “Non-Separable”,
all objects using a “non-separable” blendmode (Hue, Saturation, Color or Luminosity) will be selected.
When selecting “Normal”, all objects without a blendmode will be selected. For more on Blend Modes,
see Blend Modes on page 480.
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Opacity
Selects all objects with an opacity higher, lower than or exactly the set value. Regular objects will have
an opacity of 100%. To select all “non-normal” objects, set the parameters to “At most 99.9 %”. For more
on Opacity, see Opacity on page 488

Soft Masks
Selects all objects containing a soft mask, including internal CT’s using an opacity channel. For more
info on soft masks, see Opacity Mask on page 222.

Objects with Transparency
Selects all objects containing any Transparency, i.e. containing at least one of the folowing properties :

• a blend mode other than “normal”
• an opacity lower than 100%
• a soft mask
• a internal CT opacity channel

Be careful : a normal object in a group with a transparency setting applied to it (in the Group Paint tab),
will not be selected. Use the next option to also include these objects.

Groups with Transparency
Selects all Groups containing any Transparency,i.e. containing at least one of the folowing properties :

• a blend mode other than “normal”
• an opacity lower than 100%
• a soft mask

Select both objects and groups with transparency to check if your job contains any PDF 1.4
Transparencies.

Overprints
Selects all objects containing overprints, represented as “trans” values in the paint style.

8.9.4.  Objects

Link
Select all objects containing a link for ArtLink.

Text
Select all text, or text smaller or bigger than the entered pointsize.
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Strokes
Select all strokes, or strokes smaller/bigger than the value.

Paths
Select paths with a diameter smaller/bigger than the value.

CAD Lines
Select CAD lines. You can select all CAD lines, or only the lines of a specific line type.

Traps
Selects all traps, created by PowerTrapper, Instant Trapper or Automatic Trapper. After editing a trap,
it is no longer recognized as a trap, and thus not selected.

Bar codes
Selects all Bar codes, containing bar code information. With some transforms (e.g. unproportional
scaling), an invalid bar code is created. A warning will be given when transforming, and the bar code will
no longer be selected with this function.

Open Paths
Selects all open paths.

Slices
Selects all Slices in the ArtPro file.

Blends
Selects all blends in the ArtPro file

Thin Part Fixes
Selects all fixes generated by the Thin Part function. See Thin Parts on page 415

Font Name
Selects all text items or text blocks containing the font entered in the input field. A text item containing
more than one font, will be selected completely if the entered font is used.
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Object Name
You can select objects (or groups) based on their object (or group) name. The search is case sensitive,
and you can select based on an exact match using “is”, or a partial match, using “contains”. See also
Named groups and objects on page 437

8.10.  Deselect Even Areas

Deselect Even Areas assigns numbers to all the selected paths according to the level they are on (from
back to front) and deselects the paths with an even number.

This leaves the paths selected that have to be colored after a scan (in a black and white job for
instance). The deselected paths are the ones that may remain white after a scan.

 

 

8.10.1.  Procedure

Vectorize a TIFF file and clean the paths.

Select All paths

Activate Deselect Even Areas.

Enter a color in the Paint Style dialog (usually 100% black).

Click Apply.

If you want to give another color to the white paths, drag a rectangle around all the paths with the
SHIFT key pressed. This will invert the selection, leaving the paths you have just colored deselected
and the uncolored ones selected

8.11.  Select Closest / Select Area

See Closest selection vs. Area selection on page 243
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9.  Prepress Menu

9.1.  Screening

ArtPro applies screening on an object base, not on a document base. This means that in theory each
object can have a different screening. As the screening, meaning the dots themselves, is not visible in
the job window, there are two functions within the Paint menu that can help you to select and to modify
only the screening from selected paths, Modify Screen and Select by Screen. For every object, you can
set what screen type should be used.

Screening can be defined for each object in the single document or for each placed picture in a S&R
job, When defining screening in a S&R job, all screening in the single file is overwritten. To avoid this,
leave the Screen setting in Object Parameters empty for every placed ArtPro file.

9.1.1.  Windows > Screens

In the Screens window, which can be opened by choosing Window > Screens, you can see the names
of all screens and the indication of whether or not the screen is used in the document . You can
doubleclick a screen name to select all objects using the selected screen. See Screens on page 469

9.1.2.  Screen

In the Screen field in Object Parameters, you can select a screen from the list defined in the active job.
If an object should not have any screening, set it to the empty space at the top of the list.

9.1.3.  Screening...

To define or change the parameters for one screen set, press the ... button next to Screens in the
Object Parameter dialog. If no screen set is selected, only the top of the dialog is shown (see top
image). As soon as a screen is selected, the rest of the dialog appears. The dialog is different for
Imaging Engine, PostScript, Nexus and Extended Nexus Screening. Nexus Screening is only used to
print to Eskos own NexusRIP. To use Nexus screening, you will need to print to a NexusRIP workflow,
which allows for PostScript screening (option PostScript Object Screening Control on). For a complete
overview of Nexus Screening, we refer to the NexusRIP manual.

Imaging Engine
Imaging Engine screening is selected with the 'Imaging Engine' tab in the screening dialog.
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Imaging Engine provides the user with the same options as the screening in Imaging Engine. Most
options are the same as in the other screen types: Dot Shape, Ruling, Angle, .... For a complete
overview of Imaging Engine screening, we refer to the Imaging Engine manual.

If you establish a connection to an Imaging Engine Server or an Automation Engine Server in the ArtPro

preferences, you will see the Server Connection icon  next to the Dot Shape dropdown. In that case,
the available settings are limited to the screenings available on the server.

If you change a screen from another tab into Imaging Engine, ArtPro will try to convert any settings you
already made into the corresponding setting in Imaging Engine screening. If you e.g. have a screen in
Nexus Extended, Family "Paragon", Dot Shape "ellipse35", ruling 45 lpi, and you switch to the Imaging
Engine tab, you will get Dot Shape PARELL35 - Paragon Elliptical35, and ruling set to 45

Postscript
PostScript screening is selected with the 'Postscript' tab in the screening dialog. PS Screening is
available for every device that executes PS Screening Settings for PS Screening are explained in parts
10.1.5 to 10.1.13.

Nexus
Nexus screening is selected with the 'Nexus' tab in the screening dialog. The screening parameters of
this dialog can be organized into 4 groups:

• output device parameters;
• dot family parameters;
• plate cell parameters;
• hybrid parameters

Nexus Screening is only used to print to Esko NexusRIP. To use Nexus screening, you will need to print
to a NexusRIP workflow, which allows for PostScript screening (option PostScript Object Screening
Control on). For a complete overview of Nexus Screening, we refer to the NexusRIP manual.

The Nexus screening is calibrated with calibration files residing on the NexusRip. This calibration
should be done with calibration files from FastCalibrator. Calibration files from Symphony Calibrator
can NOT be used. Use Nexus Extended Screening instead.

The Settings for Nexus Screening are explained in this chapter, parts Nexus & Nexus Extended: Output
device parameters: 'Device' and 'Resolution' on page 261 to Nexus : Calibration on page 262

Extended Nexus
Extended Nexus screening is selected with the 'Nexus Extended' tab in the screening dialog. Nexus
Extended provides the user with the same options as the screening in Nexus 9.0. Most options are
the same as in the Nexus Make Separation activity : Device, Resolution, Dot Shape, Ruling. For a
complete overview of Nexus Screening, we refer to the NexusRIP manual. The Settings for Nexus
Extended Screening are explained further in this chapter, in parts Nexus & Nexus Extended: Output
device parameters: 'Device' and 'Resolution' on page 261 to Nexus Extended: Extra Cutbacks on page
263
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Note on Partial Screening Control in Nexus
“Nexus” Screening can NOT be used in combination with the Screening settings in Nexus set to “Ruling
Control In PS”, “Angle Control In PS”, and “Angle/Ruling Control in PS”.

For these settings, that allow screening to be controlled partially from the workflow, and partially from
the file, the screening needs to be set to PostScript Screening or to Nexus Extended Screening.

9.1.4.  Screen

Screen shows you what screen is edited. In the list, the default screen will always be on top, even if its
name was changed. The other screens will be sorted in alphabetical order.

9.1.5.  Name

In the Name field, you can change the name of the active screen.

9.1.6.  Duplicate

Using the Duplicate button, you can add a screen, based on the active screen. The name will be the
name of the original screen, with a space and a number (1, 2, ...) attached to it. After duplication, the
new Screening can be set as needed.

9.1.7.  Merging Screens

When inserting an ArtPro job into another ArtPro job, the sets of screens of the two jobs will be
merged. Screens that are compatible will be put together as one screen. A screen set is compatible if
there is no difference in the settings and in the name for the screen. If a value is left blank in one screen
and entered in another, the screens are compatible for that setting, and the resulting screen will have
the value as entered in the second screen.

Example
In Job 1, there are 4 screens:

Lineart, Diamond dot shape, freq. 133

CTs, ellipse dot shape, freq. 133

Line, Line dot shape, freq. 120

Gradations, Ellipse dot shape, freq. 120

In Job 2, there are 4 screens:

Lineart, round dot shape, freq. 133

CT, ellipse dot shape, freq. 133
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Line, Line dot shape, freq. 120

Gradations, dot shape field is blank, freq. 120

• “Lineart” from Job 1 is not compatible with “Lineart” from Job2, so these screens will remain.
• “CTs” and “CT” are not compatible, as the name is different
• “Line” is the same in both jobs, and will b merged
• “Gradations” is compatible : the dot shape is empty in job 2, so the value of Job 1 will be used.

The resulting screen list will be:

Lineart, Diamond dot shape, freq. 133

Lineart 1, round dot shape, freq. 133

CTs, ellipse dot shape, freq. 133

CT, ellipse dot shape, freq. 133

Line, Line dot shape, freq. 120

Gradations, Ellipse dot shape, freq. 120

9.1.8.  PS : Dot Shape

In the Dot Shape field, you can select the desired dot shape. You can define the dot shape for all the
separations of the ArtPro document. The dots are inverted with Negative output. If the Dot Shape field
is empty, the default dot shape of the RIP is used.
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The Diamond dot starts round and grows to a diamond shape in the 50% screen zone. The Helio 2
halftone screen, developed by Antonio de Llamas, starts with a smaller dot in between two regular
dots. As this dot grows to the same size of the regular dots (values above 25%), the screen frequency
becomes 1.4 times its original value, and the screen angle is rotated over 45º. The dots with Lock
behind the names are PowerLock screen dots (see below)

Esko Dot Shapes
The Esko dot shapes are also available in the PostScript Screening. For more information on the Esko
dot shapes, we refer to the Esko documentation. Both separated and composite PostScript output will
include the Esko dot shapes. Esko back-end systems will detect and execute all the correct screening
parameters.

When exporting PDF, only rulings and angles will be recognised when entering the PDF file in Esko
back-end systems. Esko dot shapes are currently ignored.

9.1.9.  PS : PowerLock (Optional)

PowerLock is an optional module for ArtPro, to include security screening within a package.
PowerLock screening is based on a set of new dot shapes included in ArtPro. All PowerLock dot shape
names end with the word 'Lock'. These dot shapes are identical to the ones without 'Lock', but are
shifted over half a phase of the line ruling.
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To use PowerLock screening, make screening sets which use the locked dot shapes and apply them in
your ArtPro file as with regular screening. Output can be generated on all output devices that accept
PostScript screening.

Authenticity checker
To make PowerLock screening visible on the film or in print, an authenticity checker is used. An
authenticity checker is a piece of film that is used to generate moiré patterns on the area(s) of the
job which contain security screening. Due to the shift of the locked screen dot, this dot will generate
different moiré patterns than the regular screening applied in the job, and thus becomes visible.

To create an authenticity checker, make a job containing a flat paint area with a value between 20
and 50% with the same screen ruling and dot shape as in the ArtPro file (regular or locked dot, makes
no difference), and output it negative. e.g. If the ArtPro file contains areas of a 150 lpi round dot in
combination with locked round dots, your authenticity checker should be a negative output from a e.g.
30% 150 lpi round (or locked round) dot. Following this rule, moiré patterns will be the easiest to see.

Tips & tricks
• Use PowerLock in combination with microtext. As ArtPro’s internal resolution is so high (12.000 dpi)

microtext is available simply by defining very small pointsizes e.g. 0.4 pt.
• When using microtext, make sure to adapt the exposure resolution, e.g. expose the job on 3600 dpi

or higher.
• Making security screening become visible, through copying a printed sample, is done by using a

combination of two screen rulings. When copied, one screen ruling will have different dot gain than
the other one and will become more visible.

• The easiest way to hide this type of screening is by using this in a kind of pattern where the two
areas of screening do not physically touch.

• PowerLock screening is most dicult to hide in flat paints and in angles identical or close to the
screen angle of the separation it is in.

• PowerLock screening will work with Nexus FlexoCal if you use a PostScript round dot instead of the
Nexus round dot.

• PowerLock probably cannot be used for gravure jobs as most gravure systems do not accept
PostScript screening.

The image below shows an example of regular screening on the left. The image on the right shows
PowerLock screening. The gray value, dotshape, frequency and angle are the same, but the dots are
shifted half a phase.
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On the left you see the checker. When the checker is placed on top of the PowerLock screening, two
different moiré patters appear, making the logo visible

 

 

9.1.10.  PS : Dot Code

In the screening dialog, under Dot Shape, there is a shape called ‘custom’. When selecting custom from
the dot shape pop-up, the edit field below will become editable. In this edit field, a custom PostScript
function can be entered. This function is then used when outputting to PS.

When importing postscript files which contain custom dot shapes, these dotshapes are kept when the
option 'keep screenings' is checked in the Import Postscript dialog Import Postscript/PDF... on page 79.

This field can also be used to define non-standard Esko Screenings (defined by the Screen Manager).
Just type in the screen dot name, and it will be used in the Normalized PDF Export.

9.1.11.  PS : Frequency

In this field, the screen frequency can be entered. if this filed is left empty, the default frequency (150
lpi) will be used.

9.1.12.  PS : Angle

In Angle, you can define the screen angle for every separation. An angle between 0 and 360º can be
chosen, e.g. 7,5º for flexo. If this field is empty, the default angles of the RIP will be used.

9.1.13.  PS : Dot Gain Compensation...

Dot Gain Compensation is by default applied on all separations. If the All Separations checkbox is
switched off, the Dot Gain compensation can be set for every separation individually. In that case, the
dotgain is defined for the active separation of the Separation menu (see Separations...  on page 470).
Dot gain is used in the Postscript File if the Dot Gain Compensation in Print Settings is on (see Print :
General Settings on page 135)
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DGC Graph
The X-axis of the graph represents the values after printing, and the Y-axis represents the values on
film. By clicking and dragging you can place and insert points on the Dot Gain Compensation Curve.
Points can be deleted by dragging them (to the left or to the right) outside the square area containing
the curve. By clicking the Resize button, the Dot gain compensation menu will extend to show all used
values.

Keep 0% at 0%
This check forces 0% to remain 0%, even if the Dot Gain Compensation curve does not cross this
point. This has no effect on the other gray values, it only influences the 0% as such. This can be very
helpful if you want to bring all values to a minimum of 5%, without changing the places with 0%

Keep 100% at 100%
This check forces 100% to remain 100%, even if the gradation curve does not cross this point. This has
no effect on the other values, it only influences the 100% as such.

Load Curve.
Load Curve allows you to load a text file which contains the values for a gradation curve as described in
Save Curve.

The Dot Gain Compensation dialog shows per separation the name of the file from which the active
curve was loaded.
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If the curve was changed after loading, and thus no longer matches the original curve, a red warning
symbol will show next to the file name.

Keep in mind that this information is NOT stored in the ArtPro file: after closing the ArtPro file, no
information on the files from which the dot gain curves originated can be retrieved, and no warning
symbol will be shown.

Save Curve
Save Curve allows you to save the gradation curve values to a text file. If you need to have the same Dot
Gain Compensation curve on more than one file, it can be useful to save the DGC curve in a separate
text file (Save Curve) which can be reloaded in another file (Load Curve).

The Dot Gain files are text files that can be edited or created in a text editor or spread sheet
application. In that way you can avoid having to reenter all values, by copying them from another text
file into an ArtPro Dot Gain Compensation file.

Clear
Clear removes all values, setting the curve back to a diagonal line, so no Dot Gain Compensation will be
calculated.

Load All Curves
Load Curve allows you to load a text file which contains the values for all gradation curve as described
in Save All Curves.

Save All Curves
Save All Curves allows you to save the gradation curve values for every gradation curve in the job, to
a text file. If you need to have the same set of Dot Gain Compensation curves on more than one file, it
can be useful to save the Dot Gain Compensation curves in a separate text file (Save All Curves) which
can be reloaded in another file (Load All Curves).

The text file created with the Save All Curves function will contain a Dot Gain compensation curve for
every separation.

On Film / Printed
In the input fields, you can enter up to 20 pairs of values. In the example, a 20% point on film, will be
33% on print. The application will use this list to lower the values on film, so you get the exact value on
paper. e.g. If a value of 40% is asked in the file, ArtPro will put 25% on film, so the actual result on paper
will be 40%.

Remark
The Screen Angle, Screen Frequency and Dot Shape values you fill out, are included in the ArtPro
PostScript output. A lot of imagesetters override these values and expose the films with their own val-
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ues. Others have an option like Override Postscript Screening, so if this option (or a similar option ) is
on, the default settings will be used i.o. the settings made in ArtPro.

9.1.14.  Nexus & Nexus Extended: Output device parameters: 'Device' and
'Resolution'

As with all screening, the Nexus screening changes depending on the selected output resolution. To
give a true preview of the exact rulings and the exact screening angles that can be created at a giv-
en output resolution, defining the device and selecting one of its resolutions for output will modify
the contents of the different pop-up menus in this dialog, and only reflect values which can truly be
achieved.

Both parameters (device & resolution) will be stored when saving the ArtPro file, as this is output
dependent. Next time you might output on a different resolution and a different device which can
result in different angles and screen rulings. Choosing the appropriate device and resolution before
defining the other parameters in this dialog, will reduce the pop-up menus in this dialog to only real
achievable values. Make sure the files 'Device Contexts.aeo' and ABScreens.txt are right next to
the application on your hard disk. In the end, it is still the resolution of the output device defined in
the assembler module of the Nexus workflow that will control the screening. However, putting the
resolution in the screening dialog to the same value as the assembler will guarantee that you see the
real parameters for the dots created and no approximation.

9.1.15.  Nexus & Nexus Extended : Dot parameters

For an explanation of the different Nexus dot families and dot shapes we refer to the Nexus manual.
As you select one frequency, all exact angles and rulings for the selected resolution are listed for the
first four separations in the bottom part of the dialog. You can define the start angle, this is the angle
the first separation should start with. Additional separations will get the same angles as the first four
separations, in the order that they appear in the separations list. The order of the angles cannot be
modified, but the order of the separations can be modified in the separations dialog.

9.1.16.  Nexus : Plate Cell parameters

The goal of introducing a plate cell into the job is to print more saturated full tones with less ink. Plate
Cell is a special screening for the 100% areas in the job and is only used in flexo. The type of plate cell
you choose from the pop-up, and its cell value depend on the anilox roller used, the output resolution,
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the printing process, etc. Defining which plate cell to use can only be done through a test procedure for
which we refer to the installation process of PlateCell.

9.1.17.  Nexus : Hybrid parameters

These parameters define the hybrid type, the mutation between the fm screening and the conventional
screening, and the size of the fm dot. For more information we refer to the installation of Hybrid
Screening.

9.1.18.  Nexus : Calibration

The calibration part allows to select a default calibration file, a CT calibration file and a Hybrid
Calibration file.

Using the Clear button removes the selected calibration file.

The Calibration file should be located on the Nexus Server end.

You can only use FastCalibrator files (Nexus 7.5 or earlier) here. If you want to use calibration files from
Symphony Calibrator (Nexus 8.0), it is necessary to use Nexus Extended Screening.

9.1.19.  Nexus Extended: Dot / Hole Centered

This popup allows to control the generation of Rosettes (dot centred or hole centred)

9.1.20.  Nexus Extended: Nominal

The Nominal checkbox allows to define if Rulings should be defined in Nominal or in Actual values.

9.1.21.  Nexus Extended: Plate Cell / Hybrid

The Plate Cell and Hybrid settings can be accessed through the Set Plate Cell / Set Hybrid… button.
The name of this button similarly changes to Change Platecell / Hybrid… if there’s already a plate cell
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or hybrid setting defined. Hybrid is disabled if either the FM screening or a CQS screening with a noise
parameter other than zero is selected.

9.1.22.  Nexus Extended: Optirange

The Nexus Extended Screening also allows to access and define OptiRange through the Set... button.
The name of this button changes to Change... if OptiRange has been set already. For a full explanation
on OptiRange and how to set it, we refer to the Nexus documentation.

9.1.23.  Nexus Extended: Extra Cutbacks

The Extra Cutback dropdown contains “Linear”, and all FlexoSync and LithoSync curves, and
“RipDefault”, allowing to use the default curve set in Nexus. The dropdown will also contain all names
defined in the Extra Cutback Curves section (see below). When sending this info to Nexus, only the
text string with the names of the curves will be taken. In the Assembler, Nexus will search in the Extra
Cutbacks folder for a file with the exact name as that text string.

When the Extra Cutback Curve for the first separation is set, this Extra Cutback Curve will be used for
all separations.

9.2.  Screening Cutback Curves

The Extra Cutback Curves can be used in the Screening menu, in the Extra Cutback dropdown in the
Extended Nexus tab. See Nexus Extended: Extra Cutbacks on page 263.

In the Extra Cutback Curves, you see a list of the already defined Extra Cutback Curves. You can add a
curve by clicking the Add button, and browse to the Curve you want to add. By clicking the Add Folder
button, you can select a folder, and all file names from that folder will be added. All files in subfolders
will be added as well, so do not select a folder (or HD) containing hundreds of files ! Select only a
dedicated folder containing curves.

By selecting a curve in the list, and clicking the “Delete” button you can remove a curve from the list. By
clicking the Delete All button, all curves will be removed from the list.

When changing the Extra Cutback Curves list while the Screen dialog is open will not change the
dropdown menu immediately. Just close the Screen Dialog and open it again to see the Curves in the
Dropdown.

The text file containing the names of the Extra Cutback Curves is saved in the System Preferences
folder of ArtPro. If needed, this text file can be adjusted manually.

9.3.  Generate Bar code

Using the Bar codes functionality, you can create a variety of bar codes in the document.
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The available Bar codes are: APB, Bobst, Traditional Codabar, CIP 39, Code 39, Code 128, EAN 13, EAN 8,
GSI 128, Eberle, ITF, ITF-14, ITF-16, Klebrand, Laetus, Plessey, PZN, SICK, UPC-A, UPC-E, MSI, Code 32,
Coupon Extended, Data Matrix ECC200, GS1 DataBar-14, GS1 DataBar Expanded, GS1 DataBar Expanded
Stacked, GS1 DataBar Limited, GS1 DataMatrix, QR, Traditional APB, Traditional Plessey, Traditional MSI.

The GS1 follow the GS1 standard. Some GS1 bar codes are existing bar codes renamed to GS1 (EAN128 to
GS1 128, RSS to GS1 Databar, DataMatrix to GS1 DataMatrix) and some new variations on the GSI Databar
were added (GSI Databar Expanded and Expanded Stacked)

The APB, MSI and Plessey bar codes have been adjusted to meet the most recent specifications. For
reasons of compatibility, the “old” APB, MSI and Plessy are still available, but renamed to “Traditional
APB, Traditional MSI and Traditional Plessy. Although Codabar was not changed, it was renamed to
“Traditional Codabar”

In the following summary, you find a description of all available bar codes with their input possibilities.
The settings and options (Magnification, Height, Corner marks,...) available for each bar code are
described below.

Shortcut:

Cmd-Shift-B, Bar codes

9.3.1.  The Codes

APB

Info APB (Algemene Pharmaceutische Bar code) is used in the Belgian
pharmaceutical industry and is based on Plessey/MSI.

Example

Input Digits and a dash. 7 characters

Check Digit Last digit, entered automatically

Settings Magnification, Height

Options Corner Marks, Clear Area

Bobst

Info Pharmaceutical code of maximum 12 bars (with a maximum value of 4096),
which is placed on the glue strip of medicine packages.
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Example

Input Decimal Input on: digits from 0 to 9 Decimal Input off: binary values 0 and 1
The number should be <4096 (decimal) or max. 12 characters (binary)

Check Digit none

Settings Magnification, Height

Options Corner Marks, Clear Area, Decimal Input

Traditional Codabar

Info Codabar is a bar code used e.g. in libraries.

Example

Input unlimitted amount of digits or a b c d - . $ / + or :

Check Digit none

Settings Magnification, Height

Options Corner Marks, Clear Area, Constant Bar Width, Generate Text

CIP 39

Info CIP 39 (Club Inter-Pharmaceutique) is a bar code used by the French
pharmaceutical industry. It is based on Code 39, but NOT compatible with it :
it contains digits only and has a check digit

Example

Input 7 digits. Do not enter the asterix (*)

Check Digit Last digit. Has to be entered

Settings Magnification, Bar Width Reduction, Clear Area Height

Options Corner Marks, Clear Area, <>, Use Text Fonts
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Code 39

Info Code 39 is a bar code frequently used in industrial bar coding systems, more
widespread in the US than in Europe.

Example

Input Maximum 32 characters (digits and capitals)

Check Digit none

Settings Magnification, Bar Width Reduction, Clear Area Height

Options Corner Marks, Clear Area, <>, Use Text Fonts

Code 128

Info Code 128 is a bar code used in a large number of applications, a.o. in the
medical pharmaceutical industry.

Example

Input Maximum 64 characters (digits and letters)

Check Digit none

Settings Magnification, Bar Width Reduction, Clear Area Height

Options Corner Marks, Clear Area, <>, Use Text Fonts

EAN 13 / 8 & GS1128

Info EAN (European Article number) is the international standard bar code for
article numbering. JIS (Japanese Industrial Standard), the Japanese stan-
dard, is identical to EAN. EAN 13 is the normal form, EAN 8 is the compact
form used on very small packages. GS1 128 is based on Code 128 but has a
double start sequence.
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Example

 

Input 8 or 13 digits for EAN 8 and 13.

GS1 128: Max 64 digits and letters

Check Digit Last digit (not for GS1 128). Has to be entered

Settings Magnification, Bar Width Reduction, Clear Area Height, Left/Right
Whitespace, Output Resolution

Options Corner Marks, Clear Area, <>, Use Text Fonts (not for GS1 128), Omit Character,
Adjust Magnification

EAN 13 Extended
By entering 15 or 18 characters for an EAN13 code, you can create an EAN 13 Extended bar code with 2
or 5 additional characters.

Eberle

Info Control code especially used in Austria and generally placed on the glue
strip of small (medicine) packages. It consists of thin and thick bars and two
triangles at the end, with a total (invariable) height of 7 mm.

Example

Input Decimal Input on: digits from 0 to 9 Decimal Input off: Quarternary values 0 to
3.

Check Digit none

Settings none
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Options Corner Marks, Clear Area, Decimal Input

Int. 2 of 5 (=ITF)

Info Interleaved 2 of 5 is a general purpose industrial bar code.

Example

Input 32 digits

Check Digit none

Settings Magnification, Bar Width Reduction, Clear Area Height

Options Corner Marks, Clear Area, Generate Borders, Use Text Font

ITF 14 / 16

Info ITF (Interleaved Two of Five) / DUN (Despatch Unit Number) is the bar code for
numbering transportation packages. These are usually carton boxes with low
printing quality, so the bar code is very tolerant.

ITF-14 is the international standard, ITF-16 is a standard used within some
countries. ITF/DUN bar codes can contain H-gauges. These are H-shaped
marks to the left and right of the bar code, that are used to check the line
growth while printing. The right H should fill up with ink. The left one should
remain open.

Example

Input 14 digits for ITF 14, 16 digits for ITF 16

Check Digit Last Digit. Has to be entered

Settings Magnification, Bar Width Reduction, Clear Area Height, S min, S max.

Options Bearer Bars, Use Text Font

Klebrand

Info Glue strip code mostly used in Germany, which can contain bars with 4
different widths.
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Example

Input Decimal Input on: digits (0 to 9) and /. the digits before the slash indicate the
number of bars (maximum 15), the digits behind the slash define the binary
value of the code. If only the digits behind the slash are keyed in, the minimum
amount of bars required to represent that value will be used.

Decimal Input off: quaternary values (digits 0 to 3). The number should be
<1.073.741.824 (decimal) or max. 15 characters (binary)

Check Digit none

Settings Height

Options Corner Marks, Clear Area, Decimal Input

Laetus

Info International pharmaceutical code originated in Germany and used in a wide
range of packaging and documentation units, such as folding boxes, labels,
leaflets, tubes and printed containers.

Example

Input Decimal Input on: digits 0 to 9.

Decimal Input is off: binary values (0 or 1) for a single track code and ternary
values (0 to 2) for a dual track code. The value of a single track code must be
less than 131070, while the value of a dual track must be less than 64570080.

Check Digit none

Settings Height, Magnification, Gap Width

Options Dual Track, Corner Marks, Clear Area, Decimal Input, Miniature

Plessey

Info The Plessey or MSI code, originated in England, is applied in retail, hardware
and grocery sectors.

Example
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Input Maximum 12 digits

Check Digit Last Digit. Has to be entered

Settings Height, Magnification

Options Corner Marks, Clear Area

PZN

Info PZN (Pharmazentralnummer) is a bar code used by the German
pharmaceutical industry, based on Code 39.

Example

Input 7 digits

Check Digit none

Settings Size, Bar Width Reduction, Clear Area Height

Options Corner Marks, Clear Area

PZN8

Info PZN (Pharmazentralnummer) is a bar code used by the German
pharmaceutical industry, based on Code 39.

Example

Input 8 digits

Check Digit Last digit. Has to be entered

Settings Size, Bar Width Reduction, Clear Area Height

Options Corner Marks, Clear Area
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SICK

Info SICK is a bar code used in the German packaging industry. It is a binary code
consisting of 2 types of bars, a thin one and a thick one. It can contain 3 to 12
bars.

Example

Input Decimal Input on: Digits (0 to 9) and a slash. Before the slash= the number of
bars (maximum 12), behind the = the binary value (maximum 4096). If only the
digits behind the slash are keyed in, it will create the minimum amount of bars
required to represent that value. Decimal Input off: binary values (0 and 1)

Check Digit none

Settings Magnification, Height, Gap Width

Options Corner Marks, Clear Area, Decimal input

UPC A / E

Info UPC (Universal Product Code) is the standard bar code for article numbering
in the US and Canada. It is compatible with (but not equal to) the EAN system.
UPC-A is the standard version, UPC-E is the abbreviated form.

Example

Input 12 digits for UPC-A and 8 digits for UPC-E

Check Digit Last digit. Has to be entered

Settings Magnification, Bar Width Reduction, Clear Area

Options Corner Marks, Clear Area, <>, Use Text Font

MSI

Info The MSI code is developed by MSI Data Corporation based on the Plessey
Code. This code is used primarily to mark retail shelves for inventory control
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Example

Input maximum 15 digits

Check Digit Last digit. Has to be entered

Settings Magnification, Bar Width Reduction, Clear Area Height

Options Corner Marks, Clear Area, <>, Use Text Font

Code 32

Info Code 32 is an Italian pharmaceutical code, based on the Pharmacode.

Example

Input 8 digits + 1 check digit

Check Digit Last digit. Has to be entered

Settings Magnification, Bar Width Reduction, Clear Area

Options Corner Marks, Clear Area

Coupon extended
The coupon extended bar code is a supplementary code that is printed to the right of the UPC-A or EAN
13 bar code. This extended code enables the communication of additional information, such as offer
codes, expiration date and household identification numbers. It always exists out of a basic part, and
an extended part.
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Basic part: Can be UPC-A or EAN 13 based

• Vendor Code: 5 digit number
• Family Code: 3 digit number
• Value Code: 2 digit number

Extended part:

There are several possibilities for the extended part: Format 1 to 5, or GS1 US. Depending on the format
you choose, you have to define one or more of the following settings.

• NSC: Number System Character, 1 digit
• Offer Code: 5 digits
• Household ID: 8 digits
• Expiration date: month/year (e.g. 12/01)
• Options: Corner Marks, Clear Area

 

 

Data Matrix ECC 200
Data Matrix is a very area ecient 2D (two dimensional) bar code symbology that uses a unique square
module perimeter pattern that helps the bar code scanner determine the cell locations.

The Module size determines the size of one module and hence the size of the entire bar code

The Minimum Symbol Size checkbox determines the number of modules in a datamatrix. If there is not
enough input data to fill the bar code, padding data is added at the end. If there is too much data, the
bar code will be larger than specified.
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The Clear Area checkbox will draw a white square underneath the bar code which is exactly one module
wider than the bar code (this is also known as the quiet zone)

Underneath are 3 examples : a 10 x 10 data matrix bar code, a 18 x 18 and a data matrix without Clear
Area.

 

 

GS1 Databar-14
GS1 DataBar-14 is based on RSS or Reduced Space Symbology, a bar code type able to create bar codes
on a smaller size. An RSS code can be as small as 30% of the comparable UPC code.

 

 

The Module size determines the size of one module and hence the size of the entire bar code

Of the GS1 DataBar-14 code, there are 4 types : Normal, Truncated, stacked (in two parts on top of each
other) and stacked omnidirectional (can be scanned in any direction)

The Clear Area checkbox will draw a white square underneath the bar code.

At the right, there are 4 examples : a normal, truncated, stacked and stacked omnidirectional GS1
Databar-14 Bar code
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GS1 DataBar Expanded - Expanded Stacked
GS1 DataBar Limited is a version of GS1 DataBar bar code in a expanded or expanded stacked version.

 

 

You can generate a GCN or Global Coupon Number bar code (with identifier "255") using the GS1 Databar
Expanded or GS1 Databar Expanded Stacked bar code type. For more information on GCN, you can
check its specifications here: http://www.gs1.org/barcodes/technical/idkeys/gcn

GS1 DataBar Limited
GS1 DataBar Limited is a version of GS1 DataBar bar code in a limited version.

The Module size determines the size of one module and hence the size of the entire bar code

 

 

QR
The QR Bar code is a 2-dimensional bar code (comparable to the Data Matrix Bar code) which is
frequently used in Japan.

The module size determines the size of one module, and hence (in combination with the Symbol Size)
the size of the bar code. The Symbol Sizes available have “version” names, and define the number of
square modules. The Error Correction is a value that indicates how much the bar code can be damaged
without loosing its readability.

The Clear Area checkbox will draw a white square underneath the bar code which is exactly one module
wider than the bar code. This is also known as the ‘Quiet Zone’. The size of the Clear Area can be
entered manually in the Clear Area Size field.
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• Input: maximum 255 roman or 128 japanese characters
• Settings: Module Size, Minimum Symbol Size, Error Correction, Bar Width Reduction, Clear Area

Size
• Options: Clear Area

UCC & EAN
The UCC and EAN organizations jointly define a standard article numbering system. For retail products,
this numbering system consists of 13 (EAN) or 12 (UCC) digits and is called EAN-13 or UPC. For trade
items, this numbering system consists of 14 digits and is called EAN-14, UCC-14 or SCC-14.

If a trade item contains one single retail item, the EAN-14 code will be identical to the EAN-13 or UPC
code with leading zeros.

The EAN-14 number can be encoded in a bar code using different symbologies.

 

 

The ITF symbology is mostly used when printing or scanning quality is not good. You can define your
EAN-14 bar code using the ITF symbology in ArtPro by defining an ITF-14 bar code that uses the 14
digits from the EAN-14 number.

The symbology Code128 is much more compact than the ITF symbology, and is thus usually preferred.
You can define your EAN-14 bar code in ArtPro using this symbology by defining an EAN-128 bar code
with an Application Identifier (AI) of 01. You then enter the EAN-14 bar code 01234567890123 as the
string “(01)01234567890123” in the EAN-128 bar code dialog.
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9.3.2.  General concepts

Color
A bar code is always created in the color active in the Paint Style menu. To keep a bar code readable,
you need to obtain a minimal contrast between the dark and light elements so keep this in mind when
creating a colored bar code.

Position
A bar code is always positioned centered on the ruler. To create a bar code in the space provided in the
job, first center the ruler on that space.

Rotation
The buttons next to Orientation allow to define the rotation of the Bar code to be created or Modified :
0, 90, 180 or 270 degrees.

Creating a Bar code
Activate the required code and enter the bar code number in the bottom right input field. Depending
on the bar code you selected, you can enter digits or characters. For specific info: See earlier in
this chapter. Press enter or the button with the bar code name in it to generate the objects in the
document. Bar codes are always compounded or at least grouped (e.g. with life text or Clear Area)

277



9 ArtPro

For Bar codes with a check digit, entering an invalid code will not only generate a warning, but will also
change the last digit to a correct digit.

9.3.3.  Other settings

Magnification
The Magnification factor (scaling of the bar code) is subject to strict rules. For an EAN-code e.g., the
magnification should be between 80 and 200%. From ArtPro 6.0 on, it is possible to generate codes
that are smaller or larger, but an error message will appear on screen first. The magnification can be
entered with a 0.1% precision.

Adjust Magnification / Output Resolution
Clicking the Adjust Magnification button will change the magnification of the bar code to match the
Output resolution. This means every bar of the bar code will start at a new pixel line.

Size
For PZN Bar codes, you cannot set the magnification, only the predefined sizes small, normal and big.

Bar Width Reduction (BWR)
The Bar Width Reduction is given in actual values. The BWR is divided over both sides of the bar width.
A positive value, usually very small, will make the bars somewhat thinner in order to compensate for the
growth during printing.

Here also there are some limitations to be respected. ArtPro will check the values and a message will
pop up whenever the values are not according to the rules.

Clear Area Height
Standard bar codes also have standard heights. Sometimes a bar code needs to be created on a
specific height. Fill in the exact height in the Clear Area Height field and the bar code will be created
with a clear area of exactly that height. For all codes with the Clear Area Height option (which are
unlimited in height without loosing their readability, e.g. to be placed all the way around a can), you can
enter the exact height you want for the bar code. When you want to create a bar code with standard
height, fill in value 0. This field is not checked for validity: Note ‘truncation’ is allowed in certain bar
code standards, e.g. ITF-14.

Height
For bar codes that do not have a standard height, you have a field to enter the desired height for the bar
code. For standard bar codes, this is replaced by the clear area height.

Gap width
The Gap width allows you to define the distance between the bars of a Laetus or a Sick bar code.
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S min and S max
The S min and S max fields allow to specify the H-gauges to be included in the ITF14 or ITF16 bar code.
Values should be integers in the range of 1 to 7. If you enter 0, no H-gauge is printed and the bar code
box is smaller.

Corner Marks
The Corner Marks check box adds Corner Marks to the bar code which define the minimum space to be
respected for that bar code.

Left / Right Whitespace
Allows you to define the left and/or right whitespace to be used for EAN 8/13 codes

Clear Area
The Clear Area check box adds a rectangle with the size of the clear area behind the bar code. The clear
area is the minimum space to be respected for that bar code. The box is created in a white masking
color (= all zero).

Light Margin Indicators < >
With this option on, Light Margin Indicators will be created on the bar code. For EAN13 and UPC-A, only
on the right side a Light Margin Indicator is added, for all others on both sides.

Generate Borders
With the Generate Borders option on, a stroke is created around the Int. 2 of 5 bar code

Use Text Font
With this option on, the digits in the bar code will be real text, in the font that is active in the Text
Character menu at the moment of creation.

By default Use Text Font is switched off and the digits are vectorized from the standard OCR-B font.

When the option is not available for a certain code, the characters will always be real text, in the font
from the Text Character menu.

Omit Character
With this option on, the EAN code will be created without text. The direction signs are not affected by
this setting.

S min, S max
The S min and S max value define the width of the H marks to the left and right of an ITF 14/16 bar code.
The value can be between 0 and 7. If the value is set to 0, there will be no H marks.
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Create
After filling out all the exact values, create the bar code by clicking on the bottom left Code button.

Remarks
• UPC-A and UPC-E currently use the dimensions of EAN-13 for their bars. Although by definition this

is correct, there are small differences between the two standards (caused by conversions of inches
to millimeters).

• Bar code dimensions are not adapted to the resolution of the output device. This limits their
accuracy. Expose at high resolution for the best results.

• For UPC-A and UPC-E, the program creates bars with dimensions in millimeters, which differ
slightly from the dimensions in inches as defined in the American standard.

9.3.4.  Modifying barcodes

After creating a barcode, there are a number of operations (moving, rotation, proportional scaling
within the limits of the barcode specification,…) that don't change the validity of the barcode. However,
other operations (e.g. disproportional scaling) will result in an invalid barcode.

In that case, you will get a warning "This operation will create an invalid barcode", and in the Layers
palette, the barcode is shown as "Barcode (Modified)"

However, even for such an invalid barcode, the barcode information is kept. If you double-click the
barcode, the barcode palette will open, showning the settings that were used to create the barcode.
Clicking the Modify barcode will result in a valid barcode again.

9.4.  PowerTrapper

Shortcut: Cmd-9, PowerTrapper

9.4.1.  The Trap Dialog

The Trap dialog is where you define all your trapping settings.

1. Go to Prepress > Trapping > PowerTrapper > Trap, use the Command + 9 shortcut or double-click
the Trap Select tool to open the Trap dialog.
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2. Choose your trapping settings in the Distance & Direction, Color & Shape, and Processing tabs.
3. If needed, define trapping rules.
4. Save your trapping settings as a trap preset to be able to reuse them on another document.

Note:  The Trap Preset List contains 6 default presets.

Distance and Direction Settings
Trapping

You can choose between two trapping modes:

• Normal Trapping: This selects adjoining color pairs, which are likely to cause registration problems
like ugly light gaps, and unwanted halo effects.

PowerTrapper Classic automatically chooses the most appropriate trap direction based on the
relative luminance of the adjoining colors. Lighter colors are generally trapped into darker colors to
minimize the visual effect of the trap.

• Reverse Trapping: This prevents overprint of adjoining color areas by trapping these color pairs
with a white knockout (erasing) trap. The white knockout trap is put on top of the lighter of the two
colors.

This is useful to prepare a job for Dry Offset printing (e.g. metal beverage cans) where overprinting
of inks is not allowed as the inks would contaminate each other on the blanket.

Trapping Distance

Enter the width you want to give your traps.

The default trap width is 0.2 mm (or equivalent in your chosen unit).

Minimum Ink Difference

Trapping is applied to two adjoining colors when either:

• The two colors each consist of at least one ink but they have no common inks.
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• The two colors have common inks but there is a difference of at least the Minimum Ink Difference
percentage for two or more inks making up these colors.

These differences in ink percentages must be in opposite directions.

For example, with the default minimum ink difference percentage of 10%, the following two colors
will be trapped:

1st color: C 5% M 10% Y 50% K 15% (+10% K)

2nd color: C 5% M 10% Y 85% K 5% (+35% Y)

Increase the minimum ink difference to trap colors that are more different, lower it to trap colors that
are more similar.

Image Trapping

• Automatic (default): this determines the most suitable trap direction automatically, by comparing
the average lightness of the CT image with the lightness of the adjoining area, then traps the lighter
color into the darker one.

• Always Towards Images: this always traps line art under adjoining CT images.
• Always Towards Line Art: this always traps CT images under adjoining line art.

Pull Back

An ink pull back keeps away all but the darkest ink of a color area composed of multiple inks that
borders to a very light background.

It prevents individual inks from the composed color to become visible on the background due to
registration errors during the printing process.

Ink pull back is also known as “Cutbacks” or “Keepaways”.

The example below shows an object with 100% dark blue and 50% magenta on an empty background.
50% magenta is pulled back and a fine line of 100% dark blue remains. The color that remains (dark
blue) is the pull back ink.

 

 

• Automatic (default): this creates pull backs on rich black or rich colors, when the color left in the
pull back area is not very different from the composed color.
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In the example below, the left color is composed of 100% purple ink and 20% cyan. The darkest ink
(purple) is not very different from the composed color, so using the Automatic pull back option will
create a pull back.

The right color is composed of 100% dark red ink and 20% blue ink. The darkest ink (dark red) is very
different from the composed color, so using the Automatic pull back option will not create a pull
back.

 

 

• Only Pull Back Rich Black: this only creates pull backs on rich black.

• Do Not Pull Back: this never creates any pull back.

Advanced Settings
Click the triangle beside Advanced Settings to show the advanced settings.

Trapping Distance

If you want to use a different distance when trapping into black, spot colors or images or when creating
pull backs, enable the corresponding option and enter the trapping distance to use.

Image Trapping

If you don’t want images to be trapped with each other, disable Trap images to images.

Pull Back

If you chose to use Automatic pull back (see Pull Back), the Also pull back light inks option is available.
Enable it if you want to create pull backs even when the pullback ink (ink remaining in the pull back
area) is visibly different from the composed color.

Enable Pull back images and gradients if you want to create pull backs on images and gradients.

Trap decision

• By default, PowerTrapper Classic uses the color luminance (Use Lightness) to define the trapping
direction, except for opaque inks, for which the Inks order is used.

• trap direction: from brightest to darkest

• If the Treat spot colors as opaque option is chosen, color luminance is used only for CMYK. For
opaque and spot inks, the trap direction is determined by the ink sequence.

• trap direction for spot colors only: towards the separation listed the lowest in the Separations
palette darkest

• trap direction goes from the process to the spot color if the spot color is below the process color
in the Separations list

• trap direction if the spot color is above the process color: from brightest to darkest
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• By selecting Use separation order, the trap direction is determined by the ink sequence for all inks,
including CMYK.

• trap direction: towards the separation listed the lowest in the Separations palette darkest

• Use reverse separation order does the same, using the reversed ink sequence.

• trap direction: towards the separation listed the highest in the Separations palette darkest

Note:  Using the Separation Order option will give the same result as changing all inks
(including CMYK) to Opaque.

Overshoot Mode

You can choose between the following three overshoot modes:

• Automatic (default): The centerline behavior is according the rules determined in the color pair list.

• Never on Dark Areas: The centerline is forced not to get beyond the center of dark areas.

• Never: The centerline is forced not to get beyond the center of any area.

An example:

During trapping, this example will generate the following color pairs:

 

 

By default (Automatic), this color pair list results in the following traps:
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If the parameter is set to Never on Dark Areas, this will result into:

If the parameter is set to Never, this will result into:

Color and Shape Settings
Trap Color Intensity

By default, PowerTrapper Classic uses the full color of the object to spread in the trap (100% trap color
intensity).

However, you can create a trap of a lighter color by reducing the trap color intensity percentage.

Image Trap Color

Choose how to trap your images:

1. Use Original Image Data (default): when spreading an image, PowerTrapper Classic uses the
underlying image data (when the image is clipped) to create the trap (see example 1 below).
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Note:  When there is no underlying image data (the image isn’t clipped), it will create an
empty trap.

2. Extend Image Data: PowerTrapper Classic will automatically extrapolate the image along its
clipping path edge to ensure the trap looks as expected even if there is no clipped image data
outside the visible image (see example 2 below).

3. Use an Approximate Flat Color: Instead of using existing or extrapolated image data in the trap,
PowerTrapper Classic will use a solid color. A suitable color is determined by averaging the image’s
colors along its boundary with the object to trap (see example 3 below).

 

 

Truncate Traps

PowerTrapper Classic can truncate the trap so that it doesn’t stick out on another color. There are two
truncation modes:

•
On Center  (default): when a portion of a trap comes too close to the contour of another object,
PowerTrapper Classic limits it to half the distance between the trapped object and the other object.

•
On Edge : when a portion of a trap comes too close to the contour of another object, it is
truncated on the other object’s edge.

 

 

End Caps

This option specifies how to shape the ends of an open trap.

•
Square  (default): this option ends the trap at right angle to the adjoining object.

•
Round : this rounds the ends of the trap. This option is typically only used in combination with
white knockout (reverse trapping).

286



9ArtPro

Attention:

We recommend not to use Round End Caps together with Truncate Traps On Center, as this
can generate some artefacts (the round caps will be truncated).

•
Object Dependent : with this option, the trap is a logical continuation of the contour of the
spread object.

 

 

Trap Corners

This option allows you to change how the traps’ sharp corners will be handled.

•
Round  (default): a round cap will be placed at all corners.

•
Beveled : this will cut sharp corners off.

•
Mitered : this option works with a miter ratio.

The miter ratio serves to limit the length of the sharp corner (the distance from the base of the trap
to the corner point).

The default miter ratio value is 4. This means that if the length of the sharp corner is more than 4
times the Trapping Distance, then the corner will be cut off (beveled). If it is less than 4 times the
Trapping Distance, the corner will be left as it is.
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Advanced Settings
Click the triangle beside Advanced Settings to show the advanced settings.

Truncate Traps

If you want to truncate traps into black differently, select Into black and choose the truncation mode
(On Center or On Edge). For more information about truncation modes, see Truncate Traps.

Processing Settings
Color Pairs

PowerTrapper Classic can trap all hits (occurrences) of a color pair the same way, or recalculate the
trap direction for different hits.

• Each hit can have its own decision (default): this recalculates the trap direction for each hit of a
color pair.

• Same decision for all hits: this traps all hits of the same color pair in the same direction.

• Same decision for objects smaller than: this uses the same trap direction for hits of a color pair
belonging to small objects, and recalculates the trap direction for hits belonging to bigger objects.

Use the field next to the option to determine the maximum size of small objects.

The default size is 1 mm.

Restrictions

If the Respect existing traps is enabled, traps in the selection will be kept, and no trapping is
performed on these locations. If the option is off, selected traps will be removed, and will be re-
trapped. This only works for traps created by PowerTrapper Classic or Instant Trapper.

Small Gaps

Some input jobs contain very small unintentional gaps between neighboring objects, preventing
the correct trapping of these objects. Although it is better to clean up such jobs before trapping,
PowerTrapper Classic can ignore these gaps automatically.

To use this option, select Close when smaller than and enter the maximum size small gaps can have.

The default size is 0.01 mm.
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Attention:  If you set a big gap size, trapping may become slower, and small parts of the job
may be ignored during trapping.

Rules
Rules allow you to define custom trapping settings for specific trapping pairs.

When to Use Rules?

In most cases the general trapping settings you enter in the Trap dialog will give you excellent results,
but in some cases you will need to refine them using rules.

Rules allow you to specify exceptions to the general trapping settings for certain color pairs. They are
an advanced feature and should be used only by experienced users.

For example, you can use them in the cases below:

• To set a different trap distance for a specific spot ink.

Sometimes you need a larger trap distance for spot inks if there is no other ink to help cover leaks
on the press.

• To prevent trapping or ink pull back in specific cases.

Depending on the type of the adjoining colors, trapping and / or pull back may be undesirable.

• To force a specific trap direction.

PowerTrapper Classic determines the trap direction based on the relative lightness of the adjoining
colors. If the colors have a similar lightness level, it selects an arbitrary direction. You can use a rule
to make it always use a particular direction for a color pair.

• To specify a different shape and / or truncation mode for certain color pairs.

For example you can choose to use “On Center” truncation when trapping under a 100% black line
and “On Edge” truncation on all other color pairs.

Creating a Rule

1. Click the Add Rule button at the bottom of the Trap dialog.
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2. In the pop-up that opens, choose the trapping pair to apply the rule to using the From and To lists.

You can create a rule to trap from/to:

• any color,

• a particular ink (process, spot or opaque),

Note:

In this case, you can choose the ink name, from which Minimum Density the rule will
apply, and if the color must be pure (no other separation in the color object) to apply the
rule.

 

 

If Spot Ink is selected, the dropdown underneath will contain all Spot Colors used in the
document.

• A specific Printing Method

• a particular object (image, gradient or empty background),

• the registration color.
3. Choose the contents of the rule.
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Options Description

Trap • Automatic lets PowerTrapper Classic calculate the trapping
direction.

• Always Trap always spreads the “From” color/object on the “To”
color/object.

• Do Not Trap never traps the “From” and “To” colors/objects together.

Trapping Distance Use this to define a special trapping distance for the trapping pair.

Trap Color Intensity Use this to define a special trap color intensity for the trapping pair.

Pull Back • Automatic lets PowerTrapper Classic decide if there should be a pull
back on the trapping pair.

• Always Pull Back always creates a pull back on the trapping pair.
The darkest ink of the pair is the pullback ink (remaining ink in the
pull back area).

• Do Not Pull Back never creates a pull back on the trapping pair.

Pull Back Distance Use this to define a special pull back distance for the trapping pair.

Pull Back Fill Mode • Normal gives normal pull backs.

• Sharpen allows sharpening on pull backs. This sharpening is used
e.g. for white text on images, on CD's or DVD's. Sharpening is done by
pulling back the image, and adding 100% black in the trapping area.

Reverse • Automatic lets PowerTrapper Classic decide if the trapping pair
should have a reversed trap.

• Always Trap Reversed always generates a reversed trap for the
trapping pair.

• Do Not Trap Reversed never generates a reversed trap for the
trapping pair.

Truncate Traps Choose if traps generated for the trapping pair should be truncated on
center or on edge. See Truncate Traps for details.

End Caps Choose how to shape the ends of open traps for the trapping pair
(square, round or object dependent). See End Caps for details.

Trap Corners Choose how to shape the trapping pair’s trap corners (round, beveled or
mitered). See Trap Corners for details.
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Options Description

Direction Mode Select into both colors to use bidirectional trapping. In case of
bidirectional trapping, the trap will go half the trapping distance in each
direction.

Horizontal / Vertical
distortion

Set the percentage of the trapping distance to be used in vertical /
horizontal direction. In the example underneath, the trap was generated
with no vertical distortion (so 100%, i.e. using the entered trap
distance) and horizontal distortion set to 50% (i.e. half the trap
distance).

4.
If necessary, use the  button to add contents to your rule.
 

 

You can use the  button to remove contents.
5. When you are done defining your rule, click OK.

You can now see your rule at the bottom of the Trap dialog.
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When trapping your document, PowerTrapper Classic will trap the trapping pairs that match rules
according to those rules, and the rest of your document according to the main trapping settings.

If necessary, you can add another rule, or remove a rule previously created. You can also edit a rule by
double-clicking it in the Trap dialog.

Trap Presets
With PowerTrapper Classic , you can save all your trapping settings as a preset to be able to reuse them
on other documents.

Trap Presets can be shared between different Esko Applications (PackEdge, ArtPro, DeskPack, ...)

The icon next to the Trap Preset dropdown shows if the current Trap Preset is local or server based.
When holding the cursor over the icon, PackEdge will show the full location of the current Trap Presets,
e.g. C:\Esko\bg_data_custom_v010\dat\trap

The Trap Presets list contains 6 default Presets that can't be changed or removed:

• Default
• Bi-directional (including a rule to trap into both colors)
• Combipress (including a rule based on Printing Method)
• Offset (optimized for offset printing)
• Reverse
• Sharpening (including a rule optimized for sharpening)

Defining a Trap Preset

1. Define your trapping settings in the Trap dialog. Add rules if you need to.

2. In the Trap Preset list, choose Save...
3. Give your preset a name and click OK.

You can now see your preset in the Trap Preset list. To reuse it in the future, just select it in the list.

• To delete a preset, select it in the Trap Preset list then select Remove.
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• To edit a preset, select it in the Trap Preset list, make your changes in the trapping settings, then
save it again with the same name.

9.4.2.  The Trap Layer

PowerTrapper Classic creates traps in your document’s Trap Layer, and leaves the other layers intact. If
your document doesn’t contain a trap layer, PowerTrapper Classic will create one.

9.4.3.  The Color Pairs Palette

After trapping your document, the Color Pairs palette shows the trapping settings associated with
each of your document’s color pairs.

It pops up automatically after trapping, or you can go to Window > Color Pairs... or to Prepress
> Trapping > PowerTrapper > Trapping Pairs, or you can double-click the Select Trap tool (if the
document has been trapped already) to open it.

 

 

For each color pair, the palette shows:

• the number of Hits (occurences of that color pair) in the document,
•

the type of object in the pair (empty background , flat color , image  or gradient ),
• the type of trap performed on that color pair (normal trap , pullback , reverse trap ),
• the trapping Distance used,
•

the traps’ Shape (truncation , caps , corners ),
• the Intensity of the trap color,
• the Pullback Ink (when the trap is a pullback).

Viewing Traps
• To select all the traps of a color pair in your document, click that color pair in the Color Pairs

palette.

Note:  Use Shift to select several color pairs, and highlight all the corresponding traps in
your document.

•
To zoom on selected traps, click  or select Zoom to Selected Hits in the menu.
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• If the Trap Select Edge tool is active, use the arrow keys to browse through the color pairs. Activate
the Zoom to Selected Hits to browse and visualize your traps one by one in your job.

Note:  Use Arrow left-right to expand or collapse the trapping pair list.

Viewing Trap Settings
You can hide trapping settings that you are not using to make the Color Pairs palette smaller.

• To hide all color pairs that are not trapped with each other, select Hide Non-trapping Color Pairs in
the palette’s fly-out menu.

To show them again, select Show All Color Pairs in the fly-out menu.
•

To hide all color pairs that don’t have traps selected in your document, click  or choose Hide
Unselected Color Pairs in the palette’s fly-out menu.

To show them again, click  again or select Show Unselected Color Pairs in the menu.
• To hide the Distance, Shape, Intensity or Pullback Ink column, select Hide Distance/Shape/

Intensity/Pullback Ink Column in the palette’s fly-out menu.

To show the column again, select Show Distance/Shape/Intensity/Pullback Ink Column in the fly-
out menu.

Refining your Traps
You can use the Color Pairs palette to select certain traps and change their trapping settings.

1. Select either:

• the color pair(s) to edit in the palette,
• the traps to edit in your document (if you want to only edit certain traps of a color pair).

2. Make your desired changes as explained below:

to change a color pair’s... do...

trapping direction
click Swap Trap Direction . Trap direction
can be from left to right, from right to left, or
bidirectional. In case of bidirectional trapping,
the trap will go half the trapping distance in each
direction.

295



9 ArtPro

to change a color pair’s... do...

Note:

When you change the direction for only
certain traps of the color pair, the color pair
will be duplicated in the palette (e.g. one
entry for spread and one for choke).
 

 

trap type choose Normal Trap , Pullback  or Reverse Trap

 in the Trap column.

You can also use this to trap a non-trapping color
pair.

trap distance click the Distance value to edit it.

trap truncation
choose On Center  or On Edge  in the Shape
column.

end caps
choose Square , Round  or Object Dependent

 in the Shape column.

trap corners
choose Round , Beveled  or Mitered  in
the Shape column.

trap color intensity click the Intensity value to edit it.

pullback ink (for pull back traps only) click the pullback ink to change it to another ink.

3.
Click Update Traps  to apply your changes to your document’s traps.

Note:  To change several color pairs the same way, use Shift to select them, then make the
changes in one color pair. Clicking Update Traps will apply your changes to all selected color
pairs.

Trap Sessions
Every time you click the Trap button in PowerTrapper Classic, the previous sessions of Color Pairs are
kept, and a new Session is started.
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You can switch to a previous session by selecting the session in Show Session in the Fly-out menu.

If you select a trap using the Select Trap tool, the Color Pairs dialog will switch to the corresponding
session

Note:  The Select Trap tool can only highlight traps from a single session. If you select
(by dragging) traps from different sessions, only the traps from the current session are
highlighted. If no traps from the current session are selected, the session with most traps in
the selection becomes active, and only traps from that session will be highlighted.

Note:  Keep in mind that by working in an older session, you can risk editing / highlighting traps
that are removed, modified or redundant. That is why a warning is shown in the Color Pairs
dialog, stating that the document was modified since it was trapped.

Clear Sessions in the Fly-out menu removes the Color Pairs information from all sessions, but does not
affect the trap layer or the traps, and vice versa: removing the trap layer does not remove the Sessions.
Therefor, if you want to restart trapping completely, it’s advised to remove the Trap Layer AND apply
“Clear Sessions”.

You can rename a Session by activating it, and clicking Rename Current Session in the Fly-out menu

Trap Sessions are stored in the ArtPro file.

9.5.  Instant Trapper

Instant Trapper is the new method of interactive trapping, available in all Esko editors.

Instant Trapper consists of the Instant Trapping dialog containing the Instant Trapper Parameters, and
two tools in the toolbar:

•

 The Trap to Object enables you to do full or partial interactive trapping of objects to other
objects.

•

 The Trap to All tool enables you to do fast, simple interactive trapping of objects to all
adjoining objects in the background / foreground. The background is everything under the object
(flat paint, images, other objects, ...), the foreground is everything on top of it.

Both tools create traps in your document’s Trap Layer. If your document doesn’t contain a trap layer,
Instant Trapper will create one.
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Note:  The trap layer needs to be the topmost layer of your document and be called Trap Layer
for Instant Trapper to recognize it. If it isn’t, Instant Trapper will create a new trap layer on top
of the other layers.

9.5.1.  Trapping an object to another object

To spread an object to another object:

Select the Trap to Object tool

Click inside the object you want to spread

Drag the cursor (that draws an arrow) into the other object (across the boundary between the objects)
and click.

 

 

To change the trapping direction (from spread to choke), hold down the Option key (when using
Illustrator Key Bindings) or space bar (when using ArtPro Classic Key Bindings)

To cancel a trap while you are dragging the arrow, use the Escape key or command - . (dot).

To cancel a trap after dragging the arrow, use the Undo function.

Note:  The two objects you want to trap must have a common edge. When trying to trap two
objects that appear to be touching but don’t actually have a common edge, you will get a
warning message.

9.5.2.  Trapping an object to several other objects

To spread an object to several other objects:

Select the Trap to Object tool

Click inside the object you want to spread

Drag the cursor (that draws an arrow) into the other object (across the boundary between the objects)
and click.
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This will trap all objects (completely) inside the rectangle in the same direction. To change the trapping
direction (from spread to choke), hold down the Option key (when using Illustrator Key Bindings) or
space bar (when using ArtPro Classic Key Bindings)

9.5.3.  Trapping several objects to one object

To spread several objects to one object:

Select the Trap to Object tool

drag a rectangle around the objects you want to spread

Drag the arrow into the objectto spread them into and click.

 

 

This will trap all objects (completely) inside the rectangle in the same direction. To change the trapping
direction (from spread to choke), hold down the Option key (when using Illustrator Key Bindings) or
space bar (when using ArtPro Classic Key Bindings)

9.5.4.  Trapping an object to all adjoining objects

Select the Trap to All tool

To spread an object to the background and the foreground (to all objects under it and on top of it), click
in it.
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To change the trapping direction (from spread to choke), hold down the Option key (when using
Illustrator Key Bindings) or space bar (when using ArtPro Classic Key Bindings)

To spread an object to the background only (to all objects under it), hold Shift while clicking in it. To
choke it with the background, hold the option / space key and the Shift key.

 

 

Note:  Instant Trapper treats an object and its stroke as two different objects. Therefore it will
not trap the fill object to the background as the stroke object is between the fill object and the
background.

9.5.5.  Trapping several objects to all adjoining objects

Select the Trap to All tool

To spread several objects to the background and the foreground (to all objects under it and on top of it),
drag a rectangle around these objects..

 

 

To change the trapping direction (from spread to choke), hold down the Option key (when using
Illustrator Key Bindings) or space bar (when using ArtPro Classic Key Bindings)

To spread several objects to the background only (to all objects under it), hold Shift while dragging the
rectangle. To choke with the background, hold the option / space key and the Shift key.

Note:  Instant Trapper treats an object and its stroke as two different objects. When spreading
a fill object and a stroke object to the background, Instant Trapper will only spread the stroke
object to the background, as it is between the fill object and the background. It will not spread
the fill object to the stroke object, as the stroke object is on top of the fill object in the file.
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9.5.6.  Combined traps

When trapping an object to two or more other objects, you can use Combined Trapping to get a
smoother connection between the different traps, and thus a better visual result.

Use this in particular to trap an object to other objects intersecting with each other.

In the example below, you can see the difference between trapping with separate actions and
Combined Trapping, when spreading an object to two intersecting objects.

• When using two separate trapping actions, you may have a gap between the traps (at the boundary
between the second -orange- and the third -purple- objects).

 

 

• When using Combined Trapping to perform both traps at once, there is no gap at the boundary
between the second and the third object.

 

 

To apply Combined Trapping:
Select the Trap to Object tool

Click into the first object

hold down the shift key

drag the arrow into the second object to spread, and click
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Still holding down the shift key, click again in the first object

Drag the arrow into the third object to spread and click.

 

 

Release the shift key. This will trap the first object to both the second and third object.

 

 

Note:  To change the trapping direction (from spread to choke), hold down the Option key
(when using Illustrator Key Bindings) or space bar (when using ArtPro Classic Key Bindings)
when clicking the second and the third object.

9.5.7.  Instant Trapper Parameters

You can open the Instant Trapper dialog by double-clicking the Trap to Object or Trap to All tool, or by
selecting Prepress > Trapping > Instant Trapper

• Set the Trap Distance. The unit used for the Trap Distance is the unit defined in the preferences.
• Choose how to Truncate your traps’ ending. On Center (as in the picture on the left) or On edge (as in

the picture on the right).
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• Choose how you want the Corners of your traps to be : Round (as in the picture on the left) or
Mitered (as in the picture on the right).

 

 

• Choose what you want to do when your file contains white objects. Leave Trap To White Objects
enabled to be able to trap colored objects to white objects or a white background. Disable Trap to
White Objects if you don’t want to trap colored objects to white objects. This will prevent you from
accidentally trapping to white objects (and will generate a warning when you do).

 

 

• The Include Opacity Masks option is by default enabled. When switched off, trapping will no longer
take Opacity Masks into account. This can fasten the process, but trapping can be less correct.

9.5.8.  Known limitations

• Instant Trapper does not support OPI Images
• Instant Trapper does not support certain types of objects created in other applications, for example

complex gradients. You will get a warning message when trying to trap a foreign art objects.
• When spreading an image, Instant Trapper uses the underlying image data (when the image is

clipped) to create the trap. When there is no underlying image data (the image isn’t clipped), it will
create an empty trap.

• When trapping objects with softmasks, traps will stop at the edge of the softmask. This is because
Instant Trapper treats the softmask as a single object.

• When trapping patterned objects, Instant Trapper will treat each individual pattern as a separate
object.
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Note:  With the Trap to Object tool, draw a rectangle around the whole patterned object before
trapping it to another object. See Trapping several objects to one object on page 299.

 

 

9.6.  Interactive Trapping...

The Interactive Trapping... menu contains all the functions to perform manual trapping in ArtPro.
Spread and Choke are the two basic functions to create trapping. Spread is used if the selected
path is lighter than its background. Choke is used if the selected path is darker than the object in the
background. It is possible to spread or choke entire objects or only parts of them. Spread and choke
can be activated by their keyboard shortcuts or by the function in the Interactive Trapping dialog.

If the object that has to be spread or choked contains transparencies, the result of the spread or choke
will be grouped, and the transparency will be applied to the group. In most cases, this will generate a
correct result.

Shortcut: Cmd-0, Interactive trapping dialog

Shortcut: Cmd-1, Spread

Shortcut: Cmd-2, Choke

9.6.1.  Mode

The Interactive Trapping functionality can be used in two different modes: “Overprint” or “Blended”.

If “Overprint” is used, an extra object is created slightly larger (Spread) or smaller (Choke) than the
original. The path on the inside becomes 0%, the path on the outside gets the original color, and
becomes overprinting (“trans”) for all other separations.

If “Blended” is used, the same is done, but the outside path will get the original color, with a “Darken”
blend mode applied to it.

This will visually result in a correct trap (also for images and gradations). However keep in mind that
flattening will be needed to output PostScript or PDF 1.3.

For more on the calculation of Interactive trapping, see further.

 

304



9ArtPro

 

9.6.2.  Spread or Choke an entire object

Select the path you want to trap.

Fill out a distance for the overlap in the Trapping dialog.

Set the corner type in the Corners pop-up menu.

Choose Spread or Choke, depending on the colors of the paths that need to be trapped. Spread will
create a bigger path as compared to the original, Choke a smaller one

9.6.3.  Spread or Choke an object partially

Spread and Choke Part enable you to make a partial spread or choke.
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Select the path you want to trap.

Fill out a distance for the overlap in the Trapping dialog.

Set the corner type for the trapping in the Corners pop-up menu.

Press Spread Part or Choke Part. The cursor changes into a pair of scissors.

Click on two points on the selected path, to indicate from where to where the path needs to trap. You
must click on intersections with other paths.

Spread Part creates a bisecting line on the intersection angle. Choke Part follows the direction of the
intersecting paths. Note that if you want to spread/choke another part on the same path, you may have
to hide the original path. Since there are now three paths lying on top of each other at the intersection
points, the program cannot know which path to intersect.

9.6.4.  Partial spread and choke on 1 object

If you want to make another partial spread or choke on the same object, make sure you select the
correct path (the top colored one or the white one): select the spread path, i.e. with the color informa-
tion, to do another partial spread. Select the choked path, i.e. with all 0%, to do another partial choke.

9.6.5.  Other Part

For the Spread Part and Choke Part function, you have to click on two intersections of a selected path
with another path. The program will always calculate the shortest part (with the fewest anchor points)
of the path in between those two intersection points. Sometimes this is not the way you want to spread
or choke part. When the program gives the wrong part of the selected path, you can ask for the Other
Part. This has to be done directly after performing a Spread/Choke Part. It can be activated by the
menu function or by its shortcut.

Spread Part  

 

Other Part  

306



9ArtPro

 

Shortcut: Cmd-/, Other way

9.6.6.  Color changes after Spread

The color of the original path is changed after spreading. The spread path, which is larger than the
original, now contains the original color data, whereby all the zero percentages of the original path are
made overprint (for Mode : Overprint), or a “darken” blend mode is applied (for Mode : Blended). This
way, you get the mix of the original color and the background. The original path is set to all zero, to
make it knock out the background. The new spread path is created on top of the original selected path
(see drawing on previous page).

9.6.7.  Color changes after Choke

The color of the original path is changed after choking. The original color data stays in the original
path, but all the zero separations are put in overprint (for Mode : Overprint), or a “darken” blend mode
is applied (for Mode : Blended). The new choked path, which is smaller than the original, is set to all
zero, to knock out the background. The new path is created underneath the original selected path (see
drawing on previous page).

9.6.8.  Trapping pictures using Blended

When trapping pictures using Blended mode, all traps will be correctly calculated. However keep in
mind that a blend mode is applied, so flattening will be needed to output PostScript or PDF 1.3.

9.6.9.  Trapping pictures using Overprint

When trapping images, you need to see first if there really are more pixels outside the clipping path
or picture box or not. If not, the only possibilities are either choking (default) or cloning pixels to
spread (time consuming and so not done often). Therefore most people choke an image to generate
transparency towards the background, even if the background is darker.

If the line art is on top of the image
• Spread or choke the line art.
• Transparency will be created to all the different underlying separations.
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If the image is on top of the line art
Trapping can be created in a number of ways, depending on the picture type.

• Mapped pictures can be trapped with the normal Spread/Choke function. Transparency needs to be
applied manually though: fill out t or trans for all separations of the background.

• EPS images can be spread or choked, but Put EPS in First Four Separations Only (see Preferences...
on page 48) needs to be switched on. To see the trapping, a separated preview must be calculated
and even then, the preview of the EPS is only a simulation. When making separated output, the
trapping will be fine. EPS pictures in PostScript by default mask out underlying layers. However,
ArtPro provides a workaround to generate transparency from EPS pictures to a spot color back-
ground. When Put EPS in First Four Separations Only is active in the Preferences dialog, the
CMYK EPS will generate transparency towards all the background colors except for CMYK itself.
Transparency within one ink cannot be generated. When Put EPS in First Four Separations Only is
not active in the Preferences dialog, the EPS will mask out all the underlying inks.

• DCS pictures (and DCS-2) do not mask out underlying layers. All separations are transparent
towards underlying inks which are not used in the DCS file. This means that the ArtPro operator
should modify the choked path which is originally set to all zero, towards zero for masking out the
underlying inks, and towards Transparent for transparent inks. So it is up to the operator to define
what separations need to overprint.

Note
• When spreading or choking a picture, ArtPro sets the inner path automatically to all 0%.
• The checkbox for Put EPS in the First Fours Separations Only works on all the EPS files in the job at

once, even untrapped images.
• If you have a monochrome EPS in a spot color (e.g. in a PANTONE Color ink), you cannot activate Put

EPS in First Four Separations Only, or the monochrome EPS will not be exposed.
• The Put EPS in First Four Separations Only preference is only read on the moment you calculate a

separated postscript file (= print).
• The Put EPS in First Four Separations Only preference is not applicable on DCS or DCS-2 pictures.

(see remark above)
• For other kinds of images you can only create trapping between line art and image if the line art lies

on top of the image. Thus, you could Stroke a path containing a picture and color the stroke (which
lies on top) transparent for the background color.

• Trapping created with interactive trapping is not always previewed correctly. In some cases
separated preview needs to be switched on.

9.6.10.  Corners

• Mitered: a mitered corner closes in one point. When the angle of the original corner is very sharp,
this might result in a very sharp peak. Therefore a Miter Limit (see below) can be used to cut off the
corner at the distance of the miter limit factor multiplied by the trapping distance.

• Rounded: a rounded corner joins the corners with a circular arc with the diameter equal to the
trapping distance.Bevel: a bevel corner is comparable to a rounded corner, while it joins the cor-
ner segments with a straight line instead of an arc.Square: a square corner is comparable to a
mitered corner. The limitation of the square corner, however, is not controlled by the Miter Limit.
The Square corner has a maximum distance on a corner of a 90° angle = Ð2 x distance, resulting in a
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square corner. The minimum appears on a 0° and 180° angle = 1 x distance. All angles between those
values vary between 1x and 1.4.x the distance. Angles < 90° are cut off, angles > 90° are not cut off.

 

 

9.6.11.  Miter Limit

A mitered corner closes in one point. In order to avoid that the resulting corner becomes too sharp, it
can be cut off. The distance where the corner is cut off, is controlled by a factor called the Miter Limit.
If e.g. the Miter Limit is 2, the distance where the corner is cut will be twice the trapping distance. The
Miter Limit value should be greater than or equal to 0.

9.6.12.  Create Die: Male / Female

The Create Die: Male / Female function was implemented to create the Die to be used for Braille fonts.
It can be used on Braille fonts, but also on any other object. It can be found by expanding the Interactive
Trapping dialog, by clicking the + (expand window) button.

The die for Braille fonts consists of a male (slightly smaller) and a female (slightly bigger) die.

Male
When pressing the “Male” button, the selected objects or text will be choked, based on the distance and
Corners settings.

The color settings of the original object remain unmodified. The newly created shape will be
completely transparent, and will be placed in a separate layer called “Male Die Layer”

Female
When pressing the “Female” button, the selected objects or text will be spread, based on the distance
and Corners settings.

The color settings of the original object remain unmodified. The newly created shape will be
completely transparent, and will be placed in a separate layer called “Female Die Layer”
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Output Fully Transparent Objects
The die information created by the Create Die function, most often needs to be exported to Illustrator
or to PDF. To avoid that completely transparent objects are ignored when exporting to PDF or to
Illustrator the option “Output Fully Transparent Objects” in Export Illustrator or Export PDFshould be
used. See Export Illustrator on page 123 and Export PDF on page 111 Output Fully Transparent Objects.

9.7.  Automatic Trapping

Note:  This module is optional. See Show Licenses on page 49 for more information.

Automatic Trapping is an additional module to the basic ArtPro package that is called PowerTrapper.

The Automatic Trapping... dialog contains all the functions to automatically trap a job or part of it.
Automatic trapping performs spreading and choking, fully or partially and to centerlines, completely
automatic. The resulting trap direction, color and distance can freely be chosen. Autotrap paths are
still editable afterwards. The dialog can be activated in the Paint menu or by its shortcut.

9.7.1.  General

 

 

Trap
The Trap button activates the actual trapping process. All settings underneath will be applied. If the
color matrix (see below) wasn’t calculated already, this will be done on the fly. The trapping process
can be cancelled at any time with COMMAND-period (Cmd-.) The cursor will stop rotating, but it is
possible that you’ll have to wait to let the trapper finish its work. When the trapping is cancelled, you
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will possibly have to wait some time (depending on how much trapping has already been done) before it
is accepted.

Remove Traps First
If the Remove Traps First checkbox is on, all existing traps will be removed before trapping is
calculated. If the Remove Traps option is on, the selection of the original objects will be kept, allowing
to immediately trap the same selection again, with different parameters.

Version 1 / Version 2
The Version defines what trapping routine has to be used. Version 1 starts to trap in the background
and works its way to the front, while version 2 starts in the front and works towards the back. This
second routine should be faster in general, though version 1 might give more consistent results, as it
has a longer development history. Therefore we recommend to use version 1 for packaging and labels
and version 2 for commercial work.

A few other differences are:

• that Version 2 will not work with live text. All fonts need to be converted to paths first.
• that Version 2 takes certain transparencies into account. In the example below, a transparent

yellow circle is put on top of a cyan and magenta rectangle. Version 1 (left) ignores transparency.
Only with version 2 (on the right) this is trapped correctly.

 

 

4Stage Trapper
4stage Trapper uses a totally different kind of procedure. Unlike Version 1 and 2, it does not work object
based, and only calculates traps for where different colors actually meet.

The 4stage Trapper is the only good way to trap objects containing transparencies. The traps made by
the 4stage trapper are defined using transparencies as well.

9.7.2.  Geometric Parameters
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Distance into Color
Defines the spread distance for trapping colors under colors. When you enter a value for into Color, it is
automatically copied for into Black as well.

Distance into Black
Defines the spread distance for trapping colors under black. If into Black needs a different value than
into Color, enter into Color first and then into Black, because by default the value from the first field
is copied into the second. Sometimes you may want a bigger spread under the black color, e.g. for a
centerspread. To create a centerspread (center trapping in black e.g. for comic strip drawings), the
spread value should be set to slightly more than half the width of the thickest black line. When the
spread value is higher than half of the black line width, in the middle, where the spreads meet from
both sides, the spreads will be limited to the center and will not overlap.

Distance into CT
Defines the spread distance for trapping colors to pictures. For Version 1 and Version 2, the color
type can be flat color or linear gradation. Multistep gradations and other pictures are not trapped
automatically.

The 4stage trapper can trap anything

Center Error
These fields specify the accuracy for the centerspread (see example below). Center Error Off means
no centerspread is calculated. The percentages, together with the distance, define the precision for
center trapping. The lower the percentage, the more precise, e.g. with a trapping distance of 0.5 mm
and 8% accuracy, the trap centerline will be at a maximum distance of 0.04 mm off the real centerline.
Keep in mind that increasing the accuracy will increase the trapping time! Also note that a smaller trap
distance results in more accurate centerspreads, so do not set the distance higher than necessary.
The accuracy cannot be different for normal colors and for black for the 4Stage trapper, or if the
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trapping distances are equal. This means that if the black trap distance is changed to equal the normal
trap distance, the accuracy will automatically be set to the one for the normal colors.

General settings are 8% for normal colors and black. If you have a job where centerspread under black
is important, put the accuracy to 2%, 1% or even 0.5%.

Example: before trapping:

 

 

with black hidden:

 

 

Center trapping:

 

 

with black hidden:
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Corners / Miter
This field defines the trap corners, which can be mitered, rounded, bevel or square (see Interactive
Trapping... on page 304). The miter limit can be set to max. 4.

Clip Chokes (only Version 1 & Version 2)
By default this option is active so that the choked paths follow the shape of their original path, as they
should. However, the result may not be optimal on certain jobs for example when a centerspread under
black is required. The trap will be clipped with the original paths lying under the black and therefore no
centerspread will be performed. Thus, deactivate the option before trapping in such cases. Perhaps
it will even be necessary to trap twice: first with a Distance into Color only and Clip Chokes, next with
a Distance into Black only (for the centertraps) and without the Clip Chokes option. When color areas
exactly touch (and do not overlap) the black keyline of a design, center spread will work correctly, even
when Clip Chokes is active.

 

 

Small Objects : Add White Frame (Only Version 2)
The Add White Frame option allows to create a white frame around objects smaller than the defined
Maximum Size for small objects. The white frame will have the size of the Into Color distance.

This can be used to make very small text more readable.

Therefor, the Max size is defined in points.

Small Objects : Handle As One (Only 4stage Trapper)
It is possible to set the 4stage trapper to handle small objects with the same paint, as one single
object. Therefore, the small objects (mostly text) should be smaller than the Maximum Size, have
exactly the same paint (i.e. same paint style, same screening and same transparency), and be within
the Max Size distance from each other.
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If the Handle As One option is on, these small objects will be spread or choked, based on the most
occurring trap direction.

Detect Small Gaps (only 4stage Trapper)
The Detect Small Gaps option allows to detect very small gaps in between objects (smaller than 0.02
mm) and ignore those while trapping. This increases the calculation time slightly, but improves the
trapping result.

9.7.3.  Color Parameters

Separation Threshold
The Threshold indicates the minimum difference that must exist between touching colors before they
will be trapped.

There must be a difference more than the Separation Treshold in at least one separation in each
direction.

The usage for the different Versions is described below.

Black Margin
The Black Margin defines what colors will be treated as black. From what percentage on should an
object be trapped with the distance into black and from what percentage on into color? The default
value is 85%, meaning a box of 100% yellow will spread into a box of 90% black with the distance
of into black. If the black in this example was only 80%, it would trap at the distance for into color.
It actually doesn’t just apply for black but in general for all dark colors. If the black value in color on
proofer multiplied with the percent value in paint style is higher than the black margin, ArtPro will use
the distance into black.

Black Margin also makes a difference in trapping images for Version 1 and 2 : all colors, except for
black, are spread into the image by default. Using the Black Margin, you can define what colors should
be choked i.o. spread. The Black Margin also applies when using Keep Away Rich Black (see below)

So, this function can be very useful in 3 cases. First of all if you use a dark pantone spot color i.o. black,
but still need to set a specific distance and center error for the dark keylines. Second, when trapping
images using Version 1 or 2, you can use the Black Margin to define that colors darker than the set
Black Margin should be choked towards pictures i.o. spread.

Third, when using the Keep Away Rich Black option.

Trap Intensity
The Intensity, by default 100%, defines the “ intensity” of the trap and can be adjusted according to
the needs. When a job is trapped, the traps should be as inconspicuous as possible. With a lower
intensity, the traps become lighter and so less visible. But keep in mind that if the intensity is too low,
the trapping will not be correct.

When using Version 1 or 2, the trap color constitutes a new color which is a mixture of the two given
colors. To calculate the trap color, ArtPro uses the highest value of the separation of the two trapping
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colors. When the Intensity is lower than 100%, the values of the lightest color are first multiplied with
this Intensity and only then the highest value is taken per separation (for examples see below).

When using 4Stage Trapper, the traps (which have the color of the spread object, and a “Darken” blend
mode) will have an opacity defined by the Intensity field, giving the same result as described above.

Insert Traps (only 4Stage)
If set to Blended, the trap will only contain the source color (the color of the object that is trapped
into the other) using blend mode “darken”, and will be placed on top of the file. If set to Opaque, the
trap will contain both the source and target color in opaque mode, so not using any blend mode, and
will be placed on top of the file. When choosing “Opaque”, the “...” button allows to open the Flatten
parameters, as flattening will be applied before trapping.

Keep Away Rich Black
A rich black is a black element, to which another color was added, to make it look darker. Usually, a tint
of cyan is added to the black, but this could be done with any separation, cmy or spot. The idea is to
make 100% black look darker on print, as black, like other inks, is a transparent ink, which sometimes
looks more like a dark gray than black.

If the Keep Away Rich Black option is on, a rich black area is trapped so that the supporting color is
kept away from the edge of the black, on white as well as on color. This means that on a white element,
a trap line is created with only black and no supporting color.

In fact, rich black trapping is not specifically applied on black, but on the color that carries the K flag in
the separations list. This means rich black trapping could be performed with a spot color that replaces
black in the file.

For Version 1 and 2, an object should have at least 95% K to be treated as a Rich Black.

For 4Stage Trapper, it should have at least the “Black Margin” value in the K separation, and the
“Separation Treshold” value in another separation. All 100% (Registration color) will not be considered
to be Rich Black.

Trap spot inks according to ink sequence
If this option is on, all separations except for CMYK, are considered “Opaque”. This can be very usefull
e.g. in gravure printing, using opaque or almost opaque inks, where the trapping direction should be
determined by the ink sequence instead of the color differences.

Split gradations (Only Version 1 & 2 )
Vignettes are normally by default spread or choked as one object, that is either completely spread or
completely choked. In theory, though, this trapping is not always correct. A gradient could be darker
than the background at one end (choke) and lighter at the other (spread).

This option makes it possible to partially spread and choke one vignette. When it is active, the
calculation of the automatic traps will divide the vignette path into several parts depending on the
colors. On the basis of the light-dark principle the different parts will then be spread or choked. Hence,
some parts of the same vignette can spread to the outside whereas other parts can choke to the
inside. So, somewhere in the middle, the trap switches from one to the other. Note that using the split
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gradations option will make the trapping matrix much more complex, because one vignette is seen as
multiple colors. The Split gradations option does not apply on multistep gradations.

 Gradation Mode (Only Version 1 & 2)
When set to “Step Into Gradation”, the program will decide on the trap direction according to the
light-dark principle. When set to “Always towards flat”, ArtPro will always force gradient to spread into
flat colored backgrounds, even if this background is lighter. This option is not applied for multistep
gradations. Forcing a multistep gradient into a flat color will have to be done manually.

The 4state Trapper always uses Step Into Gradation.

Trap Images / All Separations (Only Version 1 & 2)
In order to trap mapped pictures automatically, enter a distance for Into CT and activate the Trap
Images option. By default it is switched off so that selected pictures are ignored during autotrapping.

Using Version 1 & 2, mapped pictures trap with flat colors or linear gradations, not with multistep
gradations or other pictures. The autotrap result will be a mapped picture with a minimum value added
for the underlying colors or a gradient transparent on top of the picture.

When all separations is active (default), it will trap all the separations of the color, whether they are in
the picture or not. When the option is not active, the image is only trapped into separations that are not
in it.

For example, a cmyk image is put on top of a cyan background and a pantone 032. With the option off,
it only traps into the pantone 032, with the option on it traps in both. By default, all colors are spread in
the image, and black is choked. This can be adjusted using the Black Margin (see earlier).

The 4stage Trapper always traps “All Separations”.

Image to Image (Only 4stage Trapper)
Using the 4stage Trapper, images are always trapped towards lineart. If the Image to Image option is
on, images will also be trapped towards images.

Image Mode (Only 4stage Trapper)
When set to “Step Into Image”, the program will decide on the trap direction according to the light-dark
principle. When set to “Always towards images”, ArtPro will always force the background to spread into
the image, even if this image is lighter.

9.7.4.  Matrix

 Color Matrix
The Color Matrix is the visual representation of the trap colors. It allows you to check and change the
automatic trapping suggested by ArtPro.
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When selecting objects and clicking “Trap”, the Matrix will be calculated, and the trapping will be done
immediately. It is however possible (and advisable) to do this in two steps :

- Select the objects, and click Calculate Matrix. The Matrix will be calculated, allowing to check and edit
trap colors and directions.

- Click the Trap button. Traps will be calculated based on the Matrix

On the left, all the colors are ordered from light to dark, then images and gradients. On top, you see the
opposite: gradients, images and then all colors from dark to light.

 

 

For Version 1 and 2, the Matrix suggests standard trapping for all the paint styles in the selection, even
colors that are physically not touching in the file. When using 4stage Trapper, only colors that actually
touch will have suggested trapping. Colors that do not touch are shown as a light gray cross (without
square)

Read the matrix as following: the colors on the left (vertical) are trapped into the colors on top
(horizontal) if the corresponding square in the matrix is on (filled with a trap color). This could be both
a spread or a choke. In the example on the right, the gray spreads into the image if it is on top, but the
same matrix would show if the gray was behind the image (then the image is choked).

By using the scroll bars you can move through the matrix. Selecting a trap color in the color matrix is
done by clicking on it. The selection shows a red rectangle around the selected cell. You can select a
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whole row or column by clicking on the color samples on the left or at the top. On the selections you
can use the Reset, Exclude, Force, Specify Trap or Apply functions.

Double clicking on a color sample on the top or left, opens the Paint Style dialog and shows you the
exact color values for that flat tint, vignette or image. Double clicking on one cell, opens the Specify
Trap dialog (see below).

If the standard trapping by ArtPro was changed in any way, a white square appears in the cell, to
indicate it is user-defined. A trap defined by Trapping Pairs is represented with a gray square in the top
right corner.

All traps defined in the matrix are saved in the ArtPro document. This means that until a cell is reset, it
will always trap in the same way, even after deselecting, saving,...

Calculate Matrix
The Calculate Matrix button calculates the trap colors for all the selected paths in the job. When the
function is performed again on some of the same objects, it will not reset the previous user-defined
traps. This allows you, for instance, to Trap, Undo, make some more modifications in the matrix
and Calculate Matrix again, leaving the first modifications unaffected. Calculating the matrix is not
compulsory before pressing the trap button, meaning you don’t have to check and make changes to the
matrix.

 

 

Force
By pressing the Force button, trapping on all selected cells in the matrix is switched on. With 4stage
Trapper, it is not possible to trap in both direction, meaning clicking “Force” will Exclude the opposite
direction.

Clicking Force while holding the Shift key, will Exclude the opposite direction.

Exclude
By pressing the Exclude button, trapping on all selected cells in the matrix is switched off. So this
makes it possible to prevent the autotrapping of certain color pairs.

Clicking Exclude while holding the Shift key, will Force the opposite direction.
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Specify Trap
 

 

The Specify Trap... button opens a dialog. On top you will see a color sample of the two colors, with a
sample of the trap color in between. In this dialog it is possible to change the trapping distance and the
trapping color for each cell separately. Note that when the distance of two colors is set to custom for
one cell, changing the general Distance into Color, Black and CT will not affect this cell anymore, until it
is reset again. It is not possible to specify trapping for images and gradients.

The changes made in Specify Trap are only used after pressing the Apply button.

Reset
By clicking on the reset button, all selected cells in the matrix are set back to the default. E.g. to cancel
a user-defined color, or a Force or Exclude, select the matrix element and click on Reset.

Clicking Reset while holding the Shift key, will Reset the opposite direction as well.

Reset All
All the modifications made in the color matrix are reset to the default values suggested by ArtPro.

9.7.5.  Trapping Pairs

The new trapping pairs functionality in Automatic Trapping, allows for users to predefine pairs of
colors. Both trap direction and trap color can be defined.

Trapping Pairs
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The 'Trapping Pairs' button opens the dialog that holds the actual trapping pairs. A trapping pair
is represented by a From color, a To color and a Mix color. The From and To are the original colors,
whereas the From will be spread into the To color. The Mix will be the color of the actual trap.

There are six buttons in this dialog:

“New” creates a default trapping pair. If it is the first one created, no separations will be provided. If
not, the new pair will receive all separations of the existing ones (color + name), the from, to and mix
values are set to ‘ignore’.

“Delete” removes the selected entry

“Reset” removes all entries

“Save” creates an XML file storing all necessary data for each entry

“Load” loads an XML file into the dialog (job), previously present trapping pairs are removed

“Merge” loads an XML file into the dialog (job), without removing the ones who were already present,
merging the new trapping pairs with the ones already present

Trapping Separations dialog
Double-clicking on a trapping pair opens the trapping separations dialog, or updates it if it was already
open. This dialog contains the separation info for the currently selected pair.
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Separations
The separations defined in the Trapping Separation dialog, can be retrieved from an open job, or can
be defined by typing in the separation name. By clicking the color square in front of a separation name,
its color can be defined in cmyk. This color can thus be different from the actual color in the job. The
number of separations, their color and their name will be the same for each trapping pair.

From, To, Mix
The From and To fields, defining the original colors, accept three forms of input

• an absolute value, which behaves similar to the values in the paint style dialog
• a range from value a to value b, defined as a:b. Both values have to range from 0 to 100, and have a

precision of 2 decimal points.
• an 'ignore' value, represented by a hyphen. These values are ignored in defining the “match” of a trap

pair. If a separation in the trapping pair contains ignore values in both from and to fields, the whole
separation is ignored.

The Mix field defines the color of the trap, i.e. the mix of both From and To colors. The mix color is
represented in the right column in the Trapping Pairs dialog. The input field accepts three forms of
input

• an absolute value, which behaves similar to the values in the paint style dialog
• an 'ignore' value, represented by a hyphen. If an ‘ignore’ value is entered in the mix column, the trap

color for this separation will be calculated by the trap module, i.e. no user defined values are used.
• exclude, represented by ‘x’. An ‘x’ in the mix field indicates that the current trapping pair should be

excluded from trapping. To avoid confusion, when an exclude value is entered in one mix field, it is
copied into all other mix fields.

All representation colors in the trapping pair dialog are based on the user defined color in the trapping
separations dialog, and may not match actual colors from the job.

Apply
The Apply button updates the selected trapping pair with the settings of the Trapping Separation
dialog. If any of the colors were changed, you will see the color changing in the Trapping Pairs dialog.
If the trapping pair should be excluded, so the mix fields all contain exclude values, an ‘X’ will appear in
the Mix column in the Trapping Pairs dialog.

Load Separations From Job
The Load Separations From Job button (ArtPro only) adds the separations from the current job (with
their colors) to the existing separations in all trapping pairs putting Ignore values in the from, to and
mix fields. The separations are only committed the moment you click the Apply button.

How It Works
When the trapping Matrix is calculated (ArtPro), all color combinations from the job are matched with
the defined Trapping Pairs. If a trapping pair is matched, the resulting trap will be represented in the
matrix as an edited trap (with a white rectangle in the trap color). Color combinations not matching
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any Trapping Pair, will have default trapping color and direction. After matrix calculation, individual
combinations of colors can still be excluded, forced or edited manually, overwriting the Trapping pair
settings.

If a paint has to be matched with a trapping pair:
First, the separation list of the actual job is matched with the separation list of the trap pairs
separation list. Wildcards used in the Trap pair separations are resolved, and the separations are put
in the order they appear in the actual job. This separation matching is done only once for the complete
job. If a paint is not a flat paint, or contains transparencies, it will be considered not matching any
of the trapping pairs. A percentage matches with a value if it equals an absolute value, if it's within
the boundaries of a range (upper bound included), or if the pair value is a don't care value. Only if all
percentages match with either all values in the from column, or with all values in the to column, the
whole paint matches. A trapping pair containing a value or range for a separation that is not present in
the actual job, cannot match.

Calculation of trap color
If a match is found, the trapping color is computed:

For each don’t care value in the mix column, default trap paint calculation is applied, the other values
are put directly into the new paint.

Obviously, no trapping color will be computed if the mix color contains only exclude values.

9.7.6.  Procedure

Automatic trapping can be done on an entire job or in sections. For complex work it is advised to trap
the job in sections, to keep the matrix and the trapping results orderly.

1. Select the elements to trap (one logo, one flap of a box, one entire page or label,...). Note that
elements on top of the selection, even if they are not selected, may affect the trapping in an
adverse way. You can select them as well or hide them.

2. Open the autotrapping dialog.
3. Fill out the general trapping distances for color, black and images.
4. Define all settings.
5. Switch “Remove Traps First” on.
6. Press Calculate matrix. ArtPro now displays how the document will be trapped. If you like you can

change the distance and color for every separate trap.
7. Press Trap. Depending on the complexity of the document, trapping may take a while to calculate,

but in general this is no more than a few minutes.
8. Zoom in on the traps and check the result carefully.
9. If any errors are found in one section of the document, select that section. If the complete selection

needs to be redone, just keep the selection as is.
10. Retrap it with different parameters or retrap that section with manual trapping.

9.7.7.  Trap Calculation Version 1 & 2
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Restrictions
• Mapped pictures can be trapped with flat colors and linear gradations, not with multistep

gradations and other pictures.
• Linear gradations will trap to flat colors, other linear gradations and mapped pictures, not to

multistep gradations.
• Multistep gradations will only trap with flat colors.

Small Paths
If paths are very small compared to the trapping distance, some unexpected or bad results may occur.
This could happen when trapping an imported gradation which has been converted to a series of paths.
Therefore it is advisable, if possible, to replace these converted gradations by ArtPro real gradations.

Which colors are trapped and in what direction?
For two adjacent objects, the lighter color should be trapped to the darker color. This is not always
correct when opaque inks are used (e.g. gold, silver, silk screen printing inks). Therefore a more
complex reasoning is required: Assume 12 is the spread color of color 1 to 2 and 21 is the spread color of
color 2 to 1. The composition of both color 12 and color 21 depends on the Intensity settings (see below).

The trap direction chosen is the one where the trap color most closely resembles the original color,
which gives the best visual results. In most cases, but not all, it will result in the lighter color being
trapped to the darker one. In case of opaque separations this procedure gives better results than the
normal always-light-to-dark. E.g. a black color and a gold opaque color with a higher opaque order than
the black. With the light color trapped to the dark, the gold would trap to the black, as gold would be
the lighter color. Spreading gold into black would here result in a gold trap (even if there is some black
underneath since the gold is opaque), thus a color which is completely different from the original black
color. Spreading the black towards the gold also gives a gold trap color, but there it is very close to the
original gold color. Hence, this direction is preferred.

How the trap color is calculated
The trap color constitutes a new color which is a mixture of the two given colors. Its intensity can
be changed (see Intensity above). To calculate the trap color of color 1 into color 2, ArtPro uses the
maximum value per separation of the two colors. For color 1 (lighter) ArtPro uses a certain percentage
(= Intensity) of its original values and for color 2 (darker) it uses the original values of the color.

With this formula the new color contains at least all the separation intensities of color 2, which is
usually the darker color, which gives very good visual results. In exceptional cases, color 2 can be a
lighter color when it has been defined opaque, with an opaque order higher than color 1.

Normal Trapping:

C M Y K

Color 10 20 100 0 (lighter)

Color 50 0 20 50 (darker)

Trap Color: 50 20 100 50
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Example: (Intensity = 40%)

C M Y K

Color1 10 20 100 0 (lighter)

at 40%
intensity:

0 8 40 0

Color2 50 0 20 50 (darker)

Trap Color: 50 8 40 50

Which color pairs are not trapped?

Colors with a difference in only one separation.

e.g.:

C M Y K

Color1 50 100 0 20 (lighter)

Color2 50 100 0 70 (darker)

Colors with all separation differences smaller than a given value (by default 5% - see
Threshold above).

e.g.

C M Y K

Color1 50 100 0 20

Color2 54 98 2 20

Difference: 4 2 2 0

As soon as there is a difference in at least two separations, higher then the threshold, normal trapping
is performed:

C M Y K

Color1 50 100 0 20

Color2 56 98 7 20

Difference 6 2 7 0

Trap Color: 56 100 7 20

Colors where the trap color is equal to the darkest color.

E.g.

C M Y K
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Color1 10 0 50 0

Color2 40 0 95 36

Trap Color: 40 0 95 36

Actually, internally, some of these traps will be created, but removed at the end of the trapping
process. This is needed to get better trapping at the intersections of the paths.

9.7.8.  Trap Calculation 4Stage Trapper

The 4 Stages of the Trapper
As the name of the 4stage trapper indicates, the 4stage trapper consists of 4 steps : See, Think, Build
and Paint. See : what surfaces touch each other. Think : how do these surfaces need to be trapped.
Build : create the outlines for the traps. Paint : define the paint for the traps.

When clicking the “Calculate” button, the first 2 stages will be done, and the Color Matrix will represent
the result. This will allow to modify the Color Matrix, using the Force, Exclude, etc.

By clicking the “Trap” button, the trapper will continue with step 3 and 4.

If the “Trap” button is clicked, the first 2 steps will also be done if the Calculate function hasn’t been
applied before.

See
The See stage looks at all selected objects, and determines which surfaces touch each other. This
may take longer than version 1 and 2, as it applies (internally) a number of set operations (intersecting,
clipping, etc.). The result is that the Matrix will only contain colors that actually touch, and that the
trapper no longer works object based, but surface based. Different parts of an object are considered
independently and thus may be trapped differently. In the example underneath, you can see clearly that
the polygon has 2 different intersections with the rectangle.

 

 

Think
The “Think” stage of the trapper is the point where the trapper decides for every surface, if trapping will
be done, and in what direction.

The Think stage takes a number of settings from the Colors tab in consideration.
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To determine the “normal” trap direction, the color of two adjacent surfaces must differ more than the
separation threshold in at least one separation in each direction. This means that the first color must
have at least one separation that is darker than the other color, and vice versa.

Examples :

C M

Color1 40 60

Color2 60 90

No trap (differences in only 1 direction)

C M Y

Color1 40 60 0

Color2 40 0 80

trapping from C2 to C1

C M

Color1 40 60

Color2 38 90

no trap : only difference in 1 direction above Treshold.

Images and gradations are always trapped too. To determine the trapping direction for these paints,
the 4Stage trapper will calculate the minimum and maximum values for each separation in the region
of the trap, and then apply the same algorithm as for flat paints.

Build
The Build stage calculates the geometry of all traps. It uses the parameters on the geometry tap, such
as trap distances, center errors and trap join type. The 4Stage trapper will always clip all traps, so the
corresponding option is disabled.

“Keep Away”s are also calculated in this stage. The distance used here is the “Distance Into Black”

Paint
Traps generated by the 4Stage trapper are almost always blend groups with blend mode “Darken” and
opacity equal to the Trap Intensity. This means the Paint Style dialog is not very usefull to inspect the
trap color, the densitometer should be used instead.

Traps for which the color was overridden, either by changes in the matrix, or traps from trapping pairs,
are painted in overprint, in order to improve their appearance where traps overlap.
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All traps are added to a separate layer to make it easier to hide or delete them. This feature, in
combination with the View Separations dialog, provides great tools for inspecting traps.

9.7.9.  Remarks

• Trapping time will increase according to the number of trap distances defined and the complexity
of the selected paths.

• Once a color has been modified, thus user-defined, it is unaffected by changes of the general
settings, such as Distance (when set to “custom”), Threshold and Intensity.

• Changing the trap color of a color pair of which one color is a gradation, will result in a flat trap
color.

• All traps are editable after the trapping process. This means that you can still remove traps or
change any trap color.

• Traps are vectors, even if the original objects contained splines or consisted of text.
• To trap two surfaces, their paths should overlap each other or at least touch in the trapping area.

Paths which do not touch cannot be trapped.
• Traps created with Automatic Trapping carry a trap flag. This means that ArtPro can distinguish

them from other paths. When a job is saved, the trap flag is retained.
• Because of the trap flag, automatic traps are also highlighted by Highlight Overprints in the Show

Separations menu.
• Traps are automatically ignored when the automatic trapping is performed again and when the

ArtPro job is exported to Illustrator. The latter can be changed by activating Include Traps in the
Export Illustrator dialog.

• By modifying traps they loose their trap flag, so ArtPro doesn’t recognize them as traps anymore.
This goes for transformations (move, rotate, scale,...), changing paint style, changing layers, copy
and paste,... Obviously, you can always select and delete these elements without trapping flags
manually.

9.8.  Path Warp...

Path Warping will warp linework, working from one open line to another. Path warping does not support
vignettes, images or text.

9.8.1.  Procedure

Create a baseline and a resultline. They can be created freely or with the Create Conic function, which
can be used in 2 ways (see below). Warping is done from the baseline to the result line. Both lines may
be curves but must be open paths. Even if you want to warp on a circle, you must cut the circle first
with the Cut Paths function in the Object menu.
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Select the paths to be warped (not the base line).

Define the warp settings (alignment, copy, times).

Press warp; the cursor changes into a cross.

Click on the baseline.

Click on the result line.

ArtPro calculates the warping of all the selected paths.

9.8.2.  Create Conic

When warping graphics for cups and bottleneck-labels, it can be dicult to define the exact warp
paths. The baseline and the result line are important, because they define the deformation and you
have to make sure that your graphics fit the deformation of e.g. your cup. Therefore Create Conic gives
the baseline and the result line automatically for your specific deformation, based on the warping
angle.

Procedure:
• Select the paths to be warped.
• Give an angle in the first input field, and click on the Create Conic button next to it. OR Give the

length of the lower circumference in the corresponding input field and click on the Create Conic
button next to it

Automatically 2 lines (=open paths, not visible in Color Preview) will be created: a straight baseline
centered on the bounding box of the selected paths and a curved result line in the upper quadrants of
the ruler, centered on its vertical axis.
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After creating the baseline and the result line in this way, Warping is achieved via creation of your own
warp lines. Graphics with bleeds usually require the bleed to be deselected when creating (Create
Conic) the warp lines.

 

 

9.8.3.  Measure Path

Measure Path calculates the length of any path (open or closed). To measure a path: click on Measure
Path and click on a path. When you measure a path belonging to a Compound, only the length of one
path (the one you click on) appears in the Measure Path field. You can use this information to choose
the length of the baseline.

9.8.4.  Alignment

 

 

• Left: the first point of the baseline is transformed to the first point of the result line.
• Right: the last point of the baseline is transformed to the last point of the result line.
• Centered: the center point of the baseline is transformed to the center point of the result line.
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• Justified: the first point of the baseline is transformed to the first point of the result line and the
last point to the last point of the result line. Between both points, the scale is adjusted. The scale
will also depend on the number of times warped.

• Proportional: the first point of the baseline is transformed to the first point of the result line and the
last point to the last point of the result line. Between both points, the objects remain the original
size but the additional space is divided and added between the objects.

9.8.5.  Times

The selected paths can be warped more than once. Fill in the number of times the warping should take
place. By entering M or Max (= maximum), the program calculates the maximum number of times the
baseline can be warped to the result line and uses this value as the number of warps wanted.

9.8.6.  Copy

When the Copy toggle button is ON, the originally selected objects for warping will remain in the job. If
the Copy toggle button is OFF, the originally selected objects disappear after warping them.

 

 

9.8.7.  Warping Vignettes

As specified in the introduction, Path Warp does not support the warping of vignettes. However, when
you have multistep vignettes, an easy trick allows you to get a warped result.

How to Warp a vignette?

1. replace the vignette by a multistep vignette
2. make sure the multistep shape is visible (use Get Shape in the Multistep dialog after selecting the

multistep path)
3. warp the multistep path as well as its shape
4. select the multistep path which is warped
5. click on Set Shape
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6. click on the warped shape
7. click on Modify in the Paint Style dialog, the multistep modifies to the new warped shape.

9.9.  Grid warp

Grid warp is an extra module in ArtPro called PowerWarp. It is used to calculate complex warping. As
opposed to path warp, this module can handle all paint styles (flat color, vignettes, images). It can be
used for e.g. conic cups, metal cups,... PowerWarp has a separate manual that you can find here.

Note:  This module is optional. See Show Licenses on page 49 for more information.

9.10.  Studio

Studio offers a 3D viewing environment where designers can see their artwork applied instantly on the
packaging. It also includes navigation and alignment tools, and by writing a 3D PDF file from Studio,
designers can share their ideas with clients for review and approval.

Studio reduces time-consuming mock-ups, spots design-errors faster and takes away the guesswork
from 2D flats.

For folding carton or corrugated packaging, the shapes can be supplied by ArtiosCAD or Score!.

The Studio tools in ArtPro can be found in Prepress > Studio.

9.10.1.  Introduction

Welcome to the Studio Designer documentation.

This documentation describes Studio Designer as a plugin in Illustrator as well as Studio integrated in
other Esko applications such as PackEdge. Although the documentation is based on Studio Designer in
Adobe Illustrator, the functionality is the same in other versions.

About Studio Designer
Studio Designer is a plug-in for Adobe Illustrator, ArtPro, PackEdge and Plato, for interactive 3D
packaging design which helps designers make graphic designs or do pre-press for folding carton,
bag files, cans, corrugated boxes, flexible packages and so on. Studio Designer works with structural
design files, created in ArtiosCAD or Studio Toolkit. These can be ARD files, .bag files or .dae/.zae
files (Collada files with a printable part defined). Once a structural design file is placed in a document,
Studio Designer can display a three-dimensional preview of the packaging with the artwork rendered
on it. This allows designers to see how their graphics will look on the final package. Studio Designer
also lets you load a multi-part structural design file as a scene. Each part of the scene can get its
graphics from another document. Studio Designer also contains productive tools for quick and
accurate aligning and duplicating graphic elements.
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Studio Designer is able to export a three-dimensional package to PDF and it can export snapshots of
the three-dimensional package to an image file.

About Structural Design files
A structural design file should always contain 2D information, and possibly even 3D information. If the
structural design file contains 3D information, Studio Designer can show a folded 3D representation of
the structural design file.

A structural design file (2D and 3D) contains all the cut and crease lines for a specific type of package.
A structural design file may also contain folding angles that define how the package is to be folded into
its final shape. The structural design file does not contain the graphics, only the structural lines. To
bring the structural design and the graphic design together, a structural design file can be placed or
opened.

Supported structural design file formats:

• ArtiosCAD or Studio Toolkit for Boxes (.ard files) for boxes
• Studio Toolkit .bag files
• Collada files with a printable part (.dae or .zae files)

In case a Collada file is placed, a check is performed to see if the Collada file has a printable part
defined. A printable part is an Esko extension to the Collada format.

Collada files with one or more printable parts can also be created in Studio Toolkit and ArtiosCAD.

You can also load a structural design file as an extra scene in the Studio window. Each part of the scene
can get its graphics from another illustrator document. See Scenes and Multiple Documents on page
346

Licenses
This software is protected against unauthorised use.

To purchase a license or a subscription, please visit http://www.esko.com/store or contact your Esko
sales representative

If you have a license for Studio Designer in PackEdge, ArtPro or Plato, this license is included in
the PackEdge, ArtPro or Plato licensing. For more information, see the licensing chapter in the
corresponding manual.

9.10.2.  Studio Designer Basics

To get started with Studio Designer, you need a document with a structural design file placed into it.

If the current document does not contain a structural design file, the Studio window will look like this:
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Above you can see how a structural design file is show as a 2D representation. Open the Studio window
to see the 3D view.

The Studio Window
The Studio window is the heart of Studio Designer. It is a floating palette where you can see the three-
dimensional shape of the package.

To view the Studio window, choose Prepress > Studio
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1.

The Maximize button . Click it to make the Studio window options panel visible. See The Studio
Window options panel

2. The Scene. This can be the structural design file used in the current document, or a scene
combining multiple documents. See Scenes and Multiple Documents on page 346

3. The View dropdown. You can select a View preset from the dropdown, or click View to open the
View settings. See View on page 337

4. The Orientation. See Changing the Document Orientation
5. The Fly-out button, opening the fly-out menu.
6. The 3D preview of the current document or scene.
7. The Refresh button. See Refreshing on page 336
8. The Full Screen Preview button. This will open the Studio Window in full screen preview, until you

hit the esc key. See Full Screen Mode on page 336
9. Show/Hide transparent panels. See Working with Panels on page 338
10. The Show/Hide Outlines button adds the outlines of the structural design to the 3D preview.
11. The Show/Hide 3D Guides button. See 3D Guides on page 354
12. The Zoom Slider. See Changing the viewing Angle and Distance on page 336

Note:  If the placed ARD file does not contain folding angles, the plug-in cannot know how the
box has to be folded. In that case 90-degree foldings are assumed on all folding lines. If the
resulting shape is not the intended one, the proper folding angles need to be added to the ARD
file, for example using ArtiosCAD or Studio Toolkit for Boxes.
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Refreshing
In ArtPro, the Studio Designer window will automatically be refreshed every time your document is
changed.

Changing the viewing Angle and Distance
In the Studio Window, you can look at the package from different angles.

• You can click and drag to rotate the 3D object.

• You can hold the shift key and click and drag to move the 3D object left, right, up or down (Panning).

• By moving the slider in the bottom-right corner you can look at the box from a closer or further
distance. Another way to do this zooming, is by using the mouse wheel.

• You can reset the camera position by double-clicking while holding the shift key.

To indicate that the package is not floating in mid-air, the floor concept was introduced. A package
in the Studio Window is always positioned relative to the floor, giving the package a top and bottom
definition. If the package (currently only boxes) is showing the wrong panel as top panel, then you can
use the Turn Box option. See Turn Box on page 341

Note:

When your box is facing the wrong way and when you have diculty to turn your box upright,
try using Turn Box... The turning around functionality has been designed in such a way that it
works fine if you have selected the right bottom panel.

Full Screen Mode

There are different ways to switch your Studio window to full screen mode:

•
By clicking the "Full Screen Mode" button  at the bottom of the Studio window

• By choosing Enable Full Screen Mode from the Studio Window fly-out menu

• By choosing Window > Esko > Studio Designer > Enable Full Screen Mode

• By using the shortcut F11 on Windows or Cmd+Alt+- (minus) on Mac

When full screen mode is activated, you can only change the camera rotation, panning and
environment rotation. You can get out of full screen mode by pressing the esc key.

Scene Settings
In the Scene Settings you can finetune the way your work looks in the Studio window.

You can open the Scene Settings dialog by choosing Scene Settings from the fly-out menu, or by
clicking the Scene Settings link in the Studio Options.

If the Preview option is enabled, the Studio window will immediately reflect the changes you make in
the Scene Settings.

All settings from the Scene Settings dialog are used in the Export dialog, except Floor Reflection and
Background Image for PDF file with 3D design and UD3.
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Environment

In the Environment tab you can set the Lighting Environment, the amount of Shadow Contrast, and
the background, either a color or an image.

Floor Reflection

The second tab of the Scene Settings defines the Floor Reflection by setting the amount of Reflection
Opacity and the Fade effect.

Note:  Lighting Environment and Floor Reflection Fade can only be set when using Visualizer
Quality. See Studio Visualizer in Studio Designer on page 338

View

In the View settings tab you can numerically set the view angles, pan and camera distance.

• Set the Object Heading and Object Tilt to define the position of the object
• Set the Pan and Camera Distance to define the position of the camera, or click Fit in Window to

reset the pan to zero and automatically adjust the camera position so that the 3D view fits in the
Studio Window.

• Set the Perspective by either defining the Focal Length (in mm) or Field of view (in degrees) of the
camera.

• Enable Keep vertical lines parallel if you want to get the effect of a tilt shift lens. If enabled, the
vertical lines in the pack shots remain vertical (without vantage point). You can use this to create
images that are easier to combine afterwards in a 'line-up' image. If the tilt angle is very large it can
lead to very unrealistic distorted perspective.

The View Preset dropdown allows to select one of the default settings, or any previously saved Preset.

You can save the current settings as a new preset by selecting Save as in the dropdown.

Select Manage... to open a separate dialog in which you can delete unnecessary presets.

The Scene Presets and View Presets folders can be found here:

• On Macintosh: Macintosh/Users/user/Library/Application Support/Esko/
Studio/

• On Windows: C:\Users\user\AppData\Roaming\Esko\Studio\

You can exchange the Presets between different operators by copying the files to another computer.

If you remove all Presets and restart Adobe Illustrator, the default Presets will be recreated.

Scene Presets

The Scene Preset dropdown allows to select one of the default settings, or any previously saved
Preset.

Note:  Scene Settings contain the Environment, Floor Reflection and View.

You can save the current settings as a new preset by selecting Save as in the dropdown.

Select Manage... to open a separate dialog in which you can delete unnecessary presets.
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The Scene Presets and View Presets folders can be found here:

• On Macintosh: Macintosh/Users/user/Library/Application Support/Esko/
Studio/

• On Windows: C:\Users\user\AppData\Roaming\Esko\Studio\

You can exchange the Presets between different operators by copying the files to another computer.

If you remove all Presets and restart Adobe Illustrator, the default Presets will be recreated.

Selecting Parts and Panels
You can select parts and panels by clicking on them in the Studio window.

By holding the option key and clicking a panel or part one or several times, you can select a panel or
part that is behind another one.

A Printable part or panel will be selected in red. When selecting a non printable part, all non printable
parts sharing the same material will be highlighted in orange. For multiple instances (e.g. multiple cans
on a tray), only the printable parts of the original instance will be highlighted.

See also:

• Zooming in on Panels in the document window on page 340
• About Hidden Panels on page 340
• Scenes and Multiple Documents on page 346

Studio Visualizer in Studio Designer
Besides the Studio Designer functionality, the Studio window contains a number of functions and
options that are related to Studio Visualizer for Adobe Illustrator. These options require a Studio
Visualizer license.

By default, Studio Designer shows a preview in its own Studio Designer quality. You can switch to the
enhanced Visualizer Quality preview, by selecting Visualizer Quality in the fly-out menu of the Studio
palette, or by selecting Visualizer Quality in the Studio Window settings panel, if no part is selected.

If Visualizer Quality is checked, a number of extra options, such as changing the lighting environment,
will also become available.

Next to these options in the Studio window, Visualizer for Adobe Illustrator also contains specific
palettes such as the Substrate and the Finishing Operations. For more information on these, we refer
to the Studio Visualizer for Adobe Illustrator documentation: http://help.esko.com/products/Studio
%20Visualizer%20for%20Adobe%20Illustrator

9.10.3.  Working with Panels

A box design and a bag design consist of a set of panels which are folded relative to each other.

Selecting Panels
In the Studio Window you can select a panel, simply by clicking on it. The selected panel is used by
certain Studio Designer features and does not affect the selected artwork.
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Tip:

Show Face Outline (in the fly-out menu) ensures that the selected panel is also shown in the
your document as a red solid line.
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Note:

Sometimes a dotted line appears next to the solid one. This is the case when you select a panel
that is also part of a composed face.

About Hidden Panels
Some panels cannot be seen in the Studio Window because they are covered by another panel no
matter which angle you are viewing the package from. To see those panels, you can choose Show
Transparent Panels, which is available at the bottom and from the Studio Window fly-out menu. In this
mode the package is drawn in a semi transparent way, allowing you to see covered panels. This will help
you to understand how the package's 2D unfolded view and the 3D view relate to each other.

 

 
 

 

By holding the option key and clicking a panel one or several times, you can select a panel that is behind
another panel.

Zooming in on Panels in the document window
If you double-click a panel (or if you select Fit Panel in Document Window from the Studio Window's
fly-out menu), the document window will zoom in on the corresponding part of the graphics.

If your graphics are in another document, then this document will become active.

Furthermore, the orientation of the document window will change to match the orientation in the
Studio Window as closely as possible.

You can also zoom in by holding down the Cmd key and dragging a rectangle around the area you want
to zoom in on.
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By spinning the package and double-clicking the different panels, the Studio Window can be used to
navigate through the document.

Turn Box
When working with designs for folding carton or corrugated boxes, you might not be able to position
the box in the desired viewing angle in the Studio Window. This happens when the package has the
wrong panel(s) facing up. You can change this e.g. in the structural design file (by selecting another
Base Panel in ArtiosCAD or Studio Toolkit for Boxes), but you can also turn the box in the Studio
Window. Just select a panel that should be facing up or down and select Turn Box from the Studio
fly-out menu. The Turn Box functionality is linked with the Floor concept, so e.g. The selected panel
facing up means that the selected panel will become the top panel relative to the floor.

Note:

The Turn Box option is only available for boxes (ard files)
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Bring Panel Forward and Send Panel Backward
This functionality is only available for boxes and composed faces of which the panels are all in the
same plane. Overlapping panels in the same plane can occur in any file. Sometimes the order of these
overlapping panels is incorrect. Most of the time, this will happen when the panels have been folded 90
degrees on top of each other. With Bring Panel Forward and Send Panel Backward, you can correct
this order.

If you wish to view another panel on top, you can select the panel, select Bring Panel Forward from the
Studio fly-out window and bring it forward.

Creating Copies with the Distribute command
Most of the faces of a package consist of a single panel. So there is just one rectangular area in the
document that will make up this face. However, sometimes a face is made of several panels. The
panels of such a “composed face” are spread across the document. They can even have a different
orientation. So for composed faces it is very dicult to create graphics that run continuous from one
panel into the other. Studio Designer can help you in this process with a feature called Distribute.

Note:

You can use Distribute on .bag and .ard files but not on Collada files.

Composed Faces

This is an example of a box with composed faces.-
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This is an example of a bag.

 

 

Viewing the Composed Face
If you select Show Face Outlines in the Studio fly-out menu and you click one panel that is part of a
composed face, 'ghost’ outlines will be drawn of the other panels of that face. These ghost outlines can
give you a good impression of the size and shape of the composed face.
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Distribute
If you draw some art within the boundaries of such a composed face, it will only appear on one
panel, since the other panels are actually somewhere else in the Illustrator document. However, with
Distribute, you can create copies of the art over several panels that are perfectly aligned to make it
look continuous on the folded composed face.

This is how the folded package will look without applying Distribute.

 

 
Distribute is available from Studio's fly-out menu. First you need to select art in the document and
you need to select the corresponding panel in the Studio Window. The selected art is supposed
to be positioned correctly on the selected panel. If you choose Distribute, copies will be made of
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the selected art for the other panels (of the same composed face). In the Studio Window (which is
automatically refreshed after a Distribute) you can see how the graphics are running seamless from
one panel into another.

Normally, distribute will make a copy of the selected objects for every panel in the composed face
(unless there is no overlap). If you do not need all these copies, you can simply delete the ones you do
not need.

This is how the folded package will look when having applied Distribute.

 

 

Making Clipping Masks
It is very likely that one or more of the copies lay partially outside of the panel they were created
for. Sometimes this is a desired effect (having the graphics run continuously over a folding line).
Sometimes this is not a desired effect and you will have to create a clipping mask to contain the copy
within its panel.

 

 

Working With Distributed Art
You can update the copied distributed art, for example after you have edited the original art; or you can
undistribute and expand distributed art if you want to delete the copies.
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Undistribute and Expand

The options Undistribute and Expand, which can be found in Studio's fly-out menu also apply to
distributed art. If you select distributed art and you Undistribute, all other (non-selected) copies
are deleted. If you have distributed art selected and you Expand, nothing will change visually yet the
selected art will loose its 'intelligence' and become regular artwork, insensitive to actions like Update
Copies or Undistribute.

You will need to use Expand if you start copying and pasting distributed art. The copy will still be
considered as part of a distribution, by expanding it, it will no longer be seen as a distribution, but as an
ordinary object.

Note:

When the distributed art is a group, ungrouping it is equivalent to applying Expand. The art
does not longer know that it was distributed, even if you group it again.

9.10.4.  Scenes and Multiple Documents

The 3D object that you see in the Studio window is typically the combination of two files: The artwork
from the current Illustrator document and the shape from the structural design file that is placed in
that document.

However, sometimes you would like to make combinations of more than one Illustrator document or
more than one structural design file. Some examples are:

• A box with inside and outside artwork

• A bottle with more than one label

• A tray containing 6 cans

• A complicated multi-piece display

• ...

This chapter describes the different mechanisms behind these workflows.

Alternative scenes

Load Scene

At the top of the Studio Window is the Scene dropdown box. Here you can see which structural design
file is currently visible in the Studio Window. By default this is the same file that is placed in your
document, but from this drop down you can load other structural design files.
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Your artwork will appear automatically on the loaded scene if the following conditions are met:

• There is a structural design file placed in the ArtPro document

• The selected scene has a printable part

• The printable part has the same size as the placed structural design
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In this example, the placed structural design file is a Collada file of a single can. The two other loaded
scenes are Collada files made in ArtiosCAD or Studio Toolkit, featuring that same can. You can switch
quickly between the loaded scenes from the drop down list. This can help you to improve the artwork
by seeing it in all of its different contexts.

Note:  If you have the WebCenter Connector plug-in installed, you can use Load Scene from
WebCenter. See Using Studio Designer and WebCenter Connector

Remove Scene

You can remove items from the list by selecting Remove…. This will free up memory but will not delete
the files. The files that are placed in an illustrator document cannot be removed, unless you close the
document first.

Collada files with Multiple Printable Parts
Some of the Studio Toolkits can produce Collada files with more than one printable part:

• A bottle with two labels, created by Studio Toolkit for Labels

• A multi-pack shrink sleeve, created by Studio Toolkit for Shrink Sleeves

• …

ArtiosCAD can also output structures with multiple printable parts. There is a slightly different
workflow for ArtiosCAD files that will be explained in the next chapter.

When you use a Collada file with multiple printable parts, you can only choose one printable part to
place:
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To see the object in the Studio Window with artwork on all the printable parts, organize your artwork in
a different document for each part. Use the same structural design file in every document and select
the corresponding part.

When all the documents are open, the Studio window will automatically show the different documents
as artwork on the different parts:

When opening all the documents one by one, the Studio window will automatically show the different
documents as artwork on the different parts:

 

 

Working with multi-part structures from ArtiosCAD
In ArtiosCAD you can also build structures with more than one printable part. This section describes
how to handle these in Studio Designer.
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Multi-Part ARD files

If all the parts are in the same board material, it is possible to save them into one ArtiosCAD (ARD) file.

Like any other ARD file, you can import it in an ArtPro document.

Studio Designer will show the composition in 3D. In this case the artwork is organized in one document.

Multiple ARD Files

In ArtiosCAD it is also possible to combine multiple files into a 3D composition (this is typically stored
as an A3D file). If you export as a Collada file, you could use the workflow described in 5.3. But then you
loose some powerful features of the ArtiosCAD file format such as 'Create Varnish Plate', 'Distribute'
and back-side. We suggest a workflow that uses both Collada and ArtiosCAD files:

In ArtiosCAD:

• Create an ARD file for every part

• Combine the parts with ArtiosCAD 3D features.

• Save the composition as a Collada file

In ArtPro:

Organize your artwork in a different document for every part. Place the corresponding ARD file in each
document.

 

350



9ArtPro

 

The Structural Design layer shows the ArtiosCAD drawing. By default, the Studio window shows just the
one part. Repeat this for the other documents:

 

351



9 ArtPro

 
 

 

To see the parts together in the Studio Window load the Collada file (from ArtiosCAD) as an alternative
scene:
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The Studio window will show the 3D shape of the collada file with the artwork of the different
documents:

 

 

Note:

For some collada files it can occur that the artwork for one part is also displayed on another
part. (This can happen if the two corresponding ARD files have identical physical dimensions).
For these Collada files, please use the procedure as described in Collada files with Multiple
Printable Parts on page 348

353



9 ArtPro

Navigating between the different ArtPro documents
When multiple ArtPro documents supply artwork to the same scene, you can double click any of the
parts in the Studio window to make the corresponding ArtPro document active. (See also Zooming in on
Panels in the document window on page 340)

If you click on a printable part for which there is no ArtPro document open, you will be asked to create a
new document for that part.

9.10.5.  3D Guides

In Illustrator, PackEdge, ... you can create horizontal and vertical Guides to align art. Studio Designer
offers another type of guides: 3D Guides for boxes and Collada files.

3D guides appear both in the document window and in the Studio Window.

Note:  3D guides are temporary visual aids, and are NOT saved.

You can hide or show the 3D guides in the document window by switching the visibility of the 3D Guides
layer on or off in the Layer window.

Select Show/Hide 3D Guides from the Studio fly-out menu (or click the button at the bottom) to hide or
show the 3D guides in the Studio Window.

If you are looking at a multi-part shape in the Studio window, the 3D guides will intersect the different
parts, and result in guides in multiple documents.

In the Studio Window, the 3D guides appear like a horizontal or vertical plane that is intersecting
the shape. In the document, a 3D Guide appears like a set of horizontal, vertical or even slanted line
segments clipped inside panel boundaries. These line segments show where the plane is intersecting
with the panels. Graphics can snap to these segments just as with regular guides.

This is how the 3D guides are presented in the 2D and 3D view:
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For Collada files made with Studio Toolkit For Labels, you can get curved 3D Guides in the document if
your printable part is a conical label:

 

 

Creating and Editing 3D Guides
To create or move a 3D guide, use the 3D Guide tool (in the applications toolbar). Click and drag
somewhere in the shape in the document to create or move a guide. By holding the option (alt) key, you
can switch between vertical and horizontal guides.
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To delete a 3D guide, use the 3D guide tool and simply drag it outside the shape in the ArtPro
document.

To delete all 3D guides, you can delete the “3D Guides” layer that contains all 3D guides.

9.10.6.  Exporting

Studio Designer offers a variety of export options to a number of common formats.

The background color and other settings defined in the Scene Settings will show up in your exported
file.

Note:  If you have the WebCenter Connector plug-in installed, you can use Save to WebCenter
to upload the exported file directly to WebCenter. See Using Studio Designer and WebCenter
Connector

Writing TIFF Images
Studio Designer can export the 3D design to an RGB TIFF image with the graphics on top (much like the
Studio window but at higher resolutions).

1. Choose Export… from Studio's fly-out menu. Choose TIFF Image as file type.
 

356



9ArtPro

 
2. Define the Width, Height and Resolution for the image that you want to export.
3. Define the Artwork Quality. Depending on what the image is needed for, you can choose between

4 presets for the level of detail. Choosing Low (fast) will export to an image fast but with less detail,
while choosing Medium, High or Highest (slow) will produce greater detail but will take more time.

Tip:

The "Low" and "Medium" presets correspondent to the "High" and "Very High" Image Quality
found under "Model" in the "old" Studio Visualizer 14 application.

4. The Transparent Background option allows you to set the background transparent instead of the
background (color or image) defined in the Scene Settings.

5. Click Save As... to save the TIFF file.

The Scene Settings are used in the exported TIFF image: Object heading and Tilt, Pan, Perspective,
etc. See Scene Settings on page 336

Export to a 3D PDF File
In Adobe Reader or Acrobat Professional (version 8.0.1 or later) you can view / rotate 3D objects in PDF
files. Studio Designer can write such PDF files that can be used to view a package in 3D on a computer
that does not have Illustrator or Studio installed.

Choose Export… from Studio's fly-out menu. Choose PDF File with 3D Design as file type.

You can define the Size of the PDF file. Since the PDF file is only meant for on-screen viewing, this size
is of little importance.

The Add Footer toggle allows you to switch on or off the footer text. Instead of the default EskoArtwork
text you can also personalize the footer text and include your own message.
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Note:

To avoid z-fighting problems in the exported PDF files, you can use the Avoid Artefacts option.
This will make sure that whenever it is unclear which panel is on top (resulting in flickering
graphics), a calculated choice will be made, cutting out the underlying part and giving the top
part carte blanche.
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Export to a U3D File
U3D is a common exchange format for 3D objects. For example, in Acrobat Professional 8.0.1 or higher
you can place U3D files in PDF files.

Choose Export... from Studio's fly-out menu. Choose U3D File as file type.

 

 

Note:

To avoid z-fighting problems in the exported U3D files, you can use the Avoid Artefacts option.
This will make sure that whenever it is unclear which panel is on top (resulting in flickering
graphics), a calculated choice will be made, cutting out the underlying part and giving the top
part carte blanche.

Export Collada File
Studio Designer can also export to a Collada file (*.zae), a common exchange format for 3D models.

1. Choose Export... from Studio's fly-out menu.
2. Choose Collada File (*.zae) as file type.

 

 
3. Select Include Graphics at… to include the graphics at the desired resolution.

359



9 ArtPro

4. If you want to further use the Collada file in Studio Designer you need to select Keep Printable
Parts.

If Keep Printable Parts is enabled, the artwork is always exported at the default resolution.
5. Click the Save As button, and define name and location for the file.

Note:

The exported Collada files (.zae) can be further used in other EskoArtwork Studio applications
like Studio Visualizer, Studio Toolkit for Shrink Sleeves or Esko Store Visualizer and ArtiosCAD
or uploaded to the online Esko Studio Viewer.

Save Graphics Preview as PNG...
From within the Studio window, you can save a graphics preview file as a .png file, mainly for use in
Studio Toolkit for Flexibles.

 

 

9.10.7.  FAQ

This section contains the answers to a number of Frequently Asked Questions.

There is no overlap between the selected objects and the selected panel
I try to distribute a logo, and I am getting the error message There is no overlap between
the selected objects and the selected panel. Please select a panel that
overlaps with the selected objects.
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Whenever distributing for the first time, you will need to select two things: the graphics that you want
to distribute in the 2D view AND the source panel in the Studio window. The 'no overlap' error message
indicates that you did select a panel in the Studio window, but in 2D there is no overlap between the
selected panel and the selected art.

It is a good idea to switch on Show Face Outlines in Studio's fly-out menu.

 

 

When Show Face Outlines is switched on, the selected panel in the Studio window will be shown in the
2D View:
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You will immediately see that there is no overlap between the selected panel (the blue rectangle) and
the selected art (the star), so you basically selected the wrong panel. You need to select a panel that
has an overlap with the selected art:

 

 

Now you see that there definitely is an overlap between the blue rectangle and the star. You will notice
that Distribute Selection will work, which will give you the following result:

 

362



9ArtPro

 

Please note that you never had to specify to which ‘target panel’ you had to distribute, so how can you
know which target panels will be taken?

In this version of Studio Designer, the distribute functionality only works on coplanar panels. The
bottom face consists of four panels coming together: two glue panels and two larger panels. The
selected panel is drawn with a solid blue line in the 2D View, the other panels that are coplanar with it
are drawn with dashed lines. Distribution happens from the panel drawn with a solid blue line to the
panels drawn in dashed blue lines.

That is why Show Face Outlines is so interesting, as it immediately gives you an indication whether or
not distributing is at all possible and to which panels the distribution will happen.

If we move one of the stars and do an update, you will notice that the three other stars need to move as
well. It is now enough to select the moved star and click Update Copies. You will notice that Distribute
Selection is now called Update Copies. There is no need anymore to select a panel in the Studio
window.

The selected art knows that it has been distributed before. An indication that you have selected
“distributed art” is given in the info message in the Studio window: The selection contains
distributed art. This piece of distributed art has become a smart object that knows to which
panel it belongs and which other art belongs to the same distribution. When clicking Update Copies,
the other art that belongs to the same distribution (in our example, the other stars) will be replaced
with a new updated copy of the selected distributed art.

In the layer browser, you also have an indication which art is “distributed art” and hence smart. The
name of distributed art is always “Distribution”.

363



9 ArtPro

What can I do if the distribution looks wrong?
The graphics have been distributed to the correct coplanar panels, but the result of the distribution in
the Studio window is still not correct.

 

 

In this case it is not that the distribution has positioned the copies in the wrong place, but that in the
2D document window, the different copies are overlapping one another. This can happen whenever
the graphic that you want to distribute is rather large.We will need to make clipping masks in this case,
using the standard tools.

If we do this for every distributed copies and then refresh the Studio window, we will get the correct
result:

You only need to make the clipping masks once. Assume you would like to move the frog a little, then
simply move one copy and click Update Copies. The other copies will also be updated and they will
keep their position under their clipping masks.

How can I distribute around a corner?
In this version of Studio Designer, distributing is only possible to other coplanar panels. Sometimes a
distribution appears to go around the corner, but this only works if a panel that is attached to the panel
around the corner is coplanar with the selected panel.

This is not the case with the box in the next example.

 

364



9ArtPro
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In this version of the software, we are not capable of doing this with the automatic distribute. We
have limited the distribution functionality to panels that are coplanar. A face in the Studio window can
be made up of different panels coming together. A beautiful example is the bottom of the box in the
picture below.

 

 

The bottom of this box consists of four panels coming together. If you select Show Face Outlines in the
Studio's fly-out menu, you will see blue lines showing up in your 2D Document Window. The solid blue
line is a reflection of the selected red panel in the Studio Window. The other panels that are coplanar
with the selected panel and that together form the bottom face, are drawn on top of that in dashed
lines. If you were to draw some graphics and click Distribute Selection then the graphics would be
copied and pasted to the three other panels that are coplanar with the selected one. Those three
panels are shown with dashed blue lines in the 2D Document Window.

In the following example, we would like a distribute from one panel to another that is adjacent to the
first in the Studio Window, but they are not at all coplanar. On the contrary, the angle between the two
panels is 90 degrees. As automatically distributing will be impossible in this case we will have to do the
copying, rotating and pasting of the graphics ourselves. The Create 3D Guide option can be a solution.

You could create a 3D Guide in the back inner panel and that is immediately going to create extra
guides in the other panels that the guide plane intersects with.

You could now design your graphics in the back inner panel. You do not need to do this upside down as
double-clicking on the panel in the Studio Window will rotate the whole job. You can also rotate your job
manually using the orientation buttons in the right top of the Studio Window.

We will add some text to this panel that also needs to extend into the other panel.
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We will now copy the text, double-click the other panel in the Studio Window where you would like the
text to be pasted, paste the text, rotate it and position it correctly on the guide:

 

 

9.11.  Step & Repeat Interactive ...

Note:  This module is optional. See Show Licenses on page 49 for more information.
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This module called PowerLayout is optional. PowerLayout includes S&R Tabular, S&R Interactive, S&R
Seamless and S&R Grid.

Step & Repeat Interactive is the most basic way of repeating a file in ArtPro. It is mainly used to step up
labels and flexible packaging, or in general, easy shaped work. This functionality allows you to create
a repetition of one single file at a time, based on either count or fill size. S&R in ArtPro works with all
the image types that can be placed in the application (ArtPro, tiff, eps, dcs, jpg, tiff-it, Scitex LW, Scitex
CT, Scitex Flyte, pdf). Usually, we use ArtPro single files, that were saved with a bitmap preview (see
Include Preview on page 75).

The S&R Interactive window exists out of 4 tabs: General, Pattern, Advanced and Group. The first
three have the basic functionality for creating an interactive S&R. The Group tab is used to modify the
step and repeat blocks that are generated by PowerOptimizer (see Step & Repeat Automatic... on page
392).

9.11.1.  Picture

Allows you to select the file to be repeated. Just click on the Browse button and select the document,
or select a file from the finder and drag it onto the S&R Interactive dialog box. When a Picture is se-
lected, ArtPro displays its file name and its size. Its size will automatically be filled into the Step fields.

9.11.2.  General

Count / Fill size
There are two ways to make a step and repeat in ArtPro: count, where the horizontal and vertical
number of labels is defined, or fill size, where the size of the paper is defined and ArtPro puts as many
labels as possible in this area.

When using the fill size, ArtPro will calculate the number of labels and equally divide the remaining
space around the S&R. When count is used, ArtPro calculates the fill size. Every repetition in ArtPro,
including all marks, is automatically grouped. Use the compound selection (see Group, compound
(object) and path selection on page 244) to e.g. select the marks separately. When a group of labels is
selected afterwards, all the used parameters will be displayed.

Bleed
The Bleed defines how much bleed is used to the outside of the repetition. So there is a different
setting for bleed in between jobs and around the repetition. It’s ignored if the Keep Bleeds toggle is
switched on. ArtPro will always check if there is enough bleed in the selected file. The trim box size is
substracted from the bleed box and divided by two. This size has to be bigger than the bleed, otherwise
ArtPro will give an error message. This can be switched off in the Preferences - Show warning when
exceeding Bleed Box on page 56.
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Keep Bleeds
When the Step distance is smaller than the bounding box of the ArtPro file, the different labels will not
overlap, but they will be cut off. Keep Bleeds forces bleeds in the original file to be used, even if there is
no place to put them. This function can be useful to generate repeats of round labels (see examples).

Angle
Using the buttons, you can define rotation for the labels. The checkboxes next to the angle, allow you to
set labels to switch direction every other label, either vertical or horizontally.

By clicking the resize button (in the title bar, next to the collapse button), a number of extra options
become available.

Step Size
The Step size is the space used for every file. Unlike the Size shown above, the step size takes rotation
and bleed (margin) into account.

Margin
Margin is used to define the bleed between the labels. It is the difference between the Step and the box
size. The horizontal and vertical margin can be set separately. If the bleed of the single file exceeds the
bleed applied on the repeat, the jobs will be cut off in the middle.

Gap / After
The Gap distance is the distance left in between labels. After defines after how many labels the gap
should be entered. A value of 2 e.g., will result in two labels without gap, then the gap, then again two
labels without, etc.

Distort
The Distort value allows you to define a distortion for every repeat block separately.

9.11.3.  Pattern

This option is used to make nested S&R. This means that the second row or column is shifted each
time and the step distance can be decreased so the labels fit into one another.
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Pattern
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Using the Pattern buttons, you can define whether every second column or every second row should
be shifted. The first button creates a rectangular pattern, with no staggering. The second two create
most basic staggering : every second row or column will be shifted, and will contain 1 label less than the
first row or column. The next two buttons will generate rows and columns with the same number of la-
bels. The buttons for round labels will shift round labels into each other to save space.

Stagger offset
The offset can either be half of the step size or any user defined value. When using the Round Label
pattern, the offset is automatically derived from the size of the job and can no be changed.
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Continuous Stagger
Without the Continuous Stagger option, all even rows or columns will be shifted, the odd rows or
columns will remain unchanged. When using the Continuous Stagger option, every row or column will
be shifted in regard to the previous.

Include Partial Labels/Do not clip partial labels
When using the Include Partial Labels option, the gaps created by the shift of a row or a column, will be
filled up with the part of the label as if the repeat was continued outside the jobsize. When setting the
Do Not Clip Partial Labels option on, these labels will be placed completely instead of just a part.

9.11.4.  Advanced

Box Size
Before stepping the selected file, it is possible to decide which box size needs to be used. Default,
this value is set to trim box. When Use Box is modified, the values in step distance and size will
automatically adapt.

Separation
Using Separation, one single separation from the selected job can be stepped. This option can only be
used to modify a created S&R, not to make a new one. This will be useful when manually optimizing the
output, e.g. for flexo output. Select the stepped job(s); when clicking on Separation, ArtPro displays
a list of all separations used in that file. When choosing one separation, ArtPro will show a colored
grayscale sample of the preview. In front of the first separation in the list, there is an empty space. Put
separations on this space to use all inks again.

Set Grid / grid gap
Set Grid creates a grid, based on dimension and position of the selection. If a Grid Gap is entered, the
grid will be based on the dimensions of the selection plus the grid gap value. This can be useful when
separating a repeat.

The Set Grid function also changes the Vertical and Horizontal cursor Key step. This makes it easy to
move around jobs or separations using the arrow keys. To optimize a repetition, the grid is set to the
label size and the Move Area tool is used to move labels (See Move area tool on page 204).

Separate
Separate will split a repetition into its separations. ArtPro will show a colored grayscale preview of the
files. The distance between the separations is based on the dimension of the repetition, and the value
of the Grid Gap. After separating, all separations can still be moved or altered, e.g. to give separate
distortion factors, or to merge two separations, simply by putting them on top of each other.

372



9ArtPro

In order to print these separations on the same film, the option All Pages on Same film, in More Print
settings should be checked. (More Settings: Page on page 142)

Multifilm
If the option Multifilm is checked when separating a repetition, the separations will be placed next to
one another, based on the job size of the active job, i.o. the selection size and Grid Gap.

Obviously, the Set Grid option will also be based on the job size.

9.11.5.  Group

In the Group tab, a number of settings for groups created by the Step and Repeat Automatic function
can be changed. For more info, see Step & Repeat Automatic... on page 392

9.11.6.  Generate

Make New Job
This option defines if the repeat has to be created in the current job, or in a new job. Since the repeat is
always placed at the bottom right of the ruler, this can be used to combine the repeat of several files on
the same sheet, with the option Make new job off, and by moving the ruler before repeating.

To get the same repeat of two different labels, make the first, then deselect the group, move the ruler,
select the second label and hit generate. This way, the exact same settings are applied as on the first
label (except bleed).

Immediate
If the Immediate checkbox is on, changing the number in count, the dimension in Fill Size, marks,
orientation, bleed,... will automatically change the already generated S&R. If the option is off, you need
to press the Generate button to create a new S&R.

Generate
Generate will create a repeat as defined in the dialog box. If the option Make new Job is on, a new job
will be generated. Otherwise, the repeat will be generated inside the open document, in the bottom
right quadrant of the ruler.

Rectangle
The Rectangle tool is an interactive way of generating a Fill Size repeat: by clicking this button, the
cursor changes to a cross. By dragging a rectangle, you can define what area should be filled with the
selected picture. This is useful to fill up gaps on the S&R plate.
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Reset
Sets all values back to initial values.

Marks...
This will open the Marks dialog, also available from the Prepress menu. See Marks on page 406. Using
the  Marks... dialog and the Generate Marks button, you can apply registration marks on the Repeat file

Cut Marks
If the Cut Marks  option is on, cut marks will automatically be generated around the repeat block. The
cut marks are generated on the used box size. When bleed is applied in between labels, double cut
marks automatically appear. The cut marks are filled with registration color.

9.12.  Step & Repeat Tabular...

Note:  This module is optional. See Show Licenses on page 49 for more information.

Step & Repeat Tabular is a tool that comes with the PowerLayout module, which is optional. The Step &
Repeat Tabular... function allows you to step and repeat one or more ArtPro jobs. Tiff, eps, dcs and pdf
files are also supported.

In the Step & Repeat Tabular dialog you can enter up to 200 different jobs. Hence, this functionality is
also used for merging purposes. Scroll bars on the right of the S&R menu allow you to scroll through the
file list if there are more than four entries.

 

 

9.12.1.  Select File

By clicking the “...” button, a dialog opens allowing you to select a file to be repeated. It is also possible
to drag and drop one or more files from the finder onto the dialog.
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When a file is selected, its dimensions will automatically be entered in the Step fields.

9.12.2.  Job Border

The default job border is the Trim Box. When changing to another Job Border, the difference between
the old and the new job border dimensions is calculated, and the same change is done on the Step
distances. E.g. if the Bleed size is 4mm bigger than the Trim Box, changing from Trim Box to Bleed Box
will add 4mm to the Step distance.

9.12.3.  Angle

By choosing one of the Angle buttons, you can rotate a job over 0, 90, 180 or -90 degrees.

9.12.4.  Reference Point

By selecting one of the three buttons, you can define the Reference Point for the positioning of the
Repeat block.

If the first button is selected, the Reference point will be placed in the center of the ruler, independent
of the previous repeat blocks. If the second button is selected, the Reference point will be placed at
the bottom left of the current column. This is the bottom left corner of the bounding box of all repeat
blocks in the same column. This way, the Repeat Block can be placed in the same column, under the
previous block.

By selecting the third button, the Reference point will be placed at the top right of the current column.
This is the top right corner of the bounding box of all repeat blocks in the column. This way, the Repeat
Block can be placed at the top of the next column.

The picture underneath shows the Reference Point for the three different settings.
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9.12.5.  Offset

The offset defines the placement of the top left corner of the repeat block, calculated from the
Reference point. Positive values work to the bottom right.

9.12.6.  Step

The Step distance defines the distance from one job to another. If the Step distance is smaller than
the job size, the jobs will be overlap. As placed ArtPro files are transparent on places where they are
empty, this can be used to create nesting. If the Step size is equal to the job size, the jobs are placed
adjacent, without any bleed. If the Step size is bigger than the Job Size, the space in between will be
divided equally, and filled with bleed, if present in the single file.

The rectangles in which the jobs are placed, will never be bigger than needed to place the complete
file, including elements outside the job size.

9.12.7.  Count

The Count values define how many jobs should be placed in the Repeat block.

9.12.8.  Radio buttons

The Radio buttons for File, Angle, Offset, Step and Count can be used to sort all entry lines by their
file name (alphabetical), their angle (left to right), Offset (increasing), Step (decreasing) or Count (de-
creasing). Keep in mind that changing the order can affect the repeat result if relative positioning is
used, i.e. if any of the entries is set to have a reference point based on the previous repeat block(s).

9.12.9.  Freeze Step

If the Freeze Step option is on, selecting another file will not change the Step values. This can be used
to create a step and repeat of another file, but using the same values. Freeze Step does not influence
the adjustment of the Step distance by changing the job border. As the S&R dialog is saved with the
file, you can re-open it if you open the repeated file. Then you can replace the label with the new one,
and with the Freeze Step checkbox on, the step distance will not be changed.

9.12.10.  Bleed for Repeat Blocks

On the outside of Repeat blocks, as much bleed is added as necessary to place all elements in the
file. If there is not enough room, e.g. in between Repeat Blocks, the available distance will be equally
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divided over both Repeat Blocks. If one of the Repeat blocks doesn't use this distance (when repeating
a label without any bleed), the other Block will take up this space.

9.12.11.  Make New Job

If the Make New Job option is on, a new job will be generated, in which the S&R is placed. If the option
is off, the repeat will be placed in the open ArtPro Job. The reference point for the first repeat block is
always placed in the center of the ruler.

The setting of this option goes along with the setting of the Import Opens New Job (see Preferences...
on page 48 Open new job on page 52)

9.12.12.  Cut Marks

If the Cut Marks option is on, cut marks will be generated on the repeat. Note that if the Step distance
is bigger than the Job size, double cut marks will appear.

9.12.13.  Step & Repeat

Hitting the Step & Repeat will create the repetition, either in a new job, or in the open ArtPro job (see
above). Note that changing values after the repeat was created, does not affect the created Step &
Repeat. In order to see the changes, a new repeat has to be generated.

9.12.14.  Marks...

This will open the Marks dialog, also available from the Prepress menu. See Marks on page 406. Using
the  Marks... dialog and the Generate Marks button, you can apply registration marks on the Repeat file

9.12.15.  Keep Bleeds

If the Keep Bleed option is on, every job will be placed completely, including all elements (even outside
the job size), even if the Step distance is smaller than this size. This is likely to create overlaps : places
where jobs lie on top of each other. As a placed ArtPro job is transparent on places where no objects
are found, this can be used to nest Jobs into each other without loosing the bleed, e.g. for round labels.

9.13.  Step & Repeat Nested...

Note:  This module is optional. See Show Licenses on page 49 for more information.

S&R Nested is a module called PowerStepper, that can be added to the PowerLayout module. It is used
to make S&R based on structural design files generated on a CAD/CAM system, to create diecuts (such
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as CFF2, DDES or ArtiosCAD MFG). Through PowerStepper ArtPro can use the same digital information
to create a step & repeat, so that the operator doesn’t have to calculate positions, rotation and nesting.

 

 

9.13.1.  Procedure:

1. Import the CAD/CAM file, with Analyze CAD File... The boxes described in the CAD/CAM file are
imported in ArtPro and joined. They remain selected after import.

2. Remove the holes (if necessary).
3. Fill the boxes with the graphics. Click on Apply Graphics... and select e.g. an ArtPro document.

PowerStepper fills, positions and rotates all the selected objects with the selected data, according
to the information that was in the CAD file.

4. Generate bleed around the boxes. Use interactive and automatic trimming to clip parts of the boxes
if necessary.

5. Put station numbers and marks on the repetition.

9.13.2.  Analyze CAD File...

With Analyze CAD File... the data of the indicated CAD file is read and displayed on the screen as
selected paths. The closed paths are placed in a layer named Repetition. In a CAD file, different line
types are defined (cut lines, folding lines,...). They are all defined with a different type. When analyzing
the file, ArtPro filters out all the cut lines and joins them together per box. All other information is ig-
nored.

When analyzing a CAD file, you have the same Reconstruct Common Cutting Lines option as when
using Structural Design > Import File.... See Reconstruct Common Cutting Lines on page 109

9.13.3.  MFG Print Items

When analysing an ArtiosCAD MFG file, this file can contain Print Items. Print Items define what single
job file should be placed on what position in the CAD file.

If the single job file referred to in the Print Item, can be found next to the MFG file, this file will be placed
at the corresponding location automatically.
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If the file was not found, it will be treated as a “dummy”: the path will have a picture paint style referring
to the name of the Print Item, even though this does not exists. This allows to replace the dummy by the
actual single job, either in the paint style or in the Links window, allowing to replace them all at once.

9.13.4.  Interpret bad CFF2 file

The option Interpret Bad CFF2 file will import a CFF2 file, inverting the order of rotation and mirroring.
A CFF2 file consists of subroutines, describing the single boxes, and the main section, describing
what box should be placed where. According to the CFF2 specs, if a box in the main section is set to
be rotated and mirrored, the mirroring should be done after the rotation. However, some CAD/CAM
systems create their main sections the other way. If a CFF2 coming from such a CAD/CAM system is
analyzed, the result is not the same as the original on the CAD/CAM system. By switching Interpret Bad
CFF2 file on, the sequence of rotation and mirroring is altered, so these (bad) CFF2 files get analyzed
correctly.

9.13.5.  And Import

The option And Import will import the analyzed CAD file.

Besides the layer with the analyzed CAD file (closed paths, only die lines), there will be another layer
added, named CAD, containing the result of a Structural Design Import (see Import file... on page 108).
This allows for alignment of elements on a specific part of the die in the S&R file.

When Importing the CAD file, you have the same options as when using Structural Design > Import
File...:

• Keep CAD Layers on page 110

• Only CAD Data on page 110

• Only Stations on page 110

9.13.6.  Apply Graphics...

Select the necessary paths and Apply Graphics... to open the corresponding ArtPro file to fill them
with. In fact again you can apply tiff, eps, dcs and pdf as well, but usually only ArtPro files are used.

You can apply different graphics in one job by selecting a few paths, applying the graphics, selecting
other paths and applying the graphics again. After analyzing a CAD file, all boxes are filled with a picture
paint style. When applying graphics, the selected job is centered in the selected shapes using the box
defined in Center Graphics on. Make sure you don’t apply any graphics in paths that already have bleed
calculated on them. Because the bleed distance is not always equal all around the box, the center could
have moved. Usually, the single CAD file is imported in the single ArtPro, positioned and the trim box is
fitted to this size before saving.
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The preview of the ArtPro files are placed inside the die lines. The die lines can be seen as a clipping
path for a picture or a window. If bleed was generated in the original file, it can be visualized here by
making the clipping path or the picture window bigger.

9.13.7.  Orientation

The orientation buttons allow to change the orientation of the one up files in the CAD die lines. The
orientation is applied on top of the orientation defined in the CAD information.

It is possible to change the orientation interactively by selecting a number of objects and click the
appropriate orientation button.

9.13.8.  Verso

The Verso button will mirror the ruler and the selected paths horizontally. It allows for creation of die-
side up repetitions as opposed to normal print-side up repetitions, and is thus mostly performed on
dies which do not have any color yet.

If the die does contain graphic files already, their paint will first be mirrored horizontally over its own
center and then it will be mirrored horizontally together with the die.

9.13.9.  Marks...

This will open the Marks dialog, also available from the Prepress menu. See Marks on page 406. Using
the  Marks... dialog and the Generate Marks button, you can apply registration marks on the Repeat file

9.13.10.  Resize window

By clicking the Resize button on the S&R Nested dialog, a number of additional options and settings
become available. These are described below.

9.13.11.  Calculate Bleeds

Bleed is always calculated after applying the graphics! Of course, to be able to give bleed, it is
important that the original ArtPro files are created with bleed. Bleed is the part of the ArtPro job
outside the trim box. In the case of CAD step and repeat, you can also say that the bleed is the zone
outside the CAD path. Enter a value in the Bleed input field, select the necessary paths and click
Calculate Bleeds. When two boxes are positioned against one another, a center bleed is created. If a
part of one job (a visible side of the box) needs to bleed over a part of another job (e.g. glue flap, tuck-in
flap), a gap is made first, using interactive or automatic trimming.

Automatic trimming can only be done on the flaps that touch the bounding box of the selection (see
picture, only the four flaps with the black areas can be automatically trimmed, all the others would have
to be done interactively). Interactive trimming can be done on any part of the box:
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Get from Single File
The Get from single file option, allows to apply trim & bleed based on the info stored in the used single
file.

This information can be stored in the Job Info dialog (S & R on page 169).

When applying Trim & Bleed with the Get from single file option on, the values stored in the single file
in the top left position, will be used to calculate the Trim & Bleed.

Note that the values of the applied Trim & Bleed, are NOT shown in the Trim & Bleed menu.

Interactive Trim

Starting an interactive trim

An interactive trim is started by selecting the Interactive Trim radio button, filling in the requested
bleed, selecting the contours on which the interactive trim has to be calculated, and clicking the Trim &
Bleed button.

Resolving overlaps

Interactive Trim will determine where outlines will overlap after bleeding. If an overlap is found, a zoom
view of the area is shown, and the overlap region is highlighted.

The cursor changes to a cross. This tool can be used to point out what contour should be on top after
bleeding. If neither contour should be trimmed for a certain overlap, pressing the Esc key will skip it
and resume with the next overlap.
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It may happen that ArtPro asks to resolve the overlap in a too large area (see example underneath)

 

 

When hitting the Enter key, ArtPro will try to split the overlap. If this succeeds, the resulting parts can
be resolved separately (see below).

 

 

All user decisions are remembered and are automatically applied when an identical overlap is
encountered.

Note that during overlap resolution, the job is in modal mode, meaning that no other jobs, dialogs,
buttons or menus are active. Only after all overlaps are resolved will normal application execution
continue. Interactive Trim can also be applied as defined in the Single File: see S & R on page 169
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Automatic Trim
Indicate a value in the Top-Bottom-Left-Right input fields and bleed, select the necessary paths and
click Calculate Bleeds. Immediately, the paths are clipped and then the bleed is calculated.

Manual Trim
Manual Trim makes it possible to manually clip certain parts of one job in the repetition, based on a
shape.

• Create the shape for clipping at the required position. Move it to the background and make it
transparent (Cmd-Alt-T) and keep it selected. Different shapes can be used at the same time by se-
lecting them all.

• Click the Manual Trim button and click on the job in the selected object to define the trimming area.
If the “All” checkbox is on, the same area is trimmed for all boxes. If not, only the boxes you click are
trimmed. Once a trim is defined, you can click anywhere in any box to apply the trim.

• If you want to perform another, different Manual Trim, click the Forget button first, to clear the
memory buffer, and then repeat this procedure.

9.13.12.  Station Number

A unique number can be put on every repeated box in the repetition. If there is an error on one of the
boxes (diecut, colors, position), all the cut out boxes with this particular number can be taken out.

• Indicate the required text parameters (font, point size, etc.) in the Text menu and the required color
(e.g. All 100) in Paint Style.

• Enter the number you want to start from in the input field next to Set.
• Define the position by entering values for the Vertical and Horizontal Offset (0,0 is centered on the

die) or by clicking on Set and then shift-clicking the position manually within the job (die path).
• To create the station numbers there are two ways: first click on Set and click on the different boxes

one by one, to define an order. Second you define the parameters for the order and hit Set All.

The text will appear on the same position and with the correct rotation on every box. Station numbers
are editable text, but can be vectorized to avoid font problems on the RIP.

Get from Single File
The Get from single file option, allows to apply station numbers on the info stored in the used single
files. This information can be stored in the Job Info dialog (S & R on page 169). When applying station
numbers (Set All) with the Get from single file option on, the station numbers will be placed and set
(font, type, etc.) according to the info stored in the specific single file. Unlike for Trim&Bleed, every
single file will be treated according to its job info.

Note that the original text, used to define text style and position of the Station Number, will not
be visible in the preview, and will not be printed on the repeat, as this would interfere with the au-
tomatically generated Station Numbers. Only when opening and printing the single file, this base text
will show and print.

Also note that the values of the applied station numbers, are NOT shown in the Station Numbers menu.
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Position
The squares next to the Set All button define where to begin: top or bottom, left or right. Vertical and
horizontal define in what direction the numbering has to be done. Snake defines if the numbering
has to be done snake-wise (see example). Zigzag is an option to solve the cases where boxes are not
exactly on the same vertical line, but staggered. See also the example.

 

 

9.13.13.  Conditions:

To be able to make the complete system work, there are some conditions which should be met : the
original ArtPro files which will be used in the S&R Nesting should be created correctly, and some rules
should be respected regarding the CAD file.

1. ArtPro original jobs
• the single ArtPro jobs should be made on the (one-up) CAD files which are used in the nested CAD

file. You can use “Import CAD...” to import the single CAD file into the ArtPro job. Make sure you don’t
use the die lines the designer put in the file. In many cases, designers draw their own version of the
dielines, that in the end might not match the CAD file.

• the trim box (usually used in S&R) of the single ArtPro job should be centered on the CAD file. Fit the
job size on the single CAD die.

• the single ArtPro files should be saved with a Preview (see Include Preview on page 75). When no
preview is saved with the ArtPro job, you get a gray preview in the repeated file (average ink for
placed pictures is 30%C, 30%M, 30%Y, 15%K). When the original ArtPro files are saved with a
preview, it will be shown in the repetition. This preview is usually 72dpi (see Preview Resolution,
p.134)
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2. Nested CAD file conditions
• CAD files on which “Common Line Removal” has been applied are not usable. Their contour should

consist of cut lines and the cut lines should not be used for anything else. All lines that have another
line type are ignored.

• To be useful for step and repeat, a CAD file must be built up according to certain rules. If that is not
the case, no S&R information can be retrieved. The main section must contain calls to individual
boxes, which must have the correct orientation. The following example shows two identical
(triangular) boxes, one upright and one upside down. Many different CFF2 files can describe this
page, but only one of them is usable for S&R. On the next pages you will find some examples of how
to built a usable cad file.

Usable :

MAIN
 CALL B at x1,y1 rotated 0 degrees
 CALL B at x2,y2 rotated 180 degrees
END
SUB B
 LINE 1 /\ 
 LINE 2 / \
 LINE 3 ————
END

Wrong :

MAIN
 CALL B1 at x1,y1 rotated 0 degrees
 CALL B2 at x2,y2 rotated 0 degrees
END
SUB B1
 LINE 1 /\ 
 LINE 2 / \
 LINE 3 ————
END
SUB B2
 LINE 1 ————
 LINE 2 \ /
 LINE 3 \/ 
END

Wrong :

MAIN
 CALL B at x1,y1 rotated 0 degrees
END
SUB B
 LINE 1 /\ 
 LINE 2 / \
 LINE 3 ————
 LINE 4 ————
 LINE 5 \ /
 LINE 6 \/ 
END

Wrong :

MAIN
 LINE 1 /\ 
 LINE 2 / \
 LINE 3 ————
 LINE 4 ————
 LINE 5 \ /
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 LINE 6 \/ 
END

You can inspect CFF2 files with any text editor (Simpletext, BBedit, MS Word,...). If the CAD vendor does
not generate CFF2 files in a usable format, send him this description and explain the importance of
being able to retrieve S&R information from the CAD system.

9.14.  Step & Repeat Seamless...

Note:  This module is optional. See Show Licenses on page 49 for more information.

This module called PowerLayout is optional. PowerLayout includes S&R Tabular, S&R Interactive, S&R
Seamless and S&R Grid.

In the Step & Repeat menu the Seamless functionality makes it possible to create seamless joins for
cylinders.

9.14.1.  Procedure:

Fill in the Vertical and Horizontal Job Size, i.e. the cylinder circumference and width.

Set the checkboxes next to the orientation in which the Step & Repeat should join, i.e. Vertical or
Horizontal, never both.

Enter a Bleed value, if necessary. The default is set to 2 mm. The bleed will be calculated on the outside
of the repetition.

Indicate the inclination in Angle, if necessary. The default value is set to 30 degrees. Values should be
between -90 and 90 degrees.

Open the ArtPro file to be repeated by clicking on Graphics File... and indicating its name. To be able to
visualize the seamless S&R, the original ArtPro file has to be saved with a preview (Include Preview on
page 75).

Set the Step and Offset values. By default, the Step Down and Right take the respective vertical and
horizontal jobsize values, the Offset is half the horizontal jobsize. The Reset button puts the Step and
Offset back to 0 mm. The offset value is the distance of the horizontal shift in a brick-like pattern from
a job in an uneven row to one in an even row. Thus, with a 0° angle, offset=0 mm means that all the jobs
will come neatly underneath each other. The zero-point is the bottom left corner. See figure below.
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To perform the repetition, click on Generate Pattern.

Afterwards, you can add registration marks as set in the Reg. marks menu (see Marks on page 406)

Tips & tricks :
• Repetitions with a 0° angle can be made to join both vertically and horizontally. Enter in the

necessary values as described above. Activate both the Vertical and the Horizontal Join button and
press Generate Pattern.

• Note that in most cases ArtPro needs to round off the Step values to make a join possible.

9.15.  Step & Repeat Grid...

Note:  This module is optional. See Show Licenses on page 49 for more information.

This module called PowerLayout is optional. PowerLayout includes S&R Tabular, S&R Interactive, S&R
Seamless and S&R Grid.

The Step & Repeat Grid functionality allows you to create a repetition of different ArtPro files with the
same size, all placed in the same folder, with or without the use of a layout file.

9.15.1.  S&R Grid without a layout file

 

387



9 ArtPro

 

• First of all you need to have the original ArtPro files, all placed in a specific folder, called the job
folder. To be able to visualize the grid Step & Repeat, you’ll need to save the original ArtPro files with
a preview (Include Preview on page 75).

• Enter a Horizontal and Vertical Step distance. The Step distance is the distance in between the
different ArtPro Jobs. If no distance is entered, the trim box size will be used, so no bleed will be
added to the ArtPro Jobs.

• Enter a Horizontal and Vertical count. The Count is the number of ArtPro jobs to be placed in
vertical or horizontal direction. If the total number of jobs to be placed is larger than the number
of ArtPro jobs in the selected job folder (see below), ArtPro will restart at the top of the list (see
example 3 later on).

• Set the order to be followed. The squares under Order define where to begin : top or bottom, left or
right. Vertical and horizontal define in what direction the jobs have to be placed. Snake defines if
the positioning has to be done snake-wise (see examples on right).
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• Set the desired Angle. Angle allows you to define if the jobs have to be placed upright (0º) or rotated
over 90º, 180º (=clockwise) or -90º (= counterclockwise)

• Select a Job Folder. Selecting a folder as Job Folder will display all files in the folder in the list on
the right side. In this list, the order can be changed by clicking and dragging. A file can be removed
from the list by selecting it and clicking Remove. This list shows in what order the specified jobs
will be used in the repetition. The jobs in the list can also be duplicated or removed. Simply select a
job from the list, choose how many times to repeat it and press Repeat. This repeats one job at the
time. To remove, just select the job(s) and press Remove.

• Click Execute to create the S&R.
• After executing,marks can be added, using the Marks and Generate marks buttons.

Examples

Example 1:
 

 

In this Example, 8 different ArtPro jobs, placed in the GRID folder, were repeated with a vertical count
of 2 and a horizontal count of 4. All ArtPro Jobs are placed once, starting with the first job in the top
left corner.

No bleed has been added.

Example 2:
 

 

The same job folder, containing the same jobs as in example 1, was used.

In this example, the count starts in the bottom left corner and the jobs were set to be rotated over 90º.
Note that entering a rotation angle, adjusts the vertical and horizontal step distance. Even though the
jobs are rotated, the first job is still placed at the top left corner of the repetition.
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Example 3:
 

 

In this example the vertical count is set to 3, the horizontal to 5. This gives a total of 15 jobs, while the
job folder contains only 8 jobs.

When filling every job from the folder in the grid once, ArtPro continues from the top of the list again. In
the example you can see that after Job 8.ap, Job 1.ap is placed again, followed by Job 2.ap etc. ArtPro
started in the top left corner and repeated the jobs horizontal and snake.

9.15.2.  S&R Grid with a layout file

• First of all you need to have the original ArtPro files, all placed in a specific folder, the job folder. To
be able to visualize the Step & Repeat, you’ll need to save the original ArtPro files with a preview.

• Enter a Horizontal and Vertical Step distance. The Step distance is the distance in between the
different ArtPro Jobs. If no distance is entered, the trim box size will be used, so no bleed will be
added to the ArtPro Jobs. Other settings, like rotation, direction,... will not have effect on a grid
repetition with a layout file.

• Select a Job Folder. Selecting a folder as Job Folder will display all files in the folder in the list on
the right side. In this list, the order can be changed by clicking and dragging. A file can be removed
from the list by selecting it and clicking Remove. This list shows in what order the specified jobs
will be used in the repetition. The jobs in the list can also be duplicated or removed. Simply select a
job from the list, choose how many times to repeat it and press Repeat. This repeats one job at the
time. To remove, just select the job(s) and press Remove.

• Select a Layout file. A Layout file is a text file, containing comma separated values, indicating
where all job should be placed.

• Click Execute to create the S&R.
• After executing, marks can be added, using the Marks and Generate Marks
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Example layout file
• A Layout file should be comma separated values (csv), which means the individual values are

separated by a comma.
• The first line should be ‘ArtPro Grid Layout file V1.0’
• Placing a number means that the job with that number in the list will be placed at that position.

Entering a minus in front of the number will rotate it over 90º. Exact names can be used as well, in
combination with the option Filenames must Match. In that case, ArtPro will place the file with the
name as entered in the layout file, i.o. using the order in the list.

• The repetition will be based on the outer rectangle of all entered values. Empty spaces in the layout
file will cause holes in the Step & Repeat file.

• Below, there are two examples of a Grid repetition that was created with layout files.

 

 

Adding Bleed
Bleed can be added using the Calculate Bleed button in S&R CAD. For normal cases, this will create
bleed at the outside of the repetition. If bleed is needed in between the different labels, the repetition
can be made with a bigger step distance, so the Calculate Bleed will divide the available space over the
two adjacent labels.
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9.16.  Step & Repeat Automatic...

Note:  This module is optional. See Show Licenses on page 49 for more information.

Step & Repeat Automatic is a part of the PowerOptimizer module. It calculates the repeat based on
the dimensions of the layout, the dimensions and settings for every individual file and the total number
of labels needed. Based on these values, ArtPro will search for the repeat with the lowest print run, to
achieve the most economic combination of the individual labels. There is an interaction with Step and
Repeat Interactive : after creating the repetition with PowerOptimizer, the parameters of each block
can be adjusted in the S&R Interactive menu.

9.16.1.  General settings

 

 

Templates
Templates allow you to store all data from the Automatic Step & Repeat dialog in a text file. This way
you can setup templates for page and plate sizes, including the margins and alignments of e.g. paper to
plate; but you can also save the completely filled dialog with all label information in it.

When opening a template with missing pictures, PowerOptimizer will ask where those pictures are.
Pressing CONTROL + cancel will cancel all, so none of the remaining pictures will be opened. The reset
button will reset all parameters to their defaults and removes all pictures.

Search / Hold
When all parameters are entered, the search button at the top left can be pressed. This will start the
actual calculation of the optimization. When not all the necessary parameters are defined, a warning
message will appear. The necessary parameters are for instance: paper size, label size and number
needed. During search the progress status will be indicated in percentage. You can put the search on
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hold to check the intermediate result. When changing an important parameter during search, or hit the
reset button, the search will be canceled.

9.16.2.  Layout

Media / size
The media pop-up lets you select between the paper or plate size. You can fill in the dimensions
manually, or you can choose from the predefined jobsizes file. Once the repetition is made, the plate
size will be set in the media box in the ArtPro jobsizes, the paper size will be set in the cropbox.

Margin
The Margin settings allow you to define where the repeats should be placed on the paper or plate.

If the Center checkbox is on, the layout will be placed at the center. The Margin fields for top, bottom,
left and right, allow you to keep a margin around the layout, e.g. to preserve space for control bars,
gripper edge, etc....

Alignment
The Alignment buttons let you position the paper relative to the plate, and the repetition on the paper.

When the Media is set to Plate these buttons allow you to align the paper relative to the plate. When the
Media is set to Paper, the repetition will be positioned relative to the paper size minus the margins.

9.16.3.  Algorithm

 

 

Algorithm
In the algorithm pop-up you can choose between two ways how the repetition should be optimized.
The Block algorithm is the same way the repetition was optimized in ArtPro 6.0. This means that this
option will search all the possibilities of placements of blocks of labels. The direction in which the
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blocks are placed is controlled by the Cut Direction pop-up. The Strip algorithm will place strips of
labels (blocks that are only one label wide).

Cut Direction
On some occasions it is necessary to know the Cut direction in order to calculate the S&R. If for
example the paper width is larger than the width of the cutting machine, the first cut must be verti-
cal. Therefore you have several possibilities in Cut Direction: Vertical, then Horizontal; Horizontal, then
Vertical; either of the above or Mix Horizontal and vertical.

• Vertical, then horizontal: the sheet will be cut vertical first, multiple times if necessary, then the
page is rotated and cut horizontal. The sheet is only rotated once.

• Horizontal, then vertical: the sheet will be cut horizontal first, multiple times if necessary, then the
page is rotated and cut vertical. The sheet is only rotated once.

• Either of the above: this means that ArtPro is free to choose any of the two options above.
• Mix horizontal and vertical: the first cut can be in any direction, the sheet can be rotated (multiple

times) if necessary.

Paper use
The value entered in Paper use, is the minimum paper usage that should be achieved. Next to the input
field, the paper usage for the selected repeat is shown. When calculating the paper use, ArtPro uses
the nett paper format, meaning the margins are substracted from the total paper size first.

Maximum number of blocks
Indicates the maximum number of repeat blocks that can be used in the job. A repeat block is a repeat
that can be created in one go in S&R Interactive. In other words, the Maximum number of blocks value
indicates how many steps are needed in S&R Interactive to have the same repeat. The default is µ,
meaning there is no limit. To reduce the maximum number of blocks on the paper, just fill in a number.
To reset to µ enter nothing, two minus signs or the infinite sign (ALT + 5)

Allow Bleed and cutmarks to overlap with margins
This checkbox will make sure that the cutmarks are placed on the block margins instead of outside.
Setting this option can save some paper.

9.16.4.  Pictures

The Pictures tab is used to add pictures to a repetition. There are two ways to add pictures. The first is
by dragging a number of pictures or a folder onto the dialog. The other way is to press the Add button
and to select the file with the Browse button.

When the actual labels are not yet available, you can add a new label whose name can be entered in the
appropriate field. It will automatically be assigned a new color that can be changed with the Choose
button. Labels can be removed with the Remove button.

The file types that are supported by PowerOptimizer are ArtPro native files, DCS, DCS-2, EPS, TIFF, PS
and PDF. The maximum number of different pictures is 360.
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Group
After entering a number of labels, the group button may be pressed to group labels of the same
of similar size. This option will increase the performance of PowerOptimizer a lot, as it processes
different labels of the same size in one go, instead as all separate labels. Grouping is strongly
recommended when working with the block algorithm, because the performance of this algorithm is
dependent of the number of blocks and not of the number of labels. The striping algorithm does not
benefit from grouping, and it is not recommended for it.

To reduce the number of groups, there is a tolerance for the difference in size. So labels whose size
differs just a little can still be grouped together.

Putting new labels into a new or an existing group can be done by entering a different group number in
the general parameters section. Clearing the group field or pressing the ungroup button will move the
selected label out of its group. To remove all groups at once, press SHIFT + Group. To put all labels into
one big group, use CONTROL + group. This can be useful if you want to change one parameter for all
labels simultaneously, for instance the bleeds.

Note: when doing this, all the parameters which were not equal for all labels, will be put to their
defaults again in that case.

Pressing remove when a group is selected in the Pictures list, will remove the group, but not the labels.
These labels will no longer have a group.

Label Parameters
There are two kinds of picture parameters: label parameters and group parameters. The group
parameters are shared by all the labels in a group, the label parameters are entered for each picture
separately. The label parameters are: general and size.

General Parameters
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Here you can set the name, an optional comment and the color of the picture. The color is used on
the resulting job to preview a particular label of which the actual file is not yet present. The number of
labels is also entered here. Optionally, you can add or change the group number in here, or remove a
label from its group.

Size Parameters
 

 

The size and orientation of the label can be chosen here. The size is entered automatically when
browsing for a picture, but has to be entered manually when creating a new label in the general pa-
rameters. Use box, Angle and Alternation have the same effect as known from Step and Repeat
Interactive. (see Step & Repeat Interactive ... on page 367)
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Group parameters:
When selecting a group from the picture list, or when double clicking a picture, the Group parameters
are shown on the right. These group parameters are divided in three sections: Counts, Margin & Bleed
and Pattern & Fill. When changing one of these parameters, they are applied to all the labels of the
same group.

Counts parameters
 

 

Max. Blocks defines the maximum number of blocks of a certain group. This value must be high enough
when using the striping algorithm (± 10), but it may not be so high for the block algorithm, because
then the performance will drop. Furthermore there are options to specify the minimum, maximum and
multiple number of labels for each block of a group in both vertical as horizontal direction.

If e.g. a label should always be repeated alternated at 0 and 180 degrees, a Multiple value in horizontal
or vertical direction can be set to 2.

Margin & Bleed parameters:
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these parameters are used to define margins and gaps for all labels inside or outside a block. The
margins outside the blocks can be used for instance to make sure that there is enough space for
adding supplementary registration marks.

Keep Bleeds works the same way as in S&R Interactive (see Step & Repeat Interactive ... on page 367).

Pattern & Fill parameters
 

 

In this section, the pattern for the blocks of a group can be set. They have the same possibilities as
Step and Repeat Interactive. With the fill parameters you can define the way a block can be filled.
Since one block can exist of different labels, this will determine the position of the labels in the block.
You can set the starting corner, the direction and whether the block must be filled in snakelike manner
or not. When you have labels of different sizes in one group, the picture alignment will define how they

398



9ArtPro

will be positioned in relation to each other. This is necessary because in one block you can normally
have only labels of the same size. In this way you can define how to divide the excess space.

9.16.5.  Results

Use result:
The Results tab contains a popup which keeps the 10 best solutions that are found for the step and
repeat, together with the number of sheets to print to obtain the demanded number of labels.

When you select a solution, it is shown in the list above. This result list shows a number of things: the
names of the pictures, the amount needed of each picture, the number of pictures on the sheet, the
total amount, and possible excess labels (effective number of excess labels and in percentage).

Remove redundant labels
PowerOptimizer will by default try to use as much of the paper as possible by putting some extra labels
rather than leaving empty space on the layout. If you do not want excess labels on the layout, or you
would like to fill these possible empty spaces on the sheet yourself, then check Remove Redundant
Labels. The paper usage (in %) does not take in account that the redundant labels are removed.

 

 

Show results
The current result can be shown by pressing the Show button. You can browse through the solutions
by pressing SHIFT + show, which will show the next solution each time. If the Make New Job checkbox
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is set, then each result will be shown in a new job. It is advised to browse through the solutions in one
window, as this uses much less memory and is much faster.

Show Filenames
The option Show Filenames will add the label names and comments on a separate layer of the
repetition. This can come in handy when working with labels that don't have a picture yet and only the
pseudo color is shown. These names and comments will be printed too. When you have a repetition
with real labels you can replace these labels on output with their pseudo colors for faster printing. This
works through the More Print settings: Replace images by Pseudocolors.

It is however possible that changes have to be made to the parameters, but doing so will destroy the
current search result. To avoid that, you can create a new job, that will automatically have the same
parameters as the old one, so the necessary changes can be made. The results are stored with the job,
even after saving and opening the file.

Report
After calculation and selection of the most satisfying solution a text report can be generated
containing all the statistics of that result. This report file is a tab-separated file that can be used in a
spreadsheet or a database program for further processing.

9.16.6.  Interaction with S&R Interactive

After showing a result generated by PowerOptimizer, the Interactive Step and Repeat module can be
used to add registration marks to the whole step and repeat, or block by block, or to change the pa-
rameters of each block separately.

For this, a new tab is added to the Interactive Step and Repeat dialog. This tab becomes accessible
only when selecting a block containing different labels that was generated by PowerOptimizer. Here
you can change the order of the labels in the block by selecting and dragging them in the picture list.
Also the fill parameters (as in the PowerOptimizer Pattern & Fill parameters) can be modified. Both
these options can help to achieve better color grouping.

Another possibility is to change the alignment of the pictures in a block, when working with different
sized labels in one group. Also you can change the number of labels in the block.

9.17.  Staggered Cutting

Staggered Cutting is designed to facilitate seamless printing in non-sleeve workflows. This means
that when web fed flexo printing jobs are not using flexo sleeves the flexo material is cut and wrapped
around a cylinder. The unavoidable seam will be positioned in between printable objects. Staggered
Cutting is the tool to define the shape of the flexo plates, which will later in the process be sent to a
Kongsberg table on which the flexo plates are cut. A cutting path can be used for all separations, or a
cutting path per separation can be defined.

Next to these staggered cutting paths, ArtPro also stores all stroked lines which are in a technical
information, in special tags in a normalized PDF file. These tags follow the same track (are forwarded by
the FlexRIP into tags in a LEN file, allowing DFS to pick them up).
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The workflow is as follows:

1. Define the staggered cutting path in ArtPro. See Creating staggered cutting lines on page 401 and
Creating additional staggered cutting lines on page 404

2. Check the staggered cutting lines by selecting the Staggered Cut groups one by one in the Layers
palette. This will not only give you visual feedback on where the staggered cut lines are positioned
in the document; on the Staggered Cut dialog you will also get feedback on the used settings and
the separations it is applied on.

3. Export the file to Normalized PDF
4. When ripping the PDF file to a LEN file via FlexRip, the staggered cutting lines are copied into the

LEN file.
5. The path is then picked up by the Digital Flexo Suite (DFS). From DFS, you can export an ACM file

which can be used to cut the plate on a Kongsberg table.

The input of this module is a selected open contour. Typically this contour will be created using the
Path Edit tool. See Edit Path on page 530.

9.17.1.  Creating staggered cutting lines

To create staggered cutting lines:

1. Create a step and repeat layout, with staggering.
 

 

A staggered layout will create a plate with a irregular seam which will avoid problems with the press.
2.

Select the Edit Path tool  and draw a path.

If you are going to use the option 'Truncate on Center', the path does not have to be too precise.
Even a roughly drawn path can be used to create the ideal seam.
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3. Choose Prepress > Step & Repeat > Staggered Cut to open the Staggered Cut dialog
4. Make the appropriate settings in the Staggered Cutting dialog. See Staggered Cutting settings on

page 405.

Note:  Make sure you indicate the separations for which you want this staggered cut path to
be set. Only non-technical separations that are in use are being listed.

5. Click Apply

The Staggered Cutting line will be created.

 

402



9ArtPro

 

When creating a Staggered Cut, a number of objects are created, based on the selected parameters:
the cut path itself, objects knocking out the pixels outside the cut path, a stroked line to visualize
where one needs to cut, etc. All these objects are grouped in a group named "Staggered Cut" , in a
separate layer named "Staggered Path".

The staggered cutting lines will get a stroke, colored in a technical ink. This ink is called "Cutline
Registration" if the staggered cut line is used for all separations. If different cut lines are created for
different separations, the technical inks used will be called "Cutline <inkname>", e.g. "Cutline Cyan".
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The most reliable way of creating the correct Staggered Cutting path, is to create it in between two
rows of labels using the correct run length (as shown in the example above), and later move it to its
exact location.

9.17.2.  Editing a staggered cutting line

To edit an existing Staggered Cut:

1. Select the entire "Staggered Cut" group, either by triple-clicking on the path using the Select tool, or
by selecting it in the Layers palette.

2. Choose Prepress > Step & Repeat > Staggered Cut to open the Staggered Cut dialog
3. In the Staggered Cut dialog, click the Edit button

As soon as you click Edit, the group will temporarily be reduced to its baseline, shown as ‘Open path’
in the Layers palette. It will be expanded to a full group again when you click Apply.

4. Make your changes

• you can change the position of path using the Transform tools
• You can change the shape of the path by using the Edit Path tool
• You can change settings and the selected separations in the Staggered Cut dialog. See

Staggered Cutting settings on page 405
5. Click Apply to confirm the changes.

Notes on editing staggered cutting lines:

• If you enable Truncate on center again when editing the staggered cut, the shape of the path is
recalculated. This means any changes to the shape of the path you may have made would be lost. 
Truncate on center is by default disabled when editing, but you can enable it yourself.

• You can select and move a complete Staggered Cut group without clicking Edit without breaking
the Staggered Cut group

• If you apply other changes to the staggered cut path without clicking Edit,  the staggered cut path
will be broken, meaning that the staggered cut information will not end up in your file. You can tell
a staggered cut is broken by the fact that the group in the Staggered Path layer is no longer called
"Staggered Cut", but simply "Group". 

• If you copy & paste a Staggered Cut, the pasted path will not be recognized as a Staggered Cut. If
you want to copy an existing Staggered Cut to create an additional one, use Edit Copy instead. See
Creating additional staggered cutting lines on page 404.

9.17.3.  Creating additional staggered cutting lines

As of ArtPro 16.0.1 it is possible to create multiple staggered cuts in the same document. You can
simply create a new staggered cutting line (see Creating staggered cutting lines on page 401), but if
you're happy with the shape and (most of the) settings of an existing staggered cutting line, you can
work on a copy of this, as described below.

1. Select the entire "Staggered Cut" group, either by triple-clicking on the path using the Select tool, or
by selecting it in the Layers palette.

2. Choose Prepress > Step & Repeat > Staggered Cut to open the Staggered Cut dialog
3. In the Staggered Cut dialog, click the Edit Copy button

This will create a new open path (the single baseline).
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4. Make any changes you need

• you can change the position of path using the Transform tools
• You can change the shape of the path by using the Edit Path tool
• You can change settings and the selected separations in the Staggered Cut dialog. See

Staggered Cutting settings on page 405
5. Click Apply.

You will now see that another Staggered Cut group has been added to the Staggered Path layer, and
that the relevant Cutline separations have been added.

Note:  For each separation only 1 staggered cutline can be made, so if you are applying a
new staggered cut on a separation that was already used in an existing staggered cut, that
separation will be removed from the older staggered cut.

9.17.4.  Staggered Cutting settings

Path Shape Options define how the shape of the cutting path will be generated from the selected
contour.

• Stroke Width specifies the width of the staggered path stroke.

• Repeat Length specifies the circumference of the cylinder. In normal situations, this equals the
height of the sheet (which is also the default value). If the Repeat Length checkbox is disabled, the
vertical job size is used. Note that formulas can be used. Basically, the cutting path will contain two
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identical horizontal segments (generated by taking the selected input contour) which will create
the seam. The distance between these two segments is the ‘Repeat Length’. These 2 segments are
connected through vertical segments which correspond with the plate edges.

• Specify a Gap at Seam when it is wishful to make the flexo plate a bit smaller than the repeat length.
The distance between the two identical segments will be “Repeat Length - Gap”. The gap is divided
equally over top and bottom.

• Round Corners will modify the input contour so that corners are rounded to the specified radius.
Rounded corners facilitate cutting without damaging the plate when taking it off the cylinder.

• Truncate on Center will modify the shape of the selected object so it is pulled to the nearest
centerline between the die shape of the stations.

Separations allows to define if the cutting path is to be used for every separation or for the selected
separation(s) only.

Cutting Options specify how the staggered cutting path will be cut on the Kongsberg table.

• Add Nicks leaves small interruptions (nicks) in the cutting path to make sure the flexo material
remains connected (and is better kept by the vacuum on the cutting table). The nicks are added on
the 4 corners of the cutting path.

• Cut to Edge will split up the cutting path so that the 2 horizontal segments are cut first, followed by
the vertical segments. Each vertical segment is cut in 2 parts, each time starting from the center
going to the corner.

• Cut to Vertical Guides will generate a number of additional vertical cutting lines. The horizontal
positions where these cut lines are created is defined by vertical guides. See Magnetism... on page
441.

• Blank Area Outside Path will generate a knockout area which covers all objects that lay outside the
cutting path. This object can be used to knockout excessive bleed.

• Blank Pixels Under Path will generate a knockout stroke on the staggered cutting line, to make sure
there is no imaged area under the staggered cutting line. Since cutting can slightly increase the
thickness of the plate around the edges, cutting through imaged areas could cause problems on the
press.

The Apply button becomes active when there is one contour selected (the input contour). It will create
a cutting path in a dedicated layer (named ‘Staggered Path’).

Clicking the Edit button will remove the Staggered Cutting paths, and reset the open path that was
used to create the Staggered Cut. This allows you to edit the path, and recreate the Staggered Cut path
based on the edited path.

9.18.  Marks

Using the Generate Marks, objects like registration marks as well as job and separation identification
can be added to the file. By clicking on the Generate Marks button, the active marks are applied. But
through Marks... those active settings can first be changed, before applying the marks to the job.

Marks are always generated on the bounding box of the active selection or on the active job box, if
nothing is selected.

For Japanese OS, the marks will be generated using the font Ryumin - regular instead of Helvetica. This
allows japanese characters in job names, separation names, etc., to be correctly inserted in the marks.
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In the Marks dialog, you can define which information and marks should come on your repetition. There
are six tags for information which can be activated separately:
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9.18.1.  User Text

This allows to add user defined text.

9.18.2.  Job Name

Puts the name of the ArtPro file in the lower left corner in all separations.

9.18.3.  Version Number

This is the number that is shown in the job size dialog box. Every time an ArtPro job is modified after
saving, the version number is increased.

9.18.4.  Date & Time

Puts the current date and time in the lower left corner in all ink separations.

9.18.5.  Separation Names

Puts the names of the separations on the separate films.

9.18.6.  Distortion

Puts the distortion from the Print dialog box in the file. The value will be preceded by V or H, depending
on the direction of the distortion.

9.18.7.  Dot Gain Filename

If a dotgain file is selected in the print dialog box and the dotgain compensation option is tagged, the
dotgain file name can be added to the comments.

9.18.8.  Color Setting Name

If a set of Color Management settings are loaded, the name of this set can be added too.

408



9ArtPro

9.18.9.  Text Settings

All the previous parameters are put in this order in a text line on the bottom left side of the page with
the following settings:

• Vectorize Text will convert all the text to paths, to avoid font problems on the RIP

• Use Text Size allows to use the text size set in Text Style. If the option is off, the default text size
is used. All Regmarks will be placed in the default font set in the preferences. See Preferences... on
page 48 Default Font on page 57.
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• Set Inside Borders allows to set the text on the inside of the borders i.o. outside the job borders.

9.18.10.  Crop marks

The crop marks are put on the bounding box.

9.18.11.  Registration marks

Appear in the four corners outside the job, or centered on the job when the option centered is on. The
width of the registration marks is 1/300 inch (about 0.08 mm) and the color is always registration.

9.18.12.  Marks File

The marks File option actually allows to select a physical marks file from disk, clicking on the button
with the three dots will open the browser for selecting the file. For a description on marks files please
refer to Import marks... on page 105.

9.18.13.  Box

The Box dropdown allows to define to what borders the marks should be applied.

9.18.14.  Adjust Cropbox / Adjust Media Box

The Adjust Cropbox setting modifies the CropBox after creation of the marks, so that the job and the
marks are completely inside the CropBox. If “Always Create CropBox” is on, a cropbox will be generated
if it wasn’t defined yet.

9.18.15.  Standard / Plug-in

A plug-in or extension for the Step & Repeat menu allows for customization of registration marks. They
appear in the pop-up window at the bottom of the dialog and can be selected there before Generating
the marks.

• The Extensions have to be stored in the “Plugins” folder which should be in the same folder as
ArtPro.

• ArtPro supports plug-ins on Power Macintosh only.
• Extensions are based on the “Code Fragment Manager” of Apple Computer. This is standard on

all Power Macintoshes and will be included as part of the “Open Doc” extension and future system
software on Quadra (680x0) Macintoshes. Until then, ArtPro only supports plug-ins on Power
Macintosh.
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• To build extensions, you need a software development environment (e.g. ETO from Apple Computer)
and a knowledge of C++ and MacOS. Contact us for more information.

9.18.16.  For PS / For PDF

As the Dotgain curve and Distortion can be placed as Marks, and these two settings can be made in the
Print menu and in the Export PDF dialog, a pop-up has been added next to the “Generate Marks” button.
The pop-up allows to set what Dotgain and Distortion should be shown in the marks: the settings for PS
(from the Print dialog) or those from the Export PDF dialog.

The pop-up only has affect when the Generate Marks button is used. If Marks are added automatically
(e.g. in the Print dialog), the appropriate settings (in this example, the settings as defined in the Print
dialog) will be shown in the marks.

9.19.  Flatten Transparencies

The Flatten Transparencies function should not be confused with the “Flatten” function in earlier
versions of ArtPro. The latter is now renamed to “Convert to CT”, and its functionality has not been
changed.The Flatten Transparencies function replace all blend modes and transparencies by “normal”
objects, maintaining the final result, i.e. the blend will be calculated to whatever is underneath at that
moment, and will be adepted in a lineart object (if possible) or an image.

Flattening is done automatically when outputting PostScript, when saving in ArtPro 7.5 format, or when
exporting PDF with the “Enable Flattener” option on. Flattening can also be done interactive, with the
function in the Arrange menu. In any way, flattening is calculated for the complete job.

The settings used when flattening (either interactive, or through the Print, Save As or Export PDF
function), can be set in the Flatten Transparencies tab of the Preferences. This dialog can be opened in
the Preferences, or by clicking the Flattener Settings in Export PDF or Print Dialog.

Keep in mind that placed PDF or placed ArtPro files can not be flattened ! In those cases a warning is
generated : “Flattener was unable to process placed art...”

This will only happen if in the job, some objects with transparency has to be flattened with a placed
image.
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9.19.1.  Flatten Overprints

If the Flatten Overprints is on, not only objects containing blend modes will be flattened, but also
objects containing overprint, i.e. “trans” in the Paint Style. This can be used to get a correct preview in
Acrobat.

9.19.2.  Flatten Black Overprints

If Flatten Overprints is on, the Flatten Black Overprints allow to decide whether only “color” overprints
should be flattened (option off) or also the objects containing only black, and “trans” for other sep-
arations. For Acrobat Reader preview, this will not make much difference, but it will force every black
overprinting object to be flattened, and consume a lot of time. It is advisable to only use Flatten (Black)
overprints if it is really necessary.

Example
In the example as shown underneath, no ct will be created, as the result of the blend modes can be
achieved using lineart only. The original (first line) is a cyan rectangle, with 3 rectangles on top, a
magenta rectangle with a Multiply blend mode, a rectangle with 100% yellow and “trans” for the other
separations and no blend mode, and the same for the last rectangle, but in black. In order to see the
result, the black is shown in a dark grey i.o. black.

You can see (as it has been moved to show the result) that a new object is created, containing the result
color of the blend / overprint.

Original

 

 

Flattened, with Flatten Overprints off
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In this case, only the Multiply blend has been flattened. The magenta outside the cyan is now solid
magenta without blend mode, and a rectangle has been created (the intersection of both rectangles),
of which the paint style is the blend color (in this case 100 Cyan and 100 Magenta).

Flatten Overprints on, and Flatten Black Overprints off:

 

 

In this case, the yellow in overprint is replaced by the intersecting rectangle, containing 100 Cyan and
100 Magenta. The yellow is no longer overprinting.

Flatten Overprints on, and Flatten Black Overprints on

 

 

In this case, the black rectangle has been modified in the same way as the yellow.

9.19.3.  Color Management

The Color Management button opens the Color Management settings. It doesn’t make any sense to
apply Color Management on images on which Blend Modes or Transparency is applied. In fact, doing so
would result in wrong results.

Therefor CM can only be applied on the flattened job, and therefor CM is now part of the Flatten dialog.

9.19.4.  Flattening Options

The Flattening Options button opens the Flattening tab in the Preferences. See General: Flatten on
page 53.

9.19.5.  Flatten

When using the interactive flattener, you will be asked to define the name and location for the images
that will be generated. All these images will be external images, and will be mapped. For Flattening
during PDF1.3, PS or ArtPro7.5 output, temporary files will be created on the hard disk in the system
temporary folder.
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9.20.  Equinox

Equinox is an optional module that allows to apply spot color conversion to 5, 6 or 7 color spaces. For
more information, we refer to the Equinox documentation.

9.21.  Ink Coverage

The Ink Coverage menu contains all the functions to calculate the surface ink coverage of the
document. By clicking Calculate, the ink coverage is calculated for the active job. The total surface of
the job and the surface covered by each separation is calculated. The results are displayed in the unit
defined in Preferences (see Preferences... on page 48), as well as in percent.

Ink coverage is only calculated inside the border set using the dropdown, so if the border is set for
example to trim box, it does not include any bleed or other elements outside that size.

Ink Coverage calculates the actual values for all elements, including Mapped Pictures, not including
other Pictures. In that case the replacement value set in Average ink in the Paint Style menu is used.

The ink coverage is calculated at a resolution as defined in the at samples per inch field. The higher
this value, the more accurate the ink coverage will be, but also the more time it takes to calculate. The
default value is 75 samples per inch, which gives you a nice balance between speed and accuracy.

 

 

9.21.1.  Save Report

With the Save Report button, you can save the ink coverage information in a separate text file. The
ink coverage information can be useful to calculate the cost price of a job more accurately. Inks like
gold and silver are very expensive. Usually, without ink coverage calculation, a rough estimation is
made for every job. If it is estimated wrong, the customer may not be paying enough. Also ink coverage
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calculation is useful for the printer to know how much (pantone) ink needs to be made and put on the
press for a certain job.

The report will be generated using the Default font as defined in the Preferences. See Preferences... on
page 48 Default Font on page 57.

Note:  The ink percentages for Technical inks are shown in the Ink Coverage palette, but are
not taken account for the total area coverage, and are not included in the Ink Coverage report.

9.21.2.  Export report to PDF

The Export report PDF option allows to create a report containing date, file name, total surface, ink
surfaces and percentages, and save it as a PDF file.

The Default Font will be used (see Preferences... on page 48 Default Font on page 57)

9.21.3.  Step and repeat jobs

To be able to calculate the ink coverage accurately on a S&R file, you need to make sure to save all
single files with a preview (see Preview on page 75), otherwise, the average ink values from the paint
style are used.

9.22.  Thin Parts

The Thin Parts function allows to search for areas where objects are thinner than a given minimum
width.

The Thin Parts dialog can be opened by selecting Prepress > Thin Parts.

 

 

Clicking the Collect button, will create a Collection of all occurrences, showing all locations where
parts of objects are thinner than the entered Threshold.

Note:  Traps are never considered as “Thin Parts”. The Thin Parts function ignores them.

The Collection window will open, so you can browse through all occurrences found. See Collection on
page 432 for more information on using a Collection.
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Be aware that the Collection generated by Thin Parts, unlike normal Collections, does NOT contain any
real objects. Instead it contains "occurrences", virtual outlines of places where objects are thinner than
the entered Threshold, possibly including the suggested fix.

In the example underneath you can see that at the ends, the lines around the logo are smaller than the
Threshold. The red (virtual) objects show the suggested fix.

 

 

Note:  Since the Collection doesn’t contain real objects, the Select option is disabled in the
Collection window.

9.22.1.  Thin Part Settings

Threshold
The minimum width below which parts of objects are shown as a “Thin Part” occurrence.

Between Thick Parts:

 If this option is chosen, all thin parts will be flagged. In the example underneath: the result on top.

 If this option is enabled, parts of objects are only flagged as Thin Parts if the thin part is in
between two parts of the object above the Threshold. In the example below: the result shown at the
bottom.
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Suggest Fixes
If this option is enabled, Thin Parts will show the suggested fix, instead of just highlighting the Thin
Part itself.

Show Centerline
If this option is enabled, the centerline of the thin part is shown.

9.22.2.  Fixing all Thin Parts

You can use the Thin Parts function to automatically create fixes:

Open the Thin Parts window, enter the desired Threshold, and click Collect.

In the Collect palette, browse through the Thin Parts, and check the suggested fixes.

In the Thin Parts palette, click the Fix All button.

The Fix Thin Parts function will create objects (as shown in the Collection), immediately on top of the
original objects, fixing all Thin Part occurrences.

You can use the Select By Attributes window to select and check all fixes:

In the Select By Attributes window, select "Thin Parts" in the Object Type section.

Click the Collect button

In the Collection palette, browse through all fixes, and correct or delete them as necessary.

See also Select by Attributes... on page 247

9.22.3.  Fix Thin Part Tool

You can use the Thin Part Tool to interactively create fixes:

Open the Thin Parts window, enter the desired Threshold, and click Collect.

In the Collect palette, browse through the Thin Parts, and check the suggested fixes.
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Select the Fix Thin Part tool .

Click the Thin Parts you want to fix

The Fix Thin Parts function will create objects (as shown in the Collection), immediately on top of the
original object.

Thin Part fixes created with the Fix Thin Part tool can also be selected using Select By Attributes. See
also Select by Attributes... on page 247

9.23.  White Underprint

White Underprint allows you to create a white background underneath the selected objects. This white
background can be necessary when printing on transparent or metal material.

To open the White Underprint dialog, click Prepress > White Underprint. The White Underprint dialog
appears

 

 

9.23.1.  White Underprint settings

To set up White Underprint:

Select the Separation to be used for White Underprint. By default, “Opaque White” is selected. If this
ink doesn’t exist yet, it will be generated when creating White Underprint. You can also select another
spot color (except Technical inks) from your document for White Underprint.

Define the Offset: the distance between the edge of the White Underprint layer and the edge of the
object under which White Underprint is applied.

Define the direction of the offset. By default the offset is set to Spread, which gives an outward offset
when adding, and a negative offset when substracting. This will result in a White Underprint slightly
larger than the objects that need the White Underprint You can also choose to Choke, which gives
an inward offset when adding, and an outward offset when substracting. This will result in a White
Underprint slightly smaller than the objects that need the White Underprint.

Set the Corners as you would for trapping: See Color and Shape Settings. You can select Bevel, Round
or Mitered. When selecting Mitered corners, you can also set the Miter Limit. Miter limit determines
whether sharp corners in objects appear pointed or beveled.
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Define if White Underprint should be generated only on visible parts of selected objects, by setting the
Only Visible Parts option.

9.23.2.  Adding and removing White Underprint

White Underprint objects will be created in a top-level "White Underprint" layer, and will be put in
overprint.

A new White Underprint layer will be created:

• If a different (new) White Underprint ink is used. There will be 1 layer per used White Underprint ink.
• If the White Underprint layer doesn't exist yet

Click Prepress > White Underprint to open the White Underprint dialog.

Select one or more objects in the ArtPro document.

Set the White Underprint settings: see White Underprint settings on page 418

In the White Underprint palette:

• Click “Add” to add White Underprint for the selected artwork: the function will compute the union of
the selected artwork and add the resulting paths at the top of the White Underprint layer

• Click “Subtract” to subtract the selected artwork from the White Underprint layer. The function
will compute the union of the selected artwork, and put the resulting paths at the top of the White
Underprint layer, in overprint, and at 0% of the selected White Underprint ink.

9.24.  Rich Black

The Rich Black tool can be used to obtain a darker black by overprinting all black areas with the
specified ink, for example Cyan.

Note:  Rich Black does not work on any placed file.

Open the Rich Black dialog by choosing Prepress > Rich Black...

 

 

Select objects using the standard ArtPro selection tools
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Use the Add dropdown to select the ink (e.g. Cyan) you want to add to create a rich black. The
dropdown will contain all inks present in the job.

Enter the Density you want to apply

Use the “To” dropdown to select the inks you want to change into rich black from the list of used
separations. All areas using the selected separation, and above the Minimal Density percentage, will
become rich black by adding the Add color.

Enable “Pure Inks Only” if you only want to create rich black for pure inks, and not in areas that already
contain a mix of inks.

Set the Offset to define the distance between the edge of the added ink and the edge of the black
object.

Set the Corners as you would for trapping: See Color and Shape Settings. You can select Beveled,
Round or Mitered. When selecting Mitered corners, you can also set the Miter Limit. Miter limit
determines whether sharp corners in objects appear pointed or beveled.

Click Create to generate a layer of overprinting objects to enrich the source ink. The layer will be called
“Rich Black” by default.

Note:  You cannot use a Technical ink for Rich Black

9.25.  Plug-ins

The Plug-ins menu will allow for the use of some special add-ons, e.g. the creation of an EMS code.

For further information please contact Esko (see About this application)
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10.  View Menu

10.1.  Preview / Outline

 

 

Displays the ArtPro job in vector mode or in color mode. In ArtPro there are two modes of viewing the
document.

The first is the vector or outline mode where only the technical lines of the paths are visible. The
second color mode or preview where the filled version of the file is displayed. Vectors can be shown
in color mode as well, when the option Show Outline is activated in the Preview Options dialog (see
below). Functions can be executed both in preview mode and in vector mode. Switching between the
two modes can be done with the Preview function in the menu or by its keyboard shortcut. Another
possibility is using the toolbar buttons for preview and outline mode.

 

 

Shortcut: Cmd-Y, Switch between preview and outline mode

10.1.1.  Picture Preview

• During on screen preview, EPS files are displayed with their PICT preview.
• TIFF files are displayed with reduced resolution: the file resolution is repeatedly divided by 2

until it is lower than the Picture Display Resolution in the Preferences menu (see Picture Display
Resolution on page 61), by default 100 ppi. In that case e.g. a 72 ppi low resolution preview file
is displayed unmodified, a 300 ppi high resolution file is displayed at 75 ppi. Changing Picture
Display Resolution once a TIFF has been previewed does not change the display resolution any
more, except for mapped TIFF, where the resolution will be updated on the next internal preview
recalculation (e.g. when switching on/off a separation in show seps - see later in this chapter, or by
switching preview off and on ).

• ArtPro files are displayed with the preview saved with the file. The resolution depends on the
setting of Preview Resolution in preferences at the moment the file is saved. If no preview is
present, a 50% gray rectangle is used.

• Vignettes are previewed with the number of steps set in the Preferences. Default this is 24 steps.
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• Small text is previewed as rectangles if it becomes too small to display (small font size or small
zoom factor).

10.2.  Previous View

Previous View cancels the last View change. This could be zoom in or out, or a pan. Preview, Preview
Options and show separations are not changed with Previous view. A 2nd undo will undo the 1st, so
it can be used e.g. to switch between a zoom and a total view. It can be activated in the menu or by its
shortcut.

Shortcut: Cmd-M : Previous View

10.3.  Fit Job in Window

Fit Job in Window displays the ArtPro document as big as possible in the active window. ArtPro puts
the bounding box of all objects visible in the file as big as possible in the window. If the job size is
bigger, then the jobsize will be fitted in the window. So it is either the job size or the job size + the
bounding box of the elements running off the jobsize that is fitted. The function can be activated in the
menu or by its shortcut.

Shortcut: Cmd-F, Fit in window

10.4.  Fit Selection in Window

Fit Selection in Window displays the selected objects as big as possible in the active window. The
function can be activated by choosing Fit Selection in Window or by its shortcut.

Shortcut: Cmd-Shift-F, Fit selection in window

10.5.  Actual Size

Actual Size shows the job with its 100 % size in the window.

10.6.  Zoom In
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Zoom In enlarges the document display. Each time it’s applied, the job is displayed twice as large as
before. In ArtPro you can zoom in until you see internal resolution (12.000 dpi). (The zoom factor can go
as high as 2mio %). It can be activated by choosing Zoom In in the View menu or by its shortcut.

Shortcut: Cmd-=, Zoom in

10.7.  Zoom Out

 

 

Zoom Out reduces the document view. Each time you click, the document is displayed at half the size
factor of the previous view. Zoom Out can be activated from the View menu or by its shortcut.

Shortcut: Cmd, Zoom out

10.8.  Repaint

Repaint forces the computer to repaint (= refresh) your complete job window. It can be activated by
clicking on Repaint in the menu or by using its shortcut.

Shortcut: Cmd-, (comma), Repaint

10.9.  Ruler

 

 

The Ruler is the origin of the ArtPro document and can be moved around. The center for the linear
transformations (rotation, scale, mirror, shear) is the zero point of the activated Ruler.

When you deactivate or hide the Ruler (Cmd-R), the center of the bounding box of the selected objects
is used instead (see later in this chapter: Copy, Move, Rotate, Scale, Shear, Mirror Vert., Mirror Hor.).

When using metric units (mm, cm), the ruler displays in millimeters. By choosing inches, mils, points, Q
or int. units, the ruler will display inches (see Preferences... on page 48).

The Ruler can be moved using the Move Ruler function (see Ruler tool on page 523).

Shortcut: Cmd-R : Show/hide ruler
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10.10.  Undo Ruler

With the Undo Ruler function you can undo the last ruler movement.

There is only one level of Undo Ruler. So if you undo twice, you return to the original position before the
first undo. (= undo of undo)

Shortcut: Cmd-Shift-R, undo move ruler

10.11.  Show Notes

Show Notes can make Notes in the complete document hidden or visible.

10.12.  Show / Hide Grid

Using Show / Hide Grid, you can make the Grid (see below) visible or invisible.

10.13.  Set Grid

Set grid is used mainly for separated S&R. It will create a grid on the selected size, the origin point
being the top left corner of the selection. At the same time the vertical and the horizontal cursor key
step (see Preferences... on page 48) are set to these same dimensions.

The grid created is always a partial grid, meaning ArtPro displays a small (per default green) cross on
the dimensions of the grid. Using the Move Area tool (see Move area tool on page 204), objects can be
moved on the grid distance, e.g. to copy and position separations of a S&R job.
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11.  Window Menu

11.1.  New Window

New Window opens a new window for the active job. It can be activated from the View menu or by
its shortcut Cmd-Alt-V. New Window allows you to have multiple windows in one or more jobs, up to
a maximum of 9 in total. Thus, it is possible to have multiple jobs open on the screen. The number of
windows and their position is saved with the file preferences.

Each window can have its own preview settings and per window Undo View is available. By default, a
new window takes the settings of the current one. Thus, it is possible, for example, to display the job in
outline mode in one window and to see it in color in another window. In the title bar every window gets a
number appended to the file name, e.g. Test:1, Test:2, Test:3 for three windows of a job called Test.

Only one window can be active at a time. A window can be activated by clicking in it, by clicking on
its title bar or by activating it in the Window menu (see below). The current window can be closed by
clicking on the close button in the title bar or by using the shortcut Cmd-Shift-W.

For each window, even if it is hidden under another one, an off-screen memory buffer is created. The
size of this buffer depends on the window size and the preview mode. For example, a 20 inch full screen
has a 0.5 Mb outline preview and a 4 Mb color preview. During contone editing the color preview is three
times as big. Therefore it is advisable to use Panes from Tile Windows, when working with multiple
windows or jobs.

Shortcut: Cmd-Alt-V, New Window

11.2.  Tile Windows

The Tile Windows menu defines how the multiple windows will be displayed. Four standard display op-
tions for multiple windows are available :

 

 

• Vertical: displays all the windows equally sized and vertically.

• Horizontal: displays all the windows equally sized and horizontally.
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• Panes: all the open windows are pane-wise divided over the full screen. This function can also be
used if only one file is open. In that case, the job window will be changed to match the screen size.
This view is the only one with a shortcut

Shortcut: Cmd-Alt-F, Tile Windows, Panes

• Stack: all the open windows are piled up one on top of another so that only the topmost one is
completely visible.

11.3.  Synchronize Windows

11.3.1.  All Windows

If the All Windows option is on, the views from all (different) jobs will be synchronized, i.e. changing the
zoom or pan in one job, will cause an identical change to the other job.

The Synchronize Jobs option uses the center of the Trim Box as reference point.

11.3.2.  Windows of Current Job

If the Windows of Current Job option is on, all views from the same job will be synchronized, i.e. all
views will be centered on the same point in the job.

Changing the zoom or pan in one view, will cause an identical change to other views.

The option is a job option, saved in the file, and applied to all views of the same job.

11.4.  Workspaces

 

 

Workspaces allow you to save and (re)load the position of all your palettes and the customised tool bar.

A Workspace is saved by selecting “Save Current”.

Using “Reload Current”, you can reset the tool bar and the palettes position to the saved Workspace.

 

 

A new Workspace is defined by duplicating the current, and entering a name for it. Delete Workspace
allows to permanently delete the Workspace. The “Default” workspace can not be deleted.
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All defined Workspaces can be selected and activated from the top of the list.

11.5.  Hide / Show Palettes

Hide / Show Palettes allows you to hide and show all palettes at once, without closing and reopening
them one by one.

11.6.  Close Palettes

Using Close Palettes or its shortcut Cmd-Alt-W all menus and dialogs will be closed except for the job
windows and the toolbar.

11.7.  Align

The Align function has two dialogs: regular align and the extended align. The functionality of the two
differs depending on the dialog that was chosen. The align dialog can be activated through Window >
Align or by its shortcut. The extended align dialog can not be found in the menu, but can be activated
by going to the regular align function holding the shift key down, or by clicking the green + button in the
align dialog. As soon as you reduce the size from the align dialog (from extended to default), all settings
of the extended window that are now hidden, are automatically deactivated.

In the align dialog, you can also find the measure tool.

Shortcut: Cmd-Alt-L, Align

Shortcut: Cmd-Shift-Alt-L, Extended Align

11.7.1.  Align

The Align functionality can be used to horizontally or vertically align or distribute a number of objects.
The first row is to align or distribute all objects vertically. The second row is to align or distribute hor-
izontally.

 

 

The first 3 buttons on the top line, align the objects to the top, the center or the bottom. On the bottom
line, they align to the left, centered or to the right. The position of alignment is determined by the
position field: if the field is empty, the objects will be aligned to the bounding box of the selection.
Otherwise, alignment is predefined relative to the ruler position. The Bounding Box button and the
Ruler button can be used to set the input fields resp. to empty or to zero.
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When you align several elements while holding shift, the selection will be moved all together (the
selection is treated as a group). Without shift, the alignment is as in older versions.

Using the 4 other buttons, you can distribute all selected objects. In this case, the outer objects
(above: top and bottom, below: left and right) are not changed.

The first distribute button will distribute the centers of the inner objects equally in between the
centers of the outer objects. The second button distributes the space in between the individual
objects. (see picture)

 

 

11.7.2.  Extended Align

The extended align dialog combines many functions like positioning the ruler, checking the position of
a selection, transforming the selection, aligning, etc....
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Ruler positioning
The bottom left part of the extended align dialog shows 9 buttons to align the ruler to the job size.
When applying shift, the ruler will be aligned to the bounding box of selected paths instead. If the
ruler is positioned on one of the 9 magnetic points of the job size, the corresponding icon will remain
highlighted. You can see that as soon as the ruler is moved away from one of the 9 positions on the job
size, no button is highlighted.

 

 

Measure point position
The second set of 9 buttons defines the position of the measure point. As soon as one of these buttons
is activated, the distances to the ruler and the size of the bounding box of the selected objects will be
measured.

 

 

Modifying the values in these measuring fields is possible and results in an immediate modification of
the distance or the size of the objects (bounding box of the selected objects).

When changing the size, the position of the active measuring point will not move. The measuring point
has to be defined before you can move or scale objects.

When clicking on the activated button, the measuring will be deactivated, but the values will remain
active. This means other objects can be aligned on this one measure point:

• select an object and choose the measure point
• deselect the measure point
• select (an) other object(s)
• use the align buttons to align them on the original value.

Bounding box or object mode
Linked to this there are two different modes of working: bounding box mode or object mode
 

 
In bounding box mode (default), the system calculates via the bounding box of the objects and allows
you to modify only position, as well as the size of the bounding box.

In object mode, the system works with the real object values, e.g. the object's real top left point,
instead of the top left point of its bounding box. When choosing the object mode, more parameters
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of the object become available and can be modified: scale vertical and horizontal, rotation angle and
shear. In the dialog all the object parameters are displayed. In the example on the right, the top left
corner of the selection is aligned on the ruler in both modes, first the bounding box mode then the
object mode.

Remark
The additional parameters in the object mode (scale, rotation and shear) are only available when
working with paths that contain creation information. In practice this means all boxes, circles, ellipses,
bar codes, etc. created with ArtPro drawing tools. Paths imported from PostScript, PDF or other file
formats will receive creation information the first time they are transformed through this extended
align dialog. Until then, these fields are empty, but you can still modify them. Paths without creation
info can still be scaled, rotated, sheared, etc. using the normal transform dialog or transformation
tools, but those functions do not update creation info.

Absolute versus relative measurements:
In the align dialog, all measure and input fields are absolute, whereas the input fields of the transform
dialog are relative. E.g. If you move an object, the vertical and horizontal distance fields in the align
window will show the absolute position in relation to the ruler position, the transform dialog will
measure the vertical and horizontal distance between the object's initial position and its new one.

11.8.  Bar codes

The top of the dialog shows 5 buttons: Separations, Links, Fonts, Screens and Bar codes. Pressing a
button will switch to the corresponding list.

• Separations... on page 470

• Links on page 438

• Fonts... on page 433

• Screens on page 469

• Bar Codes

At the bottom, next to the other buttons, there is an action button menu containing additional

functions depending on the selection. You can access the menu by clicking the action button. 

Bar codes shows the bar codes used in the file, and allows you to show those bar codes in the file or to
replace them. The used Bar codes dialog can be activated through the View menu or its toolbar icon

11.8.1.  Bar code list

The Bar code list contains all the Bar codes in the job. The preview, Code and Type is always shown,
and the Reduction and Magnification column can be switched on or off in the action button, in “Show
Column”. You can sort the pictures based on the column by clicking the column header.

Clicking a bar code will select it in the job, double-clicking will zoom in on that selection.
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11.8.2.  Code

You can change the code of a Bar code directly in the Used Bar codes list, by clicking the code and
typing a new code, or selecting it from the list showing all codes used in the file. All Bar codes with the
same code and type will be changed as well.

11.8.3.  Type

This shows the bar code type. If the bar code was edited but still contains the parameters of the bar
code, the type will have “(Modified)” appended to it. This indicates that remake the bar code using the
bar code parameters, the result may not match exactly.

11.8.4.  Remove

You can remove a Bar code by selecting it and clicking the Remove button, or by selecting Remove Bar
code from the action button.

11.8.5.  Generate Report

You can generate a PDF or TXT report of the resources, containing the following information:

• Separations: Name, Type, Used
• Images: Name, Resolution, Size, Type, File Size
• Fonts: Name
• Screens: Name, Used
• Bar codes: Code, Type, Magnification, Reduction.

By selecting “Bar codes Only”, you can output a report on the Bar codes only.
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11.9.  Certified PDF

11.9.1.  Show Sessions

The Show Sessions function is only available when working in Certified Mode. This function opens the
Session Dialog. For more info on Certified ArtPro and the Session dialog, see Certified ArtPro on page
65.

11.9.2.  View Session Comments

The View Sessions comments function is only available when working in Certified Mode. This function
opens the Session Comments. These are the same Comments opened when saving a Certified ArtPro
file. For more info on Certified ArtPro and the Session comments, see Certified ArtPro on page 65

11.10.  Collection

A Collection is a temporary set of objects, based on a selection. It allows to navigate through the
objects in the Collection, automatically zooming in on them.

A collection is temporary, and only kept until it is cleared, or until the document is closed.

Note:  Objects that are removed from the job will also be removed from the collection.

Select a number of objects. You can select objects manually, or by using e.g. Select by Attributes.

Choose Window > Collection to open the Collection dialog

 

 

Click the Make Collection button to make a collection based on the selection.

Note:  By clicking the Collect button in the Select by Attributes window, you can skip step 2 and
3, and immediately create a collection based on the properties set in the Select by Attributes
window. See also Select by Attributes... on page 247
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Browse through the collection The Collection dialog will show the number of objects in the collection

• Use the browse buttons to navigate through the different objects in the collection
• The Info field shows the type of object currently selected
• Select the Highlight option to show the currently browsed object with a rectangle around the

bounding box in the selection color.
• Select the Zoom option to automatically zoom in on the currently browsed object.
• Select the Select option to automatically select the currently browsed object.

11.10.1.  Modifying a Collection

You can modify the Collection using one of the functions in the fly-out menu of the Collection palette:

• Click the Make New Collection button or select Make Collection from the fly-out menu to "forget" the
current collection, and create a new collection based on the current selection.

• Select Clear Collection from the fly-out menu to "forget" the current collection.
• Select one or more objects in the job, and select Add Selection from the fly-out menu to add the

selected objects to the collection.
• Browse to an object in the collection, and select Remove Selection from the fly-out menu to remove

the selected objects from the collection.

Note:  Objects that are removed in the job, are automatically removed from the collection.

• Select Select All from the fly-out menu to select all objects in the collection.

11.11.  Color Pairs

The Color Pairs window shows the PowerTrapper settings associated with each of your document’s
color pairs. See The Color Pairs palette

11.12.  Fonts...

The top of the dialog shows 5 buttons: Separations, Links, Fonts, Screens and Bar codes. Pressing a
button will switch to the corresponding list.
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• Separations... on page 470

• Links on page 438

• Fonts
• Screens on page 469

• Bar codes on page 430

Fonts shows all the fonts used in the file, and allows you to show those fonts in the file.

By expanding a font (i.e. clicking the triangle in front of the name) you can see all the occurrences of
the font.

Clicking a font or an occurrence will select it in the job, double-clicking will zoom in on that selection. If
only a part of the text box is in the specified font, the whole text box will be selected.

You can remove the selected text blocks by clicking the delete button.

11.12.1.  Generate Report

You can generate a PDF or TXT report of the resources, containing the following information:

• Separations: Name, Type, Used
• Images: Name, Resolution, Size, Type, File Size
• Fonts: Name
• Screens: Name, Used
• Bar codes: Code, Type, Magnification, Reduction.

By selecting “Fonts Only”, you can output a report only containing the Fonts information.

11.13.  Layers...

 

 

Allows the use of layers in an ArtPro job. The Layers dialog can be opened by selecting Layers in the
view menu, by clicking on its toolbar button, or by using its shortcut. Layers can be viewed, locked and
printed to proofer/imagesetter individually by (de)activating the respective eye, lock and printer icons.
Clicking on the icon at the top of the list (de)activates all layers at once for that option.

If you vectorize without opening a file first, the resulting paths are put in a “Vectorized Tiff” layer. If you
import a CFF2 file, the resulting paths are put in a “CFF” layer. If you import a HPGL file, the resulting
paths are put in a “HPGL” layer.

When making a new job, there will be only one layer called Layer 1. You can change the name by
selecting it and typing another one. When PostScript files from Illustrator are imported, all layers can
be kept as in the original Illustrator file. Depending on the setting of the Merge Equal Layers, layers
with the same name are put together or not. If the option Recognize Illustrator Layers is not active, the
file is imported in the current layer. If there is no current layer, a new layer called “Postscript Import” is
generated. When using Step & Repeat, the repetition is created in a layer named “Repetition”.
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Opening a file can merge all layers with the same name, if the Merge Layers with same name option is
on.

Shortcut: Cmd-Shift-L, Layers...

11.13.1.  Handling layers

Visible, Printable, Locked
You can make a layer (in)visible, (un)locked or (un)printable by clicking the eye button, the padlock or
the printer button.

Note:  If you make a (printable) layer invisible, the printability of the layer will show this icon

, and the layer will be treated as a non-printable layer when exporting to PDF with the
“Keep PDF1.5 layer properties” option enabled. In other cases (e.g. export to PostScript or PDF
without this option) the hidden layer will remain printable. When making the layer visible again,
the printability returns to its previous state.

Active Layer
The active layer is indicated by the black triangle to the right of it, and the name of the layer is in bold.
In order to activate another layer, just select it. Note that the result of some functions, such as Unite,
Intersect,... from the Arrange menu, is created in the active layer, which might not be the one required.
Furthermore, the objects that are being created, will have the current state of the layer, i.e. (in)visible,
(un)locked and (un)printable. As a consequence, for instance, an object that is being created in the
active hidden layer will disappear immediately.

Selections
When objects in a job are selected, a little square in the selection color to the right of the layer name
indicates in which layer the selection is made. If all objects in the layer are selected, the blue square
will have a black stroke.

To clean up the layers, you can Select All (Cmd-A) elements and check if all layers are used. The layers
without square are not used. Obviously you need to make sure that no elements or layers are hidden or
locked. You can also use the option Delete unused Layers from the action button

Layer order
The layer order ranges from top to bottom as listed, the first one in the list being the topmost layer. To
change the order of a layer, select it and drag the layer(s) up or down to the required position.

New

With the New button  a new layer will be created on top of the other layers. ArtPro uses a default
name “Layer x” and numbers the new layers automatically.
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Delete

By pressing this button , the selected layer(s) is deleted from the layers list, together with all the
elements that were placed on it. ArtPro will warn you if the selected layer contains artwork, and after
deleting, the Undo (Cmd-z) function can bring the elements back.

To Current
To move elements from one layer to an other, select the objects, activate the correct layer and press To

Current . All the selected elements are moved to the active layer.

11.13.2.  Handling objects inside layers

By clicking the grey triangle in front of the layer name, you can show or hide the objects in the layer.

Visible, Locked
You can make individual objects (in)visible or (un)locked by clicking the eye button or the padlock.
Unlike the eye and padlock icons for layers, the icons for objects can have 3 states:

For visibility:

• The eye is enabled: both the layer and the object are set to visible.
• The eye is disabled: the layer is visible, but the individual object is hidden.
• The eye is greyed out: the layer is invisible, so the object is invisible, regardless of its own visibility

setting.

For locking:

• The padlock is disabled: both the layer and the object are set to unlocked.
• The padlock is enabled: the layer is unlocked, but the individual object is hidden.
• The padlock is greyed out: the layer is locked, so the object is locked, regardless of its own locked

setting.

If a layer is made visible or unlocked again, the individual objects will return to their previous (locked or
hidden) state.

Note:  If you have a layer that contains a mix of visible/hidden or locked/unlocked objects, you
can enfoce the setting (visible/hidden or locked/unlocked) for every individual object in the
layer by shift-clicking the “visible” or “locked” button.

Labels
The label indicates the kind of object: Path, Compound path, Group, ... If the object label is underlined,
it means the object has an opacity mask applied to it.

The icon in front gives a preview of the object. The size of the preview can be set in the action button.
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Named groups and objects
By clicking the label, you can rename the label of a group or object to a custom name. Names of groups
and objects are saved in the ArtPro file, and will be saved when outputting Normalized PDF for objects
not specific for the application (e.g. the name of strokes are not saved).

By making the name field empty, you can return to the automaticly generated label.

You can use the Select by Attributes to select objects based on their name. See Select by Attributes...
on page 247.

Selection
If an object is selected in the job, a blue rectangle is shown at the right side. You can select/deselect
objects by clicking the same place, right next to the scroll bar. You can add / remove objects to the
selection by holding down the Shift key.

The selection in the job is independent of the selection in the Layers dialog, shown by a blue
background for the object entry. This selection is used for the Layer dialog functions, such as “Delete
Selected Objects” and dragging and dropping objects.

Paint indicator
Next to the selection indicator you can see the Paint Indicator, shown as a black circle. If the object
has no transparency set (i.e. blend mode “Normal”, opacity at 100%), the circle will be white. If any
transparency is set (a blend mode other than “normal”, or an opacity lower than 100%) the Paint
indicator will be filled in grey.

If the Paint Indicator is selected (i.e. stroked), this means that the Paint (both Paint Style, Screening
and Transparency) shows the paint of that specific object. This can be useful when selecting multiple
objects. By clicking a Paint Indicator, the Object Parameter dialogs will show the settings for that
specific object. If the Paint Indicator of a group is clicked, the Group parameters will be shown.

Drag & Drop
You can drag and drop one or more selected objects to change their order. You can also drag and drop
objects from one layer to another one.

Scroll to selection
 

 

If an object is selected in the job, you can use the “Scroll to selection” to easily find the object(s) in the
Layers dialog.
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11.14.  Links

The top of the dialog shows 5 buttons: Separations, Links, Fonts, Screens and Bar codes. Pressing a
button will switch to the corresponding list.

• Separations... on page 470

• Links

• Fonts... on page 433

• Screens on page 469

• Bar codes on page 430

At the bottom, next to the other buttons, there is an action button menu containing additional

functions depending on the selection. You can access the menu by clicking the action button.

Links shows the pictures used in the file, and allows you to show those pictures in the file or to replace
them. The Links dialog can be activated through the Window menu or its toolbar icon

11.14.1.  Link list

The Links list contains all the internal and external mapped and placed pictures of a job. The columns
(except the preview and name) can be switched on or off in the action button, in “Show Column”. You
can sort the pictures based on the column by clicking the column header. The available columns are:

• A small preview of the picture
• The name of the picture
• The resolution of the picture, if applicable. The resolution shown is the resulting resolution, e.g.

a 300 dpi picture placed at 50% will indicate 600 dpi. A “>” is shown if the horizontal and vertical
resolutions are different, or if the picture is used multiple times in the job.

• The size of the picture, in pixels (for bitmaps) or in length units (as defined in the preferences), e.g.
in mm for placed PDF or ArtPro files.

• The type of the picture
• The file size of the picture
• The image profile, working space profile and embedded profile
• The Label Count. If the Label Count is visible, you can define the number of sheets to be printed

below. The Label Count column will then show the number of prints you will have for that specific
image (or, in case of a S&R, the number of labels).

By expanding a picture (i.e. clicking the triangle in front of the name) you can see all the occurrences of
the picture, each with its own resolution and size (always in length units).

Clicking a picture or an occurrence will select it in the job, double-clicking will zoom in on that
selection. If a picture is selected, you can see all the link information (see below).

If you select one or more images in the job, the corresponding line(s) in the Links list will become
selected.
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In case the Link list is too long, so the selected Link is not visible, you can click the Scroll to Selection
button to easily scroll to the selected line.

11.14.2.  Link info

The link info will show the data for the selected picture.

• File: contains the file information such as type, file size, original resolution and location of the file
• Color space: shows the image profile, working space profile and embedded profile of the picture. It

also shows the location of the original file (i.e. before color management was applied to it)
• Separations: shows the separations used in e.g. placed ArtPro or PDF files
• Page Boxes: shows the dimensions of the page boxes of placed ArtPro or PDF files

11.14.3.  Place Picture

By clicking the Place Picture button  or selecting “Place Picture” from the action button, you can
place a picture in the file. See Place Picture... on page 240.

11.14.4.  Remove Picture

By selecting a picture in the list, and clicking the Remove Picture button  or selecting “Remove
Picture” from the action button, you can delete a placed picture in the file.

11.14.5.  Replace Picture

By selecting a picture in the list, and simply clicking the Replace Picture button  or selecting
“Replace Picture” from the action button, you can replace the picture by another one. All appearances
of the picture will be replaced, in the same way as Apply Picture, meaning that the new picture will be
modified, keeping the same position and scaling parameters as the original picture, providing it has the
same size and resolution.

If you click and hold the triangle at the right side of the Replace Picture button, you get three options.
The same three options are also available from the fly-out menu:

• Replace Selected Pictures: the default behaviour as described above: only replace the image where
it is used as a picture (and not as a mask)

• Replace Selected Masks: only replace the picture where it is used as a mask
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• Replace Selected Pictures and Masks: replace all selected pictures, both pictures and masks.

11.14.6.  Edit Picture

By selecting a picture in the list, and clicking the Edit Picture button  or selecting “Edit Picture”
from the action button, you can open the picture in the application that is assigned to it in the Finder.

11.14.7.  Color Management

When Color Management is applied on a picture, the image is replaced by a color managed version, but
a link to the original image is kept as well.

When selecting such a picture in the Links window, the Color Space section will show the location and
name of the original file, the embedded profile, the image profile and the working space profile. When
opening an ArtPro file, ArtPro will check if any of the original images was changed. If so, the Links
window will open with the changed picture selected.

If the original image was changed, two options are available in the action button : Either synchronize
the picture, i.e. updating the color managed image to the changed original file, or validating it, i.e. forc-
ing to accept the image as it is, breaking the link with the original, modified image.

The profile of the selected image can be changed using the Change Profile function in the action
button. The user can define to use the embedded or a selected color profile, and the rendering intent.

 

 

For more info on Color Management, see Color management on page 183

11.14.8.  Reload Pictures

The Reload Pictures function from the action button allows to refresh all placed images, reloading
them from disk.

11.14.9.  Calculate PDF Preview

Calculate PDF Preview can be used to calculate a separated preview of a placed PDF in ArtPro.

This preview will allow you to switch separations on and off in the Viewer: see Viewer on page 504.
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The preview will use the resolution set in the Preferences: see Preview Resolution on page 52. However,
this resolution can not be set lower than 50 ppi.

This function can be found in the action menu of the Links window, or in the contextual menu of a
placed PDF.

11.14.10.  Save PDF Preview

Save PDF Preview will calculate a separated preview of a placed PDF in ArtPro (see Calculate PDF
Preview on page 440) and add it to the PDF file.

This means the separated PDF Preview will be available next time the PDF is placed.

This function can be found in the action menu of the Links window, or in the contextual menu of a
placed PDF.

11.14.11.  Hide/Show Partially Visible Pictures

Using the Hide/Show Partially Visible Pictures option, pictures that are not completely placed inside
their path, can be hidden or shown in the picture list. This can be very useful if the Links window is
used to determine how many labels will be printed. When using the S&R interactive on e.g. round
labels, parts of the label can be placed at the outside of the sheet. In order not to count these half
labels in, the option to Hide Partially Visible Pictures should be switched on.

11.14.12.  Generate Report

You can generate a PDF or TXT report of the resources, containing the following information:

• Separations: Name, Type, Used
• Images: Name, Resolution, Size, Type, File Size
• Fonts: Name
• Screens: Name, Used
• Bar codes: Code, Type, Magnification, Reduction.

By selecting “Links Only”, you can output a report only containing the Links (used images) information.

11.15.  Magnetism...

In the Magnetism dialog all possible magnetic items can be defined and activated. Magnetic items are
useful for aligning and positioning objects. When all toggles are on, priority ranges from top to bottom.
The menu can be activated in View, by double clicking the Ruler icon in the Toolbar or by its shortcut.
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Shortcut: Cmd-Alt-G, Magnetism...

11.15.1.  Activate Magnetic Objects

Any ArtPro path can be a magnetic object. By activating the checkbox, the use of magnetic objects will
be available. Select the path(s) and click on Set to make it magnetic. In order to use it as such, check
the toggle next to Activate Magnetic Objects. All the magnetic paths will then be shown in the Display
Color for Magnetic Objects (see Display Colors: on page 59), by default bright green. Even to a magnetic
object, all normal functions, such as transformations, coloring, etc., can be applied.

The Lock button (cfr. the same function in the Arrange menu) will fix (lock) all magnetic objects
(selected or not) in the job so that they cannot be selected and manipulated accidentally. Use Unlock
All in Arrange (Unlock All  on page 213) to return it to its unlocked state.

Release deactivates the magnetism from the selected path(s).

11.15.2.  Activate Grid

A Vertical and Horizontal grid can be defined, by default in mm, and activated separately. Switch on the
Activate Grid option to visualize the grid. You can enter the distance between the vertical or horizontal
grid lines in the Vertical and Horizontal field. The grid can be used to snap to with the SHIFT key and the
Move and Create functions.

By default the grid points are shown as crosses. With the Full Grid option the grid lines appear. Clicking
on Grid Origin places the zero point of the grid on the zero point of the ruler.

11.15.3.  Activate Angle

With this option is on, the selected paths can be moved manually, in combination with the SHIFT key,
along the specified Angle. If a point is being moved exactly along the angle, a filled square will be shown
on the point, when moving off the angle an outline square will appear.
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By default the Activate Angle option is on, with an angle of 90°, making it possible to manually move
objects along their vertical or horizontal axis when the Shift key is pressed. The angle is defined from
the zero line clockwise (see fig. beside). Use the negative angle for counterclockwise.

11.15.4.  Activate/Show Ruler

The ruler is shown or hidden by switching the toggle on or off. When the ruler is visible, it is also active
and will be used in relation to functions from the Edit menu (scale, rotate,...).

11.15.5.  Lock Ruler

With the Lock Ruler option on, it is not possible to move the ruler. If you use the Move Ruler tool with
this option on, and there is no guide selected, you will get a preview of the ruler moving, but when you
release the mouse button, the ruler will not be moved.

11.15.6.  Activate Guides

With this option on, it is possible to see, create and move guides in the ArtPro document. Guides are
also used to position and align elements.

Guides can be created with the Ruler Tool (see Ruler tool on page 523). Just click and drag with the
ruler tool as if you are moving the ruler, then hold down the option key to create a guide. Depending on
whether you move closer to the horizontal or vertical part of the ruler you will get respectively a vertical
or horizontal guide. Let go of the mouse button to create the guide. The guide remains selected after
creation.

A selected guide is a dashed line with small dashes. If it is shown with long dashes, it is not selected.
You can reselect a guideline by clicking on it with the Ruler Tool and deselect it by clicking on another
guide, by clicking on the ruler or by selecting another tool (e.g. press the command key and deselect
with the regular selection tool). You can add to the selection by holding down the shift key. If one or
more guides are selected, they can be moved with the arrow keys.

If you move a guideline manually, holding down Shift will have it snap magnetically to selected objects
or to the job size. Magnetism does not apply when moving a guide by using the cursor keys.

With the Move button, you can move the selected guide(s) over the vertical or horizontal distance set in
the Position fields. This will only work if there is a guide selected.
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With the Create button, you can create a new guide on the position (vertical or horizontal) set in the
Position fields. If only a vertical value, or both values are entered, a horizontal guide will be created. If
only the horizontal distance is entered (so vertical is zero), a vertical guide will be created.

11.15.7.  Lock Guides to Ruler

With the Lock Guides to Ruler option on, the position of the guides in relation to the ruler is locked.
This means if you move the ruler, all guides are moved with it.

11.15.8.  Key Step

In the Key Step fields, you can enter the distance the ruler or the selected guide has to move when
using the arrow keys (Vertical for up and down key, Horizontal for left and right).

11.15.9.  Position

The Position field is used to create or move a guide (see above).

11.15.10.  Magnetism to guides

When moving an object, magnetism is activated by holding down the Shift key. When moving manually,
the object will snap to the ruler and to guidelines. When moving with the arrow keys, the object will only
snap to the ruler. When drawing objects, the endpoints can snap to the guides also by holding the Shift
key down.

11.16.  Messages

This will open the Messages window. This Message window contains all error messages, warnings and
information issued by the application. If an Error or Warning is generated, the Message window will
open by default.

Using the fly-out menu, you can clear all visible messages. Using the filter or by selecting a specific
reporter, you can clear a subset of the entire message list. .

11.17.  Navigate

The navigation window is used to define the preview of the file. Use the sliding bar at the bottom to
zoom in or out of the document. The value at the right shows the zoom factor and can also be filled in
manually. A small preview of the job is shown above. The red rectangle represents the area of the job
that is currently previewed. Click inside and move it to scroll through the job.
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A number of buttons can be used for fast access. The left row contains (from top to bottom) Zoom In,
Fit Job in Window, Fit Selection in Window, Actual Size and Zoom Out.

The right column contains 4 user definable zoom factor buttons.

Click and hold the button to set the current zoom factor for that preset. You will see the rectangle in
the preview turn blue for a moment.

Simply click the preset button to go to the earlier set zoom factor.

11.18.  Object Parameters

In ArtPro, there are 3 Object parameters : the Paint Style, the Screen and the Transparency.

 

 

The Paint (Style) is always attached to a path, while a compound or group can have a Transparency,
which can be different from the Transparency of the enclosed object(s). How Transparencies for
groups are calculated, can be found in Group Parameters on page 448.

The Object Parameters is the dialog containing all parameters for one or more objects. The dialog can
be opened using its shortcut, Cmd-i. This is the same shortcut for paint style, meaning it will toggle
between the Paint Style and Objects Parameters dialog.

11.18.1.  Transparency vs. Overprint

In order to avoid any misunderstanding, some basic terms are explained here

Transparency
Transparency is a part of the paint parameters of an object or group. Transparency can be a blend
mode, an opacity percentage or an opacity mask, or a combination of these.
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Overprint
OverPrint is set as part of the Paint Style, by entering “trans” in some separations.

11.18.2.  Selected Objects

Type
The Type gives the type and shape of the selected object(s). This can be opened path, closed path,
compound, group, text or “multiple objects”. If available, the shape can be shown as well : box,
polygon, ..., based on the creation info. If a CAD line is selected, the line type will be shown as well.

Preview
The Preview rectangle on the right will draw a small preview of the selected objects. By default,
preview will only be drawn when 1 single object is selected. By increasing the “Paths for selection
preview” value in the Display tab of the Preferences, you can get a preview of multiple selected objects.
Be aware that increasing this value to high numbers, can create nice thumbnails of large selections
(even complete jobs), but in some cases the thumbnail generation can become rather slow.

Number
The number of selected objects. In case the selection contains groups or compounds, the number of
objects shown will always be the lowest level objects : individual paths, and text. Keep in mind that a
text object is counted as a single object, even if it is a complete paragraph.

Level
This indicates the level of the object. If the selected object(s) are regular objects in the layer, the level
will be 1. An object which is part of a group or compound will have level 2. If this compound itself is part
of a group, the compound will have level 2, and the objects will have level 3, etc. If objects with different
levels are selected, no level will be shown

Size
This indicates the size of the selection.

Layer
This indicates the layer on which the selected objects are. If objects from different layers are selected,
this is left blank
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Indicator
The Indicator (a red square with exclamation mark) is shown if the selected object is part of a group
that has a blend mode or transparency. This will explain why e.g. the thumbnail preview of an object
has a different color than the screen preview, even though the selected object has no transparency.

11.18.3.  Object Paint

The Object Paint is the paint of the last object that was selected or clicked (cfr Paint Style behavior in
earlier versions). If multiple objects are selected at the same time (by shift-clicking), the paint of the
last object clicked on, is shown. Dragging a selection does not change the paint. Creating new objects
will apply all object paint parameters to the newly created objects.

Style
The Style indicates the type of paint. These are based on the various tabs from the Paint Style dialog :
flat paint, Linear gradation, Linear Multistep gradation (when set using Set Vertical or Set Horizontal),
Irregular Multistep gradation (when based on a shape), Pattern, Placed Picture or Mapped Picture.

Clicking the ... button on the right will open the paint style dialog. For more info on the Paint Style
Dialog, see Paint Style... on page 452

Screen
The Screen shows the pull-down with all defined screens, and indicates the screening of the current
paint.

Clicking the ... button on the right will open the Screen dialog. See Screening on page 252

Transparency
This indicates the Blend mode applied on the current paint, and the transparency percentage.

Clicking the ... button on the right opens the Object Transparency dialog. See Transparency on page
480

Apply
Clicking Apply in the Object Parameters dialog will apply all Object Parameters (Paint Style, Screening
and Transparency) to all selected objects.

11.18.4.  Group paint

The Group Paint allows to define, see or change settings on a Group. Unlike the Object Paint tab, this
tab only contains settings for transparency, to be applied on a group. If the selection does not contain
any groups, clicking Apply in the Group Paint tab will result in an error “No Groups Selected”.
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Clicking the apply button in the Group Paint tab will apply the current transparency on all selected
Groups, whereas clicking Apply in the Object Paint, the Paint Style, the Screening Dialog and the
Transparency dialog, always sets the parameters for every individual object, whether or not they are
enclosed in a group.

The settings in the Group Paint are described in Transparency on page 480 for the general
transparency settings, and in Group Parameters on page 448 for the specific group settings.

If you select a single Group, and this group contains any Blend or Transparency, the object parameter
dialog will automatically switch to Group Paint.

11.18.5.  All Transparent

A path can be made completely transparent with Cmd-Alt-T. This changes the paint style of selected
paths to flat color, completely transparent. It will also reset the blend mode to “Normal”, clear any
opacity mask, and set Opacity to 100%.

Note that this is not the same as the “All Transparent” button in the Paint Style. This button only
changes the values in the Paint Style (without applying), while the shortcut Cmd-Alt-T is applied
immediately, and resets the blend mode, opacity and opacity mask.

11.18.6.  Group Parameters

The Group Paint tab of the Object Parameters is very comparable to the earlier explained Transparency
dialog. For most options (Blend Mode, Opacity, Opacity Mask) we refer to Transparency on page 480.

However, the Group Parameters are assigned to a group, and not to individual objects.

 

 

Multiple objects vs. groups
In the example as shown on the right (start situation) we have a yellow background, and a cyan square
and magenta circle on top.
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First possibility is to apply a blend (in this example a Normal blend at a 50% opacity) to the individual
objects (by applying the Blend in the Transparency dialog, or in the Object Parameters in the Object
Paint tab). First the Blend between the Magenta circle and the yellow background is calculated.
The result will be 50% magenta and 50% yellow. Next the cyan rectangle is blended with the result
underneath

The result in the overlapping area will be 50 % cyan (50% of the color to be blended) and 50% of the
background (which is 50% yellow and 50% magenta), thus the final result in the intersection will be
50%C, 25%M and 25%Y. Second possibility is to apply the same blend, but now to the group. Therefor,
the two objects has to be grouped, and the group needs to be selected. Next the desired Transparency
needs to be set in the Group Paint tab. This should be applied by clicking Apply in the Object Parameter
dialog in the Group Paint tab (and NOT in the Transparencies dialog, as this would apply the blend to the
individual objects)

 

 

In that case, the group will be (internally) calculated to a one level object, knocking out all overlapping
areas (in this example, the magenta underneath the cyan will be disregarded).

 

 

Next, the blend is calculated between the group result, and the background. In that case, the result will
be 50%C 50%Y in all areas that were 100%C (including the intersection between the square and the
circle)

449



11 ArtPro

Blends inside a group
The default way to calculate blends, is to first calculate the blends on the individual objects to
whatever is underneath, and blend the result with whatever is underneath the group.

 

 

In this example, we have a pink line pattern, a blue frame and a green arrow.

A Screen blend is assigned to the green arrow, at a 70% opacity. You can clearly see the screen blend is
calculated both to the pink lines as to the blue frame.

Next the blue frame and green arrow are grouped, and a Multiply blend is applied to the group. The
Multiply is calculated from the group (the result after the first blend) to the pink strokes.

Isolate Blends
The Isolate Blends option is an option that can be used for blends applied to a group, or on placed
ArtPro files. When an object inside a group (or Placed AP file) has a blend assigned to it, this will affect
all objects underneath. If the “Isolate Blends” option is on, blends assigned to objects inside a group,
are only calculated to objects within the same group (or within the placed ArtPro file) and not to objects
outside the group. The opacity however will also affect the objects underneath.

In this example you can clearly see that the Screen blend on the green arrow is only applied from the
green arrow to the blue frame. The Screen blend is not applied on the pink strokes. The 70% opacity
however is calculated on the complete green arrow.
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Knockout Groups
The “Knockout Groups” option is an option that can only be used in the Group Paint.

With the “knockout groups” option on, objects inside the group will only interact with what’s behind
the group - not with other elements inside the same group. This means that all blending and opacity
calculation is done between the object (which is inside the group) and the group’s background (which is
outside the group).

 

 

In this example you can see that the green arrow blocks out the blue frame, so the Screen blend of the
arrow, and the multiply blend of the group only affects the green arrow towards the pink strokes.

Opacity & Mask define knockout shape
The Opacity & Mask define knockout shape option only affects the combination of objects with an
Opacity mask, inside a group with the Knockout Group option. The result will be that, instead of
knocking out completely, the object with the Opacity Mask will be knocked out based on the Opacity
Mask and the Opacity value.

The example underneath shows :

1. the original shapes : pink bars, a yellow star and a cyan ellipse.

2. A Multiply transparency is applied on the blue ellipse : the cyan ellipse is multiplied with the yellow
star and the pink bars.

3. An ellipse is drawn on top, with a horizontal gradation from 0% white to 100% black.

4. The gradation is used as opacity mask for the blue ellipse. The blue ellipse is faded from right to left,
based on the luminosity of the gradation.

5. The blue ellipse and the yellow star are grouped, and the “Knockout Groups” option is switched on (for
the group). You can see the blue ellipse is blocking out the yellow star underneath, before calculating
the blend from the blue ellipse.
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6. The circle is selected out of the group, and the “Opacity & Mask define knockout shape is switched
on. You can see now that the blue ellipse is knocking out the yellow star, based on the applied Opacity
Mask

 

 

11.19.  Paint Style...

 

 

The Paint Style dialog defines, together with the transparency and the screen, the Paint of the
selected object. The dialog displays the Paint Style of the last object that was clicked on (not click and
drag). The Paint Style dialog can be activated by the menu function, with its button in the toolbar or
by its shortcut. In every Paint Style menu (except patterns), there is a preview of the entered colors or
images.

Next to the Color preview, a red exclamation mark is shown, if the selected path is influenced by a
blend mode:

• : The object itself has a blend mode
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• : The path is part of a group with a Group Transparency defined to it

This indicates that the final result of the paint defined in the paint style will be influenced by the Blend
Mode. Clicking this indicator will open the Transparency dialog. See Transparency on page 480.

Paint Style can be opened from the Paint Menu, from the Object Parameters (see Object Parameters
on page 445) or by its shortcut Cmd-i. This is the same shortcut as for the Object Parameters. This
means if Cmd-i is hit a first time, it will open the Paint Style. When hit again, or if the Paint Style was
already open, it will open the Object Parameters.

Shortcut: Cmd-i, Paint Style

11.19.1.  Flat Color

Flat color is the normal plain color definition. This could be cmyk as well as pantone colors. You can
fill in any mixture of cmyk and pantone colors. There is only one column of input fields for the different
separations in which you can define the color composition.

Procedure
Select the paths you want to color.

Select Flat color

Fill out the % or trans for the different separations.

Click Apply or press the Enter button.

11.19.2.  Registration

Registration color is a flat color, with the “Registration” option on. A registration color gets the same
percentage for every searation.

A Registration can be defined by switching on the “Registration Color” option. If this is on, all
separations will get the same value. Changing one value will change the other separations as well.
When you define a color using the “a” shorcut (see All separations value on page 469) or using the “All
100%” button (see All 100% on page 467), the registration color flag will be switched on automatically.
The “All 0%” or “All Trans” button switches the Registration Color flag off.

Note that a registration color doesn’t need to be all 100%. A registration color can also be set at e.g.
20%.

Visually, there is no difference between a registration color and a non-registration color with the same
values, and on output devices, no difference will be visible.

However, the registration flag does influences the way some functions handle these colors.

Used Separations
In ArtPro 9.0, the paints with the Registration flag on will be ignored when defining the “separations in
use”. (See also Separations In Use on page 474).
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This means that if you create an object with 100% for all separations without setting the registration
flag, ArtPro will consider all separations as “used”, and all plates will be output.

All functions using “used separations”, such as regmarks, Artlink, the “search” option in the output
separations, the “Remove unused separations” function in the separation dialog,... will be influenced by
this new registration color.

Adding a new separation
When adding a new separation, every object get zero% for the new separation. If the Registration flag
is on, the new separation will get the same percentage as the others.

However, when deleting a separation and immediately adding a new separation, the original ink
percentages for the deleted separation are remembered and will be applied to the newly created
separation.

Import PS/PDF
PostScript and PDF use a definition for registration color, using the separation “/all”. Those objects will
be automatically converted to Registration color on import.

Opening older ArtPro files
When opening an ArtPro file created before ArtPro 8.6, ArtPro will search for objects with 100% for all
separations, and set the Registration flag. Note that for compatibility reasons, ArtPro will only search
for objects with all 100%. Objects with e.g. 20% for every separation will NOT have the Registration flag
automatically. It is still possible to change those manually, e.g. using the Selector.

11.19.3.  Vertical Gradation

With Vertical Gradation the Paint Style dialog box shows two columns for screen percentages. The
column on the left represents the first vignette color, the column on the right the second color.
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Position and Size
The length of the gradation is defined by the vertical size of the bounding box of the selection. Color
1 will come at the top of the bounding box, color 2 at the bottom, and a linear vignette will be created
between the two. Outside these two positions the color stays plain color 1 and color 2, respectively
above and below the bounding box.

Procedure
Select the paths you want to color.

Select Vertical Gradation in the Paint Style dialog.

Fill out the percentages for the different separations. The left column defines the top color for the
vignette , the right one the bottom color

Click Apply or press the Enter button.

11.19.4.  Horizontal Gradation

With Horizontal Gradation the Paint Style dialog box shows two columns for screen percentages. The
column on the left represents the first vignette color, the column on the right the second color.

 

 

Position and Size
The width of the horizontal gradation is defined by the horizontal size of the bounding box of the
selected paths. Color 1 will show at the left of the bounding box, color 2 at the right, and a linear
vignette is created between the two positions. Outside these positions the color stays plain color 1 and
color 2, resp. to the left and right of the bounding box.

Procedure
Select the paths you want to color.
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Select Horizontal Gradation in the Paint Style dialog.

Fill out the percentages for the different separations. The left column represents the left color for the
vignette, the right one defines the right color.

Click Apply or press the Enter button.

11.19.5.  Circular Gradation

With Circular Gradation the Paint Style dialog box shows two columns for screen percentages. The left
column represents the first vignette color, the right column the second color.

Position & Size
The diameter of the circular gradation is defined by the corners of the bounding box of the selected
elements. The color gradation completely fills the bounding box. Color 1 is defined at the outside edge
of the circle, color 2 at the inside of the circle, and a linear vignette is created between the two. Outside
the diameter the color stays plain color 1.

Circular Gradations Inside Bounding Box:
defines the diameter of the circular gradation to be the shortest side of the bounding box of the
selected elements. The circular gradation lies completely inside the bounding box rectangle.

 

 

By default, the diameter of the circular gradation is the longest side.

Procedure
Select the paths you want to color.

Select Circular gradation in the Paint Style.

Fill out the percentages for the different separations. The left column defines the circle color on the
outside edge, the right column the center point color.

set Circular Gradations Inside Bounding Box. as needed.

456



11ArtPro

Click Apply or press the Enter button.

11.19.6.  Multistep Gradation

Multistep gradation allows you to create non-linear vignettes numerically with up to 10 colors and
based on a completely free shape.

Position and Size
The position of the vignette is that of the shape which is being followed. The size depends on the
number of colors defined and their numerical positions.

Procedure
Create the shape to be followed. The baseline (= shape) may be one path or one compound and must be
closed.

Select the paths you want to color (not the shape!).

Select Multistep gradation in the pop-up menu in the Paint Style dialog.

Press Set Horizontal, Set Vertical or Set Shape. When pressing Set Shape, the cursor changes into a
cross. With the cross, click on the shape. Visually nothing happens, but ArtPro now knows that’s the
path the vignette needs to follow.

Define the number of colors using the Add and Remove buttons. The minimum is 2 the maximum 10.
When only two colors are defined, the Remove buttons gray out. When the maximum is set, the Add
button grays out.

Define the Positions for the different colors. ArtPro will always order the columns of colors in the
order of their positions. The smallest comes first, the largest last. The position of the shape is 0 mm. A
gradient always starts from the inside (negative values) at right angles to the shape and goes towards
the outside (positive values). ArtPro displays the colors as they appear on this ‘line’ (see drawing on the
right). The positions can be changed by grabbing the triangles under the vignette sample and dragging
them to the left or right. Double-clicking a triangle below the bar opens the Color Book menu and
allows any color to be picked from the indicated book.

If you want you can change the midpoint between every two colors. The midpoint indicates a
percentage of the distance between two colors. The midpoint can be changed from 13% to 87%.
By default it is always set to 50%. Midpoints can also be changed by taking the triangles above the
gradient sample and dragging them to the left or right.

Next, fill out the colors for each separation. Make sure you define the colors after the positions,
because changing the positions, may swap the color order.

Press apply

Note:  You can add a new color at a specific location by shift-clicking in the color
representation bar.
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Set Horizontal, Set Vertical
In fact, even with horizontal or vertical gradients, ArtPro uses a shape. Set Vertical instructs the
program to create an (invisible) rectangle. The width of this rectangle is the same as the width of the
bounding box of the selection (fill object). The height is 1 internal pixel: 1/12.000 inch. This will result in
a multistep vertical vignette with a zero position at the top of the bounding box of the selected objects.
The position values work downwards and should therefore only be positive. The same thing happens
with horizontal gradients, only the other way around.

 Set shape
You can define the fill object as its own shape. This means that the vignette will follow the contours of
the object itself. Still in this case, the position of the shape is 0 mm.

Anything on the inside of that is negative, anything to the outside positive. As the inside of the shape is
all you use, all values have to be smaller than or equal to 0mm.

 

458



11ArtPro

 

Get shape
Once a multistep gradient is created, the shape is copied internally in the file. So the original object can
be deleted, if you wish. However, to modify the shape, you need the object back. Select the gradient,
go to Paint Style and press Get Shape. The internal shape is generated on the original position in the
file, not the current position of the multistep if it has been moved. To be able to edit, the best thing is to
keep the shape transparent and grouped with the object.

11.19.7.  Patterns

Patterns can be defined in ArtPro, or can be imported from a PostScript file. During import, all PS
patterns with the pattern command are converted into ArtPro patterns. Defining a pattern in ArtPro is
done with the Set Cell button.

These steps have to be followed when defining a pattern:

Select the contour in which you want to apply the pattern.

Click Set Cell. The cursor will change to a cross.

Drag a rectangle over the elements to be in the pattern. Keep in mind that only flat colors are
supported, and only objects completely inside the rectangle are used. The pattern objects are copied
internally, so you can move or remove the original objects around afterwards.

Set the Step distances. When using the Set Cell button, the Step distances will automatically be set to
the bounding box of the pattern objects.

The pattern will start at the position of the selected cell and will repeat based on the step sizes. The
step size may be smaller than the cell size, to make nested patterns. When elements of adjacent cells
overlap, the order of drawing is undefined.
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Get Cell
As mentioned above, the pattern objects are kept internally. Even when the original objects are
removed, you can recover these objects using the Get Cell button. Just select the pattern and press
Get Cell.

Adjust Pattern in Rip
Normally, on output, ArtPro will expand all patterns to objects. But with this option on, the pattern will
be put in the PS file using the PS pattern command. The RIP then converts the pattern and adjusts it to
match the output resolution.

If this option is off, the numerical position is exact. This is most useful when using big cells, and if
the pattern should align with other objects. The second possibility will result in a more equal pattern,
especially when using a pattern with small cells.

11.19.8.  Picture

ArtPro objects can also be filled with Pictures. It supports TIFF, EPSF, JPEG, DCS-1, DCS-2 (multi and
single files), Scitex Handshake LW, Scitex CT and Scitex Flyte, TiffIt CT, LW, FP and HC, Photoshop
(PSD) and ArtPro files.
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Page nr.
For a placed PDF file containing multiple pages, the page number, defining what page of the file should
be placed, can be entered in the Paint Style, immediately under the name of the file.

Image types / color space
In general, RGB images should not be used in ArtPro. These images can be previewed on screen and
proofed correctly, but separated output will be wrong. In fact, they can only be used if the RIP can
convert them to CMYK or if the image will be replaced by an OPI system afterwards anyway. In both
cases, the images should not be mapped.

ArtPro doesn’t support Lab or indexed images. PSD, DCS, EPS or TIFF images with spot colors are
completely supported. The missing separations will automatically be added to the job if they are not
already present. CMYK, grayscale and bitmap images are also supported.

EPS and DCS images are previewed and proofed (only DCS) with their pict preview. The preview
resolution for images is defined by the value in Picture Display Resolution (see Preferences... on page
48) at the moment the image is placed. It can only be modified for mapped images.

You can place an ArtPro file as a picture inside another ArtPro file. It will be displayed with its preview
or with a 50% gray surface if no preview is available (see Preview on page 75).

Placed DCS files can only be output correctly if separated PS output is used, composite PS and PDF will
not be correct.

Placed EPS output to PDF will work fine on certain Rips (Rips based internally on PS format, like Nexus
Rip). Most PDF Rips will not accept these PDFs.

Photoshop PSD and Photoshop DCS files are also supported to be placed in ArtPro. Bitmaps, Grayscale,
RGB, CMYK and Multichannel images are supported. Duotones and Indexed color are not supported.
ArtPro only extract the pixel information that is in the PSD file and maps it.

Clipping paths defined in the Photoshop file will be recognized. Photoshop PDF files can only contain
one path that is defined as clipping path. ArtPro ignores other path information. Photoshop images
may contain layers. ArtPro shows all pixel information of the active layers. Activating and deactivating
layers should be done in Photoshop.

Separation
The separation dropdown allows to place a single separation of the placed file. This is meant for
placing a single separation of a placed ArtPro file. In case the ArtPro file is saved with a separated
preview, the preview of this single separation will be correct. In case a single separation of a placed
image (Tiff, Jpeg, ...) is used, the regular preview is shown, colored in the selected separation. On
output, the result will be correct. It is however advised to use Mapped Pictures to place a single
separation of a Tiff or Jpeg, as in that case, the preview will be correct.

To fill an object with a picture
Select the paths you want to color.

Select picture in the Paint Style dialog.
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Click on the Set Picture button. A dialog box appears to define the image you want to place.

Choose the picture to place

Click Apply or press the Enter button.

The image is centered on the bounding box of the selected paths. The size is always 100%, rotation and
shear angles are 0º. The position, rotation, scale and shear can be changed by entering a value in the
Picture Scale field and activating Modify (see Apply and Modify further in this chapter).

The picture type, name, original resolution and a preview are shown at the top of the dialog.

Job Ticket
 

 

An ArtPro file contains XML information, which can be accessed by any 3th party application.

The XML information can also be seen when an ArtPro file is placed in ArtPro, by clicking the Job Tick-
et button.

Besides the size, dot gain curve, separation and screening info, the XML part of the ArtPro file also
contains bar code information (code, type, magnification, bar width reduction), image information
(name and path, type, position, scaling and pixel size) and a list of all fonts used in the file.

Average Ink
This button opens a dialog to enter the average ink use for the picture. This is the value that will be
used for Ink Coverage calculation (see Ink Coverage on page 414). If you enter e.g. 30% cyan, the ink
coverage will be calculated as if the picture was replaced by a 30% cyan flat color. New values are only
accepted after Apply or Modify

11.19.9.  Mapped Picture

Mapped picture is a paint style that allows the handling of images per channel and map them into
the correct separations. Mapped Picture allows you to create a new picture paint, by mapping any
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channel of any TIFF, JPEG, Scitex HS, TiffIt, PSD or Photoshop DCS file (CMYK, gray, black & white,
Multi Channel) into any ArtPro separation. It also makes it possible to change intensity (including
transparency) or minimum value for each mapped TIFF channel.

In ArtPro 9.0, placing Tiff/JPEG images will always map the images. The reason for not working with
placed TIFF/JPEGs anymore is that placed images cannot be flattened, only mapped images can be
flattened.

When opening an ArtPro file containing placed (unmapped) JPEG or TIFF pictures, a dialog will be
opened, allowing to map all JPEG and TIFF pictures.

In case the ArtPro job contains JPEG or TIFF files in a color space that can’t be mapped (RGB or LAB), a
warning will be generated, indicating how many pictures couldn’t be mapped.

 

 

Changing a picture to a mapped picture manually
Select the picture you want to change. You need to make sure to click on it instead of clicking and
dragging. Only by clicking, Paint Style will update and display the correct image information.

Open the Paint Style dialog and go to Mapped Picture.

Hit Apply to place the picture centered at 100% scaling, or Modify to keep its settings

 Filling a path with a new mapped picture
Select the path you want to fill with a mapped picture.

Open the Paint Style dialog and go to Mapped Picture.

Click on the file button (three dots) next to the separation you want the first channel of the image to
appear in.

Select the TIFF or JPEG image you want to open.

Click Apply
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Adding channels to an image
Select the picture you want to change. You need to make sure to click on it instead of clicking and
dragging. Only by clicking, Paint Style will update and display the correct image information.

Open the Paint Style dialog.

Click on the file button (three dots) next to the separation you want the first channel of the new image
to appear in. The new image needs to have the same size and resolution as the one already present.

The other channels of the added image will be put in the next empty separations.

Press Apply or Modify

Swapping channels, changing intensity or minimum
Select the picture you want to change. You need to make sure to click on it instead of clicking and
dragging. Only by clicking, Paint Style will update and display the correct image information.

Open the Paint Style dialog.

In the pop-up next to every separation, you can put any separation of the selected image (+ all other
channels in the file with matching resolution and size). To make a separation empty, select the blank
space on top of the pop-up list. You can use the same channel in different separations. E.g. A jobs is
printed in Pantone 300 CVC, M, Y and K instead of CMYK. Put the cyan separation on blanc and put the
cyan channel in P300.

 

 

Intensity enables you to reduce the values of a separation to e.g. 50%. This is a relative change. See
example on the right.

Minimum enables you to add a minimum value for a separation. E.g. a minimum of 30% will bring all
values lower than 30% up to 30%. This is an absolute change. See example.

You can invert a channel by clicking the Neg. checkbox.

All changes are executed by clicking Apply or Modify.

Transparency and Opacity
• If there is no Opacity Channel, the image will be knocking out the background for the separations

where a Intensity value is entered (0-100%)
• Even if no channel is defined for a particular separation, it will also knock out the background unless

TRANS is entered in the Intensity field, in which case the image is not affecting that separation.
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• If an Opacity channel is used, the Opacity channel defines, in combination with the value in the
Opacity fields, where the image is transparent or opaque. The Opacity channel is an internal
channel, i.e. a channel of an image that has been produced or edited with ArtColor (see ArtColor,
internal CT and CT files on page 37 for more details).

• The image is knocking out the background, with the value of the opacity channel at that place,
multiplied by the Opacity value for that specific separation. If the Opacity channel is 100% at a
specific place, and the Opacity field is set to 100%, the image will be knocking out the background.
If the Opacity channel is 60% at a specific place, and the Opacity field is set to 50%, the image
will be knocking out the background for 30%. It means 30% of the image channels and 70% of the
background will be mixed. In places where the Opacity channel is 0%, the background is not blocked
out at all. The image is completely transparent.

Channels in PSD or Photoshop DCS files
If a CMYK PSD contains extra channels, or if the PSD file is a Multichannel file, ArtPro will try to
recognize the channels. For RGB PSD files, extra channels will be ignored. A PSD file can contain
channels indicating masked areas (type1), channels indicating selected areas (type2) and channels
indicating spot colors (type3) Channels of type 1 and 2 are treated as alpha channels, thus put into an
opacity mask. If the PSD file contains more than one alpha channel, only the first is used, and all others
are ignored, though the separation are generated based on the channel names present in the Tiff. If a
PSD contains no extra channels, or if the PSD contains at least one spot color, the file will be placed as
a mapped picture. If the PSD contains an alpha channel, the file will be placed as a mapped picture with
an opacity mask.

If spot color channels are found, a separation will be created with the same name as the PSD file
channel. The color definition (CMYK representation) for this spot color will first be searched in the
ink book. If the spot color is not found in the ink book, or if no ink book is loaded, ArtPro will extract
the color information from the PSD file. Since this color definition is normally given in RGB or HSB,
conversion to cmyk will usually yield a deviation from what is expected. Therefor, a warning is
generated. If ArtPro encounters an unknown color space, a new separation will be created with the
channel name, and with cmyk representation 0, 0, 0, 100. PSD files with a transparent background are
converted to ArtColor. Be aware of the hard edge that may appear.

Remarks
• It is always recommended to work with mapped images where you can in ArtPro, because they have

many advantages over unmapped pictures. A mapped image can be altered (mapping, intensity,
minimum,...) easier; automatic trapping only works on mapped images; They can correctly be
preview per separation, the preview resolution can be altered and the full resolution can be shown;
they can be cropped at output, so they print faster, the ink coverage is calculated accurately in-
stead of using an average ink value; etc....

• You can specify the preview resolution for mapped images. The value is set to 100 ppi by default.
See Preferences... on page 48. Keep in mind that increasing the resolution also increases the
internal memory needed to store pictures in ArtPro. A mapped picture which has already been
defined only adapts its screen resolution when a new preview has to be calculated (e.g. by repaint
command: Cmd-,).

• Loading the image data from disk to the internal memory is not done when applying the paint, but
occurs the first time the mapped TIFF is previewed. The first preview of a mapped TIFF is slow,
while later previews are much quicker, as the data stays in memory until the job is closed.

• The Clear button makes the Mapped Picture empty.
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• When converting a Scitex PG or a TiffIt FP file (both files combine a CT and LW file) into a mapped
picture, the result will come at the highest resolution, i.e. at the resolution of the lineart file. This
means all CT information is upsampled to a LW resolution, what could slow down your computer.
Mapping a Scitex LW, Scitex PG, TiffIt LW, TiffIt FP or TiffIt HC should be avoided when possible

• When opening a file containing mapped PSD or Photoshop DCS file, the image information will be
lost when opening the file in ArtPro 8.4 or lower for Photoshop DCS files, or in ArtPro 8.2 or lower for
PSD files.

Why use a mapped image; some examples
• Giving any color to a gray TIFF image by remapping it into one or more ArtPro Pantone separations.
• Creating a lighter picture by remapping the 4 channels of a CMYK TIFF into the CMYK ArtPro

separations, reducing the channel intensities to 50%.
• Remapping the cyan channel of a chocolate bar picture into a Pantone® brown separation.

11.19.10.  Paint Style options

Color book...
The Color book... button opens the color book dialog. In the Color Book dialog, all pantone colors are
shown. When choosing one, ArtPro puts the CMYK equivalent of this color in the CMYK separations of
the percentage column. The remaining percentages are set to zero.

Clicking a color will apply it immediately to the selected paths. If no path is selected the color
composition shows only in the Paint Style menu.

For gradations there is a color book button for each column.

If no Color Book is loaded, the dialog is gray. One can be selected by pressing the Load Color Book
button. Color books are spread sheet files that can be edited in any spread sheet application. These
files contain information on how many colors and how many rows are used in the file, definitions of the
used separations, and for each color the color name and the separated values.

A number of basic Color Books (.col) can be found in the “Color Guides” folder next to the ArtPro
Application.

The Find field and button allows you to search a color by name, part of the name or number, i.o.
searching manually. E.g. type in 300 and press enter, Pantone 300 is automatically selected and
applied in the selected objects.

If a color is selected that uses a separation not defined in the job, the separation will be added to the
separation list. If Add All Separations is clicked, all separations needed for and defined in the color
book will be added. In most cases (e.g. when using the default colorbook) CMYK separations will be
added if not present yet. When a hexachrome color book is used, the separations defined in the color
book will be added.

 Color Palette
The Color Palette shows all the colors that have been used in the file so far and allows you to fill other
objects with the same colors. It can be used for flat colors and vignettes. Press the Color Palette
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button under the correct column and click on a color in the dialog. The color is immediately applied to
the selected object. The Color Palette always starts with 3 predefined color squares: all zero, all 100 %
(= registration color), all transparent.

Once you have applied a color to a path, that color is automatically added to the Color Palette. After
working on a document for a while, the color palette will probably contain colors which you do not use
anymore. If you close your job and open it again, the palette is updated and only the colors which are
actually in use will appear.

 

 

All Zero
The All Zero button sets all separations 0 %.

All 100%
All 100% sets all separations to 100 % (e.g. to color registration marks).

All Transparent
All Transparent sets all separations to transparent. Transparency can also be defined by typing t or
trans. See also how to make a path transparent, further in this chapter.

Make Overprinting / Knockout
For Flat Paints and for Gradations, it is possible to hold down the Shift key when clicking the “All Trans”
button. This will change the values that are 0% to “trans”, and vice versa. This allows to change a color
very easy from knockout to overprint and vice versa.

Apply / Modify
Apply fills the selected paths with the current paint, active in the Paint Style dialog at that moment.
Apply uses default parameters for position, angle, rotation and shear. For gradients this means they
are built from the top to the bottom (vertical), left to right (horizontal) or corner to middle (circular) of
the bounding box of the selection. Pictures are centered on the bounding box of the selection with
scaling 100%, rotation and shear 0º.

Modify applies the current paint to the selected paths without using default position, etc.... To position
the paint, Modify uses the information from the last selected path, i.e. the one active in the Paint Style
dialog, and not the bounding box of the selected paths. For pictures, Modify will use the position and
scaling information from the last time you selected the image by clicking. All transform functions will
not change these values until you reselect the image.

Modify is very useful to:
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• copy a paint from one path to another: Select the path you want to copy the color into, Shift-select
the colored path, click Modify.

• replace a picture by another one: Select the clipping path, change the picture by clicking Set
Picture, click Modify.

• change colors of a gradation after transforming it: Select the vignette path, change the colors in
the Paint Style, click Modify.

11.19.11.  Transparency in %

Each path in ArtPro can be defined as one of the three color definitions: flat color, vignette or picture.
When assigning a flat color, a gradation or a mapped picture to a path, you are also able to define
if the underlying levels should be knocked out or should show through (=transparency). Filling in
transparency in an object for e.g. cyan, means that the object will not affect any of the cyan objects
underneath.

 

 

Transparency can only be defined towards other underlying separations. Defining 0% - 100% will
mask out the underlying objects and replace them with that value; defining T or trans will use trans-
parency for that object on that separation. ArtPro is able to show transparencies on the screen, where
they are used for flat colors and gradations. E.g. a path with a flat color consisting of C=80%, M=50%.
Transparency can be defined towards the other underlying separations. So for the yellow and the black
we can choose if they should be transparent or masking. If you define Y=0%, the yellow underneath will
be knocked out. If you define Y=trans, the yellow underneath will shine through the path.

11.19.12.  Shortcuts in the paint style dialog

When entering values in the paint style dialog, some shortcuts can be used :
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All Transparent
A path can be made completely transparent with Cmd-Alt-T. This changes the paint style of selected
paths to flat color, completely transparent.

It will also reset the blend mode to “Normal”, clear any opacity mask, and set Opacity to 100%.

Note that this is not the same as the “All Transparent” button in the Paint Style. This button only
changes the values in the Paint Style (without applying the change), while the shortcut Cmd-Alt-T is
applied immediately, and also resets the blend mode, opacity and opacity mask.

All others Transparent
Shift-clicking the All Transparent button will only change the entries at 0% to transparent. This allows
to make the paint overprinting to other separations.

Transparent
Trans can be entered to make an object transparent to a specific separation (see above). This can also
be done by entering “t”. ArtPro will change the “t” into “trans”

100 %
Entering 100% in an input field in the paint style, can also be done by entering “x”. ArtPro will change
the “x” into “100”

All separations value
It is also possible to set a value for all separations. By entering “a” in front of a value (e.g. a15), the value
will be entered for every separation.

11.20.  Screens

The top of the dialog shows 5 buttons: Separations, Links, Fonts, Screens and Bar codes. Pressing a
button will switch to the corresponding list.

• Separations... on page 470

• Links on page 438

• Fonts... on page 433

• Screens
• Bar codes on page 430

At the bottom, next to the other buttons, there is an action button menu containing additional

functions depending on the selection. You can access the menu by clicking the action button.

Screens shows all the screens defined in the file, and allows you to show the objects in the file using
this screening.
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Double-clicking a screen name in the list will open the screen dialog (showing the settings for the
selected screen, select all objects using this screen and zoom in on these selected objects.

Using the action button menu, you can delete a screen, delete unused screens, and load / save all
screens.

11.20.1.  Screens In Use

Next to every screen name, an indicator is shown, indicating if the screening is in use or not.

 indicates a screen is in use. If the space is left blank, the screen is not being used in the job.

11.20.2.  Generate Report

You can generate a PDF or TXT report of the resources, containing the following information:

• Separations: Name, Type, Used
• Images: Name, Resolution, Size, Type, File Size
• Fonts: Name
• Screens: Name, Used
• Bar codes: Code, Type, Magnification, Reduction.

By selecting “Screens Only”, you can output a report only containing the screening information.

11.21.  Select by Attributes

This will open the Select by Attributes dialog. See Select by Attributes... on page 247

11.22.  Separations...

 

 

The top of the dialog shows 5 buttons: Separations, Links, Fonts, Screens and Bar codes. Pressing a
button will switch to the corresponding list.

• Separations
• Links on page 438

• Fonts... on page 433

• Screens on page 469

• Bar codes on page 430
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At the bottom, next to the other buttons, there is an action button menu containing additional

functions depending on the selection. You can access the menu by clicking the action button.

In the Separations window the printing inks are defined. Every color defined here will result in the
output of an extra plate or film. ArtPro can use up to 64 different separations per job. Use the scroll
bar at the right to move through the list. The separations dialog can be activated through the Window
menu, its toolbar icon or with the shortcut.

Shortcut: Cmd-Shift-I, Separations

11.22.1.  Add separations from InkBook / Add separation

When documents are imported, vectorized or placed in ArtPro, all the necessary colors are auto-
matically defined. New separations can be added by clicking the Add Separation from Inkbook or Add

Separation button , or by selecting it from the action button.

For more info on the ink book, see Ink Books on page 478

11.22.2.  Separation color

You can change the color of a separation by double-clicking the color square, or by selecting the
separation and choosing “Change Color” from the action button. The Color on Proofer dialog contains
the CMYK and Lab representation of all inks. When making composite PS for proofing devices, ArtPro
converts all pantone inks to CMYK, based on these values.

 

 

• The four process colors (CMYK) are automatically defined as 100% of the process ink. (e.g. Cyan is
represented by 100% C)

• The inks from an ink book take the information included in that book.
• House inks are by default represented with 100% black, so you should change the Color on Proofer

values.

With the To Display button, you force Color on Display (see below) to adjust to the new Color on Proofer
Values.
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Color on Display
The Choose Color button opens the Macintosh Color Wheel dialog to define the representation of each
ink on the screen. The C, M, Y, K colors are defined automatically. The inks from an ink book take the
values determined in that book. The house inks should be defined by yourself as they are shown by
a representation of the values in the Color on Proofer dialog, which by default is Black. The Color on
Display dialog may come in handy to represent for instance a varnish as light yellow on the screen, or
an opaque white as light blue.

Note that Color on Display is disabled if Color Management is on, since Color Management will make the
transition between the CMYK on proofer, and the RGB values for screen representation.

11.22.3.  Name

In the Separation Name field you can change the name of the separation by double-clicking it. Entering
C, M, Y or K will automatically enter Cyan, Magenta, Yellow or Black. The type of the ink will auto-
matically be set to the corresponding ink.

If a separation with the same name already exists, you will get a warning.

11.22.4.  Link

You can link a separation to a parameter by selecting a separation and clicking the link button that
appears next to the name. For more information, see Parameters... (ArtLink) on page 171.

11.22.5.  Type

Using the dropdown menu, you can define the type of the selected ink.

Opaque
Using Opaque you can define whether an ink is transparent or opaque (like gold, white, silver,...). By
default, all new inks are transparent. Real opaque inks, will therefore not display correctly where
transparency is used. Transparency shows where in reality the ink would cover the underlying colors.
To see an ink opaque on screen and on proof, select Opaque as ink type.

Varnish
You can also define if an ink is a (transparent) Varnish. The "Varnish" setting has no influence on the
visualization of the job.

The setting is also used in the Automatic trapping, where Varnishes are ignored completely.
The setting can also be used when jobs are processed through Nexus. We refer to the Nexus
documentation for detailed information.
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Technical Inks
You can also define if an ink is a Technical ink (Die).

Setting an ink to Technical has some effects:

• A Technical ink is always shown opaque
• Technical inks can not be used for White Underprint or Rich Black
• If an object using a Technical ink is not set in overprint, or uses a non-separable blend mode on

an object containing Technical ink, a warning will be given in the Message Center when opening or
saving the ArtPro file, or when importing or exporting PDF.

• If a process color is set as "technical", this will be reset when exporting a PDF.
• The ink percentages for Technical inks are shown in the Ink Coverage palette, but are not taken into

account for the total area coverage, and are not included in the Ink Coverage report.
• In the Viewer, technical inks have no influence on the Total Area Coverage limit, Breakout or Moire

Detection.
• In trapping, Technical inks are ignored completely.

More info can be found in the White Paper on Technical Inks, available from http://help.esko.com.

CMYK type
CMYK type indicate which separations should be handled as CMYK, even if they were replaced by
spot colors. These settings are very important when working with placed, unmapped pictures, when
importing PS files or when outputting PS files to other applications, e.g. XPress.

When placing an unmapped picture the CMYK channels will output on the separations that carry the
respective CMYK type. On PS import, all elements defined in CMYK will be imported in the separations
that have the CMYK type. When printing to an eps, then placing this file in an other application, e.g.
Quark, it will treat the separation with the cyan type as cyan, even if it was turned into for example
Pantone 632 in ArtPro.

For separated output the separations indicated as C-M-Y-K are known in the PostScript file as cyan-
magenta-yellow-black for plate color and document color. It is therefore not advisable to have the
following situation e.g.

1 Pantone 512 CVC Cyan

2 Magenta Magenta

3 Yellow Yellow

4 Black Black

5 Cyan

as some RIPs will output both separations 1 and 5 on one film. Thus, do not use the names cyan-
magenta-yellow-black unless they are marked with C-M-Y-K, or rename them e.g. 5 Cyan2. For some
RIP’s it is best to switch CMYK Flags off.
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CMYK type can be switched off one by one, by selecting a separation and setting the type to “Standard”

11.22.6.  Separations In Use

Next to every separation, an indicator is shown, indicating if the separation is in use or not.

 indicates a separation is in use. If the space is left blank, the separation is not being used in the
job.

Registration Color (using the Registration Color option, see Registration on page 453) does not
influence the indicator.

 is used for separations that are not used, i.e. there is not a single object with a value for that
separation other than zero or transparent, but the separation has been used for the definition of
an Opacity Mask. The objects used to define an opacity mask are not visible in the job, but still the
separation in which they are defined (in most cases this will be the black separation) is still needed in
the job. Therefor, this is indicated.

The Used Separations info will be used for the following functions:

• Automatic Regmark Generation using ArtLink, will only include the Used separations. Separations
that are not in use, or only for Opacity Mask generation, will not be included.

• When exporting the file to PDF, only the separations In Use will be included.
• When placing an ArtPro file, only the separations In Use will be added to the open ArtPro file, if

necessary.

11.22.7.  Order

The printing order for the inks is defined by their order in the Separations list. The print order can be
changed by selecting the separation and dragging it up or down to the position you want. The print
order is important for previews on screen and for proofs, but also for automatic trapping. A gold square
on top of a dark blue background will choke if the opaque flag is on, but it will spread if it is off.

You can use the “Show Indeces” option from the action button to put a separation at a specific index,
possibly creating ‘holes’ in the list.

11.22.8.  Remove Separation

By clicking the Remove Separation button  or by selecting “Remove [separation name]” from the
action button, you can remove the selected ink from the Separations list. If the selected separation
is used anywhere in the job or if ArtPro cannot be sure if it is used or not, a warning will appear on
screen asking if you are sure you want to delete it. ArtPro cannot tell which separations are used in
a document if there are placed, unmapped images. If you are sure about which colors are used, you
can force ArtPro to delete the unused separation with this function. This function ignores registration
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color (all 100%), meaning that, if an ink is only used in the registration marks and cropmarks , it is not
considered in use in the file.

11.22.9.  Remove Unused Separations

By selecting “Remove Unused Separations” from the action button, you can remove all the inks that
are not used in the job from the Separations list. It cannot delete any inks in a repetition or in a job
containing unmapped pictures (unless you hide all the pictures). The Remove Unused Separations does
not take into account any object in registration color (see Registration on page 453).

11.22.10.  Make Selected Objects ...

In the action button, you have two functions to change objects. They allow to make the paint value for
the selected objects either zero or trans for the selected separation. This allows e.g. to take out the
cyan for the selected objects.

11.22.11.  Remap Separations

It is possible to remap a separation to another separation, by clicking the Remap button , or
selecting Remap [separation] from the Action Button.

 

 

By selecting CMYK, the selected separation will be converted to CMYK. By selecting Existing
Separation, you can remap the separation to another separation in the job. By selecting Separation
from ink book, you can remap the current separation to an ink you select in the Ink Book. See Ink Books
on page 478

Keep in mind that this will imply some limitations. Limitations and conflicts concerning overprints,
can be avoided by flattening overprints first. Placed PDF, EPS and Tiff files will not be converted. Re-
mapping image separations will only work for mapped Images.
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If an object already contains a value for the destination separation, a warning will be generated, and the
object will get the highest of both values.

For mapped images, the merging will be done if possible, i.e. if only one of both (destination or original
separation) contain an image channel. Minimum values will be merged, keeping the highest value. If for
some reason the conversion can not be done (e.g. the image has a channel in Pantone and in Cyan), an
error message will be generated

11.22.12.  Color Engine Ink Book

If Color Engine Ink Books are used (by selecting Load Color Engine Ink Books in the Color tab of the
preferences, see Color on page 64), an extra column is added in the separation dialog, showing from
which Ink Book a custom color is coming.

PantoneLIVE
ArtPro can use both Color Engine Ink Books or PantoneLIVE ink books, if present.

In the separation dialog, an icon will show if an ink is from a

Color Engine Ink Book  or a PantoneLIVE ink book .

The same icon is also shown e.g. when selecting an ink in the Remap Ink dialog.

 

 

Note:  PantoneLIVE ink books will only be available if a PantoneLIVE license is available in Color
Engine. See Show Licenses on page 49

11.22.13.  Printing Method

You can set the “Printing Method” for every separation. This information will be stored in the ArtPro file,
and will also be included when generating Normalized PDF. The information can also be imported when
importing a Normalized PDF.
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By default, the Printing Method column is hidden. By selecting “Show Printing Method” in the fly-out
menu you can make it visible.

You can select one of the predefined printing methods, or create a new printing method.

 

 

If you select “Save to presets”, the newly created printing method will be saved in a preset file, and will
remain available in the list.

The presets are saved in [user] > library > preferences > ArtPro > UserPrintingMethod

11.22.14.  Reload Color Engine Ink Books

When selecting Reload Color Engine Ink Books from the fly-out menu in the Separations dialog, ArtPro
will reload separation info from Color Engine Ink Books, without having to restart ArtPro.

This option is only available if Load Color Engine Ink Books is enabled in the Preferences. See
Preferences... on page 48 Load Color Engine Ink Books on page 64

11.22.15.  Generate Report

You can generate a PDF or TXT report of the resources, containing the following information:

• Separations: Name, Type, Used
• Images: Name, Resolution, Size, Type, File Size
• Fonts: Name
• Screens: Name, Used
• Bar codes: Code, Type, Magnification, Reduction.

By selecting “Separations Only”, you can output a report only containing the Separations information.
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11.23.  Ink Books

You can use an Ink Book when creating a new separation from inkbook, or if you remap an existing
separation to a separation from Ink Book. You can either use local Ink Books (as in ArtPro 9.6 and ear-
lier), or you can use Color Engine Ink Books, either from your Automation Engine / BackStage server, or
by browsing to their location.

11.23.1.  Using a local Ink Book

The Ink Book is an ASCII file, which you will find in the ArtPro application folder. A personalized ink book
can also easily be created with a spreadsheet. The standard ink books, provided by Esko, are Pantone
licensed and can be found in the ArtPro application folder.

 

 

The ink book is built up in a similar way to a color book. It starts with a standard header. In the header,
the number of pantone colors defined in the ink book is defined under # Colors. The height indicates
the number of rows this list will be displayed in when selecting this ink book in ArtPro. In the color list,
the first column contains the ink name, next the default screen angle, the next column contains either
a 0 or a 1, defining if the ink should be transparent or opaque by default. The last columns are the CMYK
(Color on Proofer) and RGB (Color on display) representations of this ink.

You could for example add a few text lines in your ink book for gold:
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Gold 45 1 38 59 73 7 145 97 61

Ink filter
To search for an ink in the ink book, you can click and drag in the window, or you can simply type in the
pantone number in the top left field and press the find button. The selected color is always immediately
applied to the active separation.

Update Separation from Ink Book
Selecting Update Separations from Ink Book in the action button will overwrite the ink data in
the separations dialog with the ink data defined in the current Ink Book, on the condition that the
separation names match exactly.

Note:  PANTONE® Computer Video simulations displayed may not match PANTONE-identified
solid color standards. Use current PANTONE Color Reference Manuals for accurate color.

Match Current CMYK Paint
In the Ink Book window, you can select “Match Current CMYK Paint” from the action button. By doing so,
the color in the ink book that most closely matches the current paint will be searched and selected. In
order to work, the current paint must be a flat color consisting of CMYK only.

This can be used to easily create a spot color separation based on a CMYK color already used in the job.

Match [Separation]
In the Ink Book window, you can select “Match [Separation]” from the action button. By doing so, the
color in the ink book that most closely matches the selected separation will be searched and selected.

11.23.2.  Color Engine Ink Books

 Setting up Color Engine Ink Books
In the Preferences, you can set ArtPro to use the Esko Color Engine Ink Books, either from the
Automation Engine Server, or by browsing to their location.

To use Color Engine Ink Books from the Automation Engine:

In the Servers tab of the Preferences, make the correct connection to the Automation Engine

In the General tab of the Preferences, enable “Load Color Engine Ink Books”, and leave “Load Color
Engine Ink Books from” at “Automation Engine”

Select the Preferred Color Engine Ink Book

To browse to the location of the Color Engine Ink Books:

In the General tab of the Preferences, enable “Load Color Engine Ink Books”
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,In “Load Color Engine Ink Books from”, select “Browse”

Locate the Esko CMS folder containing the Color Engine Ink Books, and select the folder containing the
“r” and “w” folders.

Select the Preferred Color Engine Ink Book.

Note:  If no Color Engine Ink Books are available, or if no connection to an Automation Engine
Server is available, ArtPro will switch back to using the local Ink Books.

Using Color Engine Ink Books
When using Color Engine Ink Books, the Add Separation from Ink Book and Remap Separation dialog
will look different, representing the colors from the Color Engine Ink Books

11.24.  Transparency

The Transparency dialog can only be accessed by clicking the ... button in the Object Parameters
dialog, next to Transparency.

 

 

ArtPro 9.0 fully support transparencies. This means when importing a pdf file containing
transparencies, these will remain after import.

When exporting to a file that doesn’t support Blend modes (such as ArtPro 7.5, Postscript, PDF 1.3), the
Flattener will be used (see Flatten Transparencies on page 411 for more info on the flattener).

The Transparencies dialog defines the Blend mode, Opacity and Opacity Mask to be used on the
selected objects. The same settings can be applied to Groups in the Group Paint tab (see Group
Parameters on page 448).

The shortcut Cmd-Alt-T sets the transparency to default (Blend mode Normal, Opacity 100% and no
Opacity Mask), and the Paint Style to flat paint, all transparent (see All Transparent on page 469)

11.24.1.  Blend Modes

A Blend Mode makes a combination between the blend object (object on which the blend mode is
applied) and a base object (underneath the blend object), resulting in a blend color. The final result
will depend on the base object, the blend color and the opacity (see below) All Blend modes and their
formulas (when available) are shown below, with an example.
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Normal
 

 

Normal means the blend color will simply replace the base color. At 100% Opacity, this gives the same
result as it would without any transparency. At other percentages, this will result in a mix of the base
and the blend object

Blend color = Blend object color

Multiply
 

 

Looks at the color information in each channel and “multiplies” the base color by the blend color. The
result color is always a darker color. Multiplying any color with black produces black. Multiplying any
color with white leaves the color unchanged.

Blend color = blend + base - (blend * base)

Screen
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Looks at each channel’s color information and multiplies the inverse of the blend and base colors. The
result color is always a lighter color. Screening with black leaves the color unchanged. Screening with
white produces white. The effect is similar to projecting multiple photographic slides on top of each
other.

Blend color = Blend * Base

Overlay
 

 

Multiplies or screens the colors, depending on the base color. Patterns or colors overlay the existing
pixels while preserving the highlights and shadows of the base color. The base color is not replaced but
is mixed with the blend color to reflect the lightness or darkness of the original color.

If (Base < 0,5) => Blend color = 2 * Blend * Base

Else => Blend color = 2 * (Blend + Base - Blend * Base) - 1

Soft Light
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Darkens or lightens the colors, depending on the blend color. The effect is similar to shining a diffused
spotlight on the image.

If the blend color (light source) is lighter than 50% gray, the image is lightened, as if it were dodged. If
the blend color is darker than 50% gray, the image is darkened, as if it were burned in. Painting with
pure black or white produces a distinctly darker or lighter area but does not result in pure black or
white.

Hard Light
 

 

Multiplies or screens the colors, depending on the blend color. The effect is similar to shining a harsh
spotlight on the image.

If the blend color (light source) is lighter than 50% gray, the image is lightened, as if it were screened.
This is useful for adding highlights to an image. If the blend color is darker than 50% gray, the image
is darkened, as if it were multiplied. This is useful for adding shadows to an image. Painting with pure
black or white results in pure black or white.

If Blend < 0,5 => Blend Color = 2 * Blend * Base

Else => Blend Color = 2 * (Blend + Base - Blend * Base) - 1

Color Dodge
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Looks at the color information in each channel and brightens the base color to reflect the blend color.
Blending with black produces no change.

If (1 - Base) < Blend => Blend Color = 1 - (1 - Base) / Blend

Else If Base = 1 => Blend Color = 1, Else => Blend Color = 0

Color Burn
 

 

Looks at the color information in each channel and darkens the base color to reflect the blend color.
Blending with white produces no change.

If Base < (1 - Blend) =>

Blend Color = Base / (1 - Blend)

Else If Base = 0 => Blend Color = 0, Blend Color = 1

Darken
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Looks at the color information in each channel and selects the base or blend color (whichever is darker)
as the result color. Pixels lighter than the blend color are replaced, and pixels darker than the blend
color do not change. This Blend mode is often used for traps.

If Base > Blend => Blend Color = Base

If Blend > Base => Blend Color = Blend

Lighten
 

 

Looks at the color information in each channel and selects the base or blend color (whichever is lighter)
as the result color. Pixels darker than the blend color are replaced, and pixels lighter than the blend
color do not change.

If Base < Blend => Blend Color = Base

If Blend < Base => Blend Color = Blend

Difference
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Blend object color and Base object color are subtracted from one another and the absolute value is
taken. ArtPro uses this blend to calculate the difference between two jobs. This blend mode has no
effect on spot colors. Blend Color = 1 - |Blend - Base|

Exclusion
 

 

Creates an effect similar to but lower in contrast than the Difference mode. Blending with white inverts
the base color values. Blending with black produces no change. This blend mode has no effect on spot
colors

Blend Color = 1 - Blend - Base + (2 * Blend * Base)

Hue
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This is a non-separable Blend, based on HSL values (see below). Creates a result color with the lumi-
nance and saturation of the base color and the hue of the blend color.

Saturation
 

 

This is a non-separable Blend, based on HSL values (see below).Creates a result color with the
luminance and hue of the base color and the saturation of the blend color. Painting with this mode in an
area with no (0) saturation (gray) causes no change.

Color
 

 

This is a non-separable Blend, based on HSL values (see below). Creates a result color with the lumi-
nance of the base color and the hue and saturation of the blend color. This preserves the gray levels in
the image and is useful for coloring monochrome images and for tinting color images.

Luminosity
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This is a non-separable Blend, based on HSL values (see below).Creates a result color with the hue and
saturation of the base color and the luminance of the blend color. This mode creates an inverse effect
from that of the Color mode.

Non-Separable Blends
There are currently 4 non-separable blend modes in PDF and ArtPro: Hue, Saturation, color and
luminosity. These blend modes operate on a 3 component color space. This means that to calculate the
resulting color of such a blend mode, we have to convert CMYK color into 3 components, calculate the
resulting blended color, and go back from 3 to 4 (CMYK) components.

However, no instructions are given on how these conversions from/to different colorspaces should
happen. This results in different behaviors and different color results in different applications/RIPs.
Non-separable Blends doesn’t mean these blends can not be separated ! It only means the blend is not
calculated based on CMYK information.

If a non-separable blend mode is encountered in the PDF file during import, or in the AP file during
PDF1.4 export, a warning will be displayed : “PDF (or AP File) containing Nonseparable Blendmodes may
be displayed differently from other Applications.”

When flattening non-separable blends, the result of the flattening will match the color on the ArtPro
Screen

11.24.2.  Opacity

The Opacity defines how much of the Blend result will be used. If the Opacity is 100%, the result will be
100% of the Blend result (as described above). If the Opacity is e.g. 60%, the final result will be 60% of
the Blend result (not the color of the object to be blended, but the resulting Blend color) and 40% of the
original Base color.

An object with “Normal” blend mode and 50% opacity will mix 50% of its color with 50% of its
background.

11.24.3.  Isolate Blending / Opacity & Mask Define ...

The Isolate Blending and Opacity & Mask Define Knockout Shape are two options that can be used
on groups. However, when placing an ArtPro file, these options can be useful as well, treating the
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complete ArtPro file as a group. For an explanation on the function of these options, see Group
Parameters on page 448

11.24.4.  Opacity Mask

Opacity Masks allow to make objects partially transparent, based on the grayscale value of the mask.
The object used for the Opacity Mask is shown as a thumbnail next to the Opacity Mask section, in-
dicating an Opacity Mask is defined, and what object is used.

Make Opacity Mask function
To define a mask, select two or more objects, compounds or groups. The topmost object will be used
as Opacity Mask for all other selected objects.

If the other object is a group, the Opacity Mask will be applied in the Group Paint tab, otherwise it will be
in the Object Transparency.

Select Object > Opacity Mask > Make to create an Opacity Mask. The object used to define the mask
will no longer be available as an object, but will (internally) be kept. A representation of the used shape
will be shown next to the Opacity Mask section in the Transparency dialog. The underlying objects will
be transparent, based on the luminosity of the mask.

If an object to which an opacity mask is applied, already contained an opacity mask, this will be
replaced by the new one. In order to apply two Opacity Mask to one object, either group the Mask object
before applying the Make Opacity function, or apply the first, group the object and apply the second. In
that case the first Opacity Mask will be applied to the object, the second will be applied to the group.

 

 

Show
Show will recreate the Opacity Mask object, making the object available for editing again.

Clear
Clear will remove the Opacity Mask from the current transparency paint.

Clip
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If the Clip option is switched on, the masked objects will become completely transparent outside the
boundaries of the Masking object. In the example on the right, the red polygon will be visually clipped by
the contours of the ellipse.

Invert
The Invert option reverses the luminosity values of the masking object, and so also reverses the
opacity of the masked objects. Below you see the result without “Invert” (left) and with the invert option
clicked on (right)

 

 

11.25.  Select by Attributes

This opens the Select by Attributes dialog. See Select by Attributes... on page 247

11.26.  Shapes

This allows to open the dialog for Box, Ellipse, Polygon, Spiral or Arrow. See Object Menu on page 189 for
more information
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11.27.  Shuttle

The Shuttle in ArtPro allows to monitor and launch workflows on Automation Engine. Automation
Engine is an Esko workflow system. More information can be found at http://www.esko.com. For a full
explanation on Shuttle and how to establish the connection, we refer to the Shuttle documentation.

11.28.  Stroke...

Stroke can be used to put a line around open or closed paths. In ArtPro, a stroke is a separate element,
that can be selected, transformed and colored separate from the original element (the parent). ArtPro
keeps object information of strokes, also for strokes that were imported from other applications. This
means that a stroke can be selected and the Stroke dialog will show the stroke width. When a stroke
and its parent are selected at the same time and the parent is modified (edit path, retrace path,...), the
stroke automatically adjusts as well.

Shortcut: Cmd-Shift-T, Strokes

11.28.1.  Making a Stroke

1. Select the paths you want to Stroke.
2. Define the Stroke Width for a symmetrical stroke, or enter values for Left/Outside, Right/Inside for

an asymmetrical stroke.
3. Set the Corner type for the Stroke: mitered, rounded, bevel or square. With a mitered corner, the

miter limit should be set.
4. Set the Caps type for the Stroke: butt, rounded or square
5. For a plain stroke, click the Stroke button. For a dashed stroke, give in Dash and Gap values, and the

Dash Offset, and then click on the Dashed Stroke button.

11.28.2.  Width: / Left/Outside: / Right/Inside:

The Width defines the line width for the Stroke. Filling in the Width will result in a symmetrical Stroke. If
you do not want to make a symmetrical Stroke, you can give in:

• the Outside and Inside value for a Stroke on closed elements.
• the Left and Right value for a Stroke on open elements.
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For open paths, left and right is defined by drawing an imaginary straight line between the end points:
the right side of this line is considered as the right side of the path. Or, if you go from the bottom point
to the top point, then Right is at the right side.

11.28.3.  Corners

 

 

Mitered
A Mitered corner closes in one point. When the angle of the original corner is very sharp, this might
result in a very sharp peak. Therefore a Miter Limit (see further in this chapter) can be used to cut off
the corner at a distance equal to the miter limit factor multiplied by the outside/inside stroke width.

Rounded
A Rounded Corner joins the corners with a circular arc with the diameter equal to the line width.

Bevel
A Beveled Corner is comparable to a rounded corner, while it joins the corner segments with a straight
line instead of an arc.

Square
A Square Corner is comparable to a mitered corner. The limitation of the square corner, however, is not
controlled by the Miter Limit. The Square Corner has a maximum distance on a corner of a 90° angle =
Ð2 x distance, resulting in a square corner. The minimum appears on a 0° and 180° angle = 1 x distance.
All angles between those values vary between 1x and 1.4.x the distance. Angles < 90° are cut, angles >
90° are not cut.
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PS Mitered
This is the same as Mitered, but if the miter limit is exceeded, bevel is used at that corner.

11.28.4.  Caps

Butt
With butt caps, the stroke is squared off at the end point of the path.

Rounded
With round caps, a semicircular arc with diameter equal to the line width is drawn around the end
points of the line, thus prolonging it.

Square
With square caps, the stroke continues beyond the end point of the path and is squared off at a
distance equal to half the line width.

11.28.5.  Miter Limit

A mitered corner closes in one point. In order to avoid that the resulting corner becomes too sharp, it
can be cut off.

The distance where the corner is cut off, is controlled by a factor called the Miter Limit.

If e.g. the Miter Limit is 2, the distance where the corner is cut will be twice the Left/Outside and the
Right/Inside value of the Stroke, resp. to the left or outside and the right or inside of the path.

The Miter Limit value should be greater than or equal to 0.

11.28.6.  Dashed Stroke

When making a stroke with Dashed Stroke on, ArtPro creates a dashed line on the selected paths. The
dashed line characteristics are controlled by the Width of the stroke, the Dash Offset and the different
Dash and Gap values.

11.28.7.  Dash Offset

The Dash Offset moves the starting point of the dashed line. Positive values move the Dash starting
point against the direction of the path. Negative values move the Dash starting point in the direction
of the path. The direction of the path depends on how the path was created. In most cases a negative
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Dash Offset will move the Dash starting point to the left, and a positive Dash Offset will move the Dash
starting point to the right. The default starting point of an open path is the leftmost point of the path.

 

 

The default starting point of a closed path is random. To specify the starting point of a closed path:

1. cut the path open with the Cut Path function (Edit menu)

2. close the path with the Join Paths function (Edit menu).

11.28.8.  Dash 1 / Gap 1 / Dash 2 / ...

The Dash and Gap input fields allow to specify the dash and gap lengths of the Dashed Stroke (see
figure).

 

 

If some values are not filled in, the Dashed Stroke only uses the defined values.

See figure on the right with values filled in for Dash 1, Gap 1 and Dash 2. As no value is filled in for Gap 2,
the Dash 1 value will serve as Gap 2 and so on.

Thus, zero values and blanks give a different result. Zero defines the dash or gap value really as a zero
distance. With a blank the dash or gap value is completely ignored.

11.28.9.  Remarks on Stroke

• The resulting paths of a Stroke are a compound and receive the same color as the original.
• The original path is not deleted.
• A stroke consists of straight lines, even if the original path uses Béziers.
• A stroke is always created in the same layer and just above the selected path.
• If you use Square or Rounded Caps on a Dashed Stroke:, make sure the gaps are wider than the

Width.
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• When dashes overlap, the result makes one path. If e.g. you type in Width = 2 mm with Square or
Rounded Caps, the dashes will be united into one Stroke line when the gap is less than the Width
distance.

• In order to create a dotted line, define a Width, a zero Dash value, a Gap and rounded Caps

11.29.  Structural Design...

In the Structural Design dialog, you can check, modify or create ArtiosCAD die information.

The ArtiosCAD information can be defined in ArtPro, or can be imported: see Import file... on page 108.
The ArtiosCAD information can also be used to submit the job to Visualizer: see Open in Visualizer on
page 166.

 

 

11.29.1.  Line Types

You can check a line type by selecting it and looking at the Line Type in the Structural Design dialog, or
in the Object Parameters dialog.

A line type can be changed by selecting it, setting the Line Type to the desired value and clicking Apply.
This can also be used to create an ARD file from any other file, e.g. an imported CFF2 file.

11.29.2.  Link

The file name of the structural design file will be shown here. By clicking the triangle in front of the file
name, you can see the Printable area, the path of the file, and the Refresh Link and Clear Link button.

If the Structural Design information has been changed (eg. lines removed or changed Line Type), a
yellow warning sign is shown. If you export the Structural Design file, this new file will be linked. See
also Export... on page 111.

Moving all CAD lines together is not considered a “change”, so the warning sign will not be shown.

495



11 ArtPro

 Refresh Link
By clicking the Refresh Link button, the CAD layer is removed, and the linked CAD file is reimported, at
the same location of the original. If the linked file was not found at the indicated path, you will be asked
to locate the structural design file.

You can use the Autostroke CAD lines in ARD files option to decide if you want automatically
generated strokes on every ARD CAD line after refreshing. If the ARD file currently has automatic
strokes, the option will be enabled. You can disable it and Refresh to remove all autostrokes.

See Autostroke CAD lines in ARD files on page 111 for more information on Autostroke.

Important:  It is advised not to create regular objects inside the CAD Layers, or to move
Structural Design objects out of the CAD layer. If you do a Refresh Link or when you export
Normalized PDF, these objects will be removed.

 Clear Link
By clicking the Clear Link button, the link to the external CAD file is removed.

11.30.  Tools...

This allows to show or hide the Tool box. For more information on the tool box, see Toolbar and Toolbox
on page 517.

Shortcut: Cmd - Shift - T: Show/Hide Tool box

11.31.  Transform

Via the Transform dialog you can execute Move, Copy, Rotate, Scale, Mirror and Shear numerically.
To execute a transform function by using the Transform dialog box, you do not need to activate the
menu functions or their toolbar icon. Just select the objects, fill in the desired values and click on the
Transform button in the dialog box. You can open the Transform dialog box by selecting transform in
the Edit menu, by using its shortcut, or by double clicking any of the transform tools in the toolbar. All
the Transform functions are performed one after the other with movement as the last function.

In all input fields you can enter simple calculations: Add “+”, Subtract “-”, Divide “/”, Multiply “*”

All calculations are executed as they are typed in.

Shortcut: Cmd-L, Transform
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11.31.1.  Distance Vertical

Vertical distance for Move. Positive values work downwards, negative values upwards.

11.31.2.  Distance Horizontal

Horizontal Distance for Move. Positive values work to the right, negative values to the left.

11.31.3.  Scale Vertical

Scale factor in vertical direction. Negative values will scale and mirror the paths over the horizontal
axis of the ruler or the center of the bounding box.

11.31.4.  Scale Horizontal

Scale factor in horizontal direction. Negative values will scale and mirror the paths over the vertical
axis of the ruler or the center of the bounding box.

11.31.5.  Angle

Rotation angle. Positive values work clockwise, negative values counterclockwise.

11.31.6.  Shear

Shear angle. Positive values shear to the right and negative values shear to the left, always horizontally.

11.31.7.  Repeat / Copy

Repeat allows you to specify the number of times the transformation has to be applied. It works more
accurately than clicking transform several times, which is shown in the examples below. This function
can be used to create patterns, e.g. line patterns.
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Without copy, the original path is deleted, but all individual transforms are kept. With copy, the original
path is kept as well.

11.31.8.  Repeat: Example 1

To create a line of 2 mm width and copy it 100 times with a repeat distance of 5 mm, there are two
methods to choose from.

A. Without repeat:
create the line

fill in 5 mm as distance in the Transform dialog

fill in one copy

click 100 times Transform.

ArtPro’s internal resolution is 12000 dpi. Any value is recalculated to this internal resolution. For this
reason the following rounding error will occur:

5 mm distance = 2362 internal pixels

100 x 2362 pixels = 236200 pixels,

while 5 mm x 100 = 500 mm = 236220 pixels.

This means that your last line will be 20 pixels (±0.0423 mm) off.

B. Using repeat
create the line

fill in 5 mm as distance in the transform dialog

fill in 100 copies

click Transform once.

ArtPro will multiply the distance by the number of copies and calculate the value in internal pixels:

5 mm x 100 = 500 mm = 236220 pixels

Then divide the amount of pixels by the number of copies:

236220 / 100 = 2362.20

Now ArtPro works with this figure and rounds each time to the nearest complete pixel as follows:

1st copy = 2362.2 pixels => 2362 pixels

2nd copy = 2362.2 x 2 = 4724.4 => 4724 pixels

3rd copy = 2362.2 x 3 = 7086.6 => 7087 pixels

This ensures the rounding errors are minimal.
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Usually, method two is the preferred choice for making patterns.

11.31.9.  Repeat: Example 2:

If you have to make a background of squares in a chessboard pattern e.g., you create a 10 x 10 mm
square and want to copy it 10 times horizontally.

A. Without repeat
make a 10 x 10 mm box

fill in 10 mm distance in the transform dialog

set one copy

click Transform 10 times.

10 mm = 4724 internal pixels

Repeating 10 times = 47240 pixels

100 mm = 47244 pixels

The last square will short of the exact 100 mm total by just 4 pixels, but with each square butting up to
the next perfectly.

Although you have a rounding error in the width of the set of squares, the squares are nicely put side by
side.

B. With repeat
make a 10 x 10 mm box

fill in 10 mm distance in the transform dialog

set to 10 copies

click Transform

10 x 10 mm = 100 mm = 47244 pixels

47244 / 10 = 4724.4

Then the copies are calculated:

1st copy = 4724.4 => 4724

2nd copy = 2 x 4724.4 = 9448.8 => 9449

This means that in between the second and the third box there is a gap of one pixel. In the same way, an
overlap of one pixel can occur. Generally, a one pixel gap or overlap is not visible. Problems may occur if
boxes that do not touch are trapped, in this instance, the first method may be the best choice.
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Alternative: rounding step distance to internal units
An alternative and even quicker way to obtain the same result as with the first method is rounding the
step distance to internal units:

Make a 10 x 10 mm box

fill in 10 mm distance in the Transform dialog

switch to internal units in the Preferences menu

delete the (invisible) digits behind the comma or re-enter only the digits before the comma

switch back to mm

set to 10 copies
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Transform once.

11.31.10.  Copy

Copy can be activated to keep a copy of the original (in the same way as the option key when
transforming manually).

11.31.11.  Reset

Resets the values to 0, the scale values to 100% and deactivates the Copy option. All values are reset
except for the ones that are locked.

11.31.12.  Lock

Normally, when a manual transformation is performed, you will see numerical feedback in the
transform dialog. The lock icon allows you to freeze the value of the separate numerical input fields, so
that the entered value will not change with a manual path manipulation.

11.31.13.  Path

By default this option is activated so that all transform functions apply to all the selected paths. With
the toggle switched off, the paths are fixed in the job while their color information is transformed.
Thus, only the paint of the selected paths will be affected by transform manipulations. The latter can
be performed manually or numerically from the Edit menu.

This feature is particularly interesting in the following cases, for instance.

• To put a gradation to a specific angle : activate the option, select the path containing the vignette,
define the angle in the Transform dialog and execute the Transform function.

• To scale picture information keeping the image at the required position: activate the option, select
the path containing the picture, define the scale in the Transform dialog and execute the Transform
function.

11.31.14.  Paint

By default this option is activated so that all transform functions apply to the paint of the selected
paths. Transforming a path that contains a picture or gradation, will also transform the picture or
gradation. When you do not want the picture or gradation definition to change or to move, deactivate
Paint before transforming the path.
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Make sure to switch it back on (default) after using it, as this can be very confusing.

11.31.15.  Opacity Mask

By default this option is activated so that all transform functions apply to the soft masks of the
selected paths. Transforming a path that has a soft mask applied to it, will also transform the soft
mask. When you do not want the soft mask definition to change or to move, deactivate Soft Mask
before transforming the path.

Make sure to switch it back on (default) after using it, as this can be very confusing.

For more info on soft masks, see Opacity Mask on page 222

11.31.16.  Scale Strokes

The Scale Strokes option defines how strokes are handled if the parent path and its stroke is scaled.

If the option is off, the stroke width will not change. This means the parent path after scaling, will be
stroked with the same width as it was before scaling.

If the option is on, the stroke will remain a stroke, and its width will be changed the same percentage as
the parent path was scaled. Thus, scaling an object with a 3 mm stroke, to 150%, will result in an object
with a 4.5 mm stroke. When scaling unproportional, the stroke will be scaled by the geometric mean of
Vertical and Horizontal scaling. This means the stroke will be scaled proportionally. See example on the
right.

The formula for geometric mean is shown underneath.

 

 

If the stroke should be scaled unproportional the same way as the objects (see above, picture on the
right), the object and stroke should be scaled separately :

• Select the parent object only
• Scale the parent object manually or by using the transform dialog.
• Select the stroke only
• Apply the same scaling. If the values are unlocked (see above), the scaling factor for the parent

object will still be shown in the Transform dialog, so simply click Transform.
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11.31.17.  Center Paint

This option is only available if “Apply On: Paint” and “Opacity Mask” is off.

It will thus transform the path only, but it will reposition the paint, based on the center point of the
path. The point in the paint (in the image or placed file) that is on the center point of the original path,
will be placed on the center point of the path after transforming.

This can be used e.g. when scaling (or distorting) Step and Repeat files, without scaling the contents of
the paths, but still retaining their position inside the paths.

11.32.  Viewer

Viewer (or View Separations/Options, as it was called in earlier versions of ArtPro) is a very accurate
separation viewer with a lot of extra production tools. Viewer eliminates the need for separated proofs
and will avoid a lot of bad platemaking.

A number of settings can be found in the action button, by clicking the button at the top right of the

dialog .
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In the title bar of the window, the used Press settings is shown. See Press Settings on page 515

11.32.1.  Outline

The Outline option allows to switch to Outline mode. This can also be done using the Outline button.
See Preview / Outline on page 421.

Separations List
The Separations List allows you to hide or show some or all separations on the screen.

The same possibilities as for showing and hiding separations are available (see Separations on page
505)

Use Separations
This option, which is toggled off by default, allows the checking of the separations in vector mode as
well as in color mode. Without the option, showing or hiding separations only has effect in color mode.

Highlight Hairlines
This option, which is toggled off by default, will highlight hairlines, i.e. outline objects that may cause
problems when ripping, such as closed paths with lines lying exactly on top of each other, or rectangles
with zero thickness.

Note:  Open paths in ArtPro will never output, and thus will not be highlighted as “Hairlines”.

11.32.2.  Separations

The Separations option allows to switch to Preview mode. This can also be done using the Preview
button. See Preview / Outline on page 421.
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Show All
Clicking the All button will select all separations. If the All button was already selected, all separations
will be switched off, as well as the “All” button.

Show Single
The Single button will deselect all separations except for one.

If the Single button is on, switching on another separation will always deselect the one that was
switched on. If the visible separation is switched off, the Single state will also switch off.

If the Single button is clicked while it is on, both the Single and the All button will switch to indecisive
state ( - ). The separations will not change.

Separations
Clicking the eye button in front of a separation will switch the separation visible or invisible.

Switching separations on and off is influenced by the setting of the “Single” button, and can affect the
“All” or “Single” button. See above for a full explanation.

Color
By default a separation is displayed in color (the leftmost button). In order to see a separation as it
would appear on film, you can switch to “Black” (middle). By switching to “Negative” (right), the visible
separation will be shown negative in black. As both “Black” and “Negative” are most usefull on a single
separation, switching to one of those two will switch on “ Show Single” . It is still possible to switch on
more than one separation, which simulates putting films on top of each other, but in a digital way.
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View Order
By default the separations are shown with the first separation at the bottom (printed first) and the last
separation at the top (printed last). Using the button, you can reverse this order, e.g. for printing at the
backside of transparent substrates. Changing the order only effects the preview of opaque inks.

Highlight Overprints
Highlight Overprints will highlight the areas where a “trans” setting in the paint style takes effect. If e.g.
the magenta separation is set to “trans”, the area will only highlight if there is magenta underneath the
object. The highlight color defined in the Display tab of the preferences is used. See Display on page
59.

Highlight Transparencies
Highlight Transparencies will highlight all objects (regardless of what is underneath) with an opacity
percentage, a blend mode or an opacity mask. The highlight color defined in the Display tab of the
preferences is used. See Display on page 59.

Highlight Screen
The Highlight Screen check box highlights all objects with a defined screening. The areas are shown in
the highlight color defined in the Display tab of the preferences. See Display on page 59.

Highlight Traps
The Highlight Traps check box highlights all automatic traps in the file. The areas are shown in the
highlight color defined in the Display tab of the preferences. See Display on page 59. It can be very
useful for checking your trapping.

Highlight Screen Conflict
The Highlight Screen Conflict check box highlights areas where a screen conflict can occur. Screen
conflicts can occur if an object with transparency (opacity mask, opacity percentage or blend mode) is
on top of an object with another screening.

Example

In the example underneath, you can see a cyan rectangle, and a circle on top, with an opacity mask. The
objects have a different screening. Where the circle is on top of the cyan rectangle, the cyan will take
the screening of the blended circle. Therefor, as shown on the right, these areas will be highlighted as
Screen Conflict.
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Highlight Color Conversion Conflict
The Highlight Color Conversion Conflict allows to highlight where color changes can occur when
converting colors. A color change can occur if the color to be converted contains overprinting (“trans”)
to a color underneath.

An example on where the result can be different :

 

 

In the original file, the pentagon is Pantone239, and overprinting to cyan. After conversion, the color
would be set to 11%C and 79%M, so the overprint would be lost. The Highlight Color Conversion Conflict
will highlight the intersection of the pentagon and the square.

11.32.3.  Total Area Coverage

TAC or Total Area Coverage, is the sum of all separation-densities at a certain point in your document.
The TAC Limit is the maximal Total Area Coverage that your document may contain, depending on
the press and the substrate. The printer should provide the TAC Limit value. Default, this is set to
270%When switching to the TAC mode, the preview will be dimmed and all areas where the sum of
the densities is higher than the TAC limit specified below, will be displayed in highlight color. Using
the densitometer, you can measure the actual Ink Coverage in that specific area. To quickly see the
maximum TAC in the document, increase the TAC limit value. The higher the value, the less pixels will
typically violate the TAC limit. The default TAC limit is set in the Press settings. See Press Settings on
page 515.
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The Highlight color and background opacity (i.e. how much the rest of the job will be dimmed) can be
set in the Display tab of the preferences. See Display on page 59.

Note:  Technical inks are not taken into account

Example
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11.32.4.  Breakouts

A Breakout is an area where the percentage of a single separation is lower than the first visible dot
value. This can be used to track areas that won’t show up on print because the values are too low. The
printer should provide the First visible dot value. The First visible dot is set in the Press settings. See
Press Settings on page 515.

When switching to Breakouts mode, the preview will be dimmed and all areas where a single separation
has a value lower than the First visible dot value (but higher than 0%), will be displayed in highlight
color. Using the densitometer, you can measure the actual percentages in that specific area.

The Highlight color and background opacity (i.e. how much the rest of the job will be dimmed) can be
set in the Display tab of the preferences. See Display on page 59.

Note:  Technical inks are not taken into account

example
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11.32.5.  Flexo Plate

If you change the Viewer Preview mode to Flexo Plate, a single separation (default the first in the list)
will be shown as a simulated flexo plate. The Flexo Plate preview will use the First visible dot setting
defined in the Press settings. See Press Settings on page 515..

Pixels with a percentage lower than the first dot percentage will be shown as areas without dots. Pixels
with a percentage equal or higher than the first dot percentage will be shown as areas with dots.

This preview predicts how clean your flexo plates will be. Especially in very light or very dark areas, you
could end up with isolated dots or holes on the flexo plate, and those areas are dicult to hold on the
plate or the substrate

You can choose the plate color (Cyrel Red, Blue, Green or Safran Yellow, or a High Contrast Blue&White)
to match the type of plate you are using.

example
 

 

11.32.6.  Flexo Print

This Viewer view mode shows the effect of highlight dot gain on the image. This effect is equivalent
with curve adjustment. To determine this curve, the Flexo Print Preview will use the setting defined in
the Press settings. See Press Settings on page 515..
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Going from light to dark, the Preview will display percentages below the first dot percentage as 0%.
The first dot percentage will be shown darker (using the First Dot prints As value). Towards the mid-
tones this darkening effect will fade out until the Range value. Percentage larger than Range, are
displayed unchanged

example
 

 

11.32.7.  Registration Errors

The Registration Errors preview is a simulation of a design printed with registration errors. This Reg-
istration Error view can be very helpful to see if trapping is applied suciently and correctly.
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The separations are randomly shifted. In fact, all separations are moved exactly the distance of the
Registration Error, but all under a random angle. The default Registration error is set in the Press
settings. See Press Settings on page 515.

If you want to see another random registration error simulation, click the “Simulate Again” button.

example
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In the example above, you can see a small area of a job in regular preview (left) and with registration
errors (right). In this case, you can clearly see no trapping was applied, so white lines appear at the
registration shifts.

11.32.8.  Moiré detection

Moiré Detection allows to detect possible screening problems (Moiré) in the file.

You can set the options to highlight overlapping areas, to detect situations in which Moiré might
occur:

• when the two overlapping areas have screening angles that do not differ 30 degrees.
• when the two overlapping areas have the same angle
• when the two overlapping areas have different rulings
• when the two overlapping areas have different dot shapes.

You can use the Ignore inks option to ignore inks that have

• a density lower than a certain value,
• a density higher than a certain value
• a Luminance higher than a certain value

as in all those cases, the Moiré patterning will hardly be visible.

All these Moiré Detection options are stored in the Press Settings. See Press Settings on page 515

Note:  Technical inks are not taken into account

11.32.9.  View Options

The View options can be selected from the fly-out menu of Viewer.

Show Selections
This option allows you to hide or show the selections.

Show Notes
This option allows you to hide or show all the notes.

Show Borders
This option allows you to hide or show the job borders.

Show All Borders
If this option is enabled, not only the active Job border is shown, but all defined job borders will be
visualized. (see Job Size... on page 166)
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Show Transparent
With this option is de-activated, the paths with paint style 'all transparent' will be hidden when you are
in lineart mode. With this option activated, they will be shown as before.

Show Outline
With this option on, all paths are visible in color preview mode. In Outline mode, this option is always on
and disabled.

Show Center
All center points of path bounding boxes are indicated by a little cross. This option can only be used if
the Show Outline option is on too.

Show Grid
The Show Grid toggle switches the grid from PowerWarp on and off. This toggle can also be found in
the Grid Warp dialog. PowerWarp is an optional module in ArtPro.

11.32.10.  Press Settings

In the Press Settings, in the Viewer action button, you can select press settings. By selecting Manage
Press Settings next to it, you can add, copy, edit or delete press settings.

In the Press tab, you can define the name, the first visible dot, the dot gain in the highlights, the limited
total area coverage and registration distance.
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In the Moiré tab, you can define all Moiré related settings (see above).

All these values are used in the different Viewer windows.

The values are stored on your hard disk, in users/shared/EskoArtwork/Press_settings

11.33.  Windows

The Windows at the bottom of the Window menu allows you to activate the required window. All the
windows that are open will appear in the list (see also above under New View). Click on one to make it
active.

11.33.1.  Scrolling

Live scrolling is performed when, for any function, the cursor is dragged outside the active window. As
the cursor approaches any edge of the edit window, the display will automatically shift in the direction
of the cursor to show a new viewing area.

Scrolling is not applied if the arrow keys are used to move (as in that case the cursor is not dragged
outside the window.)
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12.  Toolbar and Toolbox
If the “Toolbar in Document Window” option in the Preferences is disabled, the toolbar is shown at the
top of your screen.

If the “Toolbar in Document Window” option in the Preferences is enabled, the Toolbar is always shown
at the top of every job window. This implies that the toolbar is not visible if no job window is open.

The Toolbar contains functions and tools, and can be fully customized (see below).

The Toolbox is a fixed set of tools. It can be shown or hidden from the Window > Tools menu, or using
its shortcut Cmd - ctrl - T. Some tools in the toolbar (e.g. the Edit Path tool) can be double-clicked to
open the corresponding dialog (e.g. the Edit Path parameters)

In both the Toolbar and Toolbox, buttons with a black triangle contain multiple tools, available by
clicking and dragging the button.

12.1.  Customizing the Toolbar

12.1.1.  Clicking and dragging

By holding the Cmd key, you can move any of the buttons to another place in the Toolbar. By dragging it
off the Toolbar, you can remove the button or set of buttons.

12.1.2.  Context menu

By right-clicking the Toolbar, you open the Context menu. You can use it to change the view (Icon&Text,
Icon only, Text Only, Small Size), to remove an item, or to open the Customize Toolbar dialog

12.1.3.  Customize Toolbar

If the Customize Toolbar dialog is open, you can compose your own Toolbar. You can drag and drop
items on the toolbar, change their location, or drag them off the toolbar.

Default set
At the bottom of the Customize Toolbar dialog, there is a “Default set”. By dragging this set onto the
toolbar, the content is replaced by the default toolbar set.
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Spaces & Separators
A few separators and spaces are provided, to allow you to organize and manage the toolbar as you
wish:

• Space: a single (fixed) space in between buttons.
• Separator: a vertical line in between buttons.
• Flexible Space: this will take up as much space as available. This can be used to align items to the

center or the right side.

Just like any other item, separators can be moved, removed, etc.

Available items
This gives an overview of all available buttons, and where to find additional information about it.

Workspace • Workspaces on page 426

View • Preview / Outline on page 421

Orientation • Orientation on page 539

Navigate • Pan on page 525

• Navigate on page 444

• Zoom Rectangle on page 526

Zoom • Zoom In on page 422

• Zoom Out on page 423

• Fit Job in Window on page 422

Print • Print : General Settings on page 135

• Export PDF on page 111

Launch • Launch Workflow... on page 135

Visualize • Open in Visualizer on page 166

Flatten • Flatten Transparencies on page 411

Automatic Trap • Automatic Trapping on page 310

Undo/Redo • Undo on page 180

• Redo on page 180

Select by Paint • Select Same Paint on page 246
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Select • Select on page 243

• Select by Attributes... on page 247

Transform • Transform on page 199

Move • Interactive Transform on page 200

• Move tool on page 202

• Move area tool on page 204

Rotate • Rotate on page 204

• Scale on page 205

• Rotate and Scale on page 206

Shear • Shear on page 207

Move Paint • Move Paint on page 211

Ruler • Ruler tool on page 523

• Magnetism... on page 441

3D Guide • Studio on page 332

Shape • Create Shape: general concepts on page 189

Edit Path • Edit Path on page 530

• Edit path options on page 531

Path • Retrace Path on page 534

• Split Path on page 536

• Cut Path on page 537

• Intersect Paths on page 538

Instant Trap • Instant Trapper on page 297

PowerTrapper • PowerTrapper on page 280

• Select Trap on page 538

Fix Thin Part • Thin Parts on page 415

Text • Edit Text on page 527
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• Text Style... on page 231

Compound • Compound on page 219

Group • Group on page 221

Opacity Mask • Opacity Mask on page 222

Front / Back • Bring to Front on page 198

• Send to Back on page 198

Forward / Backward • Move Forward on page 198

• Move Backward on page 199

Note • Notes on page 181

Measure • Measure on page 524

• Densitometer on page 526

White Underprint • White Underprint on page 418

Rich Black • Rich Black on page 419

Select by Attributes • Select by Attributes... on page 247

Certified PDF • Certified ArtPro on page 65

Bar code • Generate Bar code on page 263

Strokes • Stroke... on page 491

Parameters • Parameters... (ArtLink) on page 171

Separations • Separations... on page 470

Links • Links on page 438

Fonts • Fonts... on page 433

Screens • Screens on page 469

Bar codes • Bar codes on page 430

Shuttle • Shuttle on page 491

Ink Coverage • Ink Coverage on page 414

Messages • Messages on page 444
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Layers • Layers... on page 434

Paint • Paint Style... on page 452

Object Parameters • Object Parameters on page 445

Screening • Screening on page 252

Viewer • Viewer on page 504

12.2.  Toolbox

The Toolbox is a fixed set of tools. It can be shown or hidden from the Window > Tools menu, or using
its shortcut Cmd - ctrl - T. Some tools in the toolbar (e.g. the Edit Path tool) can be double-clicked to
open the corresponding dialog (e.g. the Edit Path parameters)

Buttons with a black triangle contain multiple tools, available by clicking and holding the button.

12.2.1.  Toolbox overview

 

 

Tool Double-click opens ... ArtPro Classic ArtPro Like
Illustrator

1 Select on page 243 Select by Attributes... on
page 247

V or hold Cmd V or hold Cmd

2 Interactive Transform on page
200  Move tool on page 202
Move area tool on page 204
Rotate on page 204 Scale on

Transform on page 199 E Cmd - Shift - M E
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Tool Double-click opens ... ArtPro Classic ArtPro Like
Illustrator

page 205 Rotate and Scale on
page 206

3 Ruler tool on page 523 Magnetism... on page 441 Cmd - Alt - R R

4 Measure on page 524 Cmd - D

5 Pan on page 525 Navigate on page 444 H or hold Alt H or SPACE

6 Zoom Rectangle on page 526 Fit Job in Window on
page 422

Z Z

7 Densitometer on page 526 I I

8 Create Shape: Box on page 190
Create Shape: Ellipse on page
191 Create Shape: Polygon / Star
on page 192

The corresponding dia-
log

M L M L

9 Edit Text on page 527 Text Style... on page 231 T T

10 Create Note on page 182

11 Edit Path on page 530 Edit path options on
page 531

Cmd - Shift - E A

12 Retrace Path on page 534 Split
Path on page 536 Cut Path on
page 537 Intersect Paths on
page 538

Edit path options on
page 531

C C

13 Trap to Object Instant Trapper on page
297

14 Trap to All Instant Trapper on page
297

15 Select Traps PowerTrapper on page
280 if document hasn’t
been trapped yet,
otherwise Trapping Pairs

16 Fix Thin Parts Thin Parts
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12.3.  Select tool

See Select  on page 243.

12.4.  Transform tools

See Transform on page 199.

12.5.  Ruler tool

The Ruler is the origin of the ArtPro document and can be moved around. The center for the linear
transformations (rotation, scale, mirror, shear) is the zero point of the activated Ruler.

See also Ruler on page 423

The Ruler can be moved using the Move Ruler tool

12.5.1.  Moving the ruler

• choose the ruler icon from the toolbar or use its shortcut: Cmd-Alt-R, then click (and drag) to
position it in the job window. Hold the shift key down to make the ruler snap to 9 magnetic points on
the job size or the selection. The ruler will snap to those points when it comes within a range of two
screenpixels.

• choose the ruler icon from the toolbar or use its shortcut: Cmd-Alt-R, then use the arrow keys
to move it around. The step size is specified in the Ver. Key Step and Hor. Key Step fields in the
Magnetism dialog (see Magnetism... on page 441).

• Hold the shift key down to make the ruler snap to 9 magnetic points on the job size or the selection.

• You can also move the ruler by clicking near the ruler origin in the move path mode.
• by using the shift key while moving the ruler, the ruler is snapping to 9 magnetic points. These 9

magnetic points are left, center and right, resp. bottom, center and top, and work on the bounding
box of the selected objects. When no paths are selected, the magnetism is applied to the borders of
the job. There is also a magnetism to the ruler itself for horizontal and vertical movements.
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• by using the arrow keys the ruler will move in steps, vertically or horizontally.

• when pressing the arrow keys together with the shift key, magnetism is used: shift-left, shift-right,
shift-up and shift-down moves the ruler to the next magnetic point in that direction. When there are
no more magnetic points in that direction, the ruler does not move. Again magnetism applies to the
bounding box of the selected paths or to the borders of the jobsize if no paths are selected.

If you hold down the option key while moving the ruler, you can create a new guide. For more
information on how to use guides, see Activate Guides on page 443.

Shortcut: Cmd-Alt-R : Move Ruler tool

12.6.  Measure

 

 

The Measure function allows you to measure the distance between two points. It can be activated by
its toolbar icon or by its shortcut Cmd-D. Activating the function will open the Measure box.

12.6.1.  Measuring the Distance

After activating Measure, click and/or drag a starting point and release the mouse button, then click
and/or drag an end point. The Measure dialog displays the distance between these two points, the
vertical and horizontal distances of their bounding box and the angle (see figure on the right).
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Holding down the SHIFT key will activate magnetism to the nearest path. The start and end points can
be moved just by clicking on them and dragging them to another position. Clicking somewhere else
results in a new starting position. In between clicks, View functions can be used (zooming, scrolling,...).

It is also possible to restrain measuring to Vertical or Horizontal, by holding the Alt key. Keep in mind
that the Alt key should be used while dragging the second measuring point, otherwise holding the Alt
key will activate the pan tool.

The correct sequence is:

click the start point

click and drag to define the end point

while dragging, use the Alt key to restrain measuring to vertical or horizontal

release to define the end point

12.6.2.  Measuring the Bounding Box size

Measuring the size of one or more objects is done simply by selecting them. The bounding box size of
these objects is displayed in the Box, Ellipse, Polygon and Spiral dialog.

12.7.  Pan

 

 

With the Pan function the ArtPro document can be moved around in the active window. Pan can be
used in two ways:

• by dragging in the direction and over the distance that the document should move in the window.
• by clicking, whereby the point you click on will move to the center of the window.
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The Pan function can be activated in the View menu, by its toolbar icon (= hand) or by holding the Alt
key.

12.8.  Zoom Rectangle

 

 

Zoom Rectangle enlarges or reduces the indicated part of the job in the window.

The Zoom rectangle to enlarge can be activated:

• by the menu function
• by its toolbar icon (= the magnifying glass)
• with the CONTROL key

It can be used in two ways: first just by clicking in the window, whereby the point you clicked is kept
at the same place in the window. The job is displayed twice as large. Second by clicking and dragging
a rectangle around the part you want to zoom in on. The job is displayed as large as possible with the
dragged rectangle at the center of the window.

The Zoom rectangle to reduce can be activated:

• by the menu function in combination with the Alt key
• by the toolbar icon (= magnifying glass) in combination with the Alt key
• by the Ctrl-Alt shortcut.

It will reduce the job view, whereby the point you clicked is kept at the same place. The job is displayed
at half size.

12.9.  Densitometer

 

 

The Densitometer allows to show the resulting amount of inks at a certain spot. All transparencies,
blend modes, images, etc., are included in the calculation.
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The Densitometer allows continuous sampling : by clicking and dragging, the Densitometer shows
instantly the values of the position of the mouse.

By double-clicking a spot in the job, the Paint Style is set to Flat Color, and the measured values are
copied to the Paint Style.

Note:  As of ArtPro 12.0, the values in the Densitometer are shown with 1 decimal for greater
accuracy. Note that small rounding errors may still occur (a difference of max. 0.4%).

12.10.  Create Box / Ellipse / Polygon

See Create Shape: Box on page 190, Create Shape: Ellipse on page 191 and Create Shape: Polygon / Star
on page 192

12.11.  Edit Text

 

 

Edit allows you to create an area for typing text (= text box) and to modify existing text. The Edit
function can be activated by the menu function or by its toolbar icon. The Edit Text tool can also be
activated by double clicking an existing text box with the select arrow.

12.11.1.  Creating text

A text area can be created numerically (see Text Box... on page 224) or manually.

• Activate the Edit function in order to create a text area manually. The cursor changes into the
typical text cursor, the I-Beam pointer I.

• Define the text box area: Clicking in the job window will define a starting position for the text. It will
be put on one line, unless you type in a hard return. Clicking and dragging horizontally will define a
column width for the text. Its measurements are shown in the Text Box... dialog in the Horizontal
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Size field. Clicking and dragging a rectangle will define a column width and depth for the text box.
The column width is reflected by the Horizontal Size field and the column depth by the Vertical Size
field in the Text Box dialog.

• Start typing text into the box immediately. Empty text boxes automatically disappear in ArtPro. The
text you compose will come in the text parameters which were active on the moment you created
the text area. Afterwards you can modify the total text area or just the selected parts of the text

12.11.2.  Selecting text

1. Selection of the whole text box:
To select the total text area (= text box), activate the Select tool (= arrow) (see Select  on page 243) and
click on a character or drag a rectangle around the total area.

2. Selection of part of a text box:
• To select a part of the text box, activate the Text tool and then select part of the text by clicking

between the characters and dragging. This is very similar to the selection of text in other ap-
plications.

• Clicking puts the text cursor either before or after the letter, depending on which side is closest.

Note:  Note that there are two different text statuses at positions where the status changes.
Example: [font 1]ABC[font 2]DEF. The status behind the C is not the same as in front of D.

• Double clicking selects the word.
• Triple clicking selects the line.
• Quadruple clicking selects the paragraph.
• Quintuple clicking selects the text of the complete text box.

12.11.3.  Modifying text

1. In order to modify the text parameters:
Select the relevant text, change the parameters in the Text Box, Paragraph, Character, Underline
or Tabulations dialogs, and click Apply in the respective dialog box. Note again the use of the Text
Style menu (see above) with the most common text parameters, which can be changed directly in the
menu without the need for applying. When text with different parameters is selected, the variable is
unknown. This is indicated by a blank input field for that variable or a check box marked with a dash.
Thus it is possible to change in text with different settings one parameter only without modifying the
others.

2. In order to modify the text color:
Select the relevant text, specify the color in Paint Style and click Apply in this menu, or activate a color
from the Color Palette. Text in vector mode is always black, in preview the text color is shown. A text
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box which is being edited, is shown black in Preview. Selected text has the selection color, both in
preview and in vector mode. Text can be colored with a flat color only, with or without transparency,
visible on the screen. In order to color text with a vignette or a picture, it will have to be converted to
paths before applying the paint.

12.11.4.  Dragging text to another position

By clicking inside a selected text part and dragging it, you can move this selection.

If the OPTION (= Alt) key is down you can copy the selection while moving it to another position. This
is only possible within the same text box. To move text to another text box you can use Copy, Cut and
Paste (see below).

12.11.5.  Copy, Cut and Paste

When editing a text, the commands Copy, Cut and Paste are supported.

Cut = Cmd-X Copies the selected text to the clipboard and deletes the text from its original position.

Copy = Cmd-C Copies the selected text to the clipboard.

Paste = Cmd-V Pastes to the position of the text cursor

These commands keep tabulation and paragraph ends, but the typographic state will change to the
settings on the position where the text is inserted.

Select All = Cmd-A Selects all text in the current text box

12.11.6.  Cursor Keys

Left and right arrow keys move the cursor to the left or right of the insertion point. Up and Down arrow
keys move the text cursor vertically to the insertion point which is closest to the initial position.

If the SHIFT (Shift) key is down, the range from start to end will be selected.

Cursor keys also work with command or option: see Text: Cursor Keys on page 46

12.11.7.  Typographic Codes & Functions

For an overview of the Typographic Codes and Functions, see Text: Typographic codes and functions on
page 46

12.12.  Note tool

See Create Note on page 182.
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12.13.  Edit Path

 

 

12.13.1.  General

Edit Path allows you to draw paths from scratch with straight lines, freehand drawing or Bézier curves,
to modify existing paths and to append points to existing paths.

 

 

Edit Path can be activated by the white arrow tool, by its menu function or its shortcut Cmd-Shift-E.
Double clicking on the tool in the toolbar activates the Edit Path menu.

When drawing a path, you can freely switch between the five types of line during the process. The new
path is generated with splines so that it can easily be edited afterwards. The different segments that
are added to the path can be removed separately with the BACKSPACE key.

Only one path can be edited at a time. It must be selected with a regular selection tool first and then
clicked on with the edit path tool. Deselecting also happens with a normal selection (Cmd). With
multiple windows the path under edit is only visible in the active window.

Drawing a path
 

 

Activate the white arrow tool or the Edit Path function.

Activate the necessary options in the Edit Path menu

Click (or click and drag) in the job window where you want the starting point of the line.

530



12ArtPro

After having defined the starting point you can define the next points. The cursor changes into a white
arrow with a black plus (append mode). Press the Shift key and place the end point on the start point in
order to close the path or use Cmd-J to Join, see further in this chapter.

In the first case, press the ENTER button to confirm the function.

 Modifying a path
 

 

Select the path you want to modify (unless Select before Path Edit is off).

Activate the edit path tool or the Edit Path function.

Activate the necessary options in the Edit Path menu (see below).

Click on the path you want to edit, so that its anchor points and handles appear.

Select the necessary point(s) or directly click on points of the path to select and modify them. Several
modification possibilities are available in the Edit Path menu (see below).

A change to a path is confirmed when the ENTER key is pressed or any other tool or function is
activated.

Adding to a path
 

 

Select the path you want to add to (unless Select before Path Edit is off).

Activate the white arrow tool or the Edit Path function.

Activate the necessary options in the Edit Path menu (see below).

Click on the open path you want to add to, so that its points appear.

Clicking on Append in the Edit Path menu will select a point at the end of the path. Click Append again
if you want to select the other endpoint. You can also directly click on the point to which you want to
append. The cursor changes into a white arrow “plus”.

Draw the points you want to add.

Press the ENTER button to confirm the function.

12.13.2.  Edit path options

All the options are activated by default.

Enable Inserting Points
Allows you to insert points on the path being edited by clicking on it. On straight lines straight points
will be added, on Bézier curves round points will be added.
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Show Handles
If this option is on, the handles of the Bézier curves are visualized in addition to the control points.
When this option is deactivated, only the control points are visible and one handle of the last point.
Even with this option deactivated, you can draw bézier curves, but you will not be able to see the
handles.

Enable Converting Corner
Makes it possible to convert a straight point into a round one (and vice versa) by double-clicking on the
point. A curve with only one handle will be converted to a straight point and back to a point with one
handle.

If you want to change it into a point with two handles, you should first delete the single handle, and then
change it into a point with handles by double-clicking the control point.

Enable Append
Allows you to add to an open path (see above under Adding to a path) If the option is deactivated, you
will not be able to append to the path, so the cursor will not change from white arrow to a white arrow
plus, if you click on one of the end points. This can make the editing of those end points a bit easier.

Use Arrow Keys
When this option is active, selected points (these can be handles or control points) can be moved using
the keyboard arrow keys, with the distance set in the Preferences dialog box (see p.132). When moving
points while holding down the shift key, the points will snap to the most nearby magnetic points. When
moving points with the arrow keys while holding down the shift key, the points will snap to the ruler.

Select Before Path Edit
When this option is active, a path has to be selected before you can apply one of the path editing
functions (edit path, retrace path, split path, cut path or intersect path). If the option is switched off,
you can edit a path directly, without having to select it first. The drawback is that, if you start editing at
a place where two contours overlap, you can not be sure what contour will be edited.

Append / Modify
Allows you to either append to an open path or to modify an existing path as described above. The
cursor indicates which edit mode is active by showing a white arrow plus (append) or a normal white
arrow (modify). You can also switch between the two modes by just clicking on a point of the path: if
you click on a start or an end point Append mode will be activated, if you click on any other point Modify
is used.

Draw
• Mixed. With this option, activated by default, you can edit a path using a combination of the three

types of points available, as described below. Simply click to draw Straight Lines. Click and drag
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to obtain Bézier curves. Click and hold last point, then press the CONTROL key to draw Freehand
paths.

• Straight Line. Click to define the next point. Dragging will enable you to change the position of
that point before you release the mouse button. Using SHIFT will constrain the paths to vertical or
horizontal lines or lines over multiples of the Constrain Angle, set in the Edit Preferences dialog (by
default 15°).

• Bézier. Every click or click-and-drag will define the end point of a curve segment. Automatically, a
curve will appear between the last added point and the point you click. When clicking, drag to pull
out the handles of the Bézier point so as to define their direction and length. These handles are the
control points that define the tangents of the splines. They can be modified at any time by selecting
them and dragging them to a new position. When both handles are selected, they move equally so
that the connection is smooth. With the SHIFT key down, rotations are restricted to multiples of the
Constrain Angle set in the Edit Preferences menu (by default 15°).

• Freehand. Drag to define the line. Under the mouse arrow the line is built up automatically. When
you release the mouse button, the freehand line stops.

• Interpolate. Every click or click-and-drag will define a point on the path. Dragging will enable you
to change the position of that point before you release the mouse button. Each time you set a
point, ArtPro will create handles in the previous point to create a smooth curve through the defined
points.

Note:  Hitting the SPACE bar will switch between the 5 Draw options, following the order in
the list Mixed-Straight Lines-Bézier-Freehand-Interpolate. The 5 options are also used for the
Retrace Path and Split Path functions (see later).

Average Anchor Points
• Horizontally: default option which places the selected points on the horizontal center line of their

surrounding bounding box.
• Vertically: places the selected points on the vertical center line of their surrounding bounding box.
• Both: puts the selected points on the center of their surrounding bounding box, thus on top of each

other.

Select All
Allows you to select all the points (control points and/or handles) on a path, according to the active
option. You can select anchor Points Only, Handles Only or Handles and Anchor Points (default)

12.13.3.  General Remarks

• All the points can be selected and manipulated separately. Points can be selected by clicking
on them or drawing a rectangle over them. Use the Shift key to add to (or inverse) the selection.
When a Bézier anchor point is clicked on, its handles will be selected as well. The handles can be
(de)selected separately by clicking on them, also in combination with x.

• Some paths contain vectors which are all straight lines from which you can move the end points.
Paths can also contain splines which are indicated by their tangents. The position of the spline and
its tangent points can be changed. When both handles are selected, they move equally so that the
connection is smooth or they stay at the same angle.
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• There will be no tangent if you click points without dragging, when working with Bézier curves.
If you try to pull out the tangent from any point, you will see that you move it instead. To obtain
the handles, double-click the point to convert the corner from straight to round. The handles will
appear automatically.

• With the Shift key down, handle rotations are restricted to multiples of the Constrain Angle set in
the Preferences menu (by default 15°).

• Lines created with Draw Path are always open segments unless you define the end point exactly on
the starting point, using Shift. In order to close the path when drawing or appending, press and hold
down the x key before placing the end point on the start point. When you do not use x, the paths will
still be open and the start and end point have to be joined with the Join Paths function (see later).

• The selected points can be moved with the arrow keys (see above) and can also be made to snap to
any magnetic object (ruler-grid-path) when x is pressed while moving.

• When curve points are deleted, the program will adjust the curve in such a way that it remains very
similar to the original curve. Since handles can be (de)selected separately, they can be deleted
separately as well. As a consequence, this feature will allow you to create a “bump-like” curve in the
following way. Draw one Bézier curve segment and press x-delete to remove the last handle. Draw
the next curve segment and x-delete again, and so on.

• Editing a vectorized path can be complicated because of the large amount of points you have to
move. Therefore it may be better to use the Distort Path function instead. Edit Path can still be
useful for a vectorized path with fewer vectors.

• When you switch from another drawing mode to interpolate, clicking a point will change the handles
of the previous point, regardless of what drawing mode it was created with, unless the point already
has handles. This means creating a point with interpolate after drawing straight line will cause the
last point set with straight line to have handles. As points set with Bézier already have handles,
these handles will not be changed by using interpolate.

12.14.  Retrace Path

 

 

Retrace Path allows you to retrace a part of a path. The Retrace Path function can be activated by the
menu function or by its toolbar icon.

Retracing a path:

Select the path(s) to be modified.

Activate the retrace tool or the Retrace Path function.

Activate the line type you want to use in the Edit Path menu.

Click a point on a selected path from where you want to start retracing.

Click points in order to draw the new part which will replace the old one. You can define as many points
as you want. During the process the different segments you are adding can be removed again one by
one with the BACKSPACE key.

The Retrace Path function uses straight lines, freehand drawing, Bézier curves or interpolate. While
retracing, you can freely switch between those four types at any time.
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(For the use of these lines : see Edit Path)

Click a point on a selected path to define the end point.

Press the ENTER button to confirm the function. The new part of the path has replaced the old one,
which disappears automatically.

 

 

12.14.1.  Remarks

• ArtPro always replaces the shortest part of the path between start and end point. Internally, the
shortest part is the one with least anchor points. Sometimes that part can be the one you do not
want to replace. If at any time ArtPro retraces the wrong way, use the Retrace Other Way function in
the Object menu (see below).

• Defining only start and end points without drawing points in between will retrace with a straight
line.

• If you click the start point on one closed path and the end point on another, you are retracing from
one path to another.

• You can retrace one single open path but it is not possible to retrace between different open paths.

12.14.2.  ...Other Way

... Other Way retraces the other part of the path in the Retrace Path function.
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Other Way can be activated by the menu function or by its keyboard shortcut Cmd-/.

With Retrace Path, the shortest part of the path between the two points will be replaced. The shortest
part for the computer is the one with the fewest memory points, which is sometimes the longest
in distance. If the computer gives the wrong part of the path, click ...Other Way immediately after
performing the Retrace Path function.

Shortcut:

Cmd-/, Retrace other way

12.15.  Split Path

 

 

Split Path allows you to divide one path into two parts, or to make one path out of two, splitting from
one path to another. The function is activated by clicking on it in the Object menu or by its toolbar icon.

12.15.1.  Splitting a path

Select the path(s) to be split.

Activate the split tool or the Split Path function.

Activate the type of line you want to use in the Edit Path menu.

Click a point on a selected path from where you want to start splitting.

Click points in order to draw the path for the split. You can define as many points as you want.
During the process the different segments you are adding can be removed again one by one with
the BACKSPACE key. The Split Path function uses straight lines, freehand drawing, Bézier curves or
interpolate. While retracing, you can freely switch between those three types at any time. (For the use
of these lines: see Edit Path)
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Click a point on a selected path to define the end point of the split.

Press the ENTER button to confirm the function. The path is now split into two paths and the original
path has disappeared automatically.

 

 

12.15.2.  Remarks

• Sometimes splits gives unexpected results. This can be due to the fact that the incoming line of
the split crosses the original line, whereas it should always come in straight. Therefore, it is good
to save your document before doing large series of split functions. So if a split goes wrong you can
revert to the saved version or use the multiple Undo option.

• Defining only begin and end points, without drawing points in between, will split with a straight line
between these two points.

• If you click the start point on one path and the end point on another, ArtPro will connect the two
paths. In this way you can make one path out of two.

• It is not possible to split open paths.

12.16.  Cut Path

 

 

Cut Path cuts the selected path on the position you click. Cut Path can be activated by the function in
the Object menu or by its toolbar icon (= one cut line). A cut path is always open, even if its start and
end points are exactly on the same position. You can recognize an open path by its small round points
which define beginning and end. If you see only one such point it means that begin and end are on the
same position. An open path can be closed again with Join Paths .
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12.17.  Intersect Paths

 

 

Intersect Paths cuts two paths exactly on their intersection. It can be activated by the function in the
Object menu or by its toolbar icon (= two lines cut on the intersection).

Click close to the points where the paths intersect, with at least one of the paths selected. The result
will be open segments from both paths. The tool accepts open paths to work on. You can’t perform the
function on a path that intersects itself.

 

 

The intersect tool can be useful for creating complex shapes: create the elementary shapes from
which you want to build the shape. Next cut these shapes into the parts required to form the shape,
using Cut Path, Intersect Paths and Join Paths.

12.18.  Trap to Object

See Instant Trapper on page 297

12.19.  Trap to All

See Instant Trapper on page 297

12.20.  Select Trap

See PowerTrapper on page 280.
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12.21.  Orientation

The Orientation buttons allow to change the orientation of the Preview of the job.

Keep in mind that this only changes the rotation of the preview, it does NOT actually rotate the job.

12.22.  Fix Thin Parts

See Fix Thin Part Tool on page 417.
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